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Contact Us

Online: NetAlly.com
Phone: (North America) 1-844-TRU-ALLY
(1-844-878-2559)

NetAlly, LLC
2075 Research Parkway, Suite 190
Colorado Springs, CO 80920

For additional product resources, visit:
https://www.netally.com/products/airmagnet-survey-pro/

For customer support, visit:
NetAlly.com/Support

Register Your Product

Registering your product with NetAlly gives you access to valuable information on product updates, troubleshooting procedures, and
other services.

Register on the NetAlly Support Page.

Legal Notification

Use of this product requires acceptance of the Terms and Conditions available at
https://NetAlly.com/terms-and-conditions or which accompanies the product at the time of shipment or, if applicable, the legal
agreement executed by and between NetAlly and the purchaser of this product.

Open-Source Software Acknowledgment: This product may incorporate open-source components. NetAlly will make available open-
source code components of this product, if any, at Link-Live.com/OpenSource (requires login).

NetAlly reserves the right, at its sole discretion, to make changes at any time in its technical information, specifications, service, and
support programs.

© 2025 NetAlly, LLC
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Introduction

AirMagnet Survey PRO contains powerful, easy-to-use tools for planning, collecting, and analyzing WLAN site radio
frequency (RF) data crucial for successful WLAN deployment. Operating at the RF level, AirMagnet Survey helps you quickly
and easily conduct RF site surveys and determine the optimal number and placement of WLAN infrastructure devices to
provide the best coverage and throughput in a cost-effective way. You can understand the behavior of radio waves in a
facility beforeyou install any wireless network access points.
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Introduction

Product Overview

AirMagnet Survey PRO contains powerful, easy-to-use tools for planning, collecting, and analyzing WLAN site radio
frequency (RF) data crucial for successful WLAN deployment. Operating at the RF level, AirMagnet Survey helps you quickly
and easily conduct RF site surveys and determine the optimal number and placement of WLAN infrastructure devices to
provide the best coverage and throughput in a cost-effective way. You can understand the behavior of radio waves in a
facility beforeyou install any wireless network access points.

« AirMagnet Multi-Floor Planneris a wireless network planning tool that accounts for building materials, obstructions,
access point configurations, antenna patterns and a host of other variables to provide a reliable predictive map of Wi-Fi
signal and performance. The solution offers superior predictive modeling to determine ideal quantity, placement and con-
figuration of APs for optimal security, performance and compliance.

* AirMagnet Multi-Floor Planner includes built-in automated tools to help you form a migration strategy from existing legacy
802.11a/b/g/n networks to Wi-Fi 5/Wi-Fi 6 technology.

» AirMagnet Multi-Floor Plannercan be purchased as a separate product or as a fully integrated feature of AirMagnet Survey.
When integrated with AirMagnet Survey, you have a powerful solution that combines state-of-the-art predictive modeling
with real-world performance data.

Copyright
© 2004-2025 NetAlly

This User Guide is furnished under license and may be used or copied only in accordance with the terms specified in the
license. The content of this document is for information only and should not be construed as a commitment on the part of
NetAlly.

No part of this document may be reproduced, transmitted, stored in a retrievable system, or translated into any language in
any form or by any means without the prior written consent of NetAlly. Further, NetAlly reserves the right to modify the
content of this document without notice.

NETALLY SHALL NOT BE HELD LIABLE FOR ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THIS CONTENT.

AirMagnet® and AirWISE® are registered trademarks, and the AirMagnet logo is a trademark, of NetAlly, LLC. All the other
product names mentioned herein are trademarks or registered trademarks of their respective companies.

This product features Autodesk RealDWG technology. See https://www.autodesk.com/developer-network/platform-tech-
nologies/realdwg
This product includes software developed by David Young. Copyright 2003, 2004. All rights reserved.

This product includes software developed by Atsushi Onoe. Copyright 2001. All rights reserved.
This product includes software developed by Sam Leffler, Errno Consulting. Copyright 2002-2005. All rights reserved.

This product includes software developed by Bill Paul <wpaul@ctr.columbia.edu>. Copyright 1997, 1998, 1999. All rights
reserved.

This product includes software developed by the University of California, Lawrence Berkeley Laboratory and its contributors.

This product includes software derived from the RSA Data Security, Inc. MD4 Message-Digest Algorithm. © 1990-1992 RSA
Data Security, Inc. All rights reserved.

This product includes software derived from iPerf Performance Test:
iPerf2 - Copyright 1999-2007, The Board of Trustees of the University of Illinois. All rights reserved.

iPerf3 - Copyright 2014-2020, The Regents of the University of California, through Lawrence Berkeley National Laboratory. All
rights reserved.

Powered by NetAlly.

NetAlly
2075 Research Parkway, Suite 190
Colorado Springs, CO 80920

Compiled in the United States of America.
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Version: v12.0, Released 06/25/2025

AirMagnet Survey PRO vs. Survey Express

AirMagnet Survey comes in two versions: PRO and Express. The table below highlights the similarities and differences

between the two.

Product Features Survey PRO Survey Express
Site Survey scenarios |Indoor site survey Yes Yes
Outdoor site survey Yes No
Coverage maps RF signal coverage Yes Yes
Data rate Yes Yes
Channel interference Yes Yes
Wi-Fi (AP operating mode, Channel width, Max [Yes No
MCS)
Packet loss/retry Yes Yes
Floor-based Single-floor data display and analysis Yes Yes
deployments Multi-floor data display and analysis Yes No

802.11 deployments

Up to 802.11be

Up to 802.11be

Surveying capabilities

Passive surveys Yes Yes
Active surveys Yes Yes
Active iPerf surveys Yes No
Data simulation Yes Yes
Active tools Yes Yes
200+ channel deployment Yes No

Reporting capabilities

Survey Reports

Multiple reports

One Report*

Network design veri- |Network design verification Yes No
fication P
VoWLAN deployment verification Yes No
Cisco Prime NCS/WCS [Survey Integration Yes No
Planner Integration Yes With purchase of
AirMagnet Planner
Module.
Network Planning AirMagnet Multi-Floor Planner Yes With purchase of

AirMagnet Planner
Module.

* AirMagnet Survey Express has one default report: ‘Overall Coverage Report by Channel’.

Additional Notes regarding AirMagnet Survey PRO and AirMagnet Survey Express:

« If you are installing AirMagnet Survey PRO, you should see the words “Survey PRO” across the top of the sticker bearing
the serial number and serial key; if you are installing AirMagnet Survey Express, you’ll see the word “Survey Express”.

« AirMagnet Survey PRO offers more features than AirMagnet Survey Express. If you are using AirMagnet Survey Express and
wish to upgrade to AirMagnet Survey PRO, contact your NetAlly product reseller or NetAlly Technical Support.

-11-



Introduction

Key Features and Benefits

AirMagnet Survey offers the following key features and benefits (Note that some of the features are available in Survey PRO
only):

« AirMapper™ support via Link-Live:

©  You can perform a survey with the AirMapper application on a NetAlly handheld tester device (AirCheck G3,
EtherScope nXG, CyberScope, or CyberScope Air), upload the results to Link-Live, and then export the survey to
AirMagnet Survey PRO.

© AirMapper export:You can export data from AirMagnet Survey to NetAlly's Link-Live cloud service for easier project
sharing.

See Using Survey with NetAlly AirMapper for more information.

o Multi Floor Planner(MFP) enables you to design a Wi-Fi network in a multi-floor building. With MFP, you can create a new
project for one or more floors and you can also import individual Legacy AirMagnet Multi-Floor Planner projects for one or
more floors as well. By creating a single building project in this way, you can see predictive heatmap visualizations, for
example, of how APs on one floor may propagate signal strength coverage to other floors. It includes support for
802.11a/b/g/n/ac/ax APs and the 6 GHz band.

* GPS support allows you to use any AirMagnet-supported GPS device for large-scale, outdoor WLAN site surveys. The
program can automatically calibrate GPS location information (longitude and latitude) of any given point on the site and
place APs in their optimal locations. It can also automatically collect site data as you are moving (walking or driving)
along the survey path. Available in AirMagnet Survey PRO only.

« AirWISE Integration incorporates AirMagnet’s AirWISE technology into the Survey product to help wireless LAN planners
and administrators make well-informed decisions regarding the requirements for their WLAN deployment and
maintenance using real data collected from a site survey. It is geared towards helping identify critical issues in WLAN
performance and providing straightforward actionable solutions to the issues that are identified. For example, one of the
policies can help you determine WLAN readiness for "Cisco Location-based Services." Available in AirMagnet Survey PRO
only.

« Comprehensive survey data reports let you turn your survey data and simulation results into various data reports. The
reports contain comprehensive information on channel allocation and usage, WLAN SSID coverage and throughput, AP
coverage, RF interference and noise, etc. The reports can be exported in popular file formats (Acrobat PDF, HTML,
Microsoft Word (RTF), Microsoft Excel (XLS) and XML). The reports can be saved on your hard drive. A translation feature
enables report templates to be localized for multiple languages. Available in AirMagnet Survey PRO only.

« Multi-floor site surveyand data analysis feature allows you to conduct RF surveys on a per-floor basis. Each survey on an
individual floor is treated as a separate project. You can then view them individually or collectively to see how they
perform in terms of signal coverage across the floors. Available in AirMagnet Survey PRO only.

+ A powerful, comprehensive, and easy-to-use WLAN deployment utility integrates functionalities such as site survey,
data analysis, channel and power simulation, data merging and filtering, calculation, and network connectivity
troubleshooting all in one package.

+ Three survey options—active, passive, and active iPerf—allow you to gather complete site RF data, including signal
strength, channel allocation, noise level, signal-to-noise ratio, coverage, media type, transmission speed, packet loss/retry
rate, etc. In an active survey, AirMagnet Survey can associate with a specific AP or SSID; in a passive survey, it can “pick
up” any RF data that exist in a WLAN environment, including data from neighboring WLANs. Active iPerf Surveys allow the
system to gather information for PHY data rates for both uplink and downlink connections.

+ Two display options enable you to view and analyze site RF data by channel or by SSID. You can easily identify WLAN defi-
ciencies in terms of AP coverage, roaming boundary, channel allocation/interference, noise impact, etc.

« Easy-to-use Simulation tool allows you to conduct simulations on AP channel allocation, output power, and SSID
assignment right from your desktop and get the results in a matter of seconds. You can conduct various “tests” to find the
best AP channel allocation with maximum signal strength and minimum co-channel or adjacent channel interference;
analyze the impact of AP repositioning to select the optimal AP deployment location and provide the most efficient signal
coverage; analyze the impact of adding or reducing the number of APs at a site to determine the optimal number of APs
for desired signal coverage; and visually compare the results before and after the simulations, etc.

« Data filtering capability allows you to zero in on specific APs for detailed analysis and to experiment with different AP
deployment scenarios.

-12 -
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Data merging gives you a holistic view of all factors affecting your wireless LAN deployment. You can experiment and
simulate with different AP deployment options for maximum signal coverage and minimum interference.

Diagnostic tools let the you analyze signal distribution patterns and conduct end-to-end connectivity tests with DHCP
and Ping tools at any time.

Built-in wireless calculatorallows you to calculate various parameters important to WLAN performance. They include
System Operating Margin, Free Space Loss, Fresnel Zone, Downtilt Angle and Distance, and Downtilt Coverage. So you can
make informed decisions for your WLAN deployment and/or upgrade.

Graphical data display with color spectrum and gradient makes it easy to understand and differentiate RF data from
various sources (that is, APs or SSIDs and channels). This allows you to base your WLAN decisions on “facts” rather than
“hypotheses”.

Support for all wireless LAN PHY standards up to 802.11be.

Survey comparison view helps visualize the differences between two surveys taken of the same area. This can help see
how a wireless environment changed over time by comparing two surveys taken months apart.

Passive survey speed data calculation generates speed data for passive or simulated data, allowing you to view the
predicted transmission rates for APs without having to conduct an active survey for each device.

Profile management makes storing configuration settings for any given site easy. You can implement profiles for each
site surveyed and quickly switch back and forth between profiles, eliminating the need to manually adjust configuration
settings at each location.

Cisco Prime NCS/WCS are network management tools. Integrated with AirMagnet Survey, it allows you to import
AirMagnet Survey and AirMagnet Multi-Floor Plannerfiles into Cisco Prime NCS/WCS. It also lets you export a Cisco Prime
NCS/WCS project into AirMagnet Survey.

System Requirements

PCs—Laptop, Notebook, or Tablet

Supported operating system:

©  Microsoft Windows 10 Pro/Enterprise 64-bit
©  Microsoft Windows 11 Pro/Enterprise 64-bit
Intel® Core™ 7 or higher recommended

8 GB or higher recommended

One available USB port for each external adapter or NetAlly multi-adapter kit (see https://www.net-
ally.com/products/airmagnet-survey-pro/ and click on Models & Accessories).

AirCheck™ G3, EtherScope® nXG, or CyberScope™ with AirMapper™ (recommended) or AirMagnet-supported wireless
network adapter(s). For more information, see:

o Guideline for Use of Wi-Fi Adapters

o AirMapper Site Survey at NetAlly.com

A site map in a format supported by AirMagnet Survey. See Supported Image File Formats.

(Survey PRO only) Google Earth must be installed to export the GPS data for outdoor surveys to Google Earth.

For GPS surveys: a supported GPS device. (If you do not see your GPS device on the list, go to https://www.net-
ally.com/products/airmagnet-survey-pro/ and click on System Requirements to check for updates.)

o US GlobalSat BU-353-S4 (Recommended)
© Garmin eTrex LEGEND HCx

©o Garmin GPS18X USB

©  Microsoft GPS-500 SIRF IlI

©  Garmin GPSMap 60

o DelLormeEarthmate GPS LT-20

o DelLormeEarthmate GPS LT-40

-13-
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©  Garmin eTrex

©  Garmin eTrex Legend
©  Garmin GPS 18 Deluxe
o Magellan eXplorist 500
© Pharos iGPS-180

Apple® MacBook® Pro:

Operating System: MAC OS X v10.5 (Leopard™) running a supported Windows OS (see "PCs—Laptop, Notebook, or Tablet"

on the previous page) using Boot Camp® or a Virtual Machine
Intel® Core™ i7 or higher recommended

1 GB free hard disk space

8 GB memory or higher recommended

One available USB port for each external adapter or NetAlly multi-adapter kit (see https://www.net-
ally.com/products/airmagnet-survey-pro/ and click on Models & Accessories).

AirCheck™ G3, EtherScope® nXG, or CyberScope™ with AirMapper™ (recommended) or AirMagnet-supported wireless
network adapter(s). For more information, see:

©  Guideline for Use of Wi-Fi Adapters

o AirMapper Site Survey at NetAlly.com

A site map in a format supported by AirMagnet Survey. See Supported Image File Formats.

(Survey PRO only) Google Earth must be installed to export the GPS data for outdoor surveys to Google Earth.

For GPS surveys: a supported GPS device. If you do not see your GPS device on the list, go to https://www.net-
ally.com/products/airmagnet-survey-pro/ and click on System Requirements to check for updates.

o US GlobalSat BU-353-S4 (Recommended)
©  Garmin eTrex LEGEND HCx

©  Garmin GPS18X USB

©  Microsoft GPS-500 SIRF IlI

©o  Garmin GPSMap 60

© DelLormeEarthmate GPS LT-20
o DelLormeEarthmate GPS LT-40
©  Garmin eTrex

© Garmin eTrex Legend

©  Garmin GPS 18 Deluxe

©  Magellan eXplorist 500

©  Pharos iGPS-180

Using Survey with NetAlly AirMapper™

AirMagnet Survey lets you transfer survey data to and from a NetAlly handheld tester with the AirMapper™ Site Survey App.

Downloading AirMapper Surveys to Survey

AirMapper eliminates the need for laptops, dongles, or tethered devices to conduct site surveys. You can perform a survey
with the AirMapper application on a NetAlly handheld Wi-Fi tester (AirCheck G3, EtherScope nXG, CyberScope, or CyberScope
Air). Then, you can analyze the data with AirMagnet Survey PRO.

Before you begin, note the following limitations for this functionality:

This function supports Active and Passive surveys as well as dual surveys (simultaneous surveys conducted with both Wi-
Fi radios in the unit.)
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You cannot import an AirMapper (.amp) file into an existing Survey Project (.svp) project. A new project is always created.
However, you can import the .svdx file from the new project into other projects.

An AirMapper (.amp) project cannot be directly imported into MultiView, but you can import it after converting it into a
Survey Project (.svp).

To transfer an AirMapper survey to AirMagnet Survey:

1.

Choose a method to transfer data:

o

o

Link-Live Download:

a.
b.
c.
d.

When saving an AirMapper survey from a NetAlly handheld tester device , select Link-Live as the destination.
Log into your Link-Live account.
Select the AirMapper icon &.

Click on the Export link € Exporton Link-Live to download AirMapper projects to your PC with AirMagnet Survey
PRO v10.0 (or later).

USB Transfer:

a
b.

C.

5 @ -

When saving an AirMapper survey, select Local as the destination.
Plug a USB thumb drive into one of the USB-A ports on your handheld tester.
Transfer the AirMapper (.amp) file that was saved to the USB thumb drive.

Remove the USB thumb drive from the handheld tester and plug it into a PC with AirMagnet Survey PRO v10.0 (or
later).

Open the AirMagnet Survey PRO application.
Go to File and select the Open Project option.
Browse to the location of the .amp file.

Select the .amp file and click the Openbutton.

When prompted to save the new project, browse to preferred destination, and then click on the OKbutton. This
creates a new Survey Project (.svp) file using the data collected by the AirMapper application.

2. After the import is complete, you can then use all AirMagnet Survey functionality to analyze your AirMapper survey data.,
including:

Heatmaps

Signal Strength

Noise

SNR

Interference

Predictive PHY Data Rates
Max MCS

AP Operating Mode
Channel Width

Simulation Mode

MultiView
DiffView
AirWISE

Reports

The following notes apply to this functionality:

The Display View shows comments added to survey points in the AirMapper survey.

A converted AirMapper project is named with the same name as the .amp file.

The Adapter Name under Survey properties is AirMapper.

Open Space Office is the default Environment. You can change this default with the Project Properties screen. Signal
Propagation Assessment matches the value used on the AirMapper application.
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The AP Default Power is set at 100.0 mW. You can change this value through the Project Properties screen. (This setting is
only used by the Simulation tool.)

Uploading AirMagnet Survey Data to AirMapper via Link-Live

AirMagnet Survey lets you export surveys to the NetAlly Link-Live cloud service. This ability adds the benefits of Link-Live's
analytical tools and web access to survey data.

The following notes and limitations apply to this functionality:

Passive and Active surveys are supported.

GPS and VoFi surveys are not supported.

For iPerf surveys, upload and download throughput data is stripped and not included in the .amp file.
For Spectrum surveys, spectrum and interferer data is stripped and not included in the .amp file.
Merge files with unsupported data are not included.

Merge files with missing original data files are not included.

To export a survey project to Link-Live:

1.

10.
11.
12.

(Optional) Set up your export configuration options:

a. Select the Settings icon €.

b. In the Settings tab, locate the Link-Live options.
Link-Live

Keep every auto sampling paint

Skip sampling paint with signal less than dBm

c. (Optional) Auto-sampling may include a great many sample points to export, which could slow analysis of the data.
To limit the amount of data sent to Link-Live, enter a number in the field for Keep every ___ auto sampling point.
For example, entering 5 keeps every 5th auto-sampled data point and discards the rest.

d. (Optional) To eliminate sampling points with weaker signal strength, enter a dBm value in the field for Skip
sampling point with signal less than ___ dBm. This discards all sampling points that are less than the value you
enter.

Open an existing survey, or create and save a new survey.

“5] Displa
Click o to go to the Display View.
Click on File > Export AirMapper Files.... This opens a file selection window.

Type the folder path or navigate to the folder where you want to save the survey. (You may want to create a new
folder: selecting an existing project folder may overwrite existing .amp files.)

Click Select Folder to save the file.

Log in to Link-Live.

Select the AirMapper icon &.

Select the Import an .amp file link € Importan.amp file This opens an import dialog.

(Optional) Enter a title and label to use for the project in Link-Live.

Click Choose File, and then use the file selection window to select the .amp file you want to upload.

Click Upload. You can then use the AirMapper tools to analyze the project data or use the Share Album option to
collaborate with team members that don't have access to AirMagnet Survey.

Guideline for Use of Wi-Fi Adapters

AirMagnet Survey/Planner gives you the option to use a Wi-Fi adapter on the same computer running the application to
capture Wi-Fi data.

AirMagnet products categorize Wi-Fi adapters into the following types:
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Recommended Adapters: These adapters have been tested by NetAlly and are recommended for use with AirMagnet
Survey PRO. Drivers may have been customized for extended feature support. For a complete, up-to-date listing of AirMagnet
Preferred wireless adapters, visit: Recommended Adapters

Other Adapters: These adapters can be used with AirMagnet Survey PRO but have not been tested by NetAlly. Drivers have
not been customized, provide limited features, and could provide inaccurate data.

NOTE: When installing Intel® and USB adapters, be sure to deselect (uncheck) the option to install the adapter’s client
utility in addition to the driver software.

NOTE: With the correct adapter, the 6 GHz band is fully supported.

Limitations of Other Network Adapters

Any Wi-Fi adapter supported by Windows other than the Preferred Adapters falls into the other network adapters category.
They can be used with AirMagnet Survey PRO to perform a survey but have not been tested by AirMagnet. These adapters’
drivers have not been customized, provide limited feature support, and could provide inaccurate information.

NOTE: NetAlly is not responsible for the quality of the test results collected using these adapters.
The following are noted limitations of generic adapters in AirMagnet Survey.

« No ability to scan specific channels: all channels are scanned. There is no Scan or 802.11 tab under the File > Configure
menu.

« No noise or signal-to-noise ratio (SNR) measurements.

e Measured PHY data rates in the uplink and downlink directions are not separated. Only a single PHY data rate for the con-
nection is reported.

» No packet retries and loss measurements on active and iPerf surveys.
o iPerf throughput performance may vary, depending on the model of the adapter in use.

o Limitations in the wireless channels that they scan: They may only be able to scan channels that are approved for wireless
use in a specific country, and unable to scan channels assigned as Dynamic Frequency Selection (DFS) channels.

« Only one non-preferred adapter can be used when using multiple adapters. See Using Multiple Adapters.

e There is no roaming control for active and iPerf surveys.

o Due to the inability to disable roaming on the adapter, active and iPerf surveys can only be conducted the “by SSID” (not
"by AP").

Wi-Fi Adapter Driver Packages

The supported driver packages for preferred adapters are located in your My AirMagnet account under the Documents/Drivers
section.

Using Multiple Adapters

Note: Use of multiple adapters is supported by AirMagnet Survey PRO only. AirMagnet Survey Express can use only a single
adapter at a time.

AirMagnet Survey supports up to two simultaneous adapters. If multiple supported wireless adapters are connected at
launch, you are prompted to select the adapters to use for the survey process.
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@ AirMagnet has detected more than one adapter present. Please select adapter(s) from the list:
k. " 4

| Card Name i
I_ Intel(R) Centrino(R) Advanced-N 6205
[7 Proxim Wireless 8494 80211a/b/g/n USB Adapter #6

Note: In some cases, you must have multiple adapters inserted to use the multi-adapter functionality. See Recommended
Adapters for more information about which adapters are supported in multi-adapter mode.

When operating in multi-adapter mode, Survey’s user interface adjusts slightly on many screens to reflect the simultaneous
use of multiple wireless adapters.
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Each adapter has its own survey pane so that you can easily track the devices and signal levels detected by each independent
device. You also get additional control over the adapters in Survey’s Scan configuration (File > Configure > Scan), where you
can adjust each device manually to specify the channels to be scanned.

Note: When you select a survey type in either of the drop-down menus, the second menu displays only the types supported
with the first selection.

The table below shows the possible surveys that you can conduct simultaneously using two adapters.

Passive Active VoFi iPerf
Passive X X X X
Active X X
VoFi X
iPerf X

Note: Only one adapter can be a non-preferred adapter when using multiple adapters. In this case, the following options are
available:

- A preferred adapter performing a Passive Survey and a non-preferred adapter performing an Active Survey.

- A preferred adapter performing a Passive Survey and a non-preferred adapter performing an iPerf Survey.

The illustration below shows the Survey Type drop-down menu for a Broadcom Wi-Fi 5 Network Adapter.
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Selected AirMagnet Adapters
| Cinly a single Alfagnet-suppoted adapter is detected. Please sebict a Surviy Typs Tar this
adapter,
Cand Meme Survey Type |
Broadcom 3021 la Network fddspter |Pasaive  vaFi «

Passive / Woffi Phone
Ackred | Agtive IPERF

0K | Cancel

Supported GPS Devices

(Survey Pro only)

When conducting a GPS outdoor survey, the GPS device must be compatible with AirMagnet Survey PRO by satisfying the
following requirements:

e Must be NMEA compliant.
o Must be capable of generating serial data which can be verified via Hyperterminal.
e Must be recognized by the laptop as a COM port.

If your GPS device is not NMEA compliant, you may use a 3rd party software solution that allows the GPS USB to be detected
as a COM port. You then need to verify that the data is converted to NMEA format. Software solutions such as this have
worked on many GPS models; however, AirMagnet cannot ensure that it works with all GPS devices.

Supported Image File Formats

A digital site map of the facility or location needs to be in one of the supported file formats. Having a site map allows you to
accurately mark AP locations and coverage areas. However, if no digital site map is available, you may create one using a
drawing software application. You can also sketch a map by hand and then have it scanned and saved in one of the
supported image file formats.

File Format Description

.BMP The standard Bit-Mapped Graphics format used in the Windows environment.

.DIB Device-Independent Bitmap, a variant of a bitmap (bmp) file.

.DWF DWF is an Autodesk Design Web Format file. This file format is highly compressed for efficient dis-
tribution.
Note: Project exports are not supported with this file type.

.DWG DWG is the format for Autodesk's AutoCAD® drawing files in MS-DOS and Windows. DWG is now being

supported by certain non-AutoCAD systems in the same manner that DXF is supported by non-AutoCAD
systems. See .DXF below. Versions up to AutoCAD 2023 are supported.

.DXF Data Exchange Format is a format for storing vector data in ASCII or binary files used by AutoCAD and
other CAD software for data interchange.

.EMF (Enhanced MetaFile) and WMF (Windows MetaFile) are the major display formats of the Windows
operating environment and the native graphics formats for MS Office applications.

.GIF Graphics Interchange Format is a variation of the bitmap image format for pictures with up to 256
distinct colors.

JPG Short for .JPEG (Joint Photographics Experts Group); a file format widely used for web images.

.PNG Portable Network Graphics is a bitmap image format that uses lossless data compression.

.VSD Microsoft Visio 2010 image file.

\WMF Windows MetaFile. See .EMF above.

VDX Visio drawing.

Note: One image file format is not favored over another. Consult a reference on digital imaging to learn which format best fits
your needs.
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o By default, a floor map is displayed in an 8.5”x 11” or 21.6 cm x 28 cm dimension.

o Make sure that the map is legible and as accurate as possible. A good map should be clear enough to view at a normal
scale (1:1) without zooming.

o Try to keep your map image file in a reasonable size. Larger-sized images take longer to upload and if too large may even
cause the program to crash. If you have problems loading a large map image, consider using a graphics editor to divide
the image into sections.

Survey Viewer License

The Survey Viewer license is available to customers who have AllyCare Support.

The Survey Viewer license replaces the “Display-Only Mode” implemented in previous releases of the software. You can
download one Viewer license from their MyAirMagnet page after registering the Survey product. You can obtain two
additional Viewer licenses by contacting Technical Support. The Viewer license can then be installed and bound to another
machine or wireless card, just as with a normal Survey installation.

Note: The Viewer license is bound in the same manner as any license, and as such can only be associated with one machine
or wireless card.

The main restriction of the Viewer license is that installations in Viewer mode cannot conduct surveys or use "Tools". Addi-
tionally, the Viewer license is based on the master Survey license you purchased and has the same limitations as the master
license. For example, if you own a Survey Express license, the associated Viewer license allows access to the Display,
Simulation, and Calculator screens.

Product Registration

By registering your purchased software, you are entitled to a free My AirMagnet account with the following benefits:
« Download software updates to the software when available.

o Access product documentation, like Release Notes and User Guides.

« Download wireless adapter drivers.

e Access training videos.

To register your product, open the following URL:

https://airmagnet.netally.com/support/register_product/

Technical Support

AllyCare Product Support

NetAlly's AllyCare is our comprehensive support and maintenance program that offers expanded coverage for the products.

For more information, visit https://www.netally.com/support/.

Contact Us
Call toll-free in North America: 1-844-TRU-ALLY (1-844-878-2559)

Visit https://www.netally.com/contact-us/for additional phone numbers. Scroll down and select your region to complete a
web form and have a NetAlly representative contact you.

Help and Sample Projects

Display help options from the Helpmenu.
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Contents...

TErET

Sample Projects k

About AirMagnet Survey...

Check Update

Press the F1 key to display context-sensitive help for the current view. Context-sensitive help (if available) is displayed.

« Contents... - Displays

« Sample Projects - Select to display a menu of sample projects. You can use these projects to learn more about
Survey PRO or modify them to suit your own project.

+ About AirMagnet Survey - Display version and update information.

o Check Update - Checks for software updates.
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In this chapter:

Preparing for Software Installation ... ... .. . ... 23
Installing Product Software ... ... ... ... . ... 24
Uninstalling Product Software ... ... ... 24
Launching the Application for the First Time ... ... ... . ... . . . . 25
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Preparing for Software Installation

NetAlly strongly recommends that you review this information before starting product installation.

Checking Product Package Contents

Before you start, make sure that the following items are included in the product package:
* Compliance Guide
o An order fulfillment acknowledgment with the serial number and serial key

In case any items are missing or damaged, contact Technical Support immediately.

Verify System Requirements

Be sure to install the software on a computer that complies with the system requirements.

Before You Begin

Consider the following before installing, launching and using the software:

e Be sure to have active Internet connection when launching the software for the first time.

* You must have administrative rights on the computer running the product software.

« Be aware certain firewall settings or anti-virus software may interfere with the product software.

« Network software that uses a wireless adapter may cause a conflict with the product software.

Product Upgrades

If the computer running the software application has an active Internet connection and a product upgrade is available, a noti-
fication dialog is displayed during product launch when a newer version of the software is available. Click Yesto proceed to
your MyAirMagnet account where you can access the software upgrade download. The product upgrade is listed in
Registered Products > Downloads section under Software Download.

An active support contract is required to upgrade from an older version to a newer version of the product. All existing
customers wishing to install a newer release of the product should verify the status of their product support contract before
starting the installation.

You can view the status of your support contract under the Registered Products section of your MyAirMagnet account.

You can also manually check for product updates by selecting Check Update from the Help menu.

Software License

You must install a unique software license to successfully run the software application. The program prompts you to install
the license when you launch the product the first time.

Obtaining a Software License

Your order fulfillment acknowledgment includes a Serial Number (S/N) and a Keycode (Serial Key). When the application is
launched for the first time, you must enter this information to proceed. This Serial Number / Serial Key combination enables
you to obtain a software license compatible with the software version of your product and in accordance with your support
contract.

Once you enter the Serial Number and Serial Key, you are prompted to obtain the license:

License Download:If the machine is connected to the Internet, you may choose to obtain the license by download. In this
case, the system automatically downloads the license and install it.

Browse to License: If the license is accessible on your network (previously downloaded), you may choose to browse to it.
The name of the license file is “serial number.lic”
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For example: A4018-04280450.lic.
The license is copied to your AirMagnet product directory.

For example: C:\Program Files\AirMagnet Inc\AirMagnet Surveyor.

Binding the License to a MAC address

One software license per MAC address is permitted. The license can be bound to a specific computer (laptop) or to a
removable wireless adapter. This provides flexibility in how the product may be used and shared.

During product installation, you are prompted to choose which option to use. Depending on your choice, the application auto-
matically captures the MAC address of the machine or adapter.

Note: If you choose to bind the software license to a removable adapter, the adapter must be active on the computer at the
time you launch the application.

MAC Address Reset

Should you desire to reset the MAC address to a different computer or adapter, you can request a MAC address reset by
choosing “MAC Address Reset” from your MyAirMagnet account.

Backing-up the License File

NetAlly strongly recommends that you register your product, download the license file and save it in a safe location. Having a
backup license file makes it easy to reinstall the application anytime, if needed because you can just browse to the file to
install it.

Support Contract Activation

Your support contract will be activated automatically upon purchase; the license file contains information that indicates
whether support has been pre-activated.

Installing Product Software

If you have a current support contract, the download is the most current version of the product; otherwise it is the version
you are entitled to download.

1. Install all available Windows updates.

2. From the Registered Products page of your My AirMagnet account, click the software download link, and run or save the
file. (If you save the file, double-click the .exe file to run the installer.)

3. Use the Windows Control Panel to uninstall any previous version of AirMagnet Survey before installing the current version
of Survey PRO or Planner.

NOTE: Do not use the Windows Repair function. This may result in unreliable performance in some versions of Windows.

Agree to the Software License Agreement to proceed with installation.

Set the installation destination folder. (Accept the Program Files default or browse to a different location.)

Click Finish to complete the installation.

N o s

Select another option from the installer, or click Exitto close the installer.

Uninstalling Product Software

From the Windows > Settings menu (accessible from the left side of the Start menu), select Apps.

Click Apps. The list of installed applications is displayed.

1
2
3. Select the desired application.
4. Select Uninstall.

5

You are prompted to choose whether to keep your license file and created/modified files after uninstalling the product:
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« Yes: The license file and created/modified files are not deleted.

« No: The license file and created/modified files are deleted.

Question |22

I.-"_q"l Do you want to keep your license files (*.lic) and created/modified files
' after uninstalling the product?

The following is a list of files affected by the selection chosen:

« Antenna patterns - User-created antenna files

e Wall/Area configuration - Areas and Walls - ArealList.txt and WallList.txt
e Floor Material - FloorMaterials.xml

e OUI to vendor mappings - LanCardVendors.txt

o Custom Report Templates - No change to current behavior. The current predefined template is replaced, and the
customer-created one is kept.

* AP Groupings - Predefined Rules.csv
o APAlias.map - APAlias.map
o Profiles from File\Configure - User-created profiles

« AirWISE Policies and Areas - For policies, user-created policies. For Areas, saved to project folder, so no action on those
files.

* Phonebook - Phonebook.xml and profiles.xml
o Speed table - SpeedMap.txt

If you choose to re-install the product software and if you preserved the files, the installer merges the new files (for example,
new antenna patterns) but does not replace any files from the above groups if they already exist on the target system. This
applies to all files in all groups.

Launching the Application for the First Time

Note: Do not attempt to launch the application during a Microsoft Windows update. If this occurs, the following error
message may be displayed, "The application has failed to start because its side-by-side configuration is incorrect."

When you launch the application for the first time, you must validate your license and install it.

License Method

Choose which method to use for installing the software license:

+ Download the license: You must be connected to the Internet and have an active Internet connection. The license is
downloaded from the NetAlly website.

« Browse to a license: You are prompted to browse to the file. The license must have been previously downloaded from
the NetAlly website.

Serial Number, Serial Key and MAC Address Binding

When launching the software for the first time, you be required to supply a valid serial number and serial key. You also need
to bind the license to the MAC address of an internal or external network adapter.
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[$ AirMagnet x

M netAlly | AirMagnet

Flease enter the Serial Mumber and Serial Key provided on the NetAlly Order Fulfillment
Acknowledgement document or from wour by Airtdagnet account (airmagnet.netally.corn).

Serial Mumber : ‘ | [*1234-12345675)

Serial Key : ‘ ‘ (1234-5678-8abc)

The Airtdagnet software must be licensed to an internal or external network adapter on
this computer. Flease select one of the available adapters.

Adapters Cualcomm QCABTx44A 802,11 ac Wireless Adapter ~

kAC Address : ACDEEIBFEAZF

< Back Cancel

License Activation Notes:

If the license file does not support the installed version of the product, an error message displays, such as “Invalid License
File” or “This serial number is currently out of support” or “Invalid Product Code.”

If you receive an error when attempting to install the software license, check for the following:

* Your license does not support a newer version of the product: Purchase a support contract that entitles you to run the
newer software.

« Invalid Product Code: The license file you chose is for a different product. Verify that the license file name has the same
serial number as the serial number for your product.

If you believe the error message to be incorrect about the status of your product or license, contact Technical Support. Be
ready to provide the serial number and serial key for the product in question.

When Using USB Adapters

o It is best to always use the same USB port for the adapter. When using any of the USB wireless adapters, you may
need to re-create wireless profiles after plugging the adapter into a different USB port. (Profiles are stored based on the
port, not the adapter itself.)

« Important: When installing new Intel® and USB adapters, uncheck the option to install the adapter’s client utility in
addition to the driver software.

e Torun AirMagnet Survey using a USB preferred adapter, you must install the adapter driver using the installer found at
https://airmagnet.netally.com/my_airmagnet/public/documents/# 3rdpartydriver (login required).
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AirMagnet Survey Main View

To open AirMagnet Survey: Open the Windows Start menu, and then select AirMagnet Survey > Survey. The application
opens in Survey mode with a default blank Map view.

@ AiMagnet Survey Professional Edition

File Edit View Help

S {R Planner T multi Floor Panner | K survey | (] Dispiay Simulation Muitiview % Diftview €7 Airwise [%] Reports
Pp @ H @S & B oM@ b oo NS mlQ Q @&\ K o4 W Viewoweral - 2 [
(3 Untitled
7] Site Map
& Survey Path
D ap I
4D sTA

M netAlly

AirMagnet ”
Survey Solution

IntellR] wiiFi BE 4X211 160MH2 -
(Survey Typs Active (AP assoc]

Associated AP status
BSSID

SSID:

Channet

PHY Data Rate:

Signal [ Frame size

To start, please open an existing AiMagnet Suney project ( svp file), convert from an AirMapper project (amp file), or use
Noce B Dely[20 e v Project Wizard to create a new project.

To open an existing project:Click Open & or select Open Project from the File menu and navigate to the project file. If you
select an AirMapper project file (.amp) you are asked to specify a new location for the converted Survey project.

Note: When opening an existing project, be sure the Windows "Regional and Language Options" setting matches between the
existing project and the computer on which you open the project.

To start a new Survey project, click Project Wizard %,

You can also access sample projects from the Help menu.

Note: If you choose to open or start a new MFP project, make sure you use the Navigation bar to change the view to Multi
Floor Planner.

Navigation Bar

The Navigation bar lets you quickly open the functional views:

| Q Planner o= Multi Floor Planner <K suney Display [ Simulation Multiview 5% Diffview ¥/ AinwiSE [2] Reports

Note: The image above shows the Navigation Bar for AirMagnet Survey PRO. (Some tools are disabled for AirMagnet Survey
Express, which has fewer features than AirMagnet Survey PRO. See the comparison chart below for more information.

Button Description

Multi Floor Simulate AP signal propagation for a building to determine optimal AP placement and configuration before
Planner deployment.

Survey Perform site surveys by collecting RF data on a WLAN site.
Note: This view is not available if the software is installed or operated in Viewer mode.
Display View and analyze RF data collected during site surveys.
Simulation Conduct data simulation on signal coverage.
AirWISE Access advice about AP deployment based on the RF data collected during site surveys.
Multi View Display and analyze RF data collected from sites with multiple floors so that you can visualize the inter-

relationship among the APs across the floors.
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DiffView

Open the project in multiple frames enabling you to compare the results of two data files.

Reports

Generate reports based on Survey project data.

Note: This function does not work until data are loaded.

Comparison of functions available in AirMagnet Survey PRO vs. AirMagnet Survey Express.

View/Tools AirMagnet Survey PRO AirMagnet Survey Express
Typical Viewer Typical Viewer
Survey yes no yes no
Display yes yes yes yes
Simulation yes yes yes yes
AirWISE yes yes no no
Multi View yes yes no no
Reports yes yes no* no
Tools yes no yes no
Calculator yes yes yes yes

*AirMagnet Survey Express has one report: ‘Overall Coverage Report by Channel'.
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Using AirMagnet Survey
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Introduction to Survey

The Survey view is the main window used for conducting WLAN site surveys to collect RF data in the airwaves over the site.

Note: The Survey view is NOT available for AirMagnet Survey that is installed or operated for display only.

With Survey, you can:

« Set up indoor, outdoor, or VoFi surveys.

« Select between active, passive, or active iPerf surveys.

To open the Survey view from any other view, simply click C\‘k survey on the Navigation Bar.

You can use start a project or open an existing project from the File menu. You can also use sample Wi-Fi 5 or Wi-Fi 6 projects

from the Help > Sample Project menu option.

The main screen has these features:

Project
Window

N

@ &

File Edit View Help

G ponner Zs s Fioorpanner | R suney | (5] owpiay ] smuton P murview O oitview € anwse [ Reports

View selection buttons

-~

» & Wl ©®@ 8 § 4 D oW

7

Q Q& x 4@

view oveatl + 27 [

Toolbar

3 Indoorssvp
=17 Site Map
DeGuignel jpg
=4 SurveyPath
ActiveSurvey2 path
[ PassiveSurvey! path
[ ActiveSurvey path
[ ActivePerfSurvey1.path
[ ActivePerSurvey2.path
[ ActivelPerfSurvey3.path
[ ActivePertSurveyMerged.path
D
D sa

i 1 il i i 1 il i
O e T AN -

Data
Window

NETSCOUT 802 110 USB Natwork Adapter
uvey Type Acwve(APassoc) v [245Griz v
ss0 [Ny ‘@
Associsted AP staus

BSSD.

ssD:

Channet

PHY Data Rate Up: Down Mops

Sorol Ml Fromesize 124 | byes
Nose [
SN

Frome siaus

Deley{20 ~|me

byes/s
Lost %
Retry %

frames/s
frames/s
frames/s

P W I O T O A N Y

Steps in Using Survey

» See Survey Configuration Overview to learn how to change the survey configuration.

Dimensions{X x1):218.05 fx 138 307t

« See Conducting Indoor Site Surveys for an introduction to indoor surveys.

o See Creating Outdoor (GPS) Surveys for an introduction to GPS-aided outdoor surveys.

« See Conducting VoFi Surveys for an introduction to VoFi surveys.

» See the Survey User Interface Reference for information on using the interface.

To learn more about using the interface options for the Survey View, see:

Legend

dow

SURVEY VIEW: MENUS, BUTTONS, AND WINDOWS

Toolbar

Project window

» Right-click Pop-up Menu

Data Window

e Media Type Button

o Active Survey Data Window
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SURVEY VIEW: MENUS, BUTTONS, AND WINDOWS

e Passive Survey Data Window

Map window

e Heatmap Legend

Modifying Project Properties

Sharing a Survey Project

Survey Menu Reference

Toolbar

The table below shows toolbar icons for the Survey view. The icons link to frequently used tools, some of which are also
found in the File and View menus.

[# = B & & | &8 & b o W0 L Q a B A K & @ 8 M viewowa - 2 [ |
Icon Name Description
Project Opens the New Project Wizard where you can create a new Survey project. See File
Wizard menu,

Open Project

Opens an existing Survey (.svp) file. See File menu,

Save

Saves changes made to the current project. (Ctrl+S)

Configuration

Opens Survey Configuration window.

GPS or
Manual Mode

Allows you to switch between GPS-aided survey or regular survey.
Note: This option is available only in Survey PRO with GPS-aided Survey projects.

Measure
Mode

Re-calibrates site dimensions of a floor plan.

Start Survey

Starts the survey.

o|lv|hll=e|moiys

Stop Survey Ends the current survey.

il Pause Stops the survey momentarily until you click to resume data collection.

0 Retract Functions as an “Undo” command, reversing the most recent data point at each click
of the button. Clicking this button repeatedly keeps erasing the survey path
backwards. To resume the survey, click a new data point on the site map.

Note: If the survey retract button is grayed out (unavailable), the "Auto Position APs
with signal greater than __ dBm" setting may be enabled. See How to Locate an AP.

L Refresh Updates the display with the latest data.

Zoom In Enlarges the view of the site map. (You can also use your mouse's scroll wheel.)
Zoom Out Reduces the view of the site map. (You can also use your mouse's scroll wheel.)
Zoom Fit Fits the site map to the Map Window.

Zoom Actual
Size

Fits the current floor map to its actual print scale.

Survey Zoom

Expands the Map Window to the entire window. To restore the default view, click the
button again.

@ h|x|® mlele]

Measure Turns on Measure Mode, which lets you measure the distance between any two points

Mode on the site map. You can also choose to recalibrate the site dimensions based on the
measurement.

Toggles Enables you to view an outline of where a heatmap transitions from one legend value

Outline to the next value.
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2

Overlap

Show or hide areas of coverage overlap for a selected AP in the Map Window.

View Overall -

View Overall

Click to select between an overall view or a per-channel view of an AP.

or Per
Channel
% Tools Opens the Signal and DHCP tools.
Calculators  |Click to open a dialog with various calculators. See Calculating WLAN Parameters

Introduction for more information.

Survey Project Window

The Project Window displays all the components of the current Survey project opened on the Survey view, as shown in the

fi

gure below.

A Data File items are as follows from the top:

Project file name.

Floor plan image file name used in the project.

Survey paths (surveys conducted) listed from first to last for this project.

Any APs and/or STA (stations) placed on the floor plan.

58 5TA

(22 survey 001 0428.svp
|_:_|!JE| Site Map
AM_Floorplan_low resjpg
[—]ﬁ' Survey Path

..M PassiveSurveyl.path
=@ AP

06:27:22:F3:BE:C4

Right-click Pop-up Menu

The Project Window on the Survey view and Display view includes a right-click menu. (Some options are available in Survey
view and others in Display view. Unavailable options are grayed out.)

Right-click a survey data file to view the right-click menu options.

File Edit

@ Planner E Multi Floor Planner C\:k Survey

View Help

;=

[ Indoor.svp

Site Map

BQ Survey Data

(A Active

Select All [ 2.

@ Channel
W@ CH (36,1

Open

Close

Delete

Rename

Data Merge...

View Merged Source...

View Survey Properties...

||§E
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Menu Option Description

Close Closes the selected data file. (Display view only)
Delete Deletes the selected (right-clicked) item.

Rename Renames the selected data file. (Display view only)
Data Merge... Merge two or more data files.

View Merged Source |Shows the sources from which a merged data file was created. (Display view only)

View Survey prop- Opens a properties window for the file. (Display view only)
erties ...

View Survey properties

From the Project Window, right-click a survey data file (.svdx), and then select View Survey propertiesfrom the pop-up
menu. The Survey properties dialog opens, as illustrated below.

The Survey properties dialog provides information about the selected survey data file.

Survey Properties - ActiveSurvey2.svdx “
Survey Type: Active Survey
Adaptor Name: Proxim Wireless 8494 802. 11a/b/g/n USE Adapter #2 00:20:A6:E2:BC: 76
Start Time: 6:17:47 PM 9292015 Stop Time:  6:39:35PM 9/29/2015

Mumber of Sampling Points: 511

Total Device Count: 2 (all discovered devices induding virtual APs)
Number of Placed APs: 0
Dimensions: 219,05 x 136,30 feet

GPS Location

Upper Left Corner Longitude: Latitude:

Lower Right Corner Longitude: Latitude:

View Survey Database

Mote: SQLite DB browser (such as http:{fsglitebrowser.org/ ) is required.

Close

View Survey Database
The Survey properties includes an option to view in-depth, database details included in the selected survey data file.

To view the database, you need a database viewer application such as DB Browser for SQLite, downloadable at: http://sql-
itebrowser.org/

Click View Survey Database. You may be prompted by Windows to associate the database with the desired database viewer
application.

Right-Click to Show CAD Layers...
From the Project Window, right-click an AutoCAD image file, and select Show CAD Layers...

_&B AirMagnet Survey Professional Edition - Indoor.svp

File Edit View Help

(ﬁ Planner i;.i_:! MMulti Floor Planner ,:;k Survey
o F H @ a B %2 29 Q Q

(2 Indoer.svp -
-] Site Map | ‘ ]

b Arques HQ Floorplan 1.g
B Q\) Survey Data Show CAD Layers...

0 A ActiveSurveyl.svdx |_—[ =
{1 P PassiveSurveyl.svdx
LdD T ActivelPerfSurveyl . svdx

P T B DaccireSinrer Snactromn oo

=

Display

:

i S

_,
"

III(FA
T
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The Drawing Layers... dialog opens, as shown below.

Drawing Layers &=
Select drawing layout and layers to display on site map
Layout: Model -
] Select all layers [¥] View black and white
Layer
0

BUILDING_ENVELOPE
DEFPOINTS

DIMENSIONS

EQUIPMENT
MOVABLE_FURNISHINGS
NON-MOVABLE_FURNISHINGS
SPACE

WALL

OK ] [ Cancel

Data Window

The Data Window displays real-time RF data as they are captured while a survey is in progress. Data start to appear in this

window once you click > (Start Survey) on the Toolbar. The contents displayed in the Data Window vary, depending on the
survey mode (active vs. passive) you select and if you are using a Wi-Fi adapter supported by NetAlly.

For example, using a Wi-Fi adapter supported by NetAlly enables the Media Type drop-down menu, the SSID/AP drop-down
menu, and the Roaming button:

METSCOUT 802.11ac USE MNetwork Adapter
urvey Type  Aclive (AP assoc) v~ | 2.4/5GHz ~

SSID v | ANY v @
Associated AF status

When using an unsupported Wi-Fi adapter, such as the adapter built into your laptop, the Media Type drop-down menu, the
SSID/AP drop-down menu, and the Roaming button do not appear:

Intel[R] i-Fi BE 22171 160MHz

Survep Type | Active [AF assoc] ~

S51D AMY e
Azzociated AP status

See Active Survey Data Window and Passive Survey Data Window for more information.

Media Type Button

NetAlly highly recommends that you select a media type before you start on a site survey. This allows you to focus on APs
using a specific type of media during the survey.

NOTE: The Media Type button does not display if you use a non-preferred adapter that automatically scans multiple bands.
See Supported Wi-Fi Adapters.
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The (Media Type) drop-down is located in the Data window of the Survey view. Click this button to display a drop-
down menu of media types that determine the type of data to be collected and displayed by the wireless network card. It
offers the following options:

e 2.4 GHz: Scans data from APs in the 2.4 GHz band only (generally, 802.11b/g/n/ax/be media types).
e 5.0 GHz: Scans data from APs in the 5.0 GHz band only (generally, 802.11a/n/ac/ax/be media types).
e 2.4/5.0 GHz: Scans data from both bands.

e 6 GHz: Scans data from APs in the 6.0 GHz band only.

Map Window

The figure below shows the Map Window on the Survey view for a 2.4 GHz, 5 GHz, and 6 GHz survey, with a site map
displayed.

(= Indoar.svp
-] Site Map
Arques HQ Floorpian 1.dwg
- Survey Path
~-[1 ActiveSurvey path
[ PassiveSurveylpath
[ ActivelPerfSurvey1 path

I S e s T s T S s |

1in=a1780 DimensionsQCxY): 282,431 x 288 321t
—_—

[] PassiveSurvey_Spectrum path
& A
&8 STA

Proxim Wwireless 8434 802.11a/b/g/n USE Adapter #
urvey Type | Passive: > ||24/5.0GHz -

& [ MAC Address [ &) l L D)

Zoom: 80%

Cunrert AP count: 0

T T e e S S T T e

By default, a site map automatically opens in the Map Window when you open a Survey project. As soon as a survey is
started, information such as AP locations, survey paths, data collection points, and so on start to appear on the map. Before
starting a site survey, make sure that the project and site map match the survey location.

NOTE: You can toggle display of the site map by selecting or deselecting the checkbox in the Project Window.

[ BESurvey.svp
=i Site Map
I . Doctors Officejpg

Legend

The right-hand side of the Display view shows the Legend which provides a variety of ways for displaying and analyzing
survey data using different color schemes and patterns.

Note: The colors gray and white may appear in a heatmap and not be indicated on the legend. White may indicate no
coverage. Gray may indicate that a coverage requirement is not met.
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w X |+ Atthetop of the Legend is the Data Type (including its unit of measure). It indicates the type of data

Skl displayed. It is identical to what is selected from the Data Type list menu on top the Map Window.

[dBm] Drag up from the bottom of the Legend or down from the top of the Legend to set the upper or lower limit
0 of RF data (signal, noise, interference, and so on) shown in the Map Window.

e You can also adjust the color scheme. See Configuring Legend Color Schemes.

-10

-20

-80

-390

-100

Survey Configuration Overview

Your site survey results are affected by AirMagnet Survey’s settings. Careful configuration of AirMagnet's parameters can help
you achieve what you intend to accomplish. This section explains how to configure the various settings on AirMagnet Survey.

The Configuration dialog defines the way AirMagnet Survey PROcollects and processes data. You can also optimize certain
attributes on the wireless network adapter to maximize its performance with the application.

To access the Configuration dialog:

Do either of the following:

o Click File > Configure...

&

This opens the configuration dialog with the project name in the title bar. By default, the Settings tab is displayed. You can
select from the tabs, set options, or enter parameter values as needed. Click OK when you have finished to save the changes.

Click the Configuration button on the main Toolbar.

Use the following configuration tabs to set up basic parameters for Survey:

» Configuring Program Settings

« Configuring AP Grouping

« "Configuring Legend Color Settings" on page 47

o "Configuring 802.11 Parameters" on page 48

« Configuring Channel Scan

» "Configuring a Survey profile" on page 50

Configuring Program Settings

The Settings tab for the Survey project defines the way AirMagnet Survey PROcollects and processes data. You can also
optimize certain attributes on the wireless network adapter to maximize its performance with Survey.
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Indoor.svp

AP Survey data

Settings AP Grouping Color  Profile |

Ignore APs whose max discovered signal is less than

99 dBmwhen opening survey data files

Hide ignored Access Point

Logging data
Auto logging data period

Beep when logging data

Sampling options

3 seconds

© Auto sampling through path

Link-Live

Keep every 1 auto sampling point

Skip sampling point with signal less than ~ -100 dBm

Use maximum heatmap drawing resolution
[ Auto Pasition APs with signal greater than -100 dBm

[ Display MAC address only

Prompt for refresh after AP location change
Enable Survey Range Indicator

Enable GPS port

["JHide APs below legend threshold in Bubble Window

Configure GPS

Channel Interference

) Sampling on click only

PHY Data Rate Map

Spectrum Integration

¥

You can change the following parameters for the Settings tab. Click OK to accept the changes. You can also choose another
tab or click one of the buttons to change additional settings.

Parameter

Description

Ignore APs whose max dis-
covered signal strength is less
than

Enter a threshold value for AP signal strength.

Note: APs with signal strengths below this value are ignored. The value of signal
strength ranges from 0 (strongest) to -100 (weakest).

Hide ignored Access Point

Hides APs with maximum signal strengths that fall below the threshold (Channel/SSID
Tree in the Display view).

Auto logging data period

Enter a value in seconds. This option sets how frequently the application automatically
logs data points during a site survey. (Default value is once every three seconds.)

Beep when logging data

Enables an audio beep each time Survey logs data. This beep can serve as an indicator
that Survey is working properly.

Note: The frequency of the beeping depends on the data sampling interval specified
above.
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Auto sampling through path

Automatically marks data sampling points on the site map, shown by blue dots along
the survey path.

Note: The data sampling interval is determined by the value you specified in the Auto
logging data period. See above.

Sampling on click only

Samples data only when you click on the site map.

Note: When conducting a Click to Sample survey, make sure that the application has
adequate time to complete a full scan cycle before clicking to record a sample and
moving on. Moving and clicking significantly faster than the scan pattern can result in
decreased heatmap accuracy. Check the progress bar at the bottom of the survey screen
to see the progression through the configured scan pattern. Wait until the bar indicates
that a full scan cycle has completed before you click to record data. Once the meter
reaches 100%, a new scan is started and the meter resets to 0. (This progress bar
appears only when you use adapters that support user-defined scan patterns.)

Use maximum heatmap drawing
resolution

Displays smoother looking heatmaps for floor plans with dimensions less than 400 feet
(122 meters).

Auto position APs with signal
strength greater than

Automatically places the APs that meet your specification in their optimal locations on
the site map. (You may also need to set a signal strength value in the space below. )

Display MAC address only

Displays all APs by MAC address alone without including a vendor ID or custom name.

Prompt for refresh after AP
location change

Tells AirMagnet Survey to prompt you to refresh the view each time you reposition an
AP.

Enable Survey Range Indicator

Enables automatic marking of the survey data sampling range (radius) as you click on
the site map.

Enable GPS port

Enables the Configure... button, which opens the GPS settings. See Creating a GPS-
Aided Survey Project Using an Existing Site Map.

Hide APs below legend threshold
in Bubble Window

When selected, excludes APs placed on the floor plan are not displayed in the Bubble
window listing.

Configure GPS

Opens the dialog to configure GPS integration for conducting a GPS survey. See Con-
figuring the GPS COM Port,

Channel Interference

Opens the Interference dialog where you can configure the minimum values of AP
signals that the program takes into account when calculating signal interference.

Spectrum Integration

Opens the Spectrum Integration dialog box where you can choose to show or hide the
Spectrum Integration window, which displays below the Map Window on the Survey and
Display screens. See AirMagnet Spectrum Analyzer introduction.

PHY Data Rate Map

Generates speed data for passive surveys. See Calibrating Wireless Network Adapter
Speed.

3. Click OK to save and apply the settings.

Configuring the GPS COM Port

If you plan to create a GPS-aided outdoor Survey project, you must configure Survey’s GPS COM port to communicate with
the GPS device to which it is connected.
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To configure Survey’s GPS COM port:

1. From your desktop, open the Device Manager. (You can search for it using the Windows search field in the bottom task

bar.)

Note: Accessing the Windows Device Manger procedure may differ somewhat depending on the Windows operating

system. See Windows Help > Device Manager.

;.‘.- Device Manager
File Action View Help

= =B BE B

~ & NETALLYFQY3LC2
i Audio inputs and outputs
> % Batteries
0 Bluetooth
® Cameras
m Computer
» I ControlVault Device
e Disk drives
[ Display adapters
3 Firmware
» fi#) Human Interface Devices

Keyboards

L Memory technology devices
3 @ Mice and other pointing devices
[ Monitors
I? Metwork adapters
i Ports (COM & LPT)
» = Print queues
= Printers
1 Processors
[ Security devices
Smart card readers
Software devices

L cai el i el i e M i

¥3 Intel(R) Dynamic Platform and Thermal Framework

Click Ports (COM & LPT).

Close Device Manager.

Goor W

the default Settingstab.

Write down the COM port number listed after the device’s name.

From AirMagnet Survey’s Survey or Display view, click File > Configure

.... The Survey Configuration dialog box appears at
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| Indoor.svp X

Seitings AP Grouping Color Profile

AP Survey data
Ignore APs whose max discovered signal is less than
dBm when opening survey data files
Hide ignored Access Paint

Logging data
Auto logging data period 3 seconds
Beep when logging data

Sampling options
© Auto sampling through path

() Sampling on click only

Link-Live

Keep every 1 auto sampling point

2

Skip sampling point with signal less than -1 dBm
Use maximum heatmap drawing resolution
("] Auto Position APs with signal greater than <100 dBm
[ Display MAC address only
Prompt for refresh after AP location change
Enable Survey Range Indicator
Enable GPS port
(] Hide APs below legend threshold in Bubble Window

Configure GPS PHY Data Rate Map

Channel Interference Spectum Integration

6. Check Enable GPS Port and click Configure GPS.... The GPS COM Configuration dialog box appears.

P

Cutdoor.svp 8
GPS5 Configuration

COM Port Corfiguration

Connect To :
Bits per Sec :
Data Bits :
Party :
Stop Bits :
Flow Control :
RTS Cortrol -
DTR Control :

Please note the GPS device must be NMEA compliant.

o
-

] [ Cancel ]

7. Under Connect to, select the COM port identical to the one you found in Step 2.
8. Under Flow Control, select None, and click OK.
9. Click OK to close the Survey Configuration dialog box.

Note:USB to Com port software may be needed when connecting a GPS device via a USB port rather than a Com port.
This software is often provided by the GPS device manufacturer.

See Creating Outdoor (GPS) Surveys for more information about GPS surveys.
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Channel Interference Settings

Definitions of signal interference and noise are rather subjective. They may vary from person to person, depending on an indi-
vidual’s perception and level of tolerance. For instance, -67 dBm or -87 dBm may be considered as interference by some
people, but may also be considered acceptable by others.

The Ch Interference Setting... button allows you to specify the minimum value that the program should consider as inter-
ference when calculating these parameters. Once specified, the program does not consider any signal from an adjacent AP as
interference if it falls below this value.

To specify interference settings:

1. From the Main Menu, select File > Configure to display the Configuration dialog.

2. Click the Channel Interference button. This opens the Interference dialog box.

[ Interference @

|nterfered APz Exclude APz if signal strength iz
weaker than

dBm

Interfering APz Exclude APz if zignal strength iz
weaker than

87 dEm

[ F, ] [Eancel ] [ Fezet ]

3. Specify the desired values for interference and noise, and then click OK.

Note: The first field specifies a setting for “Interfered APs”, or those that are experiencing interference from other sources.
The second refers to “Interfering APs’, or those that are causing interference to others.
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Configuring the PHY Data Rate Map

The PHY Data Rate Map button in the Settings dialog opens the PHY Data Rate Map table, which lets you specify speed
transmission information for the wireless network adapter in use. This information helps with speed data calculations for
passive or virtual surveys.

The values displayed in the speed mapping table relate to the minimum signal strength required to transmit data at a given
speed. For example, the default value for transmitting at 6 Mbps for 802.11g traffic is -86 dBm.

Note: The default values provided in the table are based on Receive/Radio sensitivity values for most wireless network
adapters. You should only modify any values that do not match those of the wireless network adapter in use. See the
adapter’s technical specifications from the vendor’s website.

To adjust speed settings on a wireless network adapter:
1. Click File > Configure...
2. From the Settings tab, click PHY Data Rate Map. The PHY Data Rate Map table appears.

PHY Data Rate Map x

802.11a BO02.11b/g Wi-Fid

Channel Width: |20 MHz - MCS:15 5GITue
bps in RESIdBm]
14.4 -82
2839 -9
43.3 R
57.8 74
86.7 -70
1166 -EE
1300 -E5
144.4 64

Cancel

Note: As shown above, the table has three tabs, each for a different media type (802.11a, 802.11b/g, and Wi-Fi 4). For the
802.11b/g tab, the Vocera B2000 Badge Speed Map option is only for surveying a Vocera deployment. When this option is
enabled, the speed map values are hidden.

3. Click the tab that matches the media type in use.

4. To modify a value, highlight the value and enter the new value.
1 -94
z \E—[%J
EE 92

Note: The value you enter must lie between the values above and below the entry.

5. Click OK to save the changes.

6. (Optional) To restore the default values, click Restore to Default.

Configuring a Spectrum Analyzer

To configure and enable a spectrum analyzer:

Spectum Integration

1. Open the Spectrum Integration dialog by clicking File > Configure... and then clicking the
button.
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r B
Spectrum Integration l&l

[7] Enable Spectium Integration

kax Hold Reset

@ Mever Reset
) Marwally Reset

() Automatically Reset

e

Check the Enable Spectrum Integrationcheckbox.

Select one of the Max Hold Resetoptions.

Option Description

Never Reset |[If selected, the Max Hold value never resets.

Manually If selected, the Max Hold value resets each time you click on the site map as you move along the survey
Reset path.

Automatically |If selected, the Max Hold value automatically resets each time or at each point data are collected or
Reset logged.

Click OK to save your selections.
Restart Survey for the new settings to take effect.

See Working with Spectrum Analyzers for more information.

Configuring AP Grouping

This dialog allows you to set up specific names for single devices that use multiple SSIDs under different BSSIDs. The
grouping helps identify instances where separate BSSIDs show up and appear to be several different devices when they
actually belong to a single device.

To open the AP grouping dialog, click the Configuration icon

&

, and then click the AP Grouping tab. You can also right-

click on a channel or AP in the Channel Tree View, and then, select the AP Grouping option.

A few predefined rules are available. You may also create custom (New) rules.

You can enable and use AP grouping as follows:

Choose to use “Any” (any vendor) for the 2.4 GHz, 5 GHz, or 6 GHz frequency band. This groups all MAC addresses where
the last octet is 0-16, for example, XX.XX.XX.XX.XX.X0

Choose to use Ubiquity 2.4 or 5 GHz: Octet: First (1), consecutive mac address 16, starting bytes: 0

Choose to use Ruckus 2.4 or 5 GHz. This groups all MAC addresses where the last octet is 0-16, for example,
XX XX XX XX XX X0

Create "New" AP Grouping Rules as described below.
Note: An enabled (checked) user defined rule (New) takes precedence over an "ANY" rule.

Note: AP Grouping information is saved as a comma-separated (.csv) file:
<drive letter>:\Program Files (x86)\AirMagnet Inc\AirMagnet Surveyor\AP-Grouping.csv

Note:To add 6 GHz AP grouping rules, you must either manually edit AP-Grouping.csv or delete that file and let Survey
PRO regenerate it when you create new rules.

AP Grouping Limitations

AP Grouping is subject to the following limitations:
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o Default rules are not editable and do not show up in the "Group Rule Name" list and cannot be deleted or edited.

+ No special name is displayed if "Display Best Name" is selected in the filter view, for example, Name is the same as if its
MAC address is selected unless there is a known AP name.

e The existing OUI to create grouping rules is not modified.
* AP grouping does not attempt to group dual radio APs into a single device.
To configure AP grouping using predefined settings:

1. From the Survey Configurationdialog box, select the AP Groupingtab.

Survey.svp >

Settings AP Grouping  Color  Profile

AP Group Rules
[+] Enable AP Grouping

MNew| | Detal | | Dot |

Group Rule Mame Enabled ~
AN -BGEHZ s
MANY-2 AGHZ

AR BGEHZ e e |
"Ubiquity-SGHz" e
"Ubiquity-2 4GH " st

SRl

Cumrent User Corfigured OLUI{s)

Edit  Delete

Yendor 1D endor Mame

Apply OUI Change

ok | cancel

2. Check Enable AP Grouping.

3. Check the desired listings in the Group Rule Name table.
4. Click OK.

Disable AP Grouping by unchecking Enable AP Grouping.

Viewing AP Grouping Rules

To view the details of the default settings.
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1. Select an AP Group rule.
2. Click Detail. A dialog box appears showing all the attributes of that auto grouping rule.

AP Group Rule @

Wendar (D VAR

Band: 24 GHz

M&C address order

@) Ascending Dezcending

MAL address hex-digit starting from;

i s 4

MHurnber of contiguous MALC address: 16

(118

The table below briefly describes each of these fields.

Parameter Description

Vendor ID Specifies the name of the device vendor that the rule applies to.

Band Specifies the device's frequency band.

MAC address order Indicates whether address is in ascending or descending order

MAC address hexdigit starting Indicates the hex digit used to start the grouping.

from

Number of contiguous MAC Indicates the number of consecutive addresses you wish to classify in the group.
address

Creating New AP Grouping Rules

The AP Grouping tab’s preconfigured auto group rules automatically incorporate a range of vendor IDs for devices from
various manufacturers. These numbers are assigned to vendors by the IEEE, and as newer cards are released, new IDs are
granted.

The IEEE OUI file is located in the c:\AirMagnet\Surveyor\OUI folder. You can download the latest IEEE file from here:

http://standards.ieee.org/develop/regauth/oui/oui.txt. Open the web page and from the browser Filemenu, select Save As.
Save as a .txt format.

Additionally, vendor names can be modified to abbreviate them or otherwise make them more meaningful as desired. For
example, you may rename "Hewlett-Packard" to "HP". To make a change, open "oui_alias.txt" located here: C:\Program Files
(x86)\AirMagnet Inc\AirMagnet Surveyor\OUI.

Note: the vendor names drop-down in AP Grouping are either the first word in the name or the first 16 characters (if the first
name is longer than 16 characters).

1. From the Survey Configurationdialog box, select the AP Groupingtab.
2. Under AP Group Rules, click New.

3. From the Vendor ID drop-down, select the desired vendor.

4. Configure the grouping options as desired.

5. Click OK.

6. The newly added vendor ID can now be enabled as a AP Group Rule.
You can delete an AP Grouping rule you created. To do this, check the desired rule and click Delete. You cannot delete a
predefined rule.

Using Current User Configured OUI(s)

1. From the Survey Configurationdialog box, select the AP Groupingtab.
2. Under Current User Configured, click New.

3. Type the Vendor ID.
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4. Type the Vendor Name.

5.
6.

Click OK.
Select apply OUI change.

The newly added vendor ID can now be used to create an AP Group Rule.

Note: If you use the same vendor name for each new vendor ID, a grouping rule using that vendor name applies to all
IDs associated with that vendor name.

Creating an ID manually

1
2
3.
4

Navigate to AirMagnet Survey’s installation directory (typically C:\Program Files (x86)\AirMagnet Inc\AirMagnet Surveyor).
Open LanCardVendors.txt.
Follow the instructions for creating a new entry.

Save and close the text file.

The new entry is implemented the next time you start AirMagnet Survey.

Configuring Legend Color Settings

This feature allows you to set and change the color settings on the Legend, which also affects the color scheme displayed in
the Map Window of the view.

To configure Legend color schemes:

1. From the Main Menu, select File > Configure....
2. Click the Color tab.
Planner.svp @
|Set1.ings | AF‘GmuDingl Color |5[Q11 | Scan I Map Paint I Pmﬁlel
Color Scheme Outline Color
@ : Red 225
I Green 225
] Blue 225
[ Automatic contrast adjustment
Granular color bar selection
AP icon size
) Smal @ Medium () Large
Conce
2. Make the selections as described in the table below.
Parameter Description
Color Scheme Use the radio buttons to select a color scheme.
Note: Each radio button represents a color scheme, which affects the overall color scheme of the
Legend. Your selection is automatically used by color legend after you click OK.
Outline Color Change any of the color values (Red, Green, Blue) by highlighting it and then typing new color values
or by clicking Select Color... and then choosing a color from the Color box.
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Note: This option affects the color of the borderline around areas (that is, cells) covered by different
APs.

Automatic contrast |Automatically adjusts the color contrast as you drag the color box up or down the Legend.
adjustment

Granular color bar  |Changes the color shade one grade at a time as you drag the color box up or down the Legend.
selection

AP icon size Use the radio buttons to set the AP icon size.

3. Click OK when finished.

Configuring 802.11 Parameters

To perform Active and Active iPerf surveys, the adapter needs to associate with the desired AP or SSID. This often requires
establishing the authentication method and security password for the AP or SSID. You can set up these requirements outside
of AirMagnet Survey using Windows Wireless settings, and then you can use AirMagnet Survey's 802.11 configuration.

Notes:

» This option displays on the configuration dialog only if you are using a NetAlly supported adapter.

o Typically, you do not have to make 802.11 adjustments unless you have to accommodate specific requirements for
enterprise networks.

To configure 802.11 parameters:

1. Use the Windows Wireless settings to set up the authentication method and security password for the AP or SSID
associated with the adapter.

2. Use the Windows Wireless settings to select and connect to each of your adapters. (Do not select the Connect auto-
matically option.)

3. From the Main Menu in Survey, select File > Configure... or else click the Configure @ putton.

4. Click the 802.11 tab.

Settings AP Grouping Color 80211 Scan  Profile
NetAlly 802.11ac USB Network Adapter #8 ~
‘Wireless Networks:

[Acthertication WPAZ
Encryption'AES

1802. % tue:
Connection Modemanual
New.

Adiust Signal

Country: | United States ~

oK Cancel

5. Click New to create a new profile. Provide a Name for the AP or SSID, and then click OK.
6. Select the SSID or AP name in the Wireless Networks drop-down, and then click Edit.

7. Make the desired entries and/or selections in the Connectionstab and Security tab as you normally would for a new
Windows Wireless connection, and then click OK.

8. (Optional) Click Adjust Signal to make custom RF signal adjustments. See Custom Adjustmentsfor more information.

9. Click OK to close the configuration dialog.

Configuring Channel Scan

Configuring channel scan settings allows you to specify the channels you want the wireless network adapter to scan and to
set the frequency at which the scanning occurs.

Notes:
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« This option displays on the configuration dialog only if you are using a NetAlly supported adapter.

» Make sure that you have enabled the scan feature for those channels using this view. (Use the check boxes or enable/dis-
able channels and the Select Country Code Channels button on the right of the window.)

To configure Scan parameters:
1. From the Main Menu, select File > Configure....
2. Click the Scan tab.

Settings AP Grouping Color 80211 Scan  Profie

Card: | NetAlly 802.11ac USB Network Adapter #3 ~ |
[+ Enable automatic configuration of 40/80 MHz channels
20MHz 40kHz Lower 40mHz Upper 80MHz Period
v
v
2
2
v
|7
2
v
v
2
v Select
v Country Code
v Channels
2
2
2
|7 Scan Time
v 250ms v
E Set All

Courtry Code:  United States

Note: When running in multi-adapter mode, a drop-down menu appears at the top of the window to select the desired
device. Select the adapter you want to configure from the list.

3. (Optional) Unchecking the Enable automatic configuration of 40/80 MHz channels option if you want to manually
specify scanning of upper or lower portions of channels. After unchecking the box, select the channels, and then check
the upper or lower channel desired for each channel. (By default, AirMagnet Survey automatically configures 40 MHz and
80 MHz channels.)

4. (Optional) Click the Select Country Code Channels button on the right of the window to select which channels are
available for scanning based on the country code configured for the Wi-Fi adapter. (To set the Country Code, see
Configuring 802.11 Parameters.)

5. Use the controls to enable the channel or channels to be scanned (checked channels are scanned).
e Use the check boxes to enable (or disable) individual channels to be scanned.
» Click Enable All to enable all channels so that all channels are scanned.
e Click Clear All to disable all the channels so that no channel is scanned.
6. Setthe scan intervals:
o Click the Period (ms) field, and select a scan frequency for the individual channels from the drop-down list.

e Click the Scan Time down arrow to select a time period, and then click Set All to apply the time period to all
channels.

o Click Reset to restore the scan settings to the default, which is 250 ms.

7. Click OK to accept the configuration changes.
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Configuring a Survey profile

The Profile tab allows you to store settings made in Survey’s configuration and reapply them for future surveys. You can save
these settings to an AirMagnet Profile (.apf) file and then upload the file onto another computer using AirMagnet Survey. This
feature can help you with repeated site surveys. Profiles can be created for individual sites, making it easy to re-configure the

scan settings as the site requires.

To configure a Survey profile:

1. From the Main Menu, select File > Configure.

2. Click the Profile tab.

Indeor.svp

Survey Profils

Profile Marme Modified Date

[ 3 Remove | [ Boor | [ impon

Notes

=)

Settings | AP Grouping | Color | 802.11 | Scan | MapPoint | Profile

3. Click New. The New Profile dialog appears.
| (New Profile) P | (3]
Profile Mame: |

(@) Create New Profile

(7 Copy From:

[ Ok ] [ Cancel ]

4. Enter a unique name for the profile. (This creates the profile’s file name, for example, “Profilename.apf”).

5. Leave the Create New Profileradio button selected.

Note: The Copy From button allows you to duplicate the settings configured in an existing profile and apply them to the

new profile.

6. Click OK. The new profile appears in the profile list window.

7. Enter any comments about the new profile in the Comments field below the Profile List (optional).

8. Click OK.

Note: The new profile automatically becomes the active profile. Any changes made in Survey’s configuration are stored

in the active profile.

Conducting Indoor Site Surveys

AirMagnet Survey can be used for both pre- and post-installation WLAN surveys to collect RF data on the site. The surveys can
be performed without having APs permanently installed in their locations. Also, there is no need to adjust channels from the
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APs before a survey since AirMagnet Survey allows you to do channel separation when analyzing the data in the Display view,
where you can change channel allocation once a suitable channel combination is identified through channel simulation. This
saves both time and resources that would otherwise be required for a conventional site survey.

When opening a Survey project, make sure that the Survey project (.svp) file is located on the laptop PC you use to conduct
the site survey. Opening projects remotely (that is, over a network connection) can create problems when trying to save the
data after conducting the survey if the network connection is no longer available.

When performing a survey that may take a long time (for example, longer than 10-15 minutes), NetAlly recommends that you
break the survey up into several smaller instances. This ensures that you do not lose all the survey data should a problem
arise with the computer. After the multiple surveys have been completed, you can then merge the resulting data files
together to create the same result as surveying the entire area at once.

This section discusses indoor site surveys, which typically are small-scale surveys conducted inside an office complex or
warehouse, etc.

Choosing a Survey Mode

Choosing a Survey Mode

After you create an AirMagnet Survey, choose the survey mode:

1. Inthe Data Window, click the Survey Type drop-down list.

IntellR] Dual Band ‘Wireless-AC 8260 2

2. Select one of the following survey types:

o Active Survey: (Default) The Wi-Fi card actively associates itself with the selected AP or SSID to send and receive RF
packets.
o To perform the active survey on an individual AP, select APfrom the drop-down list on the left and then choose a
specific AP from the drop-down list on the right. The Wi-Fi card associate only with that AP.

o To perform a survey on an entire network, select SSIDfrom the drop-down list on the left and then choose an SSID
from the drop-down list on the right. The Wi-Fi card associates with the AP that has the strongest RF signal in the
SSID group as you roam the site during the survey.

o See Active Survey Data Window for more information on the data window.

« Passive Survey: The Wi-Fi card does not associate itself with any particular AP or SSID. Instead, it simply listens to the RF
data moving through the site, detecting and recording all RF signals and noises in the environment.

o Leave the SSIDfield set to Any, or
o Select a specific SSID or AP from the drop-down.

« See Passive Survey Data Window for more information on the data window.

* Active iPerf Survey: This option enables AirMagnet Survey’s integration with the open-source iPerf software. This works
like a standard active survey but with more initial configuration information to provide additional transmission data. You
can gather transmission data for both uplink and downlink rates (as opposed to just the former). See Using iPerf
Integration for information on configuring and activating iPerf integration.

Pre-Installation Site Surveys

A properly conducted predeployment survey can help ensure that the ultimate network installation operates at peak
efficiency, with a minimum of extraneous or conflicting components. The process outlined below details how to conduct a
basic survey of the network environment before actually installing any network components.

Note: The following steps are intended to outline the basic required steps for a proper survey; additional enhancements for
improved results can be found later in this documentation.

Pre-installation survey procedures consist of the following steps:
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1. Conduct a passive survey of the entire site to collect data regarding ambient traffic, noise levels, frequency usage, floor-
to-ceiling height, height between each floor, and signal loss per foot between floors. (You can divide this survey step into
several shorter surveys, if necessary.)

2. Use AirMagnet Multi-Floor Plannerto create a model of the new site, including anticipated layout, obstacles, and so on.

Note: You must have an AirMagnet Multi-Floor Plannerlicense to model the network using AirMagnet Multi-Floor Planner.
For steps on manually planning out the environment, see Manually Planning the Deployment. Note that a manually
created plan can provide several advantages over a Planner-assisted one, since it is based on real-world data. After
creating the manual plan, continue with these steps to complete the pre-installation survey process.

3. Use the Planner Advisor function to allow Planner to automatically suggest optimal AP locations for the new site. See
Generating a Multi Floor Planner Advisor Layout for more details.

4, Use Multi-Floor Planner’s Display view to analyze the Planner results (or the results from the manual plan) to verify that
the projections meet the needs of the expected deployment.

5. Set up the network as projected from the steps above.

Manually Planning the Deployment

Manually testing the new wireless site before deployment can take environmental variables into account and therefore
provides more detailed information. The following survey is generally referred to as an AP-on-a-stick survey because you use
a single AP to determine the potential placement of several APs.

To manually plan the wireless deployment:

1. Go to the likely location where you may want to deploy an access point (AP).

2. Use atest AP to conduct as many active surveys as needed to ensure that the AP’s intended coverage area is fully
covered by the surveys.

Note: Since you should save the survey data at the end of each survey, you may end up having several active survey data files
for the AP at one location.

3. Move the AP to the other potential AP locations and conduct several active surveys at each location in the same manner
as described in Step 2. Remember to save the survey data at the end of each survey.

Conduct one passive survey using the same AP.

Save the survey data.

4
5

6. Switch AirMagnet Survey to the Display view.

7. Merge all the active and passive survey data files. For instructions on how to merge data files, see Merging Survey Data.
8

Display the merged data by channel or by SSID. See Project Window and Channel/SSID List.

Note: For better results, NetAlly recommends that you: 1) merge the active survey data files collected at each location, 2)
merge the merged active survey data files from all locations, and 3) merge the passive survey data file with the merged active
survey data file (the active survey data from all locations). This provides you with the most comprehensive RF data about the
AP and the site environment.

Post-Installation Site Surveys

Regular post-deployment surveys can help you ensure that you keep abreast of changes in the wireless environment. Even
when perfectly designed, a pre-installation site plan cannot account for changes in the network’s demands, unexpected
interferers, along with a multitude of other dynamic factors in a wireless coverage area. You must conduct “refresher” surveys
at regular intervals to verify that the deployment continues to meet enterprise requirements.

Note: The following steps are intended to outline the basic required steps for a proper survey; additional enhancements for
improved results can be found later in this documentation.

Post-installation survey procedures contain the following steps:

1. Conduct a passive survey of the entire deployed environment . (You can break this survey step up into several shorter
surveys, if necessary.)

2. Compare the results to those generated during the planning stage of the predeployment process described above.
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3. Make any required adjustments that were not accounted for in the pre-installation portion to make the network meet
user and throughput requirements.

Note: This step is necessary because some factors cannot be accounted for during the planning process. For example,
having people moving through the wireless environment can cause interference that would not be there before install-
ation.

4. Conduct an active survey to verify that there are no gaps in the coverage area that were not discovered during the
passive survey. This process also allows you to verify that the real-world network traffic (for example, PHY data rate,
packet loss/retry, uplink/downlink data) meets user requirements.

Note: Even though active surveys are more complex, they provide a variety of additional benefits over passive surveys.
See Choosing a Survey Modefor more information.

5. Repeat this procedure at least every three months to keep up-to-date information about the wireless network on hand.

Tips for Improved Survey Accuracy

The following tips are intended as guidelines that can help enhance the general survey procedures.

« Focus on one frequency band at a time. Attempting a survey of more than one band may take less time, but it can cause
gaps in the data.

o Plan the survey path ahead of time to conduct the most complete survey in minimal time. Planning and walking the path
ahead of time can help you identify obstacles, potential trouble spots, etc.

e Be sure to survey from all areas of the network; do not assume that coverage on one side of the APs is identical on the
opposite.

* Moving faster can result in insufficient data collected; however, moving too slowly results in longer processing times due
to an excess of information.

o Active surveys give a much more comprehensive perspective of “real-world” performance, and as such are required for a
complete survey process.

Conducting a Passive Survey

A passive survey offers a quick and easy method to gather all available 802.11 information in the wireless environment. You
can view any traffic present, whether it comes from a neighboring network or from ambient noise. The steps below detail the
basic process of conducting a passive survey.

When you start a survey, the application begins collecting data about the environment. Then you walk a systematic path
through the areas for which you want to measure signal coverage.

Note: The steps below assume that the you have already created a survey project for the desired site. NetAlly recommends
that you create the Survey projects ahead of time to make sure that the site map is accurate and of good resolution.

To conduct a passive survey:

“u

1. From AirMagnet Survey, click g (Open Project) from the Toolbar.

2. Locate and open the Survey project (.svp) file of interest. The selected project file appears in the Project Window and the
site map displays in the Map Window.
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3. If the project has more than one site map, select the map you want to display in the Map Window.

4, Click (Media Type) and select a media type (2.4 GHz, 5.0 GHz, or Both from the drop-down list.

NOTE: This option is only available when using Wi-Fi adapters that support the use of custom drivers.

5. From the Data Window, click the Survey Type drop-down list and select Passive.

Proxim ‘wireless 8494 802.11a/b/g/n USE Adapter
Survey Type | Passive ~|[24/506Hz ~]

ANY =

4 1 | »

Current AP count: 0

See Passive Survey Data Window for more information.

Note: For best results, NetAlly recommends leaving the SSID field to Any while performing a passive survey. This lets you
collect comprehensive RF signal data from the site environment.

6. Click [ (start Survey) and walk through a planned survey path that covers all areas you want to measure. clicking as
necessary to indicate each step in the survey.

Click a point when you start the survey. (By default, AirMagnet Survey automatically spaces data points over time.)
Walk at a slow steady pace (slower than a normal walk) to gather plenty of data.

Click on your position on the image map each time you change direction.

Click at identifiable landmarks (such as doorways) that indicate your position on the image map.

Save your data from time-to-time as you travel along your survey path.
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« An inactivity timer automatically pauses the survey if you do not click in the system-specified time. You then receive a
warning prompt and a count- down timer before the survey is automatically paused.

Note: NetAlly recommends that you walk at a slow steady pace (slower than a normal walk) to gather as much data as

possible.

7. Click @ (Stop Survey) once you have covered the survey area.

8. Save the survey data when prompted.

For instructions on how to view and analyze survey data, see DiffView and Data Analysis.

Passive Survey Data Window

The figure below shows the Data Window during a survey when set in Passive Survey mode using an adapter that supports
both the 2.4 GHz and 5 GHz bands.

Note: During a passive survey, if an AP is detected with a Hidden SSID, the AP name shown in the MAC Address column on the
Survey page displays in red, instead of the usual black to distinguish it from the broadcasting SSID APs.

Prowim Wireless 8494 802.11a/b/g/n USE Adapter #
Survey Type | Fassive 2480 GHz
S50 AN
| MAC Address | ©) | @ | 68 | 5510 p-
1 48 air-tek-03 |g |
1 [l s aiek0n i
44 B 54 citek03
1 [ 42 aitek02
1 [ 42 aitek05
44 B 52 aitek02
44 Fa0 B 53 aitekO1
a4 aR-capas.. 40 B8 53 airter0s
11 lapbaya25 44 B8l 43 DanaherTM
1 lapbayz2s 4O +2
161 Kam-3502 46 B 46 sirtekm
161 Koam-3502 (46 [l 45 airter03
11 | lap-baya-2-5 -- 41 AuthonizedGuest
161 Kam-3502 (46 B 46 sirtek.05 i
o D e B ., ~ ., -
Current AP count: 137
Option Description
Adapter The adapter used for the survey is noted at the top of the window.
Survey Type Options are Active, Passive and Active iPerf.
Media Type Options are 2.4 GHz, 5.0 GHz, or Both.
NOTE: This option is displayed only if you are using a NetAlly supported adapter.
SSID/AP Detects devices by AP or SSID during the survey. A drop-down lets you choose a specific device
to survey or choose ANY to capture data for all detected devices (SSID or AP).
NOTE: This option is displayed only if you are using a NetAlly supported adapter.
Channel | &g Captures the RF channel each AP is using. The Channel column displays the primary and
secondary channels, channel bandwidth, and the channel span.
MAC Address The MAC addresses of each AP. It can display either "Best Name" or MAC address. Right-click the

window to change the display type.

Signal Strength ()

The signal strength of all received packets from the AP.

Noise Level @

The level of background RF energy in the 2.4 GHz or 5 GHz band. The Lower the value, the less
noise detected.

Signal/Noise Ratio

The signal strength compared to the noise level. A higher SNR ratio usually means better
network performance, because less noise affects the signal.

SSID

The name of the network to which an AP belongs.

Current AP Count

The total number of APs currently detected.
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Conducting an Active Survey

As explained previously, active surveys are more difficult to set up and perform than passive surveys, but have the advantage
of providing real-world data for PHY Data Rate, packet loss/retry, and uplink/downlink rates. Active surveys require some con-
figuration and initial setup before collecting data, but they give the most accurate reflection of the network’s performance for
end-users.

To conduct an active survey:

Ty

1. In AirMagnet Survey, click = (Open Project) on the Toolbar.

2. Locate and open the Survey project (.svp) file you want. The selected project file appears in the Project Window, and the
site map displays in the Map Window.

() AiMagnet Survey Professional Edition - My Survey Project 001.svp felle ==

File Edit View Help

(& Planner iz Multi Floar Planner | o Survey Display [T Simulation Muttiview Y Diffview €/ Arwise [%] Reports

# & H o &8 B @ b ono Q& MB Y 4L @ 0 vewowan- B E
5 7 3 0 g g 7
Q3 My Survey Profect 001.5vp A s e s s e )
1-li5] Site Map 1 Signal
AM_Floorplan_02_Page_1jpg | sin=m2an Dimensions(Xx 1): 226.31 20195/t [ngm]
_—
-~ Survey Path L0
A N
4D STA e
. o UL LY s
2| M o l-‘|
= 5 L}
3
] |
Proin Wirsksss 6434 802 11 arhégdn USB Adapter [l |
]
Survey Type [Ackive (6P azmoe] =) [24/50GHz + q |
i B i
Bssuciated AP status = I
BSSID Spesd ]
5500 ] |
Chanrel: — J
1 i
| |
1 !
- s |
Signal [ Frame size: 1028+ bytes 1
Noise B Doy 250 v mo a
i ]
Frame status B
bt trames/s -
Lost 2 ames/s o !
Fistiy o Hramesés k|
]

3. If the project has more than one site map, select the map you want to display in the Map Window (if it is not already
opened).

4. Click (Media Type) and select a media type from the drop-down list.

5. From the Data Window, click the Survey Type drop-down list and select Active.
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Prowim ‘wWireless 8434 80211 a/b/a/n USE Adapter :

Survey Type | Active [P assoc] v |[24/5.0GHz |

air-tek 01 + (&)

Azzociated AP status

BSS5ID: CigooER:36:E0 Speed: 1.0
SSID:  air-tek-01

Channel: 1

Signal 431 Frame size: 1024 » bytes

Noise E Delay: 280+ mg

S/

Frame status

G344 bytes/s B frames s
Lost: 0 0 frames/s
Retmy: an 4 frames/s

See Active Survey Data Window for additional information.

Use the first drop-down to select the frequency band (media type), either 2.4 GHz, 5.0 GHz, or Both.
Use the first drop-down to select SSID(to associate to a specific SSID) or AP(to associate to a specific AP).

Use the second drop-down to select the SSIDor AP to which the application should associate.

o © N o

If the selected SSID or AP requires a specific authentication mechanism, configure this information via the 802.11 tab
from the File > Configure... menu or Windows' Network and Internet Settings. See Configuring 802.11 Parameters for
more information. If no authentication is necessary, continue to the next step.

10. Click 2 (Start Survey) and walk through the planned survey path, clicking as necessary to indicate each step in the
survey.

« Survey automatically spaces data points over time, so you only need to click a point when you start the survey or
when you change direction.

» While conducting a survey, click from time-to-time to save the data as you travel along your survey path. Otherwise,
an inactivity timer automatically pauses the survey. (You are prompted and a countdown timer appears before the
automatic pause.)

Note: AirMagnet recommends that you maintain a steady pace slower than a normal walk to gather as much data as
possible.

11. Click (Stop Survey) once enough data have been collected.
12. Save the survey data when prompted.

For instructions on how to view and analyze survey data, See Introduction to Data Analysis.

Active Survey Data Window

The figure below shows the Data Window when AirMagnet Survey is set in active survey mode using a NetAlly supported
adapter that supports both the 2.4 GHz and 5 GHz bands.
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Prozim ‘Wireless 8494 802.11a/b/g/n USE Adapter
Survey Type | Active [4P assoc) = |[24/5.0GHz ~|
air-tek-01 « (&
Agsociated AP status
BSSID: CizcoEB:36:60 Speed: 1.0
SSID:  air-tek-01
Channel: 1
Signal 430 Frame size: 1024 = bytes
Moise  [EEN Delay: 250 = ms
SN
Frame status
E344  byteszs E frames/s
Lost: 0 % 0 frames/s
Retry: an x 4 frames/s
Option Description
Adapter The adapter used for the survey is listed at the top of the window.
Survey Type Options are Active, Passive gnd Active iPerf,
Media Type {@} Options are 2.4 GHz, 5.0 GHz, or Both.
NOTE: This option is displayed only if you are using a NetAlly supported adapter.
SSID/AP Choose from the drop-down menu to select a specific AP or SSID during the active survey.
NOTE: This option is displayed only if you are using a NetAlly supported adapter.
Roaming (&) Allows you to set the roaming criteria for the survey. See Setting Roaming Properties.
NOTE: This option is displayed only if you are using a NetAlly supported adapter.
BSSID The name and MAC address of the AP being associated with.
SSID The name of the network to which the associated AP belongs.
Speed The rate (in terms of Mbps) at which packets are transmitted.
Channel The radio channel the AP uses to send and receive RF signals, including the primary and secondary
channels, channel bandwidth and the channel span.
Signal The signal strength for the received packets. The higher the value, the stronger the signal.
Noise The level of background radio frequency energy in the bands being scanned (2.4 GHz, 5 GHz) band.
The lower the value, the less the noise.
S/N The signal-to-noise ratio. Compares the signal data to the amount of ambient noise.
Frame Size The size of the frame transmitted in terms of bytes.
Delay The time (in microseconds) between successive transmissions.
Bytes/s The number of bytes (of data) transmitted per second.
Frames/s The number of packets (of data) transmitted per second.
Lost The percentage and number of packets that were not transmitted successfully from the AP.
Retry The percentage and number of packets that were retransmitted from the AP.

Setting Roaming Properties

Use the (& (Roaming Option) button in the upper-right corner of the active survey window to control the roaming capability
of the wireless network adapter. You can define precisely when the adapter roams, based on the properties that you
configure in the Set Roaming Criteria dialog box. See the figure below.

A list of adapters that support this feature may be found under the "Supported Adapters" section of the AirMagnet website at:
https://www.netally.com/wp-content/uploads/AirMagnet-Recommended-Adapters.pdf.

Configure the Roaming Control (Signal) feature when using a USB wireless network adapter to perform a site survey by SSID.

Note: To test roaming during an active survey, set the Windows Wireless Profile to Automatically Connect and the other
profiles to Manually Connect. Otherwise, Windows may activate the other profiles when the Roaming feature is enabled.

To set the roaming properties of a wireless network adapter:
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1. From the Survey view, click @ The set Roaming Criteria dialog box appears.

Roaming Criteria H

[] Trigger roaming to a new AP if Signal on cumently connected AP
drops below 55 dBm dBm.

Mote: Roaming will happen only if the new AP signal is greater
than the threshold above. Roaming might take up to several
seconds.

Gar

2. Select Trigger roaming to a new AP if signal on currently connect AP drops below.

3. Click the down arrows to select a value.

4. Click OK.

Configuring roaming based on signal strength causes your computer to roam once it reaches a specific minimum signal

strength.

Using iPerf 2 Integration

AirMagnet Survey’s integration with the open-source iPerf software provides you with a means of recording both upload and
download transmit rates during an active survey. Although this requires some additional configuration when compared to
active surveys, the ability to view both upload and download speed information can be invaluable when analyzing the
wireless network environment.

During an iPerf survey, the laptop which is being used to conduct the survey transmits custom iPerf data packets to a user-
configured iPerf server. The server’s responses allow Survey to record the station’s download speed from the current
location.

To conduct an active iPerf survey, you must download and install the iPerf server software on a separate device. AirMagnet's
iPerf 2 integration is designed to operate with iPerf Server versions 2.0.5 and 2.0.9. (See the For iPerf3 section below for
information about using Survey's iPerf3 integration.)

Note: AirMagnet recommends that you create an iPerf folder in the root directory to contain the files (that is, C:\iPerf).

Starting the iPerf Server:

After the iPerf server software has been downloaded and installed, you must launch the application before starting an iPerf
survey.

1. Type ‘emd’ in the Windows search field in the bottom Akbar.

2. Open the Windows command-line interface.

3. Navigate to the iPerf folder (e.g., C:\Iperf) using the CHDIR command as needed.

4. Type ‘iPerf -s’ and press Enter. A message appears describing the TCP port in use by the server.

Note: In the command to start the iPerf server, the ‘-s’ parameter stands for ‘server’ and the ‘-p 5001 part tells the server to
listen on port 5001. By default, AirMagnet Survey uses 5001 as the port for its transmissions during an active iPerf survey. If
the iPerf server port is changed, you must change the port used by the Survey application as well.

To access iPerf configuration options, select Active iPerf as the Survey type, and then select the Advancedbutton to open
the iPerf Config dialog box. (See Choosing a Survey Mode and Active Survey Data Window.)

Note: Ensure that the Client port set in the iPerf Config dialog is not blocked by an AP/controller/firewall, etc. The default
client port for the down link is 9999.

Once the iPerf server status message appears, the system is actively listening for iPerf transmission messages. The system is
now ready for conducting an active iPerf survey.
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For iPerf 3

Beginning with Survey version 9.3, iPerf 3 is supported for performing an iPerf survey, either via iPerf 3 server software
installed on a PC or other machine, or using NetAlly's Test Accessory.

» To download and install iPerf 3 software, visit https://iperf.fr/.

« Learn more about the Test Accessory from NetAlly.com/products/TestAccessory. See the Test Accessory User Guide for
instructions on adjusting the Test Accessory's settings.

Note the following differences in functionality between iPerf 2 and iPerf 3:

o While using iPerf 2, you can run both upload and download throughput measurements at the same time. While using iPerf
3, you can run upload or download tests only. iPerf 3 does not support the option to run both tests at the same time.

* You have the option to perform an iPerf 3 throughput survey against your own iPerf 3 server, or you could use NetAlly’s
Test Accessory (pocket sized iPerf server). You cannot perform an iPerf 2 survey against the NetAlly Test Accessory.

o iPerf 3 surveys are only supported while using Wi-Fi 5/Wi-Fi 6/Wi-Fi 7 adapters. (You can still use older Wi-Fi adapters while
running an iPerf 2 survey.)

o For iPerf3 servers, the default port number is 5201. iPerf3 clients use an ephemeral port.

Using an iPerf 3 Server
See the "iPerf user docs" page at https://iperf.fr/.

In the Active iPerf Survey Data Window, select iPerf 3 in the appropriate drop-down menu field.

Placing APs in the Survey

Active Survey for a specific AP: When you Start an Active Survey for a specific AP (Click Start Survey s ), you are
prompted about whether you want to place the AP at its location on the floor plan. If you choose Yes, an AP appears on the
floor plan, and you may drag it to its actual location.

Passive Survey: When you Start a Passive Survey (Click Start Survey. > ), detected AP(s) are listed in the Passive Survey Data
window. Before the first click, you can drag a desired AP listing on to the floor plan to indicate its actual location. You can do
this one-at-a-time for as many APs as desired.

When you stop and save the survey, any APs on the floor plan get saved in the associated Survey Data Files (.svdx) that gets
saved in the project. This means that when you switch to Display view and open a Data File, any APs saved in the data file are
automatically placed on the floor plan.

At this point, once a survey is stopped and saved, you can drag one or more APs on to the floor plan, however; these new APs
are in the next survey (since the last survey was saved and closed) or, if you do not conduct another survey, these APs are in
the survey project but not contained in a data file.

Deleting APs from the Survey Project

You can delete any APs from the survey project. From the Survey view, right click the desired AP listing in the Project Window
and select Delete. However, any data file created (saved surveys) still contains the placed APs.

EJ survey 001 0428 svp
E|!]E| Site Map
22 AM_Floorplan_low res.jpg
[—]* Survey Path
e PassiveSurveyl.path
-4 AP

.l 06:27:22:F3:BE: g
4D STA Delete

Deleting APs from a Data File

If one or more APs were placed in the survey project and the survey was saved, the APs appear in the data file in Display view
(see Map Window). You can delete a placed AP from the data file.
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1. Select the desired data file (.svdx) in Display view to show its floor plan and heatmap in the Map window.

2. In the Map window, right-click the desired AP and select Delete location information for this AP. You are prompted to
choose one of two options:

« Delete from both the survey and project files: The AP location is deleted from both this survey data file and also
from this opened survey project.

« Delete from survey file only: The AP location is deleted from this survey data file only; it is kept in the survey
project.

Merging Survey Data

When performing a site survey on a large site, you may want to break up the project into several small survey projects. Each
small project covers only a part of the site. You save the survey data collected from each small area as a separate Survey
(.svp) file. When the whole survey project is completed, you end up having several survey files, each covering a specific part of
the site or network. You then have to merge the individual Survey files together to get a Survey file containing data that cover
the whole site. You then use this consolidated (.svp) file to plan and enhance your wireless network.

NetAlly recommends the following steps when merging Survey data files:
1. Merge all the active survey files collected at the same AP location.

2. Merge the merged active files from all AP locations.

3. Merge the merged active file from Step 2 with the passive survey file(s).

See How to Merge Survey Data for more information.

Documenting Your Surveys and Analyses

You can document the results of your site surveys and data analysis using AirMagnet Survey’s Copyand Print functions.

Copying Your Data into Other Applications

You can copy your survey data and the results of your analysis (displayed in the Map Window) into any software application
that supports the copy-and-paste function. The copied data contains whatever information displayed in the Map Window,
including the site map, AP locations, survey paths, and the graph (if in Display screen). This is a great way to share your
survey data.

To copy data to another application:
1. Display the data you want to show on the site map.
2. Click Edit > Copy Heatmap Image.

3. Open afile in a software application that supports copy-and-paste and paste it into the document. The following figure
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shows survey data copied and pasted into a Microsoft Outlook document.

HEHD O+ |- Untitled - Message (HTML) = B R
!@g Message Insert Options Format Text Review Adobe POF & 0
Cut - | = —_ Foll Up -
& Cu Calibri (Boch = 11 = A" A7 | = - =~ % @ g @ @ ¥ Follow Up Q
E3 Copy , High Importance
Paste ah? . A - ._ = Address Check | Attach Attach Signature Zoom
- dFurmat Fainter LS AR — % = Book Mames File Ttem~ - § LowImportance
Clipboard [P Basic Text MNames Include Tags a| Zoom ‘
| e | |
=1 || ‘
Send
Subject |
2
[
[~]
A

Printing Your AirMagnet Survey Data

You can print your survey data using AirMagnet Survey’s printing capability. The data you print can be raw data collected

from site surveys or the results of your data analysis, simulation, or filtering. This can be an effective way to document your

site surveys and WLAN infrastructure, as well as an easy way to share your work.

To print your survey data:
1. Display the file in the Map Window.

2. Click File > Print Preview. APrint Preview window appears.
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3.
4.

| Bt st o) Pz Poe ) i) (i) 2o 0 ) i

Page 1 All checked Channels

If you are satisfied with what you see in the Preview window, click Print. The Print dialog box appears.

Choose your desired print options, and then click OK.

Creating Outdoor (GPS) Surveys

This section explains the procedures for creating GPS-aided Survey projects. These surveys usually cover large outdoor areas.
Like creating an indoor Survey project, creating an outdoor Survey project also involves importing a site map which is done in
the same way as you do when creating an indoor Survey project.

NOTE: Before you begin, make sure that you have configured and enabled the GPS port. See Configuring the GPS COM
Port.

To create a new site map using Bing Maps or Google Maps:

1.

o s W

Open Bing Maps or Google Maps in a web browser, and enter a location for your outdoor Survey, zooming in appro-
priately.

Use a screenshot application (like Windows Snipping Tool) to create a .png or .jpg of the area.

Open AirMagnet Survey.

Create a new GPS Survey project (see details below).

To view GPS coordinates (for later entry into the New Project Wizard dialog box GPS Coordination):
» In Bing Maps, right click at the desired map location.

e In Google Maps, left click at the desire map location. A pop-up displays the GPS coordinates of the spot where you
clicked.
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To create an outdoor Survey project using an existing site map:

1.

o & W

Start AirMagnet Survey and click File > New Project.... The New Project Wizard view appears.

Mew Project Wizard 4

Project Mame and Directony

Specify Project Mame:
| test |

Specify Project Type:

m netAlly

() Mon GPS Project (8 GP'S Project
ﬂl rmagﬂ et (C) Cizco Prime Infrastructure Survey Project

Survey Solution

Project Directony:

| F:AT emphbirmapperitest

[ 5et as default project directany

< Back et » Cancel Finizh

Specify the name of the new project.

Select GPS Project.

Type the directory path or browse to the location where you want to store the project file.

Click Next.

Note: The following steps assume you want to import a site map (image file) from your local computer.

Click the Import Outdoor Street/Campus Map (GPS) Image radio button. The "Select Type" drop-down appears, which
lets you browse for a map.
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10.
11.

To import a site map from the local computer, click Browseand then open the desired image.

Mew Project Wizard

mnetAlly

AirMagnet

Survey Solution

< Back

Floar Plan Information

Import ldoar Flaor Plan Image:

(@) Import Dutdoor Street/Campus Map [GPS] Image:

Browse...

For accurate rezults, the GPS b ap should be Unit of Measurement

oriented with Morth at the top of the page. Feat e
GPS Coordination
Left Top Comer Paint Right Bottom Corner

Longitude: I:l Longitude: I:I
Latitude: I:I Lakitude: I:l

If wou krnow the GPS coordinates of the GPS map, pleaze input now;
If wou do not know the coordinates at this moment, pou can leave it
blank, and use the calibration tool to specify it later. —

Mext = Cancel Finizh

If you know the values of GPS coordinates, enter them now. (You can also use the calibration tool

2

data later. For more information about GPS calibration, see Performing a GPS-Aided Site Survey.)

Click Next. The New Project Wizard view refreshes.

Mew Project Wizard

mnetAlly
AirMagnet

Survey Solution

< Back

to calibrate the

E rviranment Information
Survey/Planner Environmment

() Restricted Closed Office - Hotel, Walled Office

() Dpen Space Office - Cubicles, ete.

() Commercial - W arehouse, Airport, Convention Center, Mall
(@) Dutdoor - Free Space [No RF Obstruction)

{1 Dutdoor - Residential [Light RF Obstruction]

(1 Dutdoor - Downtown [Severe RF Obstruction]

GPS enabled map includes campus, city map etc.

Signal Propagation Assessment | 250 Feet

AP Default Power L

Mesxt = Cancel Finizh

For Survey Environment, check the outdoor option that best matches the environment to be surveyed.

For Signal Propagation Assessment, do nothing (normally), since AirMagnet Survey can automatically assign the value

according to the survey environment you have selected.
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12.

13.
14.

Note: AirMagnet Survey assigns the Signal Propagation Assessment value based on the estimate of the distance RF
signals could travel in each of those typical survey environments as shown in the figure above. Normally, NetAlly
recommends that you accept the default value the program assigns. (You can set a value of your own, but note that the
value you specify affect the way the program interpolates survey data.

For AP Default Power, do nothing (normally).
Note: If you know the value of AP power, enter it now. (It is used for data simulation.)
Click Next. The New Project Wizard view refreshes.

Enter a short description of the project in the space, and then click Finish. The newly created Survey project auto-
matically opens on the Display view with the site map in the Map Window.

Verifying GPS Device Connection

To verify the connection to a GPS device:

1.

2.

From the Navigation Bar, click Tools > GPS Information. Survey’s Toolsdialog box appears.
Tools =

SGPGSAA3.07.13.10.09.23.08.... 40253234

Longitude:  121.974058W
Lattude:  37.38388T'N
Attude:  257M
Headng: 4829

Speed:  0.07

uTC:  232407.000

Pleass nots the GPS device must be NMEA compliant

| Signal Dt | DHCP [{GPS ifomation. ||

Note: The view should be populated with valid GPS information if Survey is successfully connected to the GPS device.
Otherwise, check the connection between Survey and the GPS device. No data can be collected if communication has
failed.

Close the Survey Configurationdialog box.

Performing a GPS-Aided Site Survey

After you establish the communication between AirMagnet Survey and the GPS device, you can start performing the GPS-
aided site survey.

Note: To find coordinates without using GPS, you can open Bing or Google Maps in a web browser. In Bing Maps, right click at
the desired map location. In Google Maps, left click at the desire map location. A pop-up window displays the GPS
coordinates of the spot where you clicked.

To calibrate the GPS Coordinates:

If you created the GPS survey project using a site map, you must first calibrate the GPS as described in the following steps.
Otherwise skip to "Starting GPS Survey."

1.
2.

Open a GPS-aided survey project that you have created.
From the GPS map, determine the two locations where GPS coordinates are to be taken.

Note: To ensure the accuracy of your GPS survey, it is highly recommended that you select two points with different GPS
coordinates on the map. They should be in the north and west directions and be set far apart from each other.

From the Toolbar, select &I (Calibrate GPS), and then click the first spot on the GPS map. AirMagnet Survey starts to
recalibrate the GPS information.
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.
GPS Calibration B

D ata Format
@ Decimal Degrees
() Degrees Minutes
() Degrees Minutes Seconds
Longitude
Decimal Degees:: fl21.974048
a
121 5E.4429
- :
121 58 2B57
Latitude
Decimal Degrees: 3V.383853
]
a5 230312
- !
a7 28 1.87
AP Mac Address:
OK ] [ Cancel
Fleaze go diagonally to a second point after accepting thiz one.

el

=

(%S

4, Click OK to close the view.

5. Move to the second location and click the corresponding point in the map. Survey recalibrates the GPS coordinates for

this location.

GPS Calibration [ 2 [

Drata Format
@ Decimal Degrees
() Degrees Minutes
() Degrees Minutes Seconds

Longitude
Decimal Degrees: 121.974025
o .
121 58,4415
a '
121 58 2649
L atitude
Decimal Degress: 37.384097
o :
37 23.0458
@ '
37 23 275
AP Mac Address:

|8

6. Click OK to close the view. A dialog box appears asking if you wish to start the survey.

7. Click Yes or go to "Starting the GPS Survey" to do so manually.

To Start the GPS Survey:

1. From the Toolbar, click B (Start Survey) and start to move along the survey path.

2. Click e (Stop Survey) when enough data have been collected.

3. Save the project.
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Note: You can repeat the same procedures to conduct as many GPS surveys as needed. The figure below shows a sample
GPS survey view.

1in.= 1270320 Dimensisns CH 1):8892.23 R HE545.39 1

e |
Lexingloa St

—_ PelarD/Gil —VHencia Dr_~/ ;
emorial Park ——-. -

Exporting GPS-Aided Site Survey Data to Google Earth
You can export your survey data collected during a GPS-aided site survey to Google Earth so that you can view the data on a
larger scale.

Note: You must be working from the Display view to export data to Google Earth.

To export into Google Earth:

1. Download and install Google Earth software (if not already done) from https://earth.-
google.com/intl/earth/download/ge/agree.html.

2. Open the GPS project in the Displayview, click File > Export to Google Earth.
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3. The Google Earth view opens, displaying your survey data superimposed over the map.
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Conducting VoFi Surveys

VoFi surveys can help you troubleshoot problems in a VoFi deployment by providing details about active calls such as WiMOS,
roaming frequency, and signal strength. A VoFi survey is a critical part of planning any voice-over-WLAN deployment because
you get a comprehensive view of the wireless environment from the perspective of a VoFi phone. A VoFi survey helps you
identify any problems or wireless hazards before the network is fully operational when such problems are much easier to fix.

Taking time to properly survey and troubleshoot the predeployment environment can greatly improve the resulting install-
ation.

VoFi surveys gather data from an active connection between a wireless AP and a VoFi phone. Before starting the survey, you
must establish a call between two phones. (One must be a VoFi phone; the other may be VoFi or wired phone, but it must
remain stationary during the survey.) Once Survey detects the call, you can start collecting the survey data.

Notes:
o To verify that an existing wireless deployment is VoFi-ready, follow the instructions provided with the .

o VoFi surveys require that you carry an actively connected VoFi phone along with the laptop during the survey process. For
best results, attach the phone to the laptop in an upright position (to best mimic the position of the phone during an
actual call). Before starting a VoFi survey, you should note down the MAC address of the phone being used, as the phone
must be selected from a list of active calls once the survey has started.

* Not supported for the 6 GHz band.

To conduct a VoFi survey:
1. Create a new survey project.
2. Configure Survey's VoFi phone book.

3. In Survey's configuration window, click the Scantab and specify the channels on which the VoFi APs operate. This step
helps the application quickly re-detect the phone during instances of roaming.

4. From the Survey view, click the Survey Type drop-down list, and then select VoFi Phone Survey.

5. Start a call with the VoFi phone and click 2 (Start Survey). The VoFi Call List dialog box appears.

VoFi Call List
YoFi Phane [ Associated &P [ 551D Channel | Signal
001441 9277.F8 13104 ] 52 dBm
00 14:41:92 7658 13104 |DACiscavoice 48 52 diim

Please select a call from the list and click "Begin Survey”

If you do not see any calls listed, please make suie you have selected the corect profie from the
phonebook and veriy that the profile seftings match your phone vendor's recommendation

Soan 64 Begin Survey Canoel Survey

6. Select the phone's MAC address from the call list.
7. Click Begin Survey.

8. Click regularly along the survey path to collect data, just as you would when performing a standard data survey. A pop-up
status window appears whenever the phone roams.

9. Once the survey is completed, click © (Stop Survey).
10. Save the data.

Note: After completing a VoFi survey, you can view the resulting picture of the wireless environment. See Analyzing VoFi
Survey Data for additional details.

Configuring a VoFi Phone Book
Note: The VoFi phone book must be configured before attempting to conduct a VoFi survey.

Due to the differences between individual VoFi phones, you must provide some configuration information to ensure that
Survey can properly interpret the data received from VoFi surveys. This process consists of you creating VoFi phone profiles in
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Survey’s phone book that correspond to the types of phones in use (or expected to be in use) on the VoFi deployment. The
following sections provide you with a guide through this process.

To access the VoFi Phonebook:

1. Navigate to the Survey or Display view.

2. Click File > Phonebook.... The Phonebook window appears.

O0:14:41:92:77:F6 | Cisco-7921

| Profile |

Note: The phone book configuration process consists of two steps: create a VoFi phone profile and add the VoFi phones

to the Phonebook. Click the links for more details.

Creating VoFi Phone Profiles

Phone profiles contain the required configuration information specific to individual types of phones. Phones provided by
different vendors (or even different phone models from a single vendor) can have drastically different configurations. If you
do not create profiles in Survey that correspond to the phone types in use, you may not get optimal results from VoFi surveys.

To create a VoFi profile:

1. From the Phonebook window, click Profiles.... The VoFi Profiles window appears.

Mame | Woice FrameDurati0n| Jitter Buffer | Codec Types
HitachiirslesslP ... 20 B0 (BT WHaw
Cisco-7320 E 70 G
Yocera |36 108 G711
Cisco-7321 20 I 16711 Uaw
Spectalick30 |30 |70 |G7PLE
Spectalink-20 |20 N G.711PLC

Add

Edit...

Delate..

0K

Cancel

2. Click Add... to open the Create Profile dialog box.

3. Enter a name for the profile (NetAlly recommends that this name match the vendor and model number of the phone).

4. Fillin the remaining fields as required by the phone. See the table below for additional details.

Field Description

Codec Type A codec refers to an algorithm or specialized computer program that encodes or reduces the number
of bytes consumed by large files and programs. Files encoded with a specific codec require the same
codec for decoding. See the VoFi phone’s user manual to determine the codec it uses.

Voice Frame In contrast to most wireless transactions, VoFi data is normally transmitted in steady fixed-size
Duration packets. The voice frame duration refers to the time (in milliseconds) that should be allocated for
each frame. This value should be available from the VoFi phone vendor’s website or documentation.

Jitter Buffer The jitter buffer refers to the amount of memory allocated to buffering voice data to account for
“jitter”, or packet delays, in the VoFi exchange. Since seemingly small amounts of delay in a con-
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versation can result in drastically reduced call quality, the phones include a built-in buffer to help
smooth out portions of the call that experience unusually high jitter levels. The phone’s specified
jitter buffer value should be provided in its documentation or website.

5. Click OK to save the new profile.
6. Repeat Steps 1 through 5 for each type of phone in use on the VoFi deployment.
7. When finished, click OKto close the VoFi Profiles window.

Note: Entering incorrect values for a VoFi phone profile can result in Survey being unable to detect calls made from phones
associated with the profile.

Once all necessary profiles are implemented, you can add phones to their corresponding profiles, as described here.

Adding Phones to VoFi Profiles

After creating a VoFi phone profile, you must enter the VoFi phones in use in the deployment into Survey’s VoFi phone book
and match each device with the appropriate phone profile. This step ensures that VoFi Survey is able to detect the call.

To add phones to the phone book:
1. From the Phonebook window, click Add.... The New Phonebook Entry dialog box appears.

New Phonebook Entry @
MAC &ddress -
Prafile Mame Cisco-7320 - ]

2. Enter the phone’s MAC address in standard MAC notation (for example, aa:bb:cc:dd:ee:ff, including colons).

Note: If you have already conducted a passive survey of the wireless environment, the MAC Address drop-down list may
already contain the phone’s MAC address information. In this case, use the drop-down to select the desired phone.

3. Use the Profile Name drop-down list to select the desired profile and click OK to save the changes.

4. Repeat steps 1 through 3 for all phones necessary.

Modifying Project Properties

You can use the Survey view to change the properties that you specified when you created a project. For example, the
dimensions of the site may need correction, new infrastructure may have been installed, or a site map may appear to be
stretched.
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Project Properties %

Site Propertiez

Dimensions

width ] 21904 —3  Unis

&

Length ) 1azay g e
Etwironment [Dpen Space Dffice -
Signal Propagation Aszeszment 200 Feet
AP Default Powver 100.0 i atts

Display Properties [inches)

Marging
Left — 0.780
Top  1.000
M apping
Tinch =

Froject Pathe  C:\Program Files [«BE]\AiM agnet InchAitkd agnet S

Right ~ 0.750
Baottorn  1.qoo
.29 Feet

(]4 ] [ Cancel

To adjust project properties:

1. Right-click the map window and select Project Properties.... (Alternatively, click View > Project Properties... from the
menu bar.) The Project Properties window appears.

2. Make any adjustments required, as described in the following Project Properties table.

3. Click OK to save the changes.

Field

Description

Dimensions

Alter the width and length of the map as desired. Note that since the units of measurement are
locked in during project creation, the Units field is grayed out.

Environment

This field allows you to change the environment type, that is, from Open Space Office to Commercial.

Signal Propagation

Adjusts the signal propagation assessment. The default value depends on the Environment selected

Assessment when creating the project.

AP Default Power Adjusts the default power setting for APs placed on the project.

Description Click this button to enter a description for the project.

Margins Allows you to adjust the spacing padded around the site map.

Mapping Adjusts the scale of the image; this setting can also be modified by using the Measure Mode tool. See

The Toolbar for more details.

Project Path

Directory location for the open project.

Sharing a Survey Project

You can share an AirMagnet Survey project with other users who have AirMagnet Survey or AirMagnet Viewer installed on their
computer along with a valid license. (For viewer restrictions, see Survey Viewer License.)

To share your project with another user:

1. Locate the survey project folder (the folder created when you set up your new project). The folder name matches the
project name you gave your project. The default location is in the My Documents folder.
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2.

Compress the folder using a compression application (for example, ZIP) and send it to the recipient.

The recipient of the compressed file can do the following to open the shared AirMagnet Survey project:

1

2. Launch AirMagnet

Decompress the folder.

Survey.

3. Select File > Open and browse to the .svp file contained in the decompressed folder.

Survey User Interface Reference

To learn more about the interface options for the Survey View, see:

File Menu

Item Description

New Project... Crete a new Survey project and open the XXX dialog. The file extension is .bml
Open... Open a multi-floor building project. The file extension is .bml

Save Saves the current project.

Save Project As...

Opens a file management window so you can save the current project under a different name.

Close Project

Closes the current project after prompting you to save any unsaved changes.

Configure...

Opens the project settings dialog to the Settings tab,

Phonebook...

Displays the VoFi Phonebook.

Print...

Opens the system Print dialog.

Print Preview

Open a print preview of the current view.

Print Setup...

Opens the system Print Setup dialog.

Recent Projects

List any previously opened project files.

Open AirMagnet
Multi-Floor Planner
Project

Opens an AirMagnet Multi-Floor Planner planner project in Multi Floor Planner,

Exit

Closes Survey.

Edit Menu

Item

Description

Copy Heatmap

This menu has only one option, Copy Heatmap Image (Ctrl+C). Selecting this option copies the

Image heatmap from the map window to the clipboard as a .png file.
View Menu
Option Description
o% Zoom In Enlarges the view of the current floor map in the map window. (You can also use your mouse's
scroll wheel.)
@% Zoom Out Reduces the view of current floor map in the map window. (You can also use your mouse's scroll

wheel.)

E Zoom to Fit

Fits the current floor map to the map window.

@ Zoom to Actual

Size

Fits the current floor map to its actual print scale.

Set Zoom...

Opens the Set Zoom dialog box where you can specify the specific ratio at which the view of the
map can be increased.

Show CAD Layers...

Allows you to select which layers of an AutoCAD image to display and, if the image has multiple
layouts, which layout to display. This feature is also available when you right-click on the image in
Display View.

Windows

Toolbars and Docking

Enables you to show (checked) or hide legend and/or status bar. If the default toolbar settings are
modified, click Reset Toolbar to reset the toolbar to default setting.
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Show Rulers Allows you to show or hide the rulers along the edge of the map window.

Show Grids Allows you to show or hide grids in the map window.

Invert Legend Colors [Flips the legend color scheme vertically.

Project Properties... [Opens the Project Properties window where you can adjust the properties for the floor map of the

survey site.

AP/Path Name Font... [Opens the Font window where you can modify the font properties of APs and survey paths on the
floor map.

Help Menu

Item Description

Contents Open Help documentation

Sample Projects Open a sample Survey projects for indoor, outdoor, or VoFi surveys.

About AirMagnet Survey PRO View basic information about Survey such as version and build number.

Check Update Find out if there is a newer version of AirMagnet Survey PRO,
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Multi Floor Planner

In this chapter:
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Introduction To Multi Floor Planner

Multi Floor Planner (MFP) allows you to simulate AP signal propagation for a building before deployment to determine
optimal AP placement and configuration, plus view signal propagation that occurs between floors in a multi-floor building.
With MFP, you can:

Create a building projects that consists of multiple floors.

Create floor plans for each floor in the building.

Determine the best location and configuration for APs on each floor.

View predictive heatmap visualizations of how APs on one floor may affect signal strength coverage to other floors or

create channel interference.

Open MFP by clicking the Multi Floor Planner button:

I; Multi Floor Planner

Once you open a project (you can open a sample Wi-Fi 5 or Wi-Fi 6 project from Help > Sample Project), the main screen has
these features:

Map View

Data Type menu

\

Toolbar
/| & Menu
Wi-Fi 5 Sample Building.bm| - Mukti Floor Planner
fle View Tools Help
; < K2 &
oD@ xS
« Wi-Fi 5 Sample Building (Feet) “
(2) Floors
level: 4 g
bght 1000 Building
Width: 17000
Length: 15000 Tree
Aligned:  Center
Height: 400 dB Loss: 32.00
(%) Ficor3
level: 3
Height 1000
Width: 17000
Length: 15000
Aligned:  Center
Height: 400  dB Loss: 32.00
(~) Floor2
Level: 2
Height:  10.00
Width: 170.00
All Checked Channels
[]24GHz [V]5GHz [V]6GHz
Select APs from: | --All Floors=- ~
Selected AP count: 34
Channels | SSID
4 QChannels
4 1

AP-10(w78) (Unknown SSID)

AP-9(wf6)(Unknown SSID)

[
JAP-1(wid)(AuthorizedGuest)
JAP-4(wid)(AuthorizedGuest)
JAP-7(wid)(AuthorizedGuest)
1

[VISRAP-4(wf4) (AuthorizedGuest)

@ ) AutoSave OFf inevery 1

min

"Camera"

control

Signal Strength (15t AP)

Refresh
Button

options

~~

AutoSave settings

(See Viewing Multi Floor Data for more information about the main MFP screen.)
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Steps in Using Multi Floor Planner

See Starting the Multi Floor Planner Building Project to learn how to start the MFP project.

See Creating a Site Plan for instructions on adding walls, identifying coverage areas, placing APs, and more.

See Viewing Multi-floor Data for additional viewing tips and controls.

See Multi Floor Planner Reports for details on creating reports for finished site plans.

See Export to CAD for information on exporting site plan results to CAD format.

See the Multi Floor Planner Menu and Toolbar Reference for information on using the interface.

See also:

See Using Legacy AirMagnet Multi-Floor Planner Projects for notes on setting up projects based on single-floor AirMagnet
Multi-Floor Planner projects.

Starting the Multi Floor Planner Building Project

This topic describes how to create and edit a Multi Floor Planner (MFP) building project. Subtopics include:

Open Multi Floor Planner

To create, import, or open an existing project

To create or edit basic building properties

To add and manage floors in a building project

To configure each level in the building project

Open Multi Floor Planner

Click &5 Muti oo Planner .\ 4, navigation Bar or from the Filemenu. MFP opens in a new window.

To create, import, or open an existing project

To create a new building project, select File > New from the File menu. This opens the New Building dialog. See below for
more information.

To open an existing project:
o Select File > Open. Browse to the building project file.

o To open an AirMagnet Multi-Floor Planner legacy project, select File > Open AirMagnet Multi-Floor Planner Project.
Browse to the building project file. See Using Legacy AirMagnet Multi-Floor Planner Projects.

To import a project:
In MFP, select File > Import. Browse to the building project .zip file and open it.

Note:The building project must have been previously exported (File > Export) to create the .zip file.

Add or edit basic building properties

1.

Access the New Building dialog or Edit Building dialog:

e For a new building project, the New Building dialog opens automatically. (This dialog is the same as the Edit Building
dialog.)

e For an existing project or an imported a project, select View > View Building Properties. This opens the Edit Building
dialog. (This dialog is the same as the New Building dialog.)

Fill out the information on the New Building dialog, and then click OK.
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New Building
Building Name: MBF Library
Building Folder: Ci\Users\KenStitzeh\Documents\MEF Library l]
Building Contact:
Unit of Measurement: Feet -
Number of Floors: 3
Floor Height: 10.000
Inter Floor Height: 4,000
Inter Floor dB per Foot Loss: | & Light8 Medium:12, Heavy:16
Inter Floor dB Loss: 32.00
Floor Plan Configuration
AirMagnet Planner Project Folder:  C:A\Users\KenStitzel\Documents\MyPlannerProject
Floor Floor Name Plan
Plan1.spi v
2 Floor2 Plan1.spi
1 Floorl Plan2.spi
Plan3.spi [
1

Multi-Floor Planner

NOTE: The New Building dialog contains the Floor Plan Configuration section only when you have opened a AirMagnet

project. See Floor plan configuration for AirMagnet Multi-Floor Planner projects.

Item

Description

Building Name

Type a building name or description.

Building Folder

Enter the directory path for the project files.

Building Contact

Type a name for company or person to contact with questions about the project.

Unit of Meas-
urement

Choose Feet or Meters.

If you are not sure of the dimensions, you can enter approximate values here and then recalibrate
the values more accurately later. See Measuring and Calibrating the Floor Plan Scale.

Number of Floors

Enter the total number of floors in the building.

Floor height

Enter the floor-to-ceiling distance for each floor.

Inter-Floor
Height

Enter the amount of space between each floor that is not part of the floor-to-ceiling distance.

<unit> Loss

Inter-Floor dB per

Choose a number for light, medium, or heavy loss of signal between floors.

Floor plan configuration for AirMagnet Multi-Floor Planner projects

The Floor Plan Configuration section appears only when you have opened a AirMagnet Multi-Floor Planner project. Use this
part of the dialog to match single-floor projects to floors in the MFP project.

1
2.

Floor Plan Configuraticn

AirMagnet Planner Project Folder:

CAlUsers\KenStitzel\Documents\MyPlannerProject

Floor Floor Name Blan
Plan1.spi >
2 Flaor2 Planl.spi
1 Floor! Plan2.spi
Plan3.spi NN
L3

Click on the floor to select it.

Use the Plan drop-down menu to select the legacy plan to match the Floor number.

3. Click OK when you have matched each floor.

Notes:

The number of floors is determined automatically by the number of .spi files. You can add (or delete) floors as needed
after you finish creating the building project.

Different floors can use the same .spi file. (To avoid file conflicts with the .spi file, MFP creates a new folder for the
building project when you use the same .spi file.)

You do not have to use all of the available .spi files.
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To add and manage floors in a building project

Each floor (level) in the building includes a menu of options. To access the menu, click the chevron in the top right corner of
the level.

File View Tools Help

D aE s S S

4 Wi-Fi 6 Demo (Feet) | I
@ Floar3 > Create Plan
Level: 3
Height: 10.00 Select Plan
Width: 170.00 Remove Plan
Length: 130.00
Aligned:  Center Add Floor Above

Height: 400  dE Loss: 32.00 gaditiooghcioy
Delete Floor

(2) Floor2 Edit Floor Detals

Level: 2
Height: 10.00 Reset Alignment

View 2D

Aligned:  Center

(Treignt: 400 dBLossi 3200 |

Width: 170.00
Item Description

Length: 150.00
Create Plan @ Creates a new floor plan project for this floor.
(or click

)

Select Plan Imports a site plan to this floor.
(or click =—)

Remove Plan Removes the floor site plan from this floor.

Add Floor Above Insert a new floor above this floor.

Add Floor Below Inserts a new floor below this floor.

Delete Floor Deletes this floor from the building and consecutively re-number the floors.
Edit Floor Details Opens a dialog containing floor details.

Reset Alignment Resets the alignment of this floor to the default alignment.

View 2D Switches to 2D view.

NOTE: If you use the Select Plan option to import a floor plan, the plan is imported "by reference": if you modify the floor
plan in MFP and save the project, the original floor plan is modified to reflect the changes. (Likewise, any changes you make
to the floor plan in AirMagnet Survey PROare also shown when you re-open the project in MFP.)

To configure each floor in the building project

In the Building Tree, each level is listed beginning with Level 1 at the bottom.

For adding an existing planner site plan to a level in the building project:
On the desired level in the building tree, click the chevron drop-down menu and select Select Plan and navigate to the
desired site plan. A valid site plan has a .spi file extension.

For creating a new project for a level in the building:
On the desired level in the building tree, click the chevron drop-down menu and select Create Plan.

Configure the new project options and click OK.
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New Project for Plan

Project Name: MNew Floor

Project Folder: C:\Users\me\Documents\MFP Building 121712\New Floor E]
Floor plan: | |E]
Dimensions:  Width(X): 120 Length(¥}: 120 Feet

Propagation: 40,000 Feet

Environment: [O‘Fﬁce =
Description:
Cancel
b d
Item Description
Project Name Give a name to this new floor plan project
Project Folder The default path where the project is created is in the parent building project.
Floor Plan You must add a floor plan image. Browse to a floor plan image. The image must be in one of the

supported file formats. See Supported Image File Formats,

Note: The Microsoft Visio format is not supported in Multi Floor Planner.

Dimensions This refers to the scale (in feet or meters) of the entire image area of the floor plan (including any
white space margin included in the image). If you are not sure of the dimensions, you may or may
not enter the approximate values here and then recalibrate the values more accurately later in 2D
view. See Measuring and Calibrating the Floor Plan Scale,

Propagation A default value default based on the estimated distance that RF signals can travel in a typical site

environments. NetAlly recommends that you accept the default value the program assigns. If you
change this value, be aware that the value affects the way the program interpolates data for the

entire site.
Environment Select an option that best matches the actual site environment.
Description (Optional) Type a text description of the project here.

Each floor in the building tree includes a summary of the values that you entered.
For additional configuration options:

« Configuring Multi Floor Planner to set general default values.

« Configure Plan for information on adjusting the sampling density.

Next Steps:
e Creating a Site Plan

Configuring Multi Floor Planner

The Tools menu provides several optional configuration steps for setting up your MFP project.

General Configuration

To set up general configuration choices, select Tools > Configure to show the general configuration dialog. This dialog lets
you set the default folder for buildings and display options.
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Configuration
Default Building Folder: | C:\Users\KenStitzel\OneDrive - NetAlly\Documents E
AP Display: (®) Best Name
() MAC Address
Bubhble Help: Show
["] Hide APs below Threshold
Walls/Areas: Display Walls/Areas
Grid: (] Draw Grid
o
Item Description
Default Building Folder Enter the default directory path for the storing project files.
AP Display Choose either Best Name (to display a text name for each AP) or
MAC Address (to display by the MAC address).
Bubble Help Check or uncheck to display AP information bubble when you hover the

mouse help over an AP in the floor plan/map view.

Hide APs below Threshold [Check or uncheck to toggle display all APs or to hide APs that don't
exceed the required signal threshold.

Walls/Areas Check or uncheck to toggle display of walls and attenuation areas in the
floor plan/map view.

Grid Check of uncheck to toggle display of grid lines in the floor plan/map
view.

Configuring the Plan (Signal Density)

To set the signal density for Configuring the sampling density is an optional step. Selecting Tools > Configure Plan to open
the Sampling Density dialog. This dialog has a slider that lets you control the precision with which Multi Floor Planner
(MFP) processes signal data.

o Setting a value toward the left (low) end of the bar means that processing signal data takes less time but is less com-
prehensive.

« Setting a value toward the right (high) end the bar means that signal data results have more detail but take more time to
process.

» (Optional) Select the Use recommended sampling distance checkbox to have MFP automatically calculate a suggested
value. MFP calculates this value based on the size and complexity of the site plan in use. Larger maps have a larger
recommended value to reduce processing time.

NOTE: This option is only available while on the 2D view.
Sampling Density

Distance between sampling points: 1.667 Feet

Use recommended sampling distance

Configuring Walls and Areas

To configure walls and areas, select Tools > Configure Walls/Areas. This shows the Wall/Area Configuration dialog. You can
« Create new areas or walls.

o Set the Attenuation Index values for areas.

o Set the db Drop values for walls.
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o Change the color for each wall or area.

o Import wall and area definitions from AirMagnet Multi-Floor Planner.

Wall/&rea Configuration

Area List | Wall List

X B[]

Apply  Mame

Brick Wall
Concrete Wall
Dy Wall

Thin Window
Thick Window
Window Office
Light Door
Heavy Door
Metal Door
Cinder Wall
Plasterboard Wall
Glass Wall with Metal Frz

(| ) 0 E ) ) e T 0

You can take the following actions:

Item Description

Area List tab Select to display the master list of areas.

Wall List tab Select to display the master list of walls.

|:| / Select the check box to apply changes that you make in the dialog to

areas or walls that are already placed in the floor plan. (If you leave the
box unchecked, changes apply only to new walls or areas that you add.)
IEI Click the Add button to add a new area or wall. This opens a new line at
the bottom of the wall or area list. Enter the new unique Name, Atten-
uation Index or db Drop value. A color is automatically assigned. (You
can change the color by double clicking it and selecting a new one.)
To delete a new area or wall, click on an area or wall. (You can select
multiple areas or walls by holding down the Ctrl or Delete key while
clicking.) Then click on the Delete button. This deletes the area or wall.
To restore the factory defaults for walls and areas, click on the Restore
button. This restores the factory defaults definitions and values for walls
and areas.

CAUTION: Any unsaved changes in the dialog are lost when you click
Restore.
To import custom wall or area definitions from AirMagnet Multi-Floor

Planner, click the Import button to import any walls or areas that are
different from ones in the list for MFP.
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I:I To change the color of an area or wall, double-click the color to open the
Color selection dialog. Select a new color, and then click OK,

Floor Alignment

By default, all levels in the building project are aligned vertically to their center point. Each level may be re-aligned based on
common walls, elevators, stairwells, and so on to create a more accurate representation of the building.

Click Align Floors @ or select Align Floors from the MFP Tools menu.
From the Select Floor to aligndrop-down above the top image, select the desired floor plan.

1.
2.
3. From the Select Ref Floordrop-down above the bottom image, select the floor plan to which the plan above is aligned.
4

On the floor plan at the top, click the first point of alignment. A push pin icon appears. Click the second point of
alignment. A second push pin icon appears. The distance between the push pins indicates the alignment edge.

5. On the bottom floor plan, click the first point of alignment. An alignment line appears between two push pins that
indicates the alignment edge to which the top plan is aligned. The push pin highlighted in pink may be adjusted around
the radius of the other push pin. If desired, click-and-drag the highlighted push pinto move its position.

6. Click Align. You may see the multi-floor view on the right readjust to account for any change in alignment.
You may continue to align floors as desired with the following exceptions:

» If you use a floor as a reference floor and then aligned it to another reference floor, any floors previously aligned the
first reference floor remain their current position.

* You cannot align a reference floor to another floor that is already aligned to the reference floor. For example, if floor 1
is a reference floor and you then align floor 2 to floor 1, you can no longer align floor 1 to floor 2.

Note: You can choose to reset alignment to the default and start over by selecting Reset Alignment from the Tools
menu.
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To save any alignment changes, click OK. To return to the Building Tree view without saving changes, click Cancel.

"B Floor Alignment
Select Floor to Align: Dim: 222,61 X 198.65 Feet

1wuow.

Select Ref. Floor: |Floor3 v | Dim: 222,61 X 198.65 Feet

[@J[a][@J0o00%

Creating a Site Plan

Now that you have created a project and imported your site map, you must draw up your planned office arrangement so you
can analyze your AP setup. AirMagnet Multi-Floor Planner’s drawing tools help you design your ideal office and then
determine how many APs you need to realize that goal.

Click on the links below to view each section.

Adding APs to the Plan

Generating the Advisor Layout

Drawing Attenuation, Coverage, and Exclusion Areas

TO PERFORM ALIGNMENT (use the left mouse button):
1. Click two points in the top image.
2. Click a reference point in the bottom image.

Drag the second pin to re-orient the image as desired.
3. Click Align.

Use the wall tool or automatic wall extraction (AWE) tool to create walls. (AWE is available only if you used an AutoCAD

format drawing for your floor plan.)

Using Antenna Manager

Using the Wall Tool

The following steps guide you through the process of outlining your building's walls and doors.

Note:If you use an AutoCAD format drawing for your site map, you can use the Automatic Wall Extraction tool to create walls.
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Create a New Wall

1.

Select a single floor from your MFP project.

%
Click the View 2D button to show the floor in the display view.

Select the Create Wall = tool from the toolbar. This displays a drop-down list of wall types in the top-right corner of the
map window. Each preset wall type has a preset dB drop level (the attenuation affect that the wall has on wireless
signals).

Note:In a Cisco Prime NCS/WCS Planner project, only Cisco NCS/WCS type walls appear in the drop-down menu.
Select the wall type and dB drop for the wall.

(B Brick wall (8 dB) -]

Concrete Wall (12 dB)
Dry Wall [4 dB)
Heawy Door (15 dB)
Light Door (4 dB)
Metal Door [11 dB)
Thick Window [4 dB)
Thin Window [2 dB)
Window Office (3 dB]

Click the place on the floor plan/map where one end of the wall starts. Move your cursor to a corner or a point where the
wall changes its angle, and click again. You can click several times along a wall, following bends and curves as needed.
Right-click to conclude this portion of the wall. This fills in the wall in the display.

« If you click the wrong spot while drawing your wall, press Ctrl+Z on the keyboard to undo the action caused by the
last click. Keep pressing Ctrl+Z to continue to reverse the previous action.

e To cancel drawing the wall, press Esc, and the wall is erased. (The drawing tool then defaults to the cursor.)

Repeat step 3 until all of your walls are filled in. Select different wall types (windows, doors, and so on) from the drop-
down as needed.

Edit or Delete a Completed Wall

To delete a wall, right-click on the wall, and then select Delete.

To edit the wall properties, right-click on the wall, and then select Properties... This opens the Wall Properties dialog.
Make your selections, and then click OK. See Area/Wall Properties for more information about the property options.

Area/Wall Properties

To modify the properties of an existing wall or area, right-click on the object and then select Properties from the drop down
menu to display the properties dialog.

Wall Properties Area Properties

Brick Wall (8 dB v
10 PR e B Cubick 28 "
Attenuation (Bl |8 |
Attenuation Indesx: | 25 E
[] Apply change to whale wall
Motes:

Notes:

NOTE: Color is the only property that you can change for coverage areas and AP exclusion areas. Selecting Properties for
these areas opens the Color selection dialog.
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et

Cancel

Use the following options to configure the wall or area properties:

Option Description

Type Opens a drop-down menu of wall or area types and the default attenuation index or dB drop
value (in dB) for areas or walls of the selected type. (To change the default values, see Con-
figuring Walls and Areas )

Attenuation (dB)
or
Attenuation Index

The attenuation or dB drop value of a wall is the drop in signal strength (measured in

dB) when the signal passes through a wall. You can measure signal strength directly (using
AirMagnet Survey, for example) on both sides of a wall and then calculate the difference
between the two sides to get the wall’s dB drop value.

The Attenuation Index is the drop in signal strength caused by distance as it passes through

Enter an attenuation value to assign to the selected wall or area.

open areas.

||:| (Color)

Click the color box to open the color selection dialog for the wall or area object. Make your selec
tions, and then click OK,

Apply change to whole |Select this check box to apply the change to the entire wall. If you do not select this option, the
wall (for walls only) change is applied 0nly to the currently selected segment of the wall.

Notes (Optional) Type a text note to describe the change in properties.

CAD Layers and Automatic Wall Extraction

If your project uses an AutoCAD floor plan, Multi Floor Planner (MFP) lets you import wall data from the AutoCAD files. You

can select which layers contain walls, and automatically draw walls in MFP at those locations.

1. Select the CAD Layers to use

2. Extract the Walls

3. (Optional) Modify walls as needed. See Using the Wall Tool.

Select the CAD Layers

1. Select a single floor from your MFP project.

2. Click the View 2D button

2

to show the floor in the display view.

3. Select Tools > Configure CAD Floor Plan. A window similar to the following appears. This window allows you to decide
which AutoCAD layers you want to display on your map.
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AutoCAD Image Configuration

Drawing Layers | Extracting Walls

Select drawing layout and layers to dispaly on site map

Layout: | Model V
View Black and White

W] Layer

0

BUILDING_ENVELOPE
MOVABLE_FURNISHINGS
NON-MOVABLE_FURNISHINGS
EQUIPMENT

SPACE

WALL

DIMENSIONS

DEFPOINTS

|| =) | | =] =]

Note: AutoCAD drawings can have many layers. Try to limit your choices to layers that represent actual walls or that
otherwise help you work with your floor plan.

4. Use the drop-down menu/check boxes as follows:

Layout: Some AutoCAD files may have multiple layouts in them. Use the Layout drop=down box to select from
available layouts in the AutoCAD file.

o Select all Layers: Selects/deselects all layers.

View black and white: Some AutoCAD files use colors on layers, but the colors could interfere with visibility of
heatmaps. Select this option to set all layers to display in black and white by default.

5. Click OK when you have finished selecting layers.

Extract the Walls
1. Select Tools > Configure CAD Floor Plan. A window similar to the following appears, displaying the layers that you
selected.
e
Drawing Layers | Extracting Walls
Select layers for wall extraction [ Save Wall Type Selections
[ Layer Wall Type. dB Drop  Color
e T -
SUILDING ENVELGPE Concrete wa - |12 |
7 [MovasLE FURNISHINGS ght Door__~ | |
7 [NON-MOVABLE FURNISHINGS o B |
T [cquipmenT Brickwan___~ |5 ]
[ |seace Brick Wall K I:|
Comvarting CAD Line Segments to Planner Walls
Ignore Line Segments Less Than: 150 Feet

Combine Parallel Segments if Within: [1.55

Applying Extracted Walls

® Cverwrite Existing Planner Walls ©) Append to Existing Plan

2. Select the layers you want to extract by clicking the check boxes in the Layer column.

Click on the Wall Type in any row to open a drop-down menu to select a wall composition to use for that layer. (The
default is Brick Wall. The available selections are Dry Wall, Concrete Wall, Thick Wall, Metal Door, Heavy Door, Brick Wall,
Light Door, Cinder Wall, Plasterboard Wall, Thin Window, Glass Wall with Metal Frame, Window Office.)

Click db Drop in any row to modify the db Drop value. This is the amount of attenuation that you expect from the wall
type.
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5. Select or deselect the following check boxes. These options can help you avoid importing artifacts from AutoCAD files
that aren’t true wall segments.
NOTE: These options are for vertical and horizontal lines (not diagonal).

» Ignore line segments less than: Specify a value to ignore short line elements that may be recognized as walls but
that create a large amount of "visual noise". This option may reduce this visual noise.

» Combine parallel segments if in: Many AutoCAD drawings represent walls with two parallel lines close to each other.

If this option is disabled, you might end up with twice as many walls, doubling the attenuation.
6. Select Overwrite Existing Planner Walls or Append to Existing Plan.

« Overwrite Existing Planner Walls: Use this option only if you are creating are importing a single AutoCAD drawing
and do not plan to add other layers.

« Append to Existing Plan: Use this option if you are adding an additional layers to the floor plan. This prevents a layer

being added multiple times, which makes editing difficult.
7. Click OK. This imports the AutoCAD drawing and displays the floor plan, such as the example below.

1in.=17.141t Dimensions(X x1Y): 120.00 ftx 91.17 ft;
e

—
[ ]
.
Il
=]
|

==
I
AN

RS

Fﬁﬂ“wz

i

8. (Optional) Repeat this procedure to add more layers.

You can now use the various MFP wall tools and options to move, modify, or delete extracted walls, just as you can with
drawn non-AutoCAD walls.

See Also:

« Using the Wall Tool (designing for your floor plan and determining how many APs you need)
» Drawing Attenuation Areas (changing the decibel values of walls and other objects)

« Adding APs to the Plan

» Using the Right-Click Menu

Drawing Attenuation, Coverage, and Exclusion Areas

Use the tools in the right sidebar to draw out the internal layout components of your office (walls, cubicles, offices, and so
on). You can mark the floor plan with the following:

o Attenuation areas: open areas that are large enough that Wi-Fi coverage may fall off with distance from an AP.
« Coverage areas: areas that require Wi-Fi coverage.
e Exclusion areas: areas that do not require Wi-Fi coverage.

Marking these areas helps MFP automatically place APs at the most effective locations on the floor plan map later in the
process.)

« Drawing Attenuation Areas

« Drawing Coverage or Exclusion Areas

o Editing Area Properties

Note: Do not use the Wall Tool or the area marking tools for the same attenuation space. For example, if you create a wall
enclosing a small office, do not create an attenuation area inside the office.
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Drawing Attenuation Areas

To mark an area that can attenuate a Wi-Fi signal:

1.

6.

Select a single floor from your MFP project.

%
Click the View 2D button to show the floor in the display view.

Choose one of the attenuation area buttons from the side toolbar:

Create Rectangular Attenuation Area
) Q Create Arbitrary Attenuation Area

‘ @ Create Elliptical Attenuation Area

A drop-down list appears in the top right corner of the map view when you select any of the attenuation types with a
preset Attenuation Index. Select an area type from the menu.

B Dry wall office (30) L'J
B Cybicle (28)

B \Warehouse Low Densii i29i

B \Warehouse Medium Density (31)
B \wWarehouse High Density (33)
B Flevator Shaft (35)

e The numbers displayed with each area type show the built-in attenuation index for that type. This index is a measure
of the rate of signal degradation for RF traffic that moves across an open area.

e Alarger value corresponds to a greater drop in signal strength. Larger spaces have higher attenuation indexes.
e This value is not identical to the dB drop value for a signal passing through a wall.
Mark the attenuation area:

e For rectangular areas, right-click the corner of the area you wish to designate. Then move the mouse cursor to the
opposite corner of the rectangular area. Right-click or double-click to complete the area.

» For arbitrary areas, right-click once at the point you wish to start drawing . Then move the cursor to the next corner of
the area and single-click. Then repeat for the next corner, and so on. When you have marked the last corner, right-
click or double-click to automatically connect the final point to the first point to complete the area.

e For elliptical areas, click once at one side of the ellipse, and then drag the cursor to the other side of the area. Release
the click when the ellipse is the correct size.

Repeat this process for any further attenuation areas you wish to draw.

Drawing Coverage or Exclusion Areas

These tools mark areas that must have good coverage or that can be excluded from coverage. (These tools work like the
attenuation area tools, except that you do not have to choose an area type. )

To draw an arbitrary region:

1.

Choose one of the coverage or exclusion area tools from the side toolbar:

.

Create Rectangular AP Coverage Area

)

Create Rectangular AP Exclusion Area

Create Arbitrary AP Coverage Area

@ Create Arbitrary AP Exclusion Area
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2. Mark the coverage or exclusion area:

Create Elliptical AP Coverage Area

Create Elliptical AP Exclusion Area

e For rectangular areas, right-click the corner of the area you wish to designate. Then move the mouse cursor to the
opposite corner of the rectangular area. Right-click or double-click to complete the area.

e For arbitrary areas, right-click once at the point you wish to start drawing . Then move the cursor to the next corner of
the area and single-click. Repeat for the next corner, and so on. When you have marked the last corner, right-click or
double-click to automatically connect the final point to the first point to complete the area.

e For elliptical areas, click once at one side of the ellipse, and then drag the cursor to the other side of the area. Release
the click when the ellipse is the correct size.

3. Repeat this process until you have marked all your desired areas.

Editing or Deleting Areas
e To delete an area, right-click on the area, and then select Delete.
o To edit area properties, right-click on the are, and then select Properties... This opens the Area Properties or Color dialog.

o Selecting Properties for coverage areas or AP exclusion areas opens the Color selection dialog. Color is the only
property that you can change for these areas. Make your selections in the dialog, and then click OK.

o For attenuation areas, selecting Properties... opens the Area Properties dialog. Make your selections in the dialog, and
then click OK. See Area/Wall Properties for more information about the property options.

Using Antenna Manager

The Antenna Manager (Tools > Antenna Manager) on Multi Floor Planner manages existing antennas and lets you create new
antenna patterns. It also contains an antenna pattern modification tool that lets you match patterns that your antenna
generates.

« Viewing Included Antenna Properties

« Creating a Custom Antenna Pattern

Get the Latest Antenna Patterns

Each release of AirMagnet Survey PRO provides updated antenna patterns as of the release date. If you subscribe to AllyCare,
NetAlly's comprehensive support and maintenance service, you can download the most recent patterns using the following
procedure. (If you do not subscribe to AllyCare, you can use the procedure to see if an antenna pattern exists, but you cannot
download it.)

1. Signin to your MyAirMagnet account. (You can use this page to view the status of your support contract under the
Registered Products section.)

2. Click on the Planner Antenna Patterns link to display a list of patterns, sorted by manufacturer. The list includes the
release date and a link to the list of updated patterns for the manufacturer.

3. Follow the screen instructions to download and begin using the new patterns.

Viewing Included Antenna Properties for Multi Floor Planner

AP vendor antenna In this topic:

« View and Filter Antenna Lists

« View Antenna Properties

« Create or Delete a User Defined Pattern

View and Filter Antenna Lists
You can view and filter lists of preset antennas included with Multi Floor Planner (MFP).

1. Click Tools > Antenna Manager... to open the Antenna Manager. (You can also open the manager from the AP Properties
dialog by clicking the Pattern button.)
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NOTE: The antenna patterns and AP vendor list may remain blank for several seconds while loading. See Saving Vendor
Lists below for information on reducing the load time.

Antenna Manager
Band: All -
Plane: | All -

Create: | All =

4 All Selected Vendors
[CAceelTex
[herotive
[allied Telesis

Cambium ANT-
D35-4X4-01 5GHz A

yal

]
i
s

P

g

Cambium ANT-
D35-4X4-01 5GHz E

Cambium ANT-
D35-4X4-01 6GHz A

Y -~
Clalinet [ %
[araknis Lo

lavsto S i
[ClAruba
[Hcambiom

=
ET.Z& Cambium ANT-

[Cledgecore D35-4X4-01 6GHz E

[ClExtreme — =~
Clrortinet o ™ [
[ClFurukawa - i
ClHuawei "‘.‘ ¥ |
VMeraki SRS s i\
[Cneru >

[taird Technologies i
TerraWare Cambium ANT- Cambium ANT- Cambium ANT-

Mist D60-4X4-016GHz A D6O-4X4-016GHZE  OM-1X1-05 24GHz A

[Cloberon =
[General 7% N o S
Ceroxim | ]

ST | | !
Rrueins r\\lf N \ \ (’L L"]

‘ Save Vendors ‘ ‘ MNew |

Cambium ANT-
D60-4X4-01 5GHz A

Cambium ANT-
D60-4X4-01 5GHz E

S
ST

2. (Optional) Use the filter options and vendor selection list at the top left of the window to display antennas that match the
selections.

Antenna Manager

Delete

Band: All =
Plane: All i
Create: | All i
|%|Extreme
Fortinel
Furukawa
Huawei
[IMeraki
Field Description
Band Click select the frequency band: 2.4 GHz, 5 GHz, 6 GHz, or All.
Plane Click to display to antenna patterns using the Azimuth (top view), Elevation (side view), or All (the default).
Create |[Click to display antenna patterns by Pre Defined (patterns supplied by MFP), User Defined (patterns you
have created yourself—see Creating a Custom Antenna Pattern for Multi Floor Planner), or All (the default).
Vendor |Use this list to sort the pattern display by vendor.
Selection |, pisht-click + All Selected Vendors - Displays a pop-up menu to:
List

o Check All (default, displays patterns for all predefined vendors)

* Uncheck All (clears all selections, displays nothing until you check a vendor name or choose Check
All).

« To display patterns from a specific vendor when all vendors are selected, just click on the vendor name
(do notselect the check box). This displays the patterns for that vendor on the right side of the screen.

» See Get the Latest Antenna Patterns for instructions on checking for more recent antenna patterns.

Saving Vendor Lists

To reduce the time needed for many antenna patterns to load, you can select and save the AP vendors that best match your
network. To select which AP vendor antenna patterns to save:
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1. Close any open Multi-Floor Planner projects if you have not previously used this feature.

2. Select the AP vendors you want with the filtering options on the left side of the Antenna Manager window, as described
above in View and Filter Antenna Lists.

NOTE: You can select different vendors for the 2.4 GHz, 5 GHz, or 6GHz bands, but you must select at least one vendor per
band.

3. Click on or tap the Save Vendors button . This saves the filtered list of vendors that you have selected. The
next time you open Multi Floor Planner, the Antenna Manager dialog shows only the vendors in the saved list.

CAUTION: Closing the Antenna Manager dialog without clicking or tapping the Save Vendors button does not save your
selections.

4. (Optional) To update the list, use the AP vendors list to make new selections, and then click or tap the Save Vendors
button again. Multi Floor Planner uses the updated list the next time it opens.

Additional notes about using this feature:

« If you open a project that includes antenna patterns from a vendor not saved in the vendor list, Multi Floor Planner auto-
matically adds the vendor and antenna patterns to the list of selected vendors.

« Depending on which vendors you select, the default antenna on the AP Properties screen could change.

Viewing Antenna Properties
You can view detailed properties of listed antennas listed.

1. To view properties for a pattern, double-click the pattern in the display area. This opens the antenna pattern dialog with
an enlarged picture of the pattern and properties. (A smaller diagram in the upper right displays the best fit of a curve to
the data points in the pattern.)

Antenna Editor

Antenna Mame: | D-Link ANT24-0401 2.4GHz 4dBi A

Property

Vendor: D-Link
Band: 2.4 GHz
Plane: Azimuth
Ring Count: ]

0 dB Ring #: 6

dB Interval: 5

0Ring dB Gain: 0

Tracker

Show Handle
Show Assist

[] Save as New

fearzz]

Note: You cannot modify the predefined antenna patterns. However, you can use the pattern to create your own antenna
by following the steps in Creating a Custom Antenna Pattern for Multi Floor Planner.

Field Description

Vendor The name of your antenna’s vendor or manufacturers.

Band Select 2.4 GHz 5 GHz 6 GHz or All,

Plane EitherAzimuth (horizontal plane/top view) or Elevation(vertical plane/side view).

Ring The number of concentric circles displayed in the field diagram, including the outermost ring.
Count

0 dB Ring [The number of dB rings from the center to the 0 dB ring of the diagram.

#

dB The interval in dB between each ring of the diagram.

Interval
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0 Ring dB Shows the peak gain value provided in the antenna vendor's user documentation/data sheet

Gain Shows a 0 if the field pattern reaches or exceeds the peak gain at any point.

e In the following examples, the 0 dB ring is highlighted in bold and shown by an arrow. In the first example,
the antenna pattern does not exceed the peak gain value, so the 0 Ring dB Gain value is 3.00 as per the
vendor's documentation. In the example on the right, the antenna pattern exceeds the peak gain, so the 0

Ring dB Gain value is 0.

Show Displays straight lines connecting the yellow points on the field, as well as the red curved fit line.

Handle

Show Displays intermediate blue points, which are connected by the best-fit (red) curved line.

Assist

Save as Select this checkbox to create a new pattern based on the properties for the current antenna pattern. Then
New follow the steps in Creating a Custom Antenna Pattern for Multi Floor Planner.

Create or Delete a User Defined Pattern

You can create new User Defined patterns based on preset Defined patterns or by creating a pattern from a vendor's spe-
cifications. You can also delete User Defined patterns.

* To create a new User Defined pattern directly:
1. Click on the New button. This opens the antenna pattern dialog.

2. Follow the steps in Creating a Custom Antenna Pattern.

e To create a new User Defined pattern from an existing vendor pattern:

1. Locate and select the preset pattern as described in Locate and View Antenna Properties above.

2. Follow the steps in Creating a Custom Antenna Pattern.

e To delete a User-Defined pattern:

1. Locate and select the User Defined pattern as described in Locate and View Antenna Properties above.

2. Select the pattern.
3. Click on the Deletebutton.

Note: You cannot delete Pre Defined vendor patterns.

Creating a Custom Antenna Pattern

If your antenna is not listed in the presets, you can create a customized antenna pattern based on the vendor's specifications
or one of the predefined vendor patterns. This enables Multi Floor Planner to accurately project the desired pattern.

To create a new antenna pattern

1. From the Antenna Manager, either click the Newbutton to open the Antenna Editor dialog or use the following procedure
to start from a predefined pattern:
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Use the steps in Viewing Included Antenna Properties to select an antenna with a pattern that resembles the pattern
you want to create.

Double-click on the antenna pattern to display the Antenna Properties dialog.

Select the Save as New checkbox in the lower right corner of the dialog. This opens the pattern and its properties in
the Antenna Editor dialog.

Tracker
N

)
© Show Handle
sav Showr Assist

Save as New

TIP: It often saves time to use an existing pattern that is similar to the one you want to create.

Antenna Editor

Antenna Name:

Property

Band: Both v
Plane: Azimuth  ~
Ring Count: 10

0 dB Ring #: 0
dB Interval: 5
0 Ring dB Gain: |0
Tracker

Show Handle
Show Assist

OK
2. For the Antenna Name, enter a unique name for the new antenna pattern. NetAlly recommends a naming standard such
as the following, separated by spaces:
<Vendor name>
<Model and frequency band, separated by dashes>
<Antenna gain dBi>
<A or E, to indicate if the pattern is for azimuth or elevation dispersion>
For example: Cisco Catalyst 91641 6GHz 4dBi A
3. Configure the antenna properties as described in the following table. Use the antenna diagram as needed:
Field Description
Vendor Enter the name of your antenna’s vendor or manufacturers.
Band Select 2.4 GHz 5 GHz 6 GHz or All,
Plane Select either Azimuth (horizontal plane/top view) or Elevation(vertical plane/side view).
Ring Count Enter the number of concentric circles that you want displayed in the field diagram, including the outer-
most ring.
0 dB Ring # Enter the number of db rings from the center to the 0 dB ring.
dB Interval The interval in dB between each ring of the diagram. (For example, if there is a 5 dB interval between each
ring, enter 5.)
0 Ring dB Gain|e Enter the peak gain value if it is provided in the antenna vendor's user documentation/data sheet
» Enter a 0 if the field pattern reaches or exceeds the peak gain at any point.
e In the following examples, the 0 dB ring is highlighted in bold and shown by an arrow. In the first
example, the antenna pattern does not exceed the peak gain value, so the 0 Ring dB Gain value is 3.00
as per the vendor's documentation. In the example on the right, the antenna pattern exceeds the peak
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gain, so the 0 Ring dB Gain value is 0.

@
N 4
o
&

Show Handle |If you choose to manually adjust the antenna pattern in the next step, select this checkbox to display
straight lines connecting the yellow points on the field, as well as the red "best fit" curved line. These yellow
points appear only on the lines radiating outward from the center of the circle. Use these points to make
larger changes to the field pattern.

Show Assist  [If you choose to manually adjust the antenna pattern in the next step, select this checkbox to display only
the blue points, which are connected by the best-fit (red) curved line. These blue points allow you to fine-
tune the field in-between the Handle points. Use these points to make detailed changes to the field pattern.
(Selecting Show Handleat the same time displays the final field view.)

4. Adjust the antenna pattern drawing by dragging the Handle and Assist points on the pattern diagram as needed. Handle
points (yellow points) allow for larger changes while the Assist points (blue points) let you fine-tune the pattern. The
following example shows the result of dragging the yellow Handle point at the top upward and then using the adjacent
Assist points to smooth out the result.
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TIP: Get an electronic image of the product antenna pattern diagram if possible. Size the image to the same size as the
diagram (antenna drawing) in the Antenna Manager. Trace the outline of the product antenna pattern onto a trans-
parency. Overlay the transparency on the Antenna Manager. Drag the handles to conform to the trace image.

TIP: You may find it easiest to uncheck the Show Assist box and then make large changes to the field pattern using only
the yellow Handle points. You can then re-check Show Assist to fine-tune the pattern drawing.

Click OK to save the new antenna pattern. The new antenna pattern appears as a User Defined selection in the Antenna
Manager.

Note: To use the new antenna pattern, create a new AP or select an existing AP on the floor plan. Double-click the AP to open
its properties. Then select the new pattern from the drop-down menu in the AP Properties dialog.

To delete the new pattern, select it from the list of User Defined patterns, and then click Delete. (You cannot delete any of the
preset patterns.)

Adding and Editing APs

You can manually add APs or edit existing APs where needed. You can also use the MFP Advisor to automatically add APs at
optimal locations.

TIP: Add APs in arbitrary locations and update the heat map to see the resulting coverage. You can roughly but quickly
determine the number and placement of APs to give you coverage for your site.

To place new APs:

1.

Use the building tree view (upper left) to select the floor on which you want to place the AP.

Click the View 2D button . This displays the floor in the display view along with the tool bar.

AF)
Click on the Add AP CJ icon on the toolbar. This changes the cursor to AP placement mode.

Place the mouse cursor at the location that you wish to place the AP on the site plan and then click.

To change back to the normal cursor, click the Selecttool [:%" or press the Esc key
» Repeat this process to place additional APs.

For each new AP, double-click on the AP icon or right-click on the icon and then select Properties.... The AP Properties
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dialog box appears.

AP Properties
AP Mame: |AP-6

() AP Model:

Channel:

MAC Address:

Full MAC Address:
SSID:

Antenna

Location

Height: 10.000

MNotes:

24 GHz | 5GHz | 6 GHz

Transmit Power (mWatt):

Omni-Directional (2.15dBi)

Media Type: | Wi-Fieé  *

1 Enable
00:00:C8:00:00:10
00:00:C8:00:00:10

Unknown SS1D
25

Rotation in degrees:
]

X 52872 | ¥:|111.826  Feet

Item

Description

AP Name

Enter a name for the AP.

AP Model @ / @

Open or close the AP Model controls. See To save or re-use AP models below.

Band (2.4 GHz, 5 GHz, 6 GHz)

Select the tab for the APs frequency band (2.4 GHz, 5 GHz, or 6 GHz).

PSC Only checkbox

(6 GHz only) Check this box to limit channels to preferred scanning channels.

Channel

Enter the channel the device operates on.

Channel selection menu

(6 GHz only) Select a channel from the drop-down menu. If the PSC Only checkbox is
checked, this lists only preferred scanning channels.

Enable checkbox

Check this box to enable or disable the frequency band. (If your AP does not operate on all
bands, disable the bands that are not applicable.)

MAC Address Modify the default value as desired to identify virtual APs.
Full MAC Address Auto populates the field in the event APs on different floors have the same MAC address.
SSID Enter the SSID, if desired, to identify a virtual AP.

Transmit Power (mW)

Enter a number that closely matches the true transmit power setting of the AP.

Antenna Use the drop-down menu to select the type of antenna your device uses. This displays the
antenna’s coverage field in the diagram on the left.
¢ Click Pattern to open Antenna Manager, which allows you to search in more detail or to
create a custom antenna pattern.
o After selecting or creating an antenna pattern, adjust the antenna orientation by entering
the rotation in degrees or by dragging the slider control.
Media Type Use the drop-down menu to choose the protocol for the AP.
Properties Displays the Properties dialog to select additional properties based on the Media Type. See
Wi-Fi 4 Properties, Wi-Fi 5 Properties, or Wi-Fi 6 Properties,
Location Enter the planned height (in feet) for the AP. The X and Y fields represent your device’s X and
Y coordinates on the map if your layout is in a grid format.
Note (Optional) Enter a text description for the AP.
7. Click OK. The filter view now shows each AP radio as an icon representing its media type:

n-]'|
802.11a: h’l
1

b

o

=
802.11b: &
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802.11g: 19
° Wi-Fi4zm
° WiFi 5: 50
° wme:ﬁ
° Wi-Fi 6E: R
Channel 2.4 GHz band: .
Channel 5 GHz band: t

Channel 6 GHz band: @

8. Click ™ (Refresh) or press F5to update the heatmap view.

To view or edit current APs

e To view or edit APs:

1. Select the floor with the AP you want to view in the building tree view (upper left).

2. Click the View 2D button

3. Double-click on an AP icon or right-click an AP located on the site map and select Properties to open the
AP Properties dialog (described above). You can then view or edit the AP properties.

' b

To move an existing AP, click on the Selecttool

. This displays the floor in the display view.

, and then click and drag the AP on the site map.

* Click ™ (Refresh) or press F5to update the heatmap view.

To save or re-use AP models

The AP Model controls let you create a master list of AP models so that you can easily select and re-use an AP models that
you have already defined.

To open or close the AP Model controls, click the Open @ or close @ icon near the top of the AP Properties dialog.

AP Name: Acme Model 1
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e To add an AP model to the master list :

1. Click the Add |§| icon to open the Create AP Model dialog.

Model Name: | Acme Model 11 |

Copy From Model | acme Model 1 “]

cance'

2. Enter a model name.

3. (Optional) To copy the settings from an existing AP, select the Copy checkbox, and then select an existing AP from
drop-down.

4. Click the Save |§| icon to save the new AP model to the master list.
5. Click OK to return to the AP Properties dialog.

To delete a model from the AP model list, select the model from the drop-down list, and then click the Delete E icon.

Wi-Fi 4 Properties

Miax MCS: 152 Streams - 64-0AM 58] |

Max Frame Size: | 8191 A-MPDU “|

Expected Op. Mode
() GreenField
) Mixed

Protection Method: | RTS_TO_CTS ~

Channel
Channel &
O 40 MHz
Sec, Channel
® Up ' Down
® 20 MHz

Block Ack
Short Guard Interval

Cancel
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Option

Description

Max MCS

Use the drop-down menu to select a MCS (Modulation and Coding Scheme) value, an integer in the
range of 0 to 31. This value corresponds to the maximum data transfer rate supported by the AP.

Max Frame Size

Use the drop-down menu to select the preferred maximum frame size. Wi-Fi 4 devices support frame
sizes up to 64 KB. A larger frame size can reduce the number of frames required per transmission and
reduce wireless overhead.

Expected Op. Mode

Greenfield mode is for a deployment that consists purely of Wi-Fi 4-capable devices. An AP set to
Greenfield mode cannot service legacy (802.11a/b/g) clients. Mixed mode means a network that
includes device types older than Wi-Fi 4.

Protection Method

(If you selected Mixed mode) Use the drop-down menu to select the type of protection mechanism in
use on the AP.

Channel Wi-Fi 4 devices can operate on 40 MHz channel widths. To accommodate the 40 MHz width, you can
set the AP to transmit over two 20 MHz channels. In this case, you can select the desired channel and
then specify whether the secondary channel used is above or below the channel selected.

Block ACK Select this checkbox to use the Block ACK frame type. This allows an AP to acknowledge blocks of

multiple frames with a single ACK frame. (In contrast, legacy devices must send an ACK frame for
every frame received, which significantly increases network overhead and decreases performance.)

Short Guard Interval

Select this checkbox to specify a short Guard Interval (the period of time that passes between data
transmissions). The Wi-Fi 4 specification provides two guard interval options: 400 ns and 800 ns. By
default, most Wi-Fi 4 devices are set to 800 ns. However, a shorter interval can help prevent wireless
hazards such as propagation delays, echoes, or reflections.
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Wi-Fi 5 Properties

If you have selected a Media Type of Wi-Fi 5 in the AP Properties dialog, this dialog lets you specify additional properties.

Wi-Fi 5 Properties

MCS

Spatial Stream Number: | 3
Max MCS: 9 =

Predictive PHY Data Rate: | 1170.00 Mbps

Max Frame Size: 65535 A-MPDU =
Channel
Primary Channel: 36
Channel Width: 80 MHz ¥
Channel: 36 P, 80WHz, 36-48
| Block Ack

["] Shart Guard Interval

Item Description

Spatial Stream Number Use the drop-down menu to select predictive MIMO support for up to 3
spatial streams.

Max MCS Use the drop-down menu to select Predictive MCS support for index values
0-11.

Predictive PHY Data Rate A calculated value based on your selections for Spatial Stream Number and
Max MCS.

Max Frame Size Use the drop-down menu to select a frame size option. (All options are for
Aggregate MAC protocol data unit (A-MPDU).)

Primary Channel Lists the Primary Channel selected for this AP.

Channel Width Use the drop-down menu to select a channel width of 20, 40, 80 and 160
MHz.

Channel Summarizes the selections made for the channel.

Block Ack Block Ack is checked by default to indicate it is enabled. It cannot be
modified.

Short Guard Interval Select this checkbox to specify a short Guard Interval (the period of time
that passes between data transmissions). The Wi-Fi 5 specification provides
two guard interval options: 400 ns and 800 ns. A shorter interval can help
prevent wireless hazards such as propagation delays, echoes, or reflec-
tions.
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Wi-Fi 6 or 6E Properties

If you have selected a Media Type of Wi-Fi 6 or Wi-Fi 6E in the AP Properties dialog, this dialog lets you specify additional
properties.

Wi-Fi 6 Properties

MCS
Spatial Stream Number: 8 N
Max MCS: " N

Predictive PHY Data Rate: | 4303.90 Mbps

Max Frame Size: 262143 A-MPDU v
Channel
Primary Channel: 36
Channel Width: 80 MHz v
Channel: 36 P, B0MHz, 36-48
+ Block Ack

Item Description

Spatial Stream Number Use the drop-down menu to select predictive MIMO support for up to 8
spatial streams.

Max MCS Use the drop-down menu to select Predictive MCS support for index values
0-9.

Predictive PHY Data Rate A calculated value based on your selections for Spatial Stream Number and
Max MCS. (Wi-Fi 6E defaults to a higher rate.)

Max Frame Size Frame size options are available for Aggregate MAC protocol data unit (A-
MPDU)

Primary Channel Indicates the Primary Channel selected for this AP.

Channel Width Provides options for the selection of 20, 40, 80 and 160 channel width. (Wi-
Fi 6E defaults to a higher rate.)

Channel Summarizes the selections made for the channel.

Block Ack Block Ack is checked by default to indicate it is enabled. It cannot be
modified.

Automatically Adding APs with Advisor

The Advisor tool automatically places APs in a Multi Floor Planner (MFP) floor plan. You can also add and edit APs manually
and use the drawing tools to create and edit walls or create and edit coverage, attenuation, and exclusion areas to help
Advisor generate an optimal AP layout.

To generate an Advisor layout:
e
1. Click the #°% (Advisor) button in the toolbar. The Advisor Criteria dialog appears so that you can specify the type of
APs you want to add.

-103 -



Multi Floor Planner

Advisor Criteria
WARNING: Unlocked APs will be replaced.

Media Type: @ Wi-Fi6E O Wi-Fi6 O Wi-Fi5 O Wi-Fi4
(cenionbondenpomrsng 5T i
Transmit Power 24 GHz: 25 mWatts
Transmit Power 5 GHz: 25 mWatts
Transmit Power & GHz: 25 mWWatts
Band: 6 GHz
(%) Channels: SE, S3E, 101E
Channel Width: 160 MHz M
Spatial Stream Number: 8 v
Max MCS: 11 [1024-QAM 5/6] M
Frame Size: 262143 A-MPDU v
AP Height: 10 Feet
Omni Antenna Gain: 215 dBi

2. Make any desired changes to the dialog information.

Field Description

Media Type Specifies the Wi-Fi standard supported by the Advisor-placed APs. (This selection may change
the available range of other settings below.)

Minimum Signal Defines the minimum strength required at any point in a coverage area (based on the power

Strength Coverage setting). The signal strength cannot drop below this value in areas that require coverage.

Transmit Power 2.4 Defines the transmit power for the 2.4 GHz APs placed by Advisor.
GHz

Transmit Power 5 GHz |Defines the transmit power for the 5 GHz APs placed by Advisor.

Transmit Power 6 GHz |Defines the transmit power for the 6 GHz APs placed by Advisor.

Band Defines the frequency band to be used by Advisor’s placed APs.

Channels Opens the Channel Allocation drop-down menu, which lets you select which channels in each
band that Advisor can use to place APs.

o You must select a minimum of three channels for each band in use.

Channel Width Specifies the channel width to be used by Advisor-placed APs.
e The Wi-Fi 4 media type supports 20 MHz and 40 MHz channel widths.
e The Wi-Fi 5 and Wi-Fi 6 media types support 20 MHz, 40 MHz, 80 MHz, and 160 MHz channel

widths.
Spatial Stream Specifies the number of spatial streams to be used by Advisor-placed APs. (Used by Wi-Fi 5 and
Number Wi-Fi 6 media types and ranges from 1 to 8.)
Max MCS Specifies the Modulation Coding Scheme (MCS) index used by Advisor-placed APs. The MCS

setting corresponds to the maximum data transfer rate supported by the AP.
e Wi-Fi4range: 0 to 31

e Wi-Fi5range:0to9

e Wi-Fi 6, 6E range: 0 to 11

Frame Size Specifies the maximum frame size used by the Advisor-placed APs. The range is 3839 to
4194303, depending on the media type. Larger frame sizes minimize wireless overhead in the
network by reducing the number of frames required per transmission.

AP Height The height of the AP. This setting directly affects signal coverage. APs placed higher than
standard ceiling height do not cover as wide an area.

Omni Antenna Gain Defines each AP’s antenna gain. (Advisor assumes omnidirectional antennas.)

3. Click OK to start the Advisor. Advisor processes the site data, tests AP locations, and then places APs on the plan, as
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shown in the following example:

1in=24.29 ft

Dimensions(X x ¥):170.00 X 150.00 Feet

Viewing Multi-floor Data

Once APs are included into your building project (either as part of an imported site plan or by adding them in the 2D view),
Multi Floor Planner (MFP) can process the data to show a predictive, color-coded visualization of the Wi-Fi environment.

To get started, click Refresh L] or press F5 . MFP processes the project to show a color-coded heatmap display.The color-
codes correspond to the legend at the far right.

The following example shows the 3D view. Note that the Building Tree view is not included in the 2D view.
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Map View
Toolbar p Data Type menu
/| &Menu N “
Wi-Fi 5 Sample Building.bm! - Multi Floor Planner — =] X
e View Tools Help
. a i a
B O g B V-] E Signel Strength (1st AP) i
4 Wi-Fi 5 Sample Building (Feet) @
(=) Floors N N
Level 4 -
Building Camera
Width: 170.00
Langthe 13000 Tree control
Aligned: ~ Center
Height 400 B Loss: 3200
@ Floors
Level:
Height:  10.00 —
Width: 170.00 - -
Length:  150.00 @l
Height: 400 dB Loss: 3200 S
(=) Floor2 B = B
w2 Refresh .
Height:  10.00
Wiet 17000 . Button -
Al Checked Channels (=] 30
[V]24GHz [VI5GHz [J]6GHz — 40
Select APs from:  —-All Floors-- (j
Selected AP count: 34 _— -50
B Legend
0
nels - o
H1 H
%AP—‘\O(\N’E)(UHKV«MI\ ssiD) Filter o e
AP-11{wf5) (Unknovin SSID) -
SRAP-3(n4) (ButhorizedGuest) Tree N 0
BRAP-3(wd)(Authorized Guest)
SQAP-5(wia) (Authorized Guest) =
%AP—E[WM](AulhnnzedGuesl]
AAP-9(wf6)(Unknown SSID) -
H6 B
ERAP-1(w) (Authorized Guest) Py
e Map -
RRAP-7(wi) (Authorized Guest) . | venEp |
s options =
BRAP-4(vi4) AuthorizedGuest) o
@ ) AvtoseveOF mevery 1 min

\ AutoSave settings

You can adjust various controls in the user interface to view data in various ways. examine various predictive scenarios (see
Data Filtering Examples).

3D View

You can enter the default three-dimensional view in these ways:
o Select View > View 3D.

« Click the 3D View® button in MFP. The 3D view displays all building floors in the Map view. Place the cursor on the view
and drag the mouse to rotate the building on the associated axis (see Menu Reference). Selecting a level from the Building
Project tree focuses on the selected level in the 3D view and dims the other levels.
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2D View

You can enter the two-dimensional view in these ways:

o Select View > View 2D.

* Select a floor in the building tree view (upper left of main screen), and then click 2D View &4 button.

¢ Select the View Thumbnail button H, and then double-click on the floor that you want to view in the 2D view.

1in.=24.29 fr
Dimensi ions (3 x ¥): 170.00 X 150.00 Feet

Thumbnail View

« Click Thumbnail view &8 to display thumbnail images of all the floors in your project in the Map view.
* Double-click a single floor to open it in the 2D view.
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AP Data

In the Map view:

o

o

Double-click the AP icon to open the AP Properties dialog.

Right-click an individual AP icon to display a menu of AP options:

Properties: Select to view the AP Properties dialog
Delete: Select to delete the currently selected AP.

Lock AP: Select to lock the currently selected APs in its current location. This prevents the AP location from being
overwritten if you use MFP Advisor.

Default AP: Select to set the properties of the currently selected AP as the default for the AP placement tool.
Selecting Default AP places a check mark beside the option in the pop-up. Deselecting this option restores the
default setting.

In the Filter view, right-click an individual AP icon and then select View Properties to display the AP Properties dialog.
See Adding and Editing APs for more information.

e Select View > View AP List to open a list of all APs currently placed on the site plan. See Viewing a List of APs.

Building Tree Controls

To select a single floor, click the floor in the building tree.

To select all floors, click the parent Building Name at the top of the tree.

For more about using the Building Tree controls, see Starting the Multi Floor Planner Building Project.

Data Type Filters

You can filter multi-floor data using the Data Type drop-down, located in the upper right corner above the site map.

- X

Channel Width

The following options are available:

Signal Strength (for 1st, 2nd, or 3rd APs)

Channel Interference

Predictive PHY Data Rate Downlink (for 1st, 2nd, or 3rd APs)

Throughput

Wi-Fi 4 Max MCS (AP Tx)
Wi-Fi 5 Max MCS (AP Tx)
Wi-Fi 6 Max MCS (AP Tx)
Channel Overlap Wi-Fi 5

AP Operating Mode
Channel Width

(These data types options are a subset of the AirWISE Requirements. See AirWISE View for more information.)

Using the Filter Tree View

The Filter Tree view on the bottom left of the MFP screen lists the APs placed on the site plans for each floor. (In the 2D view,
this view fills the left side of the MFP screen.)
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&l Checked Channels

[¥] 24 GHz 5GHz & GHz
Select APs from: | --All Floors-- ¥

Selected AP count: 28
Channels | 551D

[ IRAAP-3(wis)[LorpNet)
[V AP-5(wf3)(CorpNet)
(13 AP-6(wfS)(Unknown SSID)
V1 AP-6(wf3) (CorpNet)
ﬁAP—B (w#5)(Unknawn SSID)
[ AP-0(wfs) (Unknown SSID)
4 []4CH (44 B, 80MHz, 36-48)
[ 3B AP-4(wf5)(Unknown SSID)
(13 AP-5(wf3)(Unknown SSID)
4 [J]®CH (48 P, 30MHz, 36-48)
[ 3B AP-1(wf3)(CorpNet)
[V 3 AP-4{wfS)(CarpNet)
V3B AP-T(wf3)(CorpNet)
4 [V]4®CH (52 P, 80MHz, 52-64)
(I3 AP-7(wfS)(Unknown SSID)
4 [VIIPCH (64 P, B0MHz, 52-64)
[V AP-4(wf5) (CorpNet)
[13AP-5(wf5)(CorpNet)

o Click the Channels tab to list APs by channel or click SSID to list APs by SSID.

Channels

'Channels (Floord)
4 [V]®cHA
[+ SR AP-3(wfdi(AuthorizedGuest -27)

o Clicking on an AP in the list shows a heatmap of the AP's signal in the floor plan.

Channels | S5ID

4 @*Chan nels

4 [VI@CH 1
(] 4™ AP-2(wf6)(AuthorizedGuest)
;:QAP—E[WI‘E] [AuthorizedGuest)
EQAP-J-[WI‘E] (AuthorizedGuest)

o Filter Tree options that are not checked are not included in the heatmap in the Map view. Re-check the option to include

the data.

Click Refresh N or press F5to update the heatmap after making changes.

Filter Tree Controls

Item

Description

Check All / Uncheck All

|AII Checked Channels (Floord)

W 24GHz [V15GHz R16GHz
o Click the Select all check box (the left-hand check box) at the top of the Filter Tree to select all

Channels or SSIDs.

e To clear all selections, click the clear all check box (the right-hand check box).

Frequency band

Select 2.4 GHz 5 GHz or 6 GHz,
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24 GHz 5 GHz
Select APETID

Selected AP count: 17

Chanrnels | 551D

[+/] 6 GHz

Select APs from:

Use this drop-down menu to control what AP information to display.

All Checked SSID (Floord)

elect APs from: | --All Floors—- *
Selected AP count:| __All Floors--
Channels | 5510 | Flaora

4 55D (Flo| --Bleedover-- }

[VIFRAP-3(wWFIICH 1.-271
¢ All Floors: Shows data from all APs on all floors.

e Floor #: Shows currently selected floor only or (if you have not selected a floor) lets you select
from multiple floors.

« Bleedover: (Appears only when you have selected a floor.) Filters out the data from the APs on
the currently selected floor while showing bleed-over data from other floors. (Data may be
easier to see in 2D view.)

Selected AP Count:

Total APs selected.

Channels tab Click this tab to list APs by their corresponding channel setting.
SSID tab Click this tab to list APs by their SSID
AP list Use the checkboxes to include or exclude an AP in making heatmap calculations. The parent

checkbox enables or removes all children.

Selected AP Count

Total APs selected.
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Legend Controls

The label at the top of the legend indicates the measurement type. The colors in the legend correspond to the associated
numbered increments along the vertical axis.
Signal (dBm) e Click and drag down from top of the legend to filter out the top ranges of data.
o Click and drag up from the bottom of the legend to filter out the lower ranges of data.
e Use the arrow button below the legend to toggle the which color starts at zero.

« See Configuring Legend Color Settings for more information about configuring the legend.

Map Controls: Overlap, Overall, Per Channel, Per SSID Controls

These heatmap filtering buttons appear on the lower right side of the Map view.

NOTE: If these controls are not visible in the lower right below the Color Legend, click on the separator bar above the legend
and drag up until the show the Map controls.

W Displays signal overlap or channel interference in the Map Window. Based on the Data
Overlap Type selected, Overlap displays only overlap data, filtering out all information that does
not overlap. Can be combined with Overall Per CH or Per SSID or Per AP,

@ (Default) Displays overall site signal strength coverage. Can be combined with Overlap.
Overall
m (If the Channels tab is selected in the Filter Tree) Displays data by channel. Can be
Per CH combined with Overlap,
PerssiD (If the SSID tab is selected in the Filter Tree) Displays data by SSID. Can be combined
Per SSID with Overlap,

@ (If you select an individual AP in the Filter Tree) Displays data by AP. Can be combined
Per AP with Overlap,

For more information about using these filters, see DiffView and Data Analysis.

AutoSave Settings

The AutoSave settings appear on the bottom of the Map view. When enabled, AutoSave automatically saves your Multi Floor
Planner work at a save interval (in minutes) that you choose. AutoSave saves information for walls, AP location/configuration,
report templates, and so on.
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NOTE: Heatmap data is not saved with AutoSave data, but you can easily regenerate the heatmap by clicking the Refresh

icon or pressing F5. You can also save heatmap data by selecting the File > Save menu item or by responding Yes
when you close the MFP project and are prompted to save your work.)

0.1
05

AutcSaveDn inevery | 1 ~ | min

* To enable AutoSave, click the AutoSave On/Off toggle.

« To set the save interval, click the arrow to display a menu of interval values (in minutes), and then select a value.
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Data Filtering Examples

To Filter by Floors or Bleedover

Use the Select APs From drop-down menu to control what AP information to display.

|AII Checked 5510 (Floord)

elect APs from: | --All Floors--  ~
Selected AP count:) __All Floors--

Channels | 551D | flaord

4 DSSID (Flo| --Bleedover-- ﬂ

[VIRERAP-3wFICH 1.-271
All Floors: (Active only when you have not selected a floor) Shows data from all APs on all floors.
Floor #: Shows currently selected floor only or lets you select from multiple floors.

Bleedover: (Appears only when you have selected a floor.) Filters out the data from the APs on the currently selected
floor while showing bleed-over data from other floors.

NOTE: Bleedover information may be of only limited use if antennas do not include elevation dispersion patterns or if the
building project has significant attenuation between floors (such as thick reinforced concrete floors).

Signal Propagation from the Selected Floor

To see how the signal strength from one floor affects the entire building:

1.

2
3
4,
5

Click on the refresh icon ® or press F5 to generate the heatmap.

Select the Signal Strength option (for 1st AP, 2nd AP, or 3rd AP) option from the data type menu.
Activate data filtering on all floors by selecting the parent Building Name in the Building Tree.

Use the Select All checkbox to select all APs in the Filter Tree.

From the Select APs from drop-down in the Filter Tree area, select a floor (for example, Floor 1). This option filters out
the data from the APs on all floors except the selected floor.

Signal Propagation by Channel or SSID

To see how the signal strength is propagated by channel or SSID:

1.

2
3
4.
5

Click on the refresh icon ® or press F5 to generate the heatmap.
Select one of the Signal Strength options from the data type menu.
Selecting the parent Building Name in the Building Tree view to activate data filtering on all floors.
Select the Channel or SSID tab in the Filter Tree area.
Select Per CH or Per SSID from the Map controls:
- | -

UYETIIR UYETIap

L} -3 1 -
NOTE: If the Map controls are not visible in the lower right below the Color Legend, click on the separator bar above the

legend and drag up to show the Map controls.

Select the desired parent or child listing in the Filter Tree to show data from all channels, from individual channels, or
from individual APs.
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Signal Bleed-over Between Floors

To include the effects of how the signal strength of particular AP or set of APs can propagate to other floors:

1.
2.

Select the Signal Strength option.

Activate data filtering on all floors by selecting the 3-D view icon @ and then clicking on the Building Name in the
Building Tree view (upper left of screen).

Selecting All Floors from the Filter Tree drop-down.

Al Checked Channels
2.4 GHz 5GHz 6 GHz

(Select APs from: | —-All Floors— > | )

(Click on the refresh icon # if the APs are not displayed in the Filter Tree.)

Use the All Checked Channels option in the Filter Tree to view all inter-floor effects, or deselect all APs and then select
APs individually to view effects of specific APs.

Signal Bleed-over on a Single Floor

To view how the signal strength from other floors affects a selected floor:

1.
2.
3.

Select the Signal Strength Data Type option.
Select the floor in the Building Tree view (upper left of screen) to activate data filtering.

In the Filter Tree area, click on the Select APs from drop-down, and then select Bleedover. This option filters out the
data from the APs on the selected floor while including any bleed-over data from other floors.

Al Checked Channels (Floar3) O

] 24GHz [#]5GHz [+] 6 GHz

Select APs from: | --All Floors--  ~
Selected AP count:| __aJ| Floors—-
Channels | SSID | Floor3 l

4 DChannelg --Bleedover--
a L F W o

| Show coverage for APs from other floors I)rizedGuest,—ﬁ?}

TIP: This data may be easier to view in the 2-D view .

View the AP List

You can display a list of all APs currently in your building plan on a floor-by-floor basis.

To List All APs on a Floor

1.
2.
3.

Select the floor in the Building Tree view (upper left of screen).
Click on the 2-D view icon .
Select View > Show AP List. This option opens the AP Listwindow.

AP List
[] Group Change
[] AP Name Channel Media Enabled Power Antenna CH Width Cp Mode
] |ar-s 1 Wi-Fi 4 ] 10 Ornni-Directional (2.15dBi) o || 20 MHz Mixed HT
] [ar-s 36 P, B0MHz, 36-48 | Wi-Fi 5 7 10 Omnni-Directional (2.15d8i) - 80 MHz Mixed VHT
] [ar-s SE P, 160MHz, 16-29E | Wi-Fi 6E 10 Omnni-Directional (2.15d8i) « [160 MKz Greenfield
] [ar6 1 WiFi 4 < 10 Ornni-Directional (2.15dBi) w20 MHz Mixed HT
O [ar-6 36 P, B0MHz, 36-48 | Wi-Fi 5 7 10 Omni-Directional (2.15dBi) - |80 MHz Mixed VHT
O [ar-6 5E P, 160MHz, 15-29E | Wi-Fi 6E 10 Omni-Directional (2.15dBi) - [160 MRz Greenfield
O [ar-7 6 Wi-Fi 4 ] 10 Omni-Directional (2.15dBi) v |20 MHz Mixed HT
O [ar7 48P, 80MHz, 36-48 |Wi-Fi 5 N 10 Ormni-Directional (2.15dBi) o |soMHz Mixed VHT
1 [ar-7 5E P, 160MHz, 1£-28E| Wi-Fi 6E 10 Omni-Directional (2.15dBi) v [160 MHz Greenfield
O [ar-8 1 Wi-Fi 4 7 10 Ornni-Directional (2.15dBi) v 20 MHz Mixed HT
] [ar-s 64 P, B0MHz, 52-64 | Wi-Fi 5 < 10 Omnni-Directional (2.15d8i) « 80 MHz Mixed VHT
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To Modify the APs Settings List

* You can modify the power setting for an AP by clicking on the AP, clicking on the AP's Power field, and then typing a new
value. Click the Apply button at the lower right corner of the dialog to save your changes.

* You can modify the antenna selection for an AP by clicking on the AP, clicking on the Antenna field to display a drop-down
menu, and then selecting an antenna from the list. Click the Apply button at the lower right corner of the dialog to save
your changes.

* To modify all other properties, double-click on the selected AP or select the AP and click the Properties... button to open
the AP Properties dialog, and then make changes in the dialog.

Column Description

Group Change Useful for batch changing Power and Antenna settings. First, select all APs you wish to change.
Then check Group Change, Making a change to one property in the group changes that
property for the entire group.

Select/Unselect All AP Use this option to select all or deselect all APs.

AP Mame Yhanne

AP Name The name of the AP.

Channel The Channel that the AP is set to.

Media The media type of the AP.

Enabled A check in this field indicates that the AP is enabled on the plan.

Power The power setting for the AP (in milliwatts). You can edit this field for a selected AP.

Antenna The antenna currently used by the AP. You can click on this field and select an antenna from a
drop-down menu.

Ch. Width The channel width in use by the AP.

Op. Mode The Operating Mode specified in the AP’s properties:

» Greenfield: for deployments using only Wi-Fi 4 or Wi-Fi 6 APs.

o Legacyfor 802.11a/b/g only.

e Mixed HT: for deployments using Wi-Fi 4 and legacy APs together.
» Mixed VHT: for a mix of Wi-Fi 5 APs with other modes.

e Mixed HE: for a mix of Wi-Fi 6 APs with other modes.

Click Apply or OK to accept your changes.

Multi Floor Planner Reports

The MFP Reports feature enables you to generate a report based on the current multi floor project.

A variety of preconfigured reports are available. The following options enable you to work with the report results and to
customize reports and report templates:

« Export a report to a variety of printable and editable formats.
e Print a report.

o Perform text searches.

o Customize the report by adding and/or removing sections.

« Duplicate a report and modify the duplicate.

« Start with a blank report and add desired sections.

« Revise the text of any heading and/or section content.

o Localize a report automatically to any of the following languages: English, German, French, Arabic, Russian, and Japanese.
Additionally, manually revise any translated text.

e Localize a report by manually modifying any or all text to the target language.

o Customize the Title Page graphics.
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« Customize to show/hide cover page, table of contents, header, footer, page number, and each section’s title and contexts.

)
To generate a report of the building project, click Refresh L on the sidebar, and then click the Report icon H This
replaces the map view with a report toolbar at the top of the map area:

x Default Planner Report v G English y |E|

To run the basic Default Planner Report, click the green arrow icon B (If the icon is not enabled, click Refresh o on the
sidebar, and then try again.)

1
Click the Add icon to create a new report template. You can select a template name, language, and the template on
which the new template is based.

|R| Click the Delete icon to delete the selected report template. (You cannot delete the Default Planner Report template.)

* | Default Planner Report ¥

Click the report selection drop down menu to select
from a menu of saved report templates. (The Default Planner Report template is always listed.)

@ Click the Edit icon to edit the template. You can then use the Edit Report Template dialog to change the General
Information (title, preparation information, location, time, cover sheet picture, logo, description, and header) and Report
Template information (report category selections, description, and executive summary).

* | English

Click the Language icon to select the report language from a drop-down menu (select English,
Arabic, French, German, or Russian). This automatically localizes the report to the selected language when you run the
report.

B Run the selected report. This creates (or re-runs) the report and displays it in the main viewing area. (If the icon is not
enabled, click Refresh % onthe sidebar, and then try again.)
The topics, floors and heatmaps contained in the report are related to the following factors:

o If the "building" is selected in the tree view, information about all floors in the building are generated. If a specific floor is
selected, the report generates information only for that floor.

« Information is generated according to the way the filters are set in the Filter Tree (see Viewing Multi-floor Data). For
example, if "Bleedover" is selected, the report generates only for bleedover information.

o Legend settings (that is, the Overlap, Overall or PerCH buttons in the lower right corner of the planner window.

Note: If any of the above settings are changed, you must regenerate the report to reflect the changes. To re-generate, click

For actions you can take with the completed report, see Viewing Multi-floor Reports.

-116 -



Multi Floor Planner

Edit Report Template

To edit a report template, select the template, and then click Q . This displays the Edit Report Template dialog. Change the
template properties as needed, and then click OK to close the dialog and save changes.

General Information Tab

Edit Report Template

Template Name: Cefault Planner Report

General Information | Report Template

Categories:

Language: English

Content Description:

 Report Description

+/ Planner AP List and Location
¥ Planner Signal Coverage
 Channel Interference

</ PHY Data Rate Coverage

¥ Throughput

+/Channel Width

+/ Operating Mode

/Wi-Fi 4 Highest MCS Index
~/'Wi-Fi 5 Highest MCS Index
/'Wi-Fi 6 Highest MCS Index
~/Wi-Fi 5 Channel Overlap

ar (v

Multi Floor | Single Floor

Executive Summary Description:

+|B J U|A-A-

o |5

Multi Floor | Single Floor

Cance!

Field

Description

Survey Title

Formal title for survey.

Prepared for

Recipient of the report.

Prepared by

Report preparer.

Location

Geographic location or address.

Time of Planning

Automatic date stamp (editable).

Cover Sheet Picture

Path to a picture to display on the cover sheet of the finished report. Recommended size is
650w x 400h pixels. (Larger dimensions may cut off the image or display part of it on a new
page.)

Corporate Logo

A logo to be displayed in the lower-right corner of the cover page. Recommended size is 164w
x 164h pixels. (Larger dimensions may cut off the image or display part of it on a new page.)

Plan Description

A brief paragraph describing the plan.

Report Page Header &
Footer

Text for running headers and footers. Both align with the left side of the page. A default page
number is automatically included at the bottom right corner of each page.

Preview Cover Sheet

Click this button to display a preview of the cover page in the space below the button.
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Report Template Tab

Template Name: Default Planner Report Language: English ©
General Information | Report Template |
Categories: Content Description:
/|Report Description KMNO(Se BT U AMAI==== == _

 Planner AP List and Location
/ Planner Signal Coverage

¥ Channel Interference
/'PHY Data Rate Coverage

¥ Throughput

¥ Channel Width

/ Operating Mode

/'Wi-Fi 4 Highest MCS Index
/' Wi-Fi 5 Highest MCS Index
/'Wi-Fi 6 Highest MCS Index

/' Wi-Fi 5 Channel Overla,
s Multi Floor | Single Floor

Executive Summary Description:

KHO|2 BT U|pa|======_

Multi Floor | Single Floor

This tab lets you choose predefined categories to include with the report and to customize the material for the introduction,
table of contents, and executive summary that precedes each section.

Categories - the list of categories that you can include. (The default template includes all categories.)
o Click a category item to display the predefined content description and executive summary.

o Use the text editing tools to customize the text as needed.

o To remove a category from the template, uncheck (deselect) the selection box next to the item.
Content Description - Summary information for a category that appears in the table of contents.

Executive Summary Description - Summary information for a category that appears at the beginning of the report
section for that category.

Multi Floor tab - Select the Multi Floor tab to edit the description for the entire multi-floor report. This information
precedes the report for all floors for a report category.

Single Floor tab - Select the Single Floor tab to edit the description for each floor. This information precedes the report
for a single floors for a category.

To Read Descriptions of Each Report Category

You can read detailed descriptions of each report category from MFP.

1.
2.

)

From the main MFP screen, click the Report icon I=).

In the reports toolbar, select the Default Planner Report in the reports toolbar.

Default Planner Report e

In the reports toolbar, select the Edit Report Template Q . This displays the Edit Report Template dialog.
Select the Report Template Tab.

Select one of the report categories in the Categories list. This displays a detailed description of the report in the dialog.
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Viewing Reports

After you run a report by clicking the green arrow icon B, the report displays in the report view.

Use the controls at the top of the Report Window to navigate, search, print, or export the report.

= T " T T S /15 g4 @ -

Icon Name Description

é. Export Opens the Export dialog box, which allows you to export the current report to a
Report specific destination in a selected format (rpt, pdf, csv, xls, xlsx, rtf, or xml).

= Print Opens a print dialog.

= Report

4 First Page [Goes to the first page of the report.

4 Back Displays the previous page.

3 Forward [Displays the next page.

3 Last Page [Goes to the last page of the report.

2 /15 Page Shows the current page number and total pages in the report.
Count

To go to a specific page, highlight the current page number, type a new page
number, and then press Enter.

i Find Opens a text search dialog.

@ Zoom Opens a dialog that lets you increase or decrease the magnification.

Export to CAD

If you imported an AutoCAD image for your project, this option enables you to export the image along with any APs and wall
data that was added to the image.

Note: To use this feature, you must use an AutoCAD image for your AirMagnet Multi-Floor Planner project.

Note: If you chose to show or hide individual layers of the AutoCAD image, these changes are reflected in your exported
AutoCAD file.

Export CAD File

Filename:l || |

Export
[/] APs [¥] AP Names  Sizer 100 | % 100%

Walls

Color. NN

OK | |Cancel
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To export to CAD:

1. From the File menu, select Export to CAD. This opens the Export CAD File dialog.

2. Type the path and name for your exported file in the Filename field, or else click the Browse button to the right of the
text box. (Be sure to use a file extension that is one of the supported CAD file formats.)

3. Use the options in the Export box to specify the information to include in the export file:
© APs: Include APs.
© AP Names: Include names that you have added for APs.
o Size: Enter a scaling factor for the floor plan. (The default is no scaling: 1.00 x 100%.)
o Walls: Include walls that you have defined in MFP.

4. (Optional) Double-click the Color box to open a color selection dialog for the default color for the exported information.
Select a color, and then click OK to set the default color.

5. Click OK to export the file.

Multi Floor Planner Menu and Toolbar Reference

See also: "Using the Right-Click Menu" on page 123.

Toolbars
Item Description
Open Open a multi-floor building project.
L p p g proj
Ei View 3D Displays the floor plans in a 3D view that simulates

width, length and floor height in three dimensional
space. Clicking a floor in the building tree highlight s
that particular floor. Clicking the parent Building
Name highlights all floors.

View 2D Displays a flat length by width view of a floor plan
selected in the Building Tree. Click a floor in the
Building Tree, and then click View 2D_ (After you
have generated a heatmap, you can mouse over the
2D floor plan to display a pop-up of data details.)

View Thumbnails Displays a 2D view of all the floors. (Double-click on a
L thumbnail to enlarge the view of that floor.)

;g’;_ Open Advisor Opens the Multi Floor Advisor, which helps you
optimize the layout of APs on each floor.

@ Align Floors Opens the Floor Alignment feature.

Print Print the current view.

Eﬂ Report Generate the Multi Floor Planner Reports,
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Side Toolbar

The side of the map view contains a toolbar for changing the map and objects.

NOTE: This toolbar

works with the 2D view

only, not with the 3D view or the Thumbnail view.)

Item

Description

K
Enlarge rectangular
area

Select this icon, then click and drag to outline a rectangle on the map. Release the click to zoom to
the rectangle.

[‘\‘E Selector

Changes cursor to selection arrow.

(41 (—1 Zoom

Click the *icon to zoom in. Click the - icon to zoom out. (You can also use your mouse's scroll
wheel.)

infout
Q (21 View [The left icon resizes the map to fit in the available window space. The right icon restores the map to
its normal size.
Thumbnails
@ Add AP Adds an AP to the plan,

ﬁ Measure Mode

Turns on Measure Mode, which lets you measure the distance between any two points on the site
map. You can also choose to recalibrate the site dimensions based on the measurement.

=22 Create Wall
—aa

E=r}

Create walls and select types for the floor plan. See Using the Wall Tool,

D Create Rect-

angular
Attenuation Area

Selects an area type (cubicle, office, etc.) and draws a rectangular area,

O Create

Arbitrary
Attenuation Area

Lets you draw an arbitrary shape for an attenuation area,

O Create Elliptical

Attenuation Area

Selects an area type (cubicle, office, etc.) and draws an elliptical area.

Create Rect-

angular Coverage
Area

Draws a draw a rectangular area,

El Create Rect-

angular Excluded
Area

Draws a rectangular excluded area (for use with Planner Advisor),

@ Create

Arbitrary Coverage
Area

Draws an arbitrary coverage area.

- Create Arbitrar
= y

Excluded Area

Draws an arbitrary excluded area (for use with Planner Advisor),

@ Create Elliptical

Coverage Area

Draws an elliptical coverage area.
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@ Create Elliptical

Excluded Area

Draws an elliptical excluded area (for use with Planner Advisor),

?( Clear All

Removes all placed objects or all objects of a certain type (APs, attenuation areas, walls, etc.).

Objects
Undo Undoes the previous action.
lm Refresh Generate and refresh the heatmap (or press F5).

Map View Options

Item

Description

Camera

3D view panning controls. Click the camera icon to
reset the default view. Arrows control the associated
panning direction.

Zoom and Rotate

While in 3D view, Right-click and drag in the desired
direction to rotate the building in 3D space; left-click
and drag up to zoom in or drag down to zoom out.

Right-click You can modify or remove objects in the planner map
view by right-clicking to display a pop-up menu. See
Using the Right-Click Menu,

Hover After you generate the heatmap by clicking the Refresh
button o pressing , hovering the mouse over

F5

any location on the heatmap displays coverage and
AP information for that point.

File Menu

Item Description

New Create a multi-floor building project. The file extension is .bml

Open Open a multi-floor building project. The file extension is .bml

Open AirMagnet
Multi-Floor Planner
Project

Opens an AirMagnet Multi-Floor Planner Planner project in Multi Floor Planner.

Close Close the multi-floor building project. Includes an option to Save any unsaved changes.
Save Save the currently opened multi-floor building project.
Export Export the building project as a .zip file. Use this option to import the project on another machine

running Multi Floor Planner.

Export to CAD

If you used an AutoCAD format file for your site map, you can export the map back to AutoCAD. If you
imported an AutoCAD image for your project's site map, this option lets you to export your project to
AutoCAD along with any APs and walls data that was added to the image. See Export to CAD,

Import

Import a building project from a .zip file. Choose the .zip from File for Import. Create the imported
project in Import Location.

Print Preview
(Current View)

Open a print preview of the current view.

Recent Files

List any previously opened files.

Exit

Quit MFP.
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View Menu
Item Description
View 3D See Map View options.
View 2D See Map View options
View Thumbnail See Map View options
View Building Prop- |See Building Project
erties
View Legend If the Legend tool is unavailable, this option restores the Legend.
View AP List View a list of all APs currently placed on the site plan. See Viewin§ a List of APs,
Tools Menu
Item Description
Align Floors See Floor Alignment
Reset Alignment Reset the building levels to default center alignment.
Copy View Copy the current site map view to the clipboard.
Copy Current View Copies the current view. If you have a zoomed-in view, this choice captures the zoom
area only.
Configure Opens the Configuration dialog, which lets you enter the project default directory and
display options for APs, bubble help, walls/areas, and grids.
Configure Plan Enter a custom Sampling Density,
Configure Walls/Areas Sets default values for areas and walls. See Configuring Walls and Areas,
Configure CAD Floor Plan Available only if you created a floor plan using an AutoCAD file. You can select the
AutoCAD layers to include in the floor plan and extract walls. See Using Automatic Wall
Extraction,
Antenna Manager See Using Antenna Manager with Multi Floor Planner,
Help Menu
Item Description
Contents Open Help documentation
Sample Project Open a sample MFP building project for Wi-Fi 5 or Wi-Fi 6.
About Multi Floor Planner View basic information about MFP such as version and build number.

Using the Right-Click Menu

You may modify or remove a placed object at any time by just right-clicking on it and selecting a menu option.

Note: The options listed in the menu depend on the object selected. For example, the Locked AP and Default AP options
only appear if you have right-clicked on an AP.

Option Description

Properties... Opens either the AP Properties or Wall/Area Propertiesdialog box, depending on the object
selected.

Delete Deletes the selected object.

Locked AP Locks the selected AP. This ensures that the Advisor cannot modify any of the AP’s properties.

Default AP Specifies the properties of the selected AP as Planner’s default AP settings. Any APs placed after
selecting this reflect the current AP’s settings.
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Using Legacy AirMagnet Multi-Floor Planner Projects

Multi Floor Planner (MFP) has several features to make it easier to use existing AirMagnet Multi-Floor Planner site plans and
information.

You can open multiple AirMagnet Multi-Floor Planner projects directly into a new Multi Floor Planner (MFP) project and
then assign the projects to a floor.

o See Starting the Multi Floor Planner Building Project for more information.

© TIP: You may find it convenient to copy the .spi files, floor plan files, and .svp files for each Planner project into a
common directory that you can then open in MFP. (Do not delete the original Planner project files or directories.)

You can import single AirMagnet Multi-Floor Planner projects to specific floors in a MFP project. See To add and manage
floors in a building project for more information.

You can import area and wall definitions from AirMagnet Multi-Floor Planner to MFP. See "Configuring Walls and Areas" on

page 82.

CAUTION: When you use existing AirMagnet Multi-Floor Plannersite plans into a MFP building project, they are added by
reference (absolute directory path). Therefore, saving changes in MFP updates the source files. If you want to avoid modifying
existing projects, make a copy of original project folder to use with MFP.
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Display View

In this chapter:

AboUt DiSPlay VIO . 126
Displaying @ Site Map ... ... ... . 126
Displaying Survey Data ... .. ... ... 126
Displaying a Survey Path ... .. . 127
Channel/SSID List ... ... . 127
COMIMI NS . 129
Measuring and Calibrating the Floor Plan Scale ... ... ... ... ... .. ... .. .. i, 129
How to Merge SUrVey Data ... ... ... 132
Creating Filtered Data Files .. ... ... .. . 133
Display View Menus and WINdoOWS ... ... . . 134
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About Display view

The Display view is designed for viewing, analyzing, and manipulating data. Normally, you use this view only after you have

7] Displa
saved a completed survey. To open the Display view, click Fl'_il' on the Navigation Bar.

(&) AirMagnet Survey Professional Edition - Indoor.svp

File Edit View Help

| Gh mamner Fig mum Floospisnner R survey [ Ospley | (] smuistion P mutview 2 oirview ) anwise [%] repons
L @ W e & B Ao M QA & & A x4 @ W vewown - (& 2 G

(2 Indoor.svp ~ PO O O T T A A |
=i site Map

Signal Strengih (1t AF) =1~ o2

Signal
(dBm)

0
PR :
H -20
¢ 3 |
= & : * 4

DeGuignel.jpg
-2 Survey Data
" A ActiveSurvey2.svdx
" [ ActivelPerfSurvey.svdx
wd” [ ActivelPerfSurvey2 svdx
O [ ActivelPerfSurvey3.svisx
M ActivelPerfSurveyMerged1.svdx
@ P PassiveSurveyl.svdx
) A ActiveSurvey.svdx v

Ll

Select Al [12.4GHz [5GHz EA6GHz

(&M@ cH1t ~

% APc08c.6020.733(-41)
H (36 P, 80MHz, 36-48)
% APedc7.22b2.209(-45)
Apple-79:4:5F (Mr B's WiFi Netwark,
CH (102,1)

% 11ac-ben(-30)

H 116

% AIR-CAP3502-4(-45)

H (129 P, 20MHz, 149-161)

0 5 "
R S

3§ ASUSTek COMPUTER-87:14:44 (ASUS

i M@ CH (153.-1) N A Zoom: 108%

@ Channel @ SSID

|
v

All checked APs in CH (36 P, 40MHz, 36-40) Selected APs 1

The Display view appears by default when you open a project file (.svp). The view may show the site map only, without any
data. To show data over the site map, click the corresponding radio button for one of the data files listed under Survey Data
in the Project Window.

NOTE: The Spectrum XT Window may appear if you are running AirMagnet Survey PRO, provided that this feature is enabled.
See Configuring a Spectrum Analyzer.

Displaying a Site Map

By default, the most recently opened site map is automatically selected and displayed when you switch to the Display screen.
If a project contains more than one site map, you may need to select the one you want to display if it is not already opened.
To select a site map:

Select the check box in front of the site map. The selected site map appears in the Map Window.

To deselect a site map:
Do one of the following:
o Uncheck the check box in front of the site map, or

o Select another site map.

Displaying Survey Data

Each survey data file contains the RF data. By default, no survey data is displayed in the Map Window when you switch to the
Display screen. You need to select a survey data file to display it.

To display a survey data file:

Click the radio button in front of the data file. The data in the selected survey data file populates the Map Window once the
file is loaded. The time it takes to open a data file depends on the size of the file. Some survey data files may take sig-
nificantly longer to load mainly because of the enormous amount of data contained in those files.
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Displaying a Survey Path

To have a better understanding of the survey data, AirMagnet recommends that the survey path be shown on the site map
when analyzing survey data. This provides a physical context for the data.

To display a survey path: Select the check box associated with the survey path. The selected survey path appears in the
Map Window.

To hide the survey path: Uncheck the check box in front of the survey path.

Channel/SSID List

The Channel/SSID List shows the channels or wireless networks contained in a selected survey data file. You can make the

Ch | SSID
selection by clicking either the Channelor SSID tab| W Crovd I@ | at the bottom of the list.

When a data file is selected in the Project list, the Channel/SSID List can be expanded to show individual APs. The APs are
organized by Channel or SSID depending on the tab selection. The APs display an associated Wi-Fi version icon (for example,

e
Select All  [] 2.4GHz 5GHz BGHz

V@& CH1I "
- 55 AIR-CAP3502-3(-43)
... ¥ Aruba-BA:BT:20 (aruba-ap,-35)
= -@ CH 36
W5k AP18€7.28d3.F0f(-40)
W S8 Aruba-BA:BT:30 (aruba-ap,-44)
.@g CH (36 P, 40MHz, 36-40)
e &3& APc08c.6020.733(-41)
@} CH {36 P, 30MHz, 36-48)
- MIEE APedcT.22b2.a09(-45)
L] 38 Apple-79:48:5F (Mr B's WiFi Network,
= l@ CH (108,7)
- .‘.*.3.‘.*. 11ac-ben(-30)
. .@g CH 116
L M2 AIR-CAP3502-4{-45)
= @ CH (149 P, 80MHz, 149-161)
..M H§) ASUSTek COMPUTER-87:1A:44 (ASUS
E @ CH (153.-1) v
< >

@ Channel & SSID

This part of the Display view contains the following control options for manipulating data display:

). Wi-Fi 5/6/7 APs include the primary channel, channel width, and channel span.

'T"
=

'T"
L

Select All: This option enables you to select or deselect all the entries (that is, channels, SSIDs, APs, etc.) in the Channel/SSID
tree with a click of the button. By default, all entries in the Channel/SSID tree are selected when a survey data file is loaded,
meaning that all the data contained in the file is shown in the Map Window.

If you want to focus on data related to one or more specific channels, SSIDs, or APs, you can uncheck this option to clear all
the selections. At this point you can manually select only those entries that concern you the most. These filter selections are
preserved when changing heatmap Data Type options.

2.4 GHz: This option enables you to display or hide signal information for the 2.4 GHz (802.11b/g/n/ax/be) spectrum.
5 GHz: This option enables you to display or hide signal information for the 5 GHz (802.11a/n/ac/ax/be) spectrum.
6 GHz: This option enables you to display or hide signal information for the 6 GHz (802.11a/n/ac/ax/be) spectrum.

- 127 -



Display View

Note: You may also create a filtered survey data file which contains data only related to selected APs. See Creating Filtered
Data Files.

Placing APs on the Floor Plan

While in Display view, you may expand the Channel/SSID list to view APs contained in the survey data file. If desired, you can
drag APs from this list to their location on the floor plan. There are a few benefits to doing this:

* Showing the physical location of APs in reports
« Modifying the AP power setting

Note: Physical APs with more than one radio may be listed in the Channel/SSID list multiple times relative to the number of
radios. If this is the case, you can place APs on top of each other on the floor plan.

To change the AP properties after placement, right-click the AP and select AP Properties. This opens the AP Properties
dialog. (Only a few options are editable.)

T
| ap Properties X

AP Properties
Alias Project -~

AP Name Cisco-24:A4:AE

Channel (36 P, 40MHz, 36-40)

MAC Address | ssiD |
34.DB:FD:24:A4:AE CorpNet11ac

Media Type Wi-Fi 5

Channel Width 40 MHz

(Capability)

Op. Mode Mixed VHT

Phy. Data Rate 151.62 Mbps

Max Signal Sampling Data -42 dBm
Count of Sampling Points 334

AP Location Properties
X 2841 Y 10887 Feet

© Display only, not applying power setting

() Apply power setting Center on AP
Criginal 100 midfatts
Simulated Power 100 miAfatts
oK Cancel

all

Alias Name: Type an alias name to map a full MAC address to a user-friendly name. Alias Name is included in the AP
information line in the Channel/SSID list. Select the drop-down menu next to Alias to apply the Alias name to the whole
Project or only the currently opened survey.

Original and Simulated Power Setting: You may also modify the power setting in milliwatts. Select Apply power setting,
and check the Center on AP checkbox to apply the power setting around the AP.

Click OK to save the changes.
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Note: For information about adding APs to the survey project (Survey view) and about deleting placed APs from the project
and from individual data files, see Placing APs in the Survey.

Comments

AirMapper site surveys performed with an AirCheck G3, EtherScope nXG, or CyberScope support comments for survey points
on a floor plan. You can view these comments in the Display View.

@ Indicates a single comment for a survey point.

@ Indicates multiple comments for the same survey point. (This may happen after you have merged two data files that

have comments at the same survey point.)

To view comments, mouse over the comment icon. A pop-up bubble displays comment text.
« Right-click on a comment icon to display the comment dialog for that icon.

©  When more than one comment exists for the same location, all of the comments show up in the same dialog. Each
comment is timestamped to make it easier to identify.

© The dialog allows you to scroll up and down and to scroll through comments.
o If there are duplicate comments, only the most recent of the duplicates is shown.

* To hide or unhide comment icons, right-click on the floor plan. Select Hide Comments Iconsto hide comments. If the
Hide Comments Icons option is checked, it indicates comments are hidden. To redisplay the comments, right-click on the
floor plan and uncheck Hide Comments Icons.

* When you merge site survey files, all comments included on the source files are included in the merged file.
*  When you filter a site survey file, all comments are copied from the original file to the filtered file.
o Except for reports, comments show up on all views for which an Access Point location is supported.

« Comments cannot be edited; they are read only.

Measuring and Calibrating the Floor Plan Scale

An easy-to-use measurement tool enables you to measure distances on the floor plan relative to the floor plan scale. It also
enables you to recalibrate the scale of the floor plan (in feet or meters).

When you create a new project and load a floor plan image, there is an option to enter the dimensions of the floor plan image
in feet or meters (X and Y dimensions). Keep in mind that entering dimensions using this method includes any white space
outside the perimeter of the building that may be included in the image. In most cases, it is probably more accurate to
recalibrate the scale. In fact, if you leave the dimensions blank when creating a new project, you are prompted at the
conclusion of the project wizard to recalibrate the default scale.

To recalibrate the scale of the floor plan:

1. From the Toolbar, click the Measurementtool . A prompt is displayed to choose whether to measure or recalibrate.
To recalibrate, click Yes.
AirMagnet Survey @

I'-: Do you want to recalibrate site dimensicns after measuring?

Yes J [ MNo I ’ Cancel
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2. Click two points on the floor plan where you know the actual distance between the points. (In general, using a longer
distance tends to be more precise than a shorter distance.) This opens the Recalibration dialog.

1in.=17.14ft Dimensions(Xx Y): 120000 ftx 120.00 ft
—_—
—————————— =
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P, ] =
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Zoom: 100%

-130 -



Display View

3. Enter the correct value for the "Actual distance" you measured, click Recalibrate, and then click OK.

P

Recalibration

@ Dual Direction B ecalibration

= direction recalibration

Digtance From Map:  158.843

Actual Distance:

Recalibrate

Recalibrated Site Dimenzsions

Width(<]  157.605
Length(¥]  161.355

-

[ 7 el

— Enable
I
(o Owenwrite

[ ok ] l Cancel

To measure a distance on the floor plan:

1. From the Toolbar, click the measurement tool
To measure, click No.

. A prompt is displayed to choose whether to measure or recalibrate.

AirMagnet Survey

l L Do you want to recalibrate site di

mensions after measuring?

=

2. Click the measurement beginning point. As you move the mouse, the distance is shown in feet or meters depending on
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the unit of measure selected for the project. Click an end point to complete the measurement.

24 cubicles

T

How to Merge Survey Data

Merging survey data means combining different survey data files into one file that includes all the data collected from the
individual files.

Note: If two data files contain placed APs having the same MAC address and any were moved, you are prompted that the
location of APs was changed between surveys.

To merge survey data files:

1. Click File > Data Merge.... The Data File Merge window appears.

Data File Merge “

Select data files to be merged:

Filename Time Size Select All
O A ActiveSurvey2.svdx 3/16/2016 11:46:04 AM 363520 Clear All
[J P PassiveSurveyl.svex 3/16/2016 11:06:36 AM 4759552
O A ActiveSurveyl.svdx 3/16/2016 11:06:42 AM 534528
O VirtualSurveyT.svdx 3/16/2016 11:08:08 AM 2002944

Data Files Generated By
(®) AirMagnet Adapter () Standard Adapter VoFi Survey

Save this merge to: | Merged.svdx

2. If the project contains data files generated by both an AirMagnet adapter and non-preferred adapter, you can only merge
files of the same type. In this case, under Data Files Generated By, select the desired adapter. Only data files created by
that adapter type are listed.
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6.

Check the files you want to merge.

In Save this merge to, type a name for the merged file.

Click OK. The file-merge progress bar appears at the bottom of the Map Window, showing the progress of the merge
operation. The newly merged file appears in the Project Window under Survey Data once the merge is completed.

To display the merged file, click the radio button in front of it.

Note: After a merged file is created, you can view the list of source files that were used to create the merged file, by right-
clicking the file and selecting “View Merged Source” from the pop-up menu.

..... [] ActiveSun
..... PassiveSu
..... [ ActiveSur
..... [ ActivelPer
..... [ ActivelPer
..... [ ActivelPer
..... [ ActivelPer
..... Mergedl,|

..... (" P PassiveSurveyl.svdx
..... (1 A ActiveSurveyl.svdx
..... " P Filtered.svdx

Open

Close

Delete

Rename

Data Merge...
View Merged Source...

View Survey Properties...

[]Select All [»] 2.4GHz [»]5GHz [v]6GHz

Creating Filtered Data Files

You may create one or more data sub-set(s) of a Survey Data file (a filtered data file). The new filtered data file is added to list
of survey data files.

To create a filtered data file:

1.

Select the desired Survey Data File.

2. From the Toolbar, click Filtering@ . The Data Filtering window appears.
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Data Filtering By APs

Check APz to be fikered:

[ 4P Name CH | Media Typs Freg MAL Address ~
[ BE54:25:94CEET 157 P, B0MHz, 149-161 B wiris BGHz BE:54: 25:94:C
[ EZFE:0771:54E0 48 P, BOMHz. 36-48 B wikis BGHz EZ:FE:0F:71:F
[ BE:FD:FD:2C2EZD 53 B wiFi g 2 4GHz 5E:7D:7D:2C:
[ 7E:54:25:94 CEET 157 F, 80MHz, 143-161 B wiFis GGHz VE:B4: 25:94:0
[ | Google. Inc.-DASEES 1 B wiFi g 2.4GHz BECE: 520
[ DES4:25AEEEERS 157 F, 80MHz, 143-161 B wiFie GGHz DE:94: 35:46:1
[ SE:AD:43:00:46:48 11 B wiFi g 2. 4GHz SE:AD:43:00:
[ PEGATROM CORPOR... 48 F. 80mMHz, 36-48 B wiFis GGHz DC:FE:O7:71:!
[ &5U5Tek COMPUTER... 36 F. 80mMHz, 36-48 B wiFis GGHz 3058 30 Ch:E
[ &RRIS Group, Inc-0B:2.. 11 B wiFi g 2. 4GHz ABSFECOR:
[ CO:54:35A6:EE:E4 53 B wiFie 2.4GHz CO:94: 35:a6:E
[ | Google. Inc.-D3:AATF B S wiFi 4 2.4GHz 55:CE:52:03,
[ &RRIS Group, Inc-C3HE. 11 B wiFie 2.4GHz AC:DE:48:C3:

[ FO:2F:74:31:CE:98 4 B wiFie 2.4GHz FO:2F:74:91:C
< >

Select/Unselect
[JalBands []24GHz []5GHz []6GH=z 551D e | | Filter
[Support 7 and )
Save the filkered to: |Fi|t8f8d1-3\"d>€ Cancel

3. Check boxes by AP names to select the APs you want to include.

4. Use the various controls to sort the AP listings:

e Column headings sort by the column type.

e Al AP check box selects all listings.

e 2.4 GHz check box selects only APs set to 2.4 GHz.

e 5 GHz check box selects only APs set to 5 GHz.

e 6 GHz check box selects only APs set to 6 GHz.

o Filter the list by selecting an option from the Filter drop-down (SSID, AP Name, MAC) or type the desired name into
the text entry box. (Two wild cards are supported. Use * for incomplete names (e.g. 00*) or ? to replace an unknown
character, such as Cisco-123?. Matches are case sensitive.) Then click Filter.

5. In Save the filtered to:type a name for the filtered data file.

6. Click OK. The newly created filtered file appears in the Projectwindow under Survey Data.

Display View Menus and Windows

The Menu bar on the Display view also has three menu groups, each containing various menu options for viewing, analyzing,
and manipulating survey data. The File and Viewmenus contain options that are specific to the Display view only. (The Help
menu content is the same for all screens.)

File menu

DiSPLAY VIEW: MENUS, BUTTONS, AND WINDOWS

Edit menu: This menu has only one option, Copy Heatmap Image (Ctrl+C). Selecting this option copies the heatmap
displayed in the map window to the clipboard as a .png file.

View menu

Toolbar

Project window
* Right-click Pop-up Menu

« Data Type List Menu

Overview Window

Map window
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e Heatmap Legend

DiSPLAY VIEW: MENUS, BUTTONS, AND WINDOWS

¢ Using Context-Sensitive Pop-up Menu

File Menu

The table below details the File menu on the Display view.

Menu Option

Description

New Project...

Opens the New Project Wizard where you can create a new project.

Open Project...

Opens an existing project (.svp) file.

Save

Saves changes made to the current project.

Note: This option is available only when changes are made to an opened project file.

Save Project As...

Allows you to save an existing project under a new file name.

Close Project

Closes the current project.

Configure...

Opens the Configuration dialog box which allows you to set up project parameters.

Phonebook

Configure a VoFi Phonebook. See Configuring a VoFi Phone Book,

Data Merge

Opens a window containing all data files so that you can select the files you want to merge.

Import Survey Path...

Opens the Import Site Survey Path File dialog box where you can import the survey data file. Also
see Import Path on the toolbar.

Import Survey Data...

Opens the Import Site Survey Data File dialog box so that you can import the data of an existing
survey project.

Import Floor Image...

Opens the Open Site Image dialog box so that you can import a site map.

Export to Google Eart

Enables you to export a GPS survey for viewing in Google Earth.

Export AirMapper
Files...

Enables you to export a survey to the Link-Live cloud service for project analysis and sharing. See
Using Survey with NetAlly AirMapper for more information.

Export AP Config...

Opens the Export AP Config dialog box so that you can export AP configuration data in the Excel
format.

Cisco Prime NCS/WCS

If a Cisco Prime NCS/WCS Planner or Survey project was imported and modified, it may be

Export exported using these options.

Print Prints the content of the Map Window.

Print Preview Opens the Preview Window so that you can preview what is to be printed.
Print Setup Opens the Print Setup window where you can set your printing preferences.

Work in Display Only
Mode

Allows you to switch to Viewer mode (which has fewer view options and no survey options).

Recent Projects

Allows you to quickly open projects that have been viewed recently.

Multi Floor Planner

Opens Multi Floor Planner

Exit

Exit the software application

View Menu
The figure below shows the View menu on the Display view.
Option Description
g% Zoom In Enlarges the view of the current floor map in the map window. (You can also use your mouse's
scroll wheel.)
Q% Zoom Out Reduces the view of current floor map in the map window. (You can also use your mouse's scroll

wheel.)

E Zoom to Fit

Fits the current floor map to the map window.

@ Zoom to Actual

Size

Fits the current floor map to its actual print scale.

Set Zoom...

Opens the Set Zoom dialog box where you can specify the specific ratio at which the view of the
map can be increased.

Show CAD Layers...

Allows you to select which layers of an AutoCAD image to display and, if the image has multiple
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layouts, which layout to display. This feature is also available when you right-click on the image in
Display View.

Toolbars and Docking
Windows

Enables you to show (checked) or hide legend and/or status bar. If the default toolbar settings are
modified, click Reset Toolbar to reset the toolbar to default setting.

Show Rulers

Allows you to show or hide the rulers along the edge of the map window.

Show Grids

Allows you to show or hide grids in the map window.

Invert Legend Colors

Flips the legend color scheme vertically.

Filter APs

Opens the Data Filtering by AP dialog box which allows you to create a filtered survey data file
which contains data only related to the selected APs. See Creating Filtered Data Files,

Overlap Allows you to show or hide signal overlap or channel interference in the Map Window. Make sure
the Data Type selected is 1st AP.
Overall Displays overall site RF coverage. This option is active by default.

Per Channel

Displays data by channel.

Per SSID

Displays data by SSID.

Lock AP Location

Allows you to lock APs to their respective locations on the site map. Note: This feature can help
make your survey results more accurate.

Project Properties...

Opens the Project Properties window where you can adjust the physical properties of the floor map
of the survey site.

AP/Path Name Font...

Opens the Font window where you can modify the font properties of APs and survey paths on the
floor map.

Measure Mode

Turns on Measure Mode, which lets you measure the distance between any two points on the site
map. You can also choose to recalibrate the site dimensions based on the measurement.

Throughput Simulator

Opens the Throughput Simulator. See About Simulation view,

) " Refresh

Refresh the heatmap display to reflect any changes.

Display View Toolbar

The Toolbar on the Display view contains frequently used tools for presenting survey data. Some of these tools are identical
to those on the File and View menus of the Display view.

The following screen shot shows the toolbar undocked. The toolbar may be undocked by dragging its handle located on the

far left.

Main Commands Toolbar x
A F H @ 8 B 2 9 B @ @ QA 8
B & % 4 @ 8 @ vVewoveal- (& B

Icon [Name Description
2 Project Opens the New Project Wizard where you can create a new Survey project. See File menu.
2 Wizard

Open Project

Opens an existing Survey (.svp) file. See Filemenu.

Save

Saves changes you have made in the current project.

Configuration

Opens Survey Configuration window. See Filemenu.

Survey Data

Print Prints what is shown in the Map Window.

Site Image Opens the Import Site Image window so you can import a site map.

Import Path |Opens the Import Site Survey Path File dialog box where you can import the survey path of a survey
data file.

Import Opens the Import Site Survey Data window so you can import site survey data (.svd or .svdx) files.

Zoom In

A NG R A a7

Enlarges the view of the site map. (You can also use your mouse's scroll wheel.)
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Zoom Out Reduces the view of the site map. (You can also use your mouse's scroll wheel.)

Zoom Fit Fits the site map to the Map Window.

Actual Size  [Displays the site image in a size as it is printed.

Measure Starts the Measure Mode so that you can measure the distance between any two points in the site
Mode map. See Measuring Distance Between Locations.

Toggle Enables you to view an outline of where a heatmap transitions from one legend value to the next
Outline value.

Create Allows you to place a comment field anywhere on the displayed map. To do so, click the button and
Comment then click where the comment should be inserted.

Refresh Generate and refresh the heatmap

Overlap Show or hide areas of coverage overlap for a selected AP in the Map Window.

Filtering Filter AP data out of the Planner project.

Tools Opens the Signal and DHCP tools.

Calculator Opens the calculator tool.

AN EREERREEE

The Display view Toolbar also includes a drop-down menu with the following options:

View Overall: Displays overall RF coverage in the Map Window. This option is active by default.

View Per Channel: Displays data by channel. The Channel tab in the Channel/SSID list must be selected.
View Per SSID: Displays data by SSID. The SSID tab in the Channel/SSID list must be selected.

Project Window

The figure below shows the Project Window on the Display view.

B 802 11ac_Indoor.svp

|_:_|!JE| Site Map

..M Augustine-2ndfloor.jpg
-3y Survey Data

----- [ . ActiveSurveyl svdx
..... ®p
----- (" I ActivelPerfSurveyl svebx
----- {7 W VirtualSurvey2.svdx
Bﬁ' Survey Path

----- [ ActiveSurveyl.path

----- PazziveSurveyl.path

As shown in the figure above, the Project Window displays files in a Survey project in three folders:

» Site Map: Shows all the site maps (floor plans) for the Survey project. To select a site map, put a check mark in the check
box in front of the map file. The selected map is displayed in the Map Window. By default, a site map is automatically
selected and displayed when a new project is created, or when an existing project is opened.

» Survey Data: Lists the data files available in this project, each file representing an individual survey. They contain data
such as SSIDs, APs, signal strength, noise level, signal-to-noise ratio, etc. captured during the survey. File types are as
follows:

ICode |Survey Type I
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A Active survey

P Passive survey

A, [Survey Mobile app survey

A [AirMapper active survey file from the management radio

iPerf survey

a |Mergesurvey

|

M

Mg |Merged survey
S

Simulation survey
|ﬂ§‘ VoFi survey

\'J Virtual survey

« Survey Path(applies to Survey projects only, not to Multi Floor Planner projects): Shows all the survey paths recorded
during a site survey. You can have as many survey paths in the folder as you recorded, and display as many of them as
necessary. To display a survey path, put a check mark in the check box in front of the survey path file.

You can show or hide any file (that is, site map, survey data, survey path) simply by checking or unchecking the cor-
responding radio button. Unlike the Project Window on the Survey view, the Project Window on the Display view has a Survey
Data folder instead of the AP folder.

By default, the most recently opened site map is automatically selected and displayed when you switch to the Display view. If
a project contains more than one site map, you may need to select the one you want to display if it is not already opened.
Also, no survey data are displayed in the Map Window when you switch to the Display view. You need to select a survey data
file to display it.

Data File Conversion

Beginning with Survey PRO/Planner version 8.8, the project data file extension was changed from .svd to .svdx. A project
containing data files having the .svd extension may be opened in version 8.8 and higher; however, if the data file is selected in
Display view (for example), you are prompted to convert the file from .svd to .svdx.

During conversion, the old file is preserved and a new .svdx file is created.

Survey PRO, Survey Express or Survey Planner version 8.7 or earlier cannot open projects that have the .svdx extension.

To Convert your Survey Data Files to .svdx:

1. In the Display View, right click on the project, and select Convert Surveys to Current Version.

@ AirtMagnet Survey Professicnal Edition - Indmr_

File Edit Wiew Help

@ Planner i‘..— Multi Floor Planner E\‘k Survey m
v & H @ & B 2 9 I Q S
@ M Close Project I—lJ—lj

e Data MEFQE---
Wiew Project Data...

----- . Convert Surveys To Current Version
..... lz_h TYEYESVUR

..... (M ActivelPerfSurvey3.svdx

----- I ActivelPerfSurveyMerged] svelx

79 M MarcieaComanad s

T =

2. Click Yesto confirm and start the conversion process.

A progress window shows the files being converted. If you click Cancelduring file conversion, the process is canceled after the
current file completes and before the next file begins.
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Right-click Pop-up Menu

The Project Window on the Survey view and Display view includes a right-click menu. (Some options are available in Survey
view and others in Display view. Unavailable options are grayed out.)

Right-click a survey data file to view the right-click menu options.
File Edit View Help
@ Planner E;.:_:i Multi Floor Planner qu Survey
o =2 H @& & B 2 29
[£2) Indoor.svp ~
Bhﬂ Site Map

. L. DeGuigneljpg
=) Survey Data
L

. A g
(_'. Active Open
f. Active Clase
AT . Active Delete

AT Active
A P Passi Rename
(" A Active Data Merge...
Select All []2.  ViewMerged Source..

View Survey Properties...

& Channel
W@ CH(36,1)

IIT_—

Menu Option Description

Close Closes the selected data file. (Display view only)
Delete Deletes the selected (right-clicked) item.

Rename Renames the selected data file. (Display view only)
Data Merge... Merge two or more data files.

View Merged Source [Shows the sources from which a merged data file was created. (Display view only)

View Survey prop- Opens a properties window for the file. (Display view only)
erties ...

View Survey properties

From the Project Window, right-click a survey data file (.svdx), and then select View Survey propertiesfrom the pop-up
menu. The Survey properties dialog opens, as illustrated below.

The Survey properties dialog provides information about the selected survey data file.
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Survey Properties - ActiveSurvey2.svdx “
Survey Type: Active Survey
Adaptor Name: Proxim Wireless 8494 802. 11a/b/g/n USE Adapter #2 00:20:A6:E2:BC: 76
Start Time: 6:17:47 PM 9292015 Stop Time:  6:39:35PM 9/29/2015

Mumber of Sampling Points: 511

Total Device Count: 2 (all discovered devices induding virtual APs)
Number of Placed APs: 0
Dimensions: 219,05 x 136,30 feet

GPS Location

Upper Left Corner Longitude: Latitude:

Lower Right Corner Longitude: Latitude:

View Survey Database

Mote: SQLite DB browser (such as http:{fsglitebrowser.org/ ) is required.

Close

View Survey Database
The Survey properties includes an option to view in-depth, database details included in the selected survey data file.

To view the database, you need a database viewer application such as DB Browser for SQLite, downloadable at: http://sql-
itebrowser.org/

Click View Survey Database. You may be prompted by Windows to associate the database with the desired database viewer
application.

Right-Click to Show CAD Layers...
From the Project Window, right-click an AutoCAD image file, and select Show CAD Layers...

,Ej AirMagnet Survey Professional Edition - Indoor.svp

File Edit View Help

: @ Planner = MMulti Floor Planner ,:;k Survey

B S A B % 9 Q Q
(2 Indoer.svp - o "
=

-4 Site Map |

Arques HQ Floorplan 1.
».:\l Survey Data Show CAD Layers...

{7 A ActiveSurveyl.svdx B
{1 P PassiveSurveyl.svdx
0 I ActivelPerfSurveyl svex

9 B DacciraSinree Snactrimn oo

i S

L1 I(;JI
|

The Drawing Layers... dialog opens, as shown below.
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Drawing Layers =
Select drawing layout and layers to display on site map
Layout: Model v
[ Select all layers [¥] View black and white
Layer
0

BUILDING_ENVELOPE
DEFPOINTS

DIMEMSIONS

EQUIPMENT
MOVABLE_FURNISHINGS
MNOM-MOVABLE_FURMISHINGS
SPACE

WALL

OK ] [ Cancel

Data Type List Menu

This option is available on the Display view only after data are loaded, that is, after a data file is opened from the Project
Window. It allows you to select the type of data you want to display in the Map Window. You can access the options by
clicking the down arrow.

The data types presented here are related to the selection you make from the Channel/SSID Tree. It affects the content
displayed in the Map Window and may also affect the options on the Color Legend and Analytical Tools.

Signal Strength (1=t AP) |'.|
Signal Strength >
Channel Interference
Predictive PHY Data Rate Down *
Wi-Fid »
Wi-Fi 3 »
Wi-Fig »

Channel Overlap Wi-Fi 5
AP Operating Mode
Channel Width

Overview Window

In the lower left-hand corner of the Display view is the Overview Window, which provides a bird’s-eye view of the entire site
map regardless of the viewing option used in the Map Window. It enables you to try different viewing options in the Map
Window without “losing the big picture.”
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By default, the Overview Window is enclosed by a red box when a survey data file is opened, indicating that you are now
focusing on the entire site (map). If you want to focus on a specific area of the site, you can click outside the red box to make
it disappear and then click and drag a smaller box on the map. You can then drag this box to zoom in on any specific area on
the map to get a close-up look at that section in the Map Window.

Map Window
The Map Window on the Display view allows you to view and analyze data contained in the selected data file.

Data at any location on the site (XY coordinates) may be viewed in two ways: Mouse hover and Measurement Details. In each
case, the data displayed depends on the Data Type selection in the drop-down at the top of the Display view.

Mouse hover: If you hover the mouse over a point on the heatmap, a summary of the current Data Type selected is displayed
in a balloon tip.

Measurement Details: You can view the Measurement Details of any location on the heatmap by clicking the desired XY

coordinates on the heatmap. A dockable window opens to display the details data. A red push pin indicates the coordinates
location selected. Click a column heading to sort data by column in ascending or descending order.

From the dockable window, click Copyto copy the data details to the clipboard.

You can also visualize and analyze the data using different color schemes and analytical tools. See Introduction to Data
Analysis for more information.
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Display View

g AirMagnet Survey Professionsl Edition - Indoor.svp.

File Edit View Help

| £ Plonner F= Multi Floor Planner &y Sunvey [T] Display Simulation Multiview | %, Dirfview | € ainmise Reports

pa E | e & BEFE N

Q & ®m @ x¥ < @ M v.mm..an.ﬁ

Signal Sirengn (15 AF)

= ’ o . " - = > ax - x
@‘.'%’U:("‘h‘f T T T e R e | [¥] » | Measurement Details: x=117.721 L
£ {ir] Site Map ((copy |
Signal Strength (1st AP): 47 ... | G Signal
i .¥ ArquesHQ Floorplan Ldwg A 5o e (e (dBm)
s Survey Data CH BSSID Signal (dBm) M 0
f Tin =181 Dimensions{Xx1): 282,431t x 268321t
A0 A ActiveSurveyl svdx 1 LAB:15:FD: 3B 47 2
® P PassiveSurveyl.sudx = 1 00 BA:CTDL a7 0
O T ActivelPerfSurveyl svdx | 1 00: 1F:1F:0B:8C:C4 512 o
) P PassiveSurvey_Spectrum.svdx 3| 161,-1 90:34:0D:DF:9D:BE 253 =4
E-R SurveyPath E 193,1 D0:1ZEIFBI52TS 55 < a0
[ ActiveSurveyl.path 27 €0 £
- PassiveSurveyl.path - B 60 £ -40
E| 61 -
[¥] Select All [#]24GHz [¥]5GHz — 1 00: 14:F 1:AF: 16:96 61 £ E
o 1 00: 14:F 1:AF: 1B:94 51 -5 50
-] HiTrid | 1 00:26:54:78:4F:78 62 £
=@ k| 198 D0:23:68:93E2E B 20
| 1 : 71«
al Signal Strength (Lt AP): -47 dBm but max: -37 1 73 € 80
Tl ) | 1 :16: 73 €
| - 1 00: 14:69:73:18:30 73 < 0
|
3 100
|
|
© channel [ SSID b
b
¥l \ L i | E
All checked Channels Selected APs 38

The right-hand side of the Display view shows the Legend which provides a variety of ways for displaying and analyzing
survey data using different color schemes and patterns.

Note: The colors gray and white may appear in a heatmap and not be indicated on the legend. White may indicate no
coverage. Gray may indicate that a coverage requirement is not met.

v x|

Signal
[dBm]

-E0
-0
-80

|

= -100

e You can also adjust the color scheme. See Configuring Legend Color Schemes.

At the top of the Legend is the Data Type (including its unit of measure). It indicates the type of data
displayed. It is identical to what is selected from the Data Type list menu on top the Map Window.

Drag up from the bottom of the Legend or down from the top of the Legend to set the upper or lower limit
i) of RF data (signal, noise, interference, and so on) shown in the Map Window.

Using Context-Sensitive Pop-up Menu

A context-sensitive pop-up menu can be accessed by right-clicking the Map Window. It is available on all major screens of the
application. As the name suggests, the content of the pop-up menu depends on the view context.
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To access the context-sensitive pop-up menu:

1

Right-click any part of the map view. The context-sensitive pop-up menu appears.

Option

Description

AP Properties

Allows you to view the properties of the AP that you right-clicked. This option is
available only when you right click an AP in the Map Window.

Project Properties

Same as View Menu,

AP/Path Name Font

Same as View Menu,

Show Rulers

Same as View Menu,

Show Grids

Same as View Menu,

Hide AP Icons

Hides the AP icons so that they do not display in reports.

Hide Comment Icons

Hides the comment icons.

Disable Measurement Tooltip and
Details Window

Prevents tip screens from popping up when you mouse over the Map Window.

Hide APs Below Legend
Threshold

Hides APs outside threshold range set for the Legend. (You can adjust the range by
clicking on either end of the Legend and then dragging toward the center.)

Smaller Survey Man

Shrinks the icon of a person on the map. (Applies only to a site survey.)

Show Arrows in Path

Adds directional arrows to survey paths. These arrows indicate the beginning to end
course of the path taken during the survey. (Not applicable to Multi Floor Planner.)

Show Heatmap

Removes the heatmap from the view.

Delete location information for
this AP

Removes the location information of the selected AP.

Set Zoom...

Sets the zoom level.

Copy

Same as View Menu,

Copy Current View

Copies the content in the current Map Window for pasting into another application.
(This may be useful for copying a zeroed-in area for detailed analysis.)

Print Current View

Prints the content view in the current Map Window to another application. (Printing a
zeroed-in area may help with detailed analysis.)

Export to Google Earth

Exports the data to Google Earth.
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Simulation View

In this chapter:

About Simulation View .. . 146
Setting Up Data Simulation ... ... . . 146
Before-Simulation Channel/SSID List ... ... ... 147
After-Simulation Channel/SSID List . ... ... .. . 147
Conducting Data Simulation ... .. 147
Simulating Data Configuration ... .. .. 148
Simulating Channel Allocation ............ ... . . 148
Simulating Network Throughput ... ... 150
Analyzing Simulated Throughput Data .. ... . ... .. 151
Throughput Simulator SumMmMary ... ... 151
Throughput Simulator Device Table ...... ... ... . 152
Simulation View Menus and WindoWs ... ... 152
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About Simulation View

The Simulation view allows you to perform channel, SSID, and power simulation to see how the network would function in
different scenarios. You can explore various WLAN deployment plans without having to have the hardware devices actually

installed. You can open the Simulation view by clicking @ SN (Simulation) on the Navigation Bar.

The map window on the Simulation view is divided into two parts: the top shows survey data before simulation, and the
bottom shows survey data after simulation. This helps you easily visualize differences between the simulated and
unsimulated data.

@ AirMagnet Survey Professional Edition - Indoor.svp b - 0 X
File Edit View Help
¢ (R manner P wtiFoor Panner R suney [ Display (] Simulation | ] Muliview | % Ditview ) Arwist [Z] Repots b
B | n Q Q & | ¥ 4 @ ) View Overall - ) Eﬂ
1| H 7] 4 H L] 7] ?
WMSelect All (112464 M56Hz [66Hz T T e s e T e T e Signd Stengh (1 A7) [¥]+ T X
E Signal
@ Channel (o] imenn Dimensenspai: 2805 0 4B
M@ CH 6T nf : 1
4 M @ CH (36, 40MHz, 36-40) = |
E vl ali)
| =
- 20
B a0
| =
] 41
B I-sn
=
] i
ERNEE Eli
| 5= .
1 g 2il a0
_[S Before Simulation Zoom: 62% v
<

@ Channel @ s

1] 2| ] 4 K | 7 A i
WM Select All V1246t [456Hz [A66Hz (el sl oyl o deali Sl Snengh (12 ) v~ =
1in.=31.20ft  Dimensions(XxY): 219.05%x 13630 ft

@ Channel
W@ CHE6T)
(5@ CH (36 P, 40MHz, 36-40)

=

—
=
1l

A

-

@ Channel D 5D o Hter Smletion Zoom: 48 v

Before: All checked channels  Selected APs 2 After All checked channels  Selected APs 2

The Simulation view can be divided into the following sections:

o Channel/SSID List (Before_Simulation)

o Channel/SSID List (After-Simulation)

e Simulation View Menu Options

* Legend (same as the legend for Display view)

Setting Up Data Simulation

Before conducting data simulation, you must place and "power" APs on the site map in the Displayview at locations where
actual APs are located:
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After you have created a survey project and conducted the survey, click on the Display view button.

Expand the Channel or SSID list and drag an AP to its physical location on the site map. Continue to do this for all the APs

in the list. (This step primarily relates to APs under your management, although you may place any or all APs in the list.)

Right-click an AP you placed on the site map and select AP Properties.

4. Check Apply Power Settingand set the Original Power milliwatts. Use the setting that matches the setting for the AP.
Click OK.

5. Navigate to Simulationview and place simulation APs on the site map.

6. On the toolbar, click Add Simulation AP. This opens the New AP Propertiesdialog. Modify any default settings (MAC
Address, SSID and Original Power settings are required). When finished, click OK. This places the AP is placed on the site

map. You may drag the AP to the desired location.

AP Properties b

Aol
Alias |Project | |
AP Name | AP-CAP3702-B |
Channel [cH |
MAC Address |ssio |
00:35:1A13:90:£0 AME-BLK

Media Type | 802.11 GN |
Channel Width ‘ 20 MHz |
(Capability)

0Op. Mode [ Mixed HT |
Phy.DataRate | 144.44 Mbps |

Max Signal Sampling Data dBm
Count of Sampling Points. I:I

You can drag and drop the AP to set its location.

o ] [ G

7. Click Refresh to view changes to the heatmap.

Before-Simulation Channel/SSID List

The Before Simulation Channel/SSID List appears on the upper-left part of the Simulation view. It lists the APs contained
in the unsimulated data. You can view the APs either by channel or by SSID using the corresponding tab at the bottom of the

list.

After-Simulation Channel/SSID List

The After Simulation Channel/SSID List appears in the lower-left part of the Simulation view. It lists the APs contained in the
simulated data. You can view the APs either by channel or by SSID using the corresponding tab at the bottom of the list.

Conducting Data Simulation

The Simulation view allows you to test a number of what-if hypotheses using data collected from actual site surveys.
Therefore, you must perform site surveys to collect the real data you need. Also, you need to open the data file on the Display
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view first before you switch to the Simulation view. Otherwise, the Simulation view is not be available. You can conducting
two types of simulations:

« Simulating Data Configuration

» Simulating Channel Allocation

Simulating Data Configuration

To conduct data simulation:

1. From the Display view, open a survey data file.

Simulation
2. From the Navigation Bar, click @ . The Simulation dialog box appears.

Simulation @
Data Corfiguration | Channel Alocation 2.4 GHz | Channel Allocation 5.0 GHz |
AP Name |cH 55D | Sim Power (/) | Orig Pawer [imh »
Edirnawx: OB:8C:C4 1 arygate - |
AP001d.4591.321 1 LA-LLwWAP-2-BD B
AP0 56218, 3bf i K.am
APO0T5.B218. 3kt 1 K.arm-wpa
APO0T5.6218. 3bf 1 K.am-wpaz
APO05.6218. 3bf 1 cizco-3500
Symbol ES.EZEC 1 drkrown
Symbol ES:EZEE 1 Ik non
Symbal ES:RB2:ED 1 [dnkrown -
4| 1 | P
Noise Simulation [ﬂ dEim Close this window after refresh
: b
il S0dBm [ Reset | [ ResetAl | [ Refresh || Close

NOTE: Wi-Fi 6E APs are not supported in Simulation mode.
3. Highlight the AP of your choice, and do any or all of the following:

e Click the CH fieldand select a channel from the drop-down list.

e Click the SSID fieldand select an SSID.

o Drag the scale to set a Noise Simulation level.
4. Click Refresh. The Loading Date File view appears. The graph refreshes once the simulation process is completed.
5. Click Close.

NOTE: Make sure that the APs are placed in their exact locations and that the correct values of the original output power are
used. APs placed on Survey‘s Display view are 'display-only* by default. Therefore, you cannot modify the AP power settings
for APs placed on the Simulation screen unless the APs are first changed to Power APs. Placing APs and enabling power can
be done on the Display view. See Channel/SSID List.

Simulating Channel Allocation

Simulating channel allocation enables you to find out the optimal channel assignment or distribution for the APs currently
detected in the survey. It helps you make well-informed decisions on the number of APs needed on the network or at a
certain part of the network: if multiple APs are covering the same area on the same channel, the chances are that not all of
the APs may be necessary.

NOTE: You can choose to simulate channel allocation on either the 2.4 or 5.0 GHz band by using their respective tabs across
the top of the dialog box.
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NOTE: Wi-Fi 6E APs are not supported in Simulation mode.

To simulate channel allocation:

1. From the Toolbar, click Simulation(not to be confused with Throughput Simulation). This opens the Simulation dialog.

2. Click the Channel Allocationtab. The view refreshes.

Simulation

Data Corfiguration | Channel Allocation 2.4 GHz | Channel Allocation 5.0 GHz |

X3

AP MName

| 551D

| Drig CH

Edimax: 0B:8C:C4

anypgate

4
1 | »

1
AP0 4591 321 Ga-LlwapP-2- .1 i A ||: 3
APO0T5.62(8. 3kt K.am 1 1 _vJ | | —
APO0T5.6218. 3bf K.am-wpa 1 1 _ﬂ |_
APO0T5.6218. 3bf F.am-wpaZ 1 1 ;] | |
APO0T5.6218. 3bf cizco-3500 1 1 _YJ | |
Symbol ESBZEC Unknown 1 1 _VJ H
Symbal ES:62:EE Unknawn 1 1 _v_! I-
Symbol ES.BZED Unkhown 1 1 ;! |_
Symbol E¥-EE:OC Unknown 1 1 LI |_ -
&l D?s_able F{E_edundarrt APs with @ dBm

minimum signal coverage of '
-100 do [ Allocate ] [ Close ]

NOTE: All APs that are detected are identified by AP name, SSID, and (original) channel. Wi-Fi 6E APs are not supported in

Simulation mode.

3. Select the AP of your choice and click the down arrow to specify its new channel, if desired.

4. Check the Lock CH box to lock the channel for the corresponding APs, if you want to ensure that the simulation process

doesn’t alter that AP’s setting.

Note:Wi-Fi 5/Wi-Fi 6 APs are automatically locked ("Lock CH" column is checked) in Channel Allocation.

5. Check the Disable Redundant APs, if desired.

Note: This allows the application to disable the APs it considers redundant. The slider allows you to configure the signal
strength required for APs to be considered redundant. If all points meet the specified signal requirement, any APs below
that level are eliminated. Once the simulation is completed, Survey automatically disables those APs that it considers

redundant.
6. Use the slider to set a minimum signal coverage value.

7. Click Allocate.

Simulation =]
Simulation
Data Configuration | Channel Allocation 2.4 GHz | Channel Alocation 5.0 GHz |
Data Configuration | Channel Allocation 24 GHz = Channel Allocation 5.0 GHz
AP Name [ssip [ 0rig cH B
17 Edmax0B:8CC4 | anpoate 1 6 - v ?f’ o) SSD e il
) = Aerohive Ne k-.. AeroHi 165 165
17 APODT.4591.321 | QALLWAP-2... 1 " om F D i (TS
s - - 1" AIR-CAP3502:3 airtek-01:AM... 165 185
"),) o [+ U APCAP3S0Z4  airtek01:AM... 116 116
1" APODISEAB36E | Kamrivps 1 1 Ll | | 1 APC0BC6020.733  CiscollacCis.. (36 P, 40MHz ... 36
I APOMSEA836  Kamwpa2 il 1| I | 1 Apple-78:43:5F Mr B's WiFiN... (36 P, 80MHz, ... 36
17 AP G830 cisco-3500 i 1 -] u 1" APedc722b2.808  CiscollacCo... (36 P, 40MHz, .. 36
Lx) SymbobESE2:EC Urknowm a4 1 ;J ,_ 1 ASUSTek COMPU. ASUS_5G (143 P. 80MHz... 149
X SymbotESE2ZEE | Unknown 1 H m 17 Zebra Technologr-.. AML 157 157
X SymbolESE2ED | Unknown 7 1] I 17 Aruba-82:77-F0 Awbs-lac  (161P. 80MHz... 181
E U 11ach: CorpNetl Tac.... (1081 108
£ SymbotEPEEOC_|Urknown ! ‘8w & T bRt (35 ) 36
D Disable Redundant APs with ‘T dBm O E‘\;‘a':‘\‘e"‘Fise‘d:;\‘dca:\:eAZS:f!!; 0 dBm
minimum signal coverage of gy g
00 00 o '

Allocate

tI—ITI—IHTITITI—I—I—I

Close

Note: You can also add APs or relocate APs to certain areas on the site map and then use the Simulation tool to see how
the changes affects the signal coverage in the target areas.
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Simulating Network Throughput

Survey’s Throughput Simulator allows you to set up theoretical network implementations and view the expected levels of
traffic that the specified devices experience. You can create entire simulated networks from scratch to test a planned imple-
mentation or use devices already detected in the current survey file to see how new additions to the environment affects the
overall performance of the existing infrastructure.

The Throughput Simulator calculates network, node and media throughput, utilization and overhead (as measured at the
802.11 Link Layer) under various network and node configurations. It allows you to add and configure up to fifty 802.11a,
802.11b, 802.11g and/or Wi-Fi 4 nodes on a “virtual channel”. The Simulator applies additional network and node parameters
based on the type and settings of the nodes present. The Simulator runs in a “perfect” environment, assuming that all nodes
can “hear” each other (to negate the possibility of packet collisions and frame retries) and that all nodes transmit as much
(and as fast) as they possibly can (based upon their individual and overall network parameters). The result of such simulation
provides a baseline measurement of the theoretical maximum link-layer throughput that can be achieved for a particular con-
figuration.

To use the WLAN Throughput Simulator:

]

1. From the Simulation view, click Throughput Simulator). The Throughput Simulator window appears.

Throughput Simulator b e
Fun AddWiFidDevice |+ Configure @ 24GHz O B5GH:z
Dievices ta simulale:
Device  Assoclated 8P Fate TxPlts TuBytes  Mbps Status Time fpsec] | PacketCount | Byte Count

Utilization (Air Time %)

100

75

‘ TxData [] TxAck [] Random Backoff [] Virtual Carrier Sense [ ] RxAck [] cca [T

Network | Avg Thioughput (Mbps) | Avg 802110 (Mbps) | Avg80211g (Mbps) | AvaWiFid Mbps) |

2. From the menu bar, click Add Device and select an option as described in the table below.
Note: For all options, you must add an AP before the Throughput Simulator allows you to create a station.
Note: Wi-Fi 6E APs are not supported in Simulation mode.

Note: To remove a device from the Throughput Simulator, right-click the desired device, and then select Delete Node.

Option Description
Add 802.11x Device... |Drop-down that enables you to select one or more devices to be added from the information
contained in the current survey data file.

802.11a Device... Opens the Device Configuration dialog box, which allows you to select a type of device to be
added and the device's physical data rate.
802.11b Device... Opens the Device Configuration dialog box, which allows you to select a type of device to be

added, as well as its physical data rate.
802.11g Device... Opens the Device Configuration dialog box, which allows you to select a type of device to be
added, as well as its physical data rate.

Wi-Fi 4 Device... Opens the Device Configuration dialog box, which allows you to select a type of device to be
added, as well as its MCS index. A series of checkboxes also allow you to specify the devices
various configuration parameters, including Greenfield, channel width, etc.

3. After you add the necessary devices, click each station’s Associated AP column to select an AP to which it should
associate.
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Device Associated AP Rate |T=P... T=D..
i, AP _t 10 0 0.00
thap_z 239 0 0 0,00
iigap_ 540 ] 0.00
HgysTA_L Associate... 24 0 o 0.00
— Assaciate. ., 0.00
15 ap_4 aP_1 200 0 0 0.00
J,5TA_3 EE—E 2 0 0 0,00
AP 4

Throug... | Status

Idle
Idle
Idle
Idle

Idle
Idle

Note: You must associate at least one station to each AP to simulate network throughput. Also note that APs with

associated stations cannot be removed.

4. After all the necessary associations have been made, click Run to start the simulation. For descriptions of the throughput
simulation data fields, see Analyzing Simulated Throughput Data.

Analyzing Simulated Throughput Data

During network simulation, the Throughput Simulator window updates dynamically as new information is calculated. These
data are displayed in three major portions of the view, as highlighted in the image below.

NOTE: Wi-Fi 6E APs are not supported in Simulation mode.

Throughput Simulator X
Run AddWiFi4 Device  |v Configure ® 24GHz (O 5GHz
Devices to simulate:
Device  Associsted AP Rate TePkis TaBples  Mbps Stalus Timelpses) [ PacketCount | By Count
27762324 14 917430
AP2 299 7 488745 132139 ‘wiaiting for MAV register (1837 psec) to count dow.
5Ta_1 &P_1 293 4 262140 75.54  Backing off for 126 psec, medium busy before DIF. o i "
Utilization (Air Time %)
100
75
50
25
| FEG2E0E [802:1a | e02.11n B Fratecik
000%  000% | BEES% | 343% (0.00%
TxData [ ] TxACK [ ] Random Backeff [[] Virtual Carrier Sense [ ] RxAcK [] cca [
Nélwnrk I Avg .Thrnughpljl-[h;l.hﬁs]l .Avg.E.[IE‘-HIh [Mhps] I Avg é[‘lZ“\“\g‘[M‘hps]‘ | Avg\p\;\—i:i:ltlzd.h.ps] ‘

Throughput Simulator Summary

The Throughput Summary portion of the Throughput Simulator displays the simulated network throughput separated based
on media type, allowing you to see how much throughput is dedicated to each type of device. These data are described in the

table below:

Field Description

Network Combined aggregate throughput of all wireless media (which may include 802.11a/b/g/n/x,
depending on the frequency band selected.

Average Average node throughput (that is, the network throughput divided by the number of nodes).

Avg 802.11a
5 GHz band is selected.

Average node throughput for all 802.11a devices. Note that this column only appears when the

Avg 802.11b

Average node throughput for all 802.11b devices. Note that this column only appears when the
2.4 GHz band is selected.
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Avg 802.11g Average node throughput for all 802.11g devices. Note that this column only appears when the
2.4 GHz band is selected.
Avg Wi-Fi 4 Average node throughput for all Wi-Fi 4 devices.

Throughput Simulator Device Table

The Device Table portion of the Throughput Summary displays the status of each device as the simulation proceeds. The data
in this portion of the window are described in the following table:

Column Description
Device The name of the device. For actual detected devices, this name is provided by the survey data. For
devices added manually, these names are numbered generic entries (for example, AP_1, STA 2).
Associated AP The AP to which a station has been associated. (APs do not display any information in this field.)
Rate The rate at which the device transmits. This number is specified when you add devices.
Tx Packets The number of simulated packets transmitted by the device.
Tx Data Bytes The number of simulated data bytes transmitted by the device.
Throughput The device’s throughput (in Mbps).
Status The current operating state of the nodes which can be any of the following:
e TXData
e TxACK

e Random Backoff

e Virtual Carrier Sense
¢ RxACK

« CCA

Note: The Status column of the Device Table is color-coded as described by the color legend listed
across the bottom of the Throughput Simulator window.

Simulation View Menus and Windows

The Menu bar on the Simulation view also has three menu groups, each containing various menu options for simulating
survey data. The File and Viewmenus contain options that are specific to the Simulation view only. (The Help menu content is
the same for all screens.)

File Menu

The Simulation view includes an additional option to the standard File menu options: Save Simulation opens the Save
Simulation dialog box where you can save the simulated data as a file.

View Menu

The View menu on the Simulation view includes additional options:

Menu Option Description
Vertical View Compare |Allows you to compare pre- and post-simulation data side by side.
Horizontal View Compare |Allows you to compare pre- and post-simulation data horizontally.

Simulation Toolbar

The following table describes additional tools available in the Simulation view.

Icon Name Description
s Save Sim Same as File > Save Simulation.Enables you to save the simulation project.
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Simulation View

Vertical Same as View > Vertical View Compare, Changes the Map view to vertical orientation.
Compare
Horizontal  |Same as View > Horizontal View Compare. Changes the Map view to horizontal orientation.
Compare
. Simulation Opens the Simulation window, which allows you to perform data simulations.
ﬁ Add Sim- Opens the New AP Properties window where you can specify the properties of the AP to be used in
: ulation AP data simulation.
c@ Help Opens AirMagnet Survey’s Help window.
Throughput [Opens the Throughput Simulator tool, which allows you to view predicted throughput speeds and
||§| Simulator bandwidth consumption for a custom-designed network. See Simulating Network Throughput for

more details.
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Multiview Map View

Multiview Map View

In this chapter:

MUV eW OV eIV eW 155
Opening Multi-Floor SUrvey Projects .. ... ... ... ... ... . 155
Single Project in MUltIVIeW .. ... . 156
Project WinNdoOW ... . o 157
ChaNNel S SID TrEe .. . . 158
MultiView Menus and OplioNS .. .. 159
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MultiView Overview

MultiView is similar to the Display view but you can display and compare up to four different surveys at the same time. When
multiple surveys are loaded, each pane in the window acts individually. You can view different survey data files in each
pane. A blue box highlights the currently active pane, as shown below.

e Begin by opening the projects that you want to include. You can then select various options to compare surveys, bands,
channels, SSIDs, etc. between the projects.

* You can also open a single project in the MultiView View to compare different parts of the same project in each pane.

File Edit View Help

i (% Panner ¥ Multi Floor Planner & Survey Display [{] Simulation Muttiview | 2 Difview € arwise Reparts

2| W QAREE kBB W veoen (B HE
P} v| -~

= Multi-Floor " Signal Strength {1st Al - X
= 802 11ac_indoorsvp _UVIII (NIANNN ”,I II! 111
T 5 site Map = 1m=2s0ft XY): 187.60 ft x 161.38 ft ScwianaI
-[¥] Augustine-2ndfloor jpg = = dn)
553 Survey Data = i
. ActiveSurvey1.svd = 10
P PassiveSurvey1svd =
-4 [ ActivelPedSurvey1.svd = 20
=22 802_11ac_Indoor_powr APs svp =
5-[i5] Ste Map = = .30
-] Augustine-2ndfloor jpg =
J-d) Survey Data 3 40
f. ActiveSurvey1.svd =
{8 P PassiveSurveylsvd = 50
-4 [ ActivelPerfSurvey.svd =
= &0
=] | -70
[ Select All [4]2.4GHz [/]5GHz [~ 6GHz ~ X W
=] 802_11ac_Indoor.svp = -80
Multi-Floar
=8 e sl tndoro il Signal Strength (1st AP) - <0
3 1in.=2680ft  Dimensions(XxY): 187.60 fix 161.28t .-100

FEEEE I

ac_|ndoor_powr APs.svp

© Chanrel & S50 = 202_11ac_Indoor_powr APs svp 2

All checked Channels

For more information, see

o The Project Window , which information for all survey projects opened in the MultiView, including individual components
in each project.

« The Channel/SSID Tree, which shows the APs and SSIDs detected in the current data file(s).

e MultiView Menus and Options

Opening Multi-Floor Survey Projects

The MultiView view is used for analyzing whether APs on a certain floor can provide RF signals strong enough to cover
wireless stations on floors above and/or below and how APs on adjacent floors could interfere with one another in terms of
channel allocation, service quality, network security, etc. However, to analyze RF data across multiple floors in a single
building, you must collect data from each of the floors involved. This means that you first of all need to create a Survey
project for each of the floors, perform the site surveys individually floor by floor, and save the survey data for each floor
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separately. Once data are collected, you need to open the one of the Survey projects first on the Display view, and then bring
up the MultiView view to open (import) the other survey projects. After all the projects are loaded on the MultiView view, you
can use the tools on the view to analyze the data.

The following procedures show how to open and analyze survey data involving multiple floors.

To analyze multi-floor survey data:
1. From the Display view, click File > Open Project.... The Open dialog box appears.
2. Browse to a Survey project (.svp) file and click Open. The project opens on the Displayview.

3. Click the radio button in front of the Survey Data file. The data loads.

4. Click MILRew) on the Navigation bar. The MultiView view opens with the project displayed.

5. To import additional floors, click File > Import Multi-Project.... The Project Import window appears.
Project Import @

Project

[ C:\Program Files [26]\bit agnet Inchéitd agnet S urveyoryDemoProjects\INDOOR ndoor. svp

[ C:\Program Files [x86]x8M agnet InchAitdagnet S urveyar\DemoProjects\B02_114CK02_11ac_lndoorsvp
[ C:\Program Files [xB6/580 agnet Inchditdagnet SurveyorsDemoProjectssPlannersPlanner svp

[ C:\UsershiconmiD ocumentshsurvey projectsiindoor_simulation_001.svp

[] Owenwrite Current Projects [New S ession) [ Single Project Multi*fiew

7. Click the check box(es) corresponding to the subproject file(s) you wish to import, and click Import. The selected project
file(s) appear on the Multi View view.

Note: A “main project” is the survey project that you first open on the Display view. Any survey project that is opened
(imported) afterward on the MultiView view is a “subproject”. AirMagnet Survey PRO allows you to display multi-floor survey
data for up to four floors on the MultiView view at the same time. For better data representation, it is recommended that you
merge all the survey data for each floor to create a merged file and then compare the merged files on the Multi View view.

The MultiView view can also help you compare several different surveys in a single project, using the Single Project Multi View
function.

Single Project in MultiView

When you import additional project in MultiView, you may also choose to view a single project in the four different panes to
compare different parts of the same project in each pane.

To view a single project in MultiView mode:

1. Open the Project Importview.

2. Check the box for the file you wish to view (you may need to browse to find the project to import).
3. Check the “Single Project Multi View” box at the bottom.

4. Click Import. This displays the single project you loaded displayed in all four panes.
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5. Click the radio buttons for the survey data you wish to load in each individual pane. Select your desired view options.

Project Window

The Project Window on the MultiView view displays all the survey projects that you have opened (imported), including the

individual components in each project.

- 157 -



Multiview Map View

E= Multi-Floor
- Indoor.svp
=47 Site Map
Aitd agnet HQ 1st Floor - Reception and
=3y Survey Data
A ActiveSurvey!1G.zvd
(P ActiveSurvey!1é.svd
" P PassiveSurvey].svd
7 L PassiveSurvey]_STA svd
& A Mergedictivel 140G, svd
0 A Filtered? svd
2231 2nd Floorsvp
=47 Site Map
Aittdagnet HO 2nd Floor - Sales and Ma
=3y Survey Data
0 A ActiveSurvey11G-1.swd
0 A ActiveSurvey11G-2svd
A ActiveSurveyl1G-Zevd
1A ActiveSurvey11G-4.avd
1A ActiveSurvey1a-1 svd
1 A ActiveSurvey114-2 svd
P PassiveSurveyl svd
L PassiveSurveyl _STA svd
P PaszsiveSurvey? svd
L
A
A
P

.

PazziveSurvey? STA swd
Mergadictivel1G.2vd
Mergedactivel 14 svd
MergedPazzivel. svd

A Mergedictivel1A0G. svd

= 3rd Floor.svp
=7 Site Map

Airtd agnet HO 3rd Floor - Engineering ar

=-3) Survey Data

9000000000

Note: AirMagnet Survey displays multiple survey projects in the order they are opened, with the one that is opened first
placed on top of the list of projects in the Project Window. For this reason, the main project should appear on the top
because it is supposed to be opened first.

Channel/SSID Tree

The Channel/SSID Tree on the MultiView view shows the APs and SSIDs detected in the current data file(s). The following
figure illustrates how channels and SSIDs are organized under their respective projects. This makes it easy to view, check and
uncheck APs and SSIDs as desired to see how changes are reflected in multiple surveys.
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The Toolbar includes Automatic Multi Select @ This feature enables you to turn the automatic selection feature on or
off. With it turned on, data about the APs selected in one Map Window automatically displays in the other Map Window(s) if

its RF signals are also contained (collected) in the preset(s). This enables you to easily visualize and compare how RF signals
propagate across the floors.

MultiView Menus and Options

File Menu

The File menu in MultiView includes the following options:
Import MultiView Project: Use this option to import up to four projects for MultiView comparison.

Close Subproject: Enables you to select a subproject file to close without closing the entire survey project.

View Menu
The View menu includes the following options:
Swap Left/Right Views: Toggles two images left and right.

Swap Top/Bottom Views: Toggles two images up and down.

MultiView Toolbar

The toolbar contains the commonly used tools for analyzing multi-floor data. Most of these tools are identical to the options
found in the File or View menus of the view. Some additional tools for Multiview are described in the following table:

Icon [Name Description
=7] |Open Subproject|Allows you to select and open a subproject of a multi-floor survey project.

3

Four View Displays the site maps used in a multi-floor project in four separate mini windows.

Swap Left/Right [Toggles two images between left and right.

Hl
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—
—

Swap Top/Bot-
tom

Toggles two images between up and down.

Automatic Multi
Select

Turn the automatic selection feature on or off. With it turned on, data about the APs selected in
one Map Window is automatically displayed in the other Map Window(s). See Channel/SSID Tree,

Legend

The color legend on the Multi View view works in the same manner as the one found on the Display view.
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DiffView and Data Analysis

AirMagnet Survey’s DiffView and other powerful analytical features allow you to visually analyze network performance and
validate WLAN deployment using collected data. This section explains how to use the various analytical tools on the Display
view and DiffView to analyze data you have collected.

In this chapter:

DiffView: Compare Surveys and Site Plans ... ... .. . 162
Evaluate Overall Site Signal Coverage .......... ... .. . 163
Identifying Coverage Cells by Individual APs ... ... ... .. . ... .. 164
Determining the Number and Placement of APS ... .. ... ... . .. . 165
Determining Cell OVerlap ... ... 166
Identifying Provisioned Bandwidth and Speed . ... ... ... ... 166
Identifying Predictive Downlink Bandwidth and Speed ................. ... ... ... ... 167
Identifying Adjacent or Co-Channel Interference ......... ... ... .. . ... . . . 168
Viewing Current Channel Allocation .. ... . ... . . . 169
Identifying Channel NOISe ... ... . . . . . 169
Evaluating Site Security Status ... ... ... . . ... 170
Viewing Wi-Fi 4,5, 6,and 7 Operating Mode ........ ... ... ... .. ... . . . . i 170
View Wi-Fi4,5,6,and 7 MCS Index Data ........... ... ... ... i 171
Viewing Wi-Fi 4, 5,6, and 7 Channel Width ... . . . . 172
Identifying Wi-Fi 5 Channel Overlap .............. ... . 173
Using the Real-Time AP Locator ............ ... . . . 177
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DiffView: Compare Surveys and Site Plans

Note: The dimensions of projects (width and height) must be identical to use this feature.

Oftentimes you may wish to display multiple projects or data files (surveys and/or site plans) side-by-side to view the
differences between them. This can be particularly useful in displaying changes made to a network environment over time.
For example, a newly-conducted site survey or site plan can be compared with one taken months earlier to identify any new
sources of interference or devices that have been added in the meantime.

>

If the data files you intend to compare are in different projects, you must use the (Import Survey Data) button to

import the data file from the project.

Typically, you can compare the same data types; however, the Diff view enables the comparison of some different data types.
If the data type is not available, the data type reverts to blank.

For example, as shown in the following screen shot, you may compare Wi-Fi 5 actual uplink throughput in an iPerf data file to
PHY Data Uplink Rate. In this case, you must choose iPerf Throughput Down in the bottom left (source) and PHY Data
Downlink Rate in the bottom right (destination).

[ AtognetSurveyProtessonalEdton -Indoorsip — = - [ |
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To compare the results of two data files:

1. Open the project that contains the two data files for comparison. As noted above, if the data files are in different projects,
open one project and import the data file into it.

DiffVi
2. From the Navigation bar, clickM(Diffview) to open the project in multiple frames.
3. From the Project Window, click the ‘+’ sign to expand the Survey Data under Survey One, select to open the first data file.

4. From the Project Window, click the ‘+’ sign to expand the Survey Data under Survey Two, select to open the second data
file. Now data contained in the two files are displayed on the view.

The top pane of the view now displays a heatmap that shows the difference between the two surveys at any given location on
the site (map). Areas marked in red indicate that Survey One (bottom left pane) is stronger and areas marked in green
indicate that Survey Two (bottom right pane) is stronger.

You may use the data type drop-down in each bottom pane to view data by various data type options. In some cases you may
be able to compare different data types. If the application permits the comparison, the choices are accepted, otherwise
unselected panes show as blank in the data type drop-down.

The blue border around a pane indicates it is the pane in focus.

See also:
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Viewing Specific Signal Comparison Data

Viewing Specific Signal Comparison Data
You can compare the signal strength of any location on the heatmap in the selected data files using the DiffView window.

1. Open the project that contains the two data files for comparison. (If the data files are in different projects, open one
project and import the data file into it.)

DiffView
2. From the Navigation bar, click DiffviewL to open the project in multiple frames, one for each project.

3. Select Signal Strength for each of the bottom panes. These show data from two different survey projects, and the top
pane shows the differences between the two.

4. Place the cursor at a spot on the site map to get the measurement details of that location.
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Evaluate Overall Site Signal Coverage

To evaluate the overall RF signal coverage at the site:

1. If your project includes more than one survey, you may choose to merge the survey data files before performing data
analysis.

From the Project Window, select the desired data file.

Click the SSID tab and select the SSID from the SSID List.

From the Data Type drop-down menu, select Signal Strength.

From the Toolbar drop-down, select View Overall.

Use the colors on the Legend to determine the signal strength at different locations.

Set the upper and/or lower limit of signal strength on the Legend.

© N o 0k~ w N

Move the cursor to different locations to view details of signal strengths from the pop-up view.
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Note: Areas of different signal strengths are indicated by different shades of colors. Areas that fall out of the signal strength
range are gray (as shown above).

Identifying Coverage Cells by Individual APs

To identify the coverage cells by individual APs:

1. If your project includes more than one survey, you may choose to merge the survey data files before performing data
analysis.

From the Project Window, select the desired data file.
Once the data are loaded, click the SSIDtab and highlight an SSID from the SSIDList.

From the Data Type drop-down menu, select Signal Strength.

o o wn

From the drop-down on the Toolbar, select View per AP. Areas covered by different APs are shown in different colors, as
shown in the following examples.
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Determining the Number and Placement of APs

To determine the optimal number and placement of APs:

1. If your project includes more than one survey, you may choose to merge the survey data files before performing data

analysis.
2. From the Project Window, select the desired data file.
3. Once thefile is loaded, click the SSIDtab and select an SSID.
4. Uncheck the APs that are of no interest to you.
5. From the Data Type drop-down menu, select Signal Strength.
6. From the drop-down on the Toolbar, select View per AP. This displays the APs in the color as they appear in the SSID
List.
For Survey:
B 00O WO MR | et 1 A) i
é P,
For Planner:
" T e T T T il i T il T 1|

Note: The figures above shows two APs selected; the heatmap reveals that these APs provide coverage for virtually the entire
map.
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Determining Cell Overlap

To determine a cell overlap:

1. If your project includes more than one survey, you can choose to merge the survey data files before performing data
analysis.

From the Project Window, select the desired data file.
From the Channel/SSID Tree, click the SSIDtab and highlight an SSID of interest.
Make sure all APs under the SSID are checked.

o &> wn

From the Data Type drop-down menu, select Signal.

6. From Toolbar, click (Overlap).

T A B W e W C]

it 5072150

fn-san

S B B i e W T

Note: The overlap areas of the AP coverage cells are shown in red.

Identifying Provisioned Bandwidth and Speed

To identify the provisioned bandwidth and speed of an AP for an Active or iPerf survey:

1. From the Project Window, select a data file.
2. From the Channel/SSID List, select the SSIDtab and highlight the SSID of interest.

3. From the Data Type drop-down menu, select Measured PHY Data Rate Up/Measured PHY Data Rate Down (iPerf
Survey only). The Legend on the right changes to a color bar consisting of different color blocks, each representing a
specific speed.

4. Hover the cursor over a spot on the site map to get a pop-up detailed data from the tooltip.

5. Click a location on the site map to get a detailed measurement display at the bottom of the screen.
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Note:When using an Wi-Fi 5 adapter, the option changes to PHY Connection Rate. Choosing this option displays the single
PHY data rate for the connection that is reported from the non-preferred adapter.
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Identifying Predictive Downlink Bandwidth and Speed

To identify the provisioned bandwidth and speed of an AP:
1. From the Project Window, select a data file.
2. From the Channel/SSID List, select the SSID tab and highlight the SSID of interest.

3. From the Data Type drop-down menu, select Predictive PHY Data Rate Down and then Predictive PHY Data Rate
Down (AP). The Legend changes to a color bar consisting of different color blocks, each representing a specific speed.
The heatmap shows the predicted PHY Data Rate.

The Measurement Details appear at the bottom of the screen, showing the details of the measurements.

Note: If there are multiple APs covering a given location, the PHY rate for the AP with the strongest signal strength is
shown.

4. Place the cursor at a spot on the site map to get detailed data from the tooltip.

5. Click a location on the site map. The Measurement Details pane appears at the bottom of the screen, showing the details
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of the measurements.
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Identifying Adjacent or Co-Channel Interference

To identify adjacent channel or co-channel interference in Display View or MultiView:

1.

If your project includes more than one survey, you may choose to merge the survey data files before performing data
analysis.

From the Project Window, select the desired data file.

From the Channel/SSID pane, click the Channel tab and select the channels adjacent to each other, such as Channels 1,
2,3,0r4,5,6,and so on.

From the Data Type drop-down menu, click Channel Interference.

On the Legend bar, drag up from the bottom (weakest signal strength) to set the minimum interference level to be
shown. This ensures that only areas that exceed a certain amount of interference are displayed.
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NOTE: Some single APs may use multiple SSIDs under different BSSIDs, which can create the appearance that there is much

more interference than really exists. You can use AP grouping to assign these multiple SSIDs to the same AP. See AP Grouping
for more information.

Viewing Current Channel Allocation

To identify current channel allocation:

1. If your project includes more than one survey, you may choose to merge the survey data files before performing data
analysis.

2. From the Project Window, select the desired data file.

3. From the Channel/SSID pane, select the Channel tab, make sure all channels are selected (checked), and highlight
Channel at the top of the channel list.

4. From the Data Type drop-down menu, select Signal Strength.

5. From the Toolbar drop-down, select View Per Channel. Each of the channels that are selected are displayed in different
a color.

For Survey:

T T N S T N ]

P 2 S I i B i e S

For Multi Floor Planner:

— e . [

Note: The channels in the Channel tab are color-coded; the colors in the Map Window indicate the channels in use.

Identifying Channel Noise

To identify channel noise:

1. If your project includes more than one survey, you can choose to merge the survey data files before performing data
analysis.

2. From the Project Window, select the desired data file.
3. From the Channel/SSID pane, click the Channel tab.

4. From the Data Type drop-down menu, select Noise Level. The Legend changes to a color bar consisting of different
color blocks, each representing a specific noise level.
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5. Place the cursor at a spot on the site map to get detailed data from the tooltip.

6. Click a location on the site map. The Measurement Details pane appears at the bottom of the screen, showing the details
of the measurements.
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Evaluating Site Security Status

This section helps you identify any unexpected or unidentified APs or stations in the current wireless environment. The
presence of such devices could signify potential network attacks at worst and improperly configured network devices at best.

To evaluate site security status:

1. From the Project Window, select a passive survey data file.

2. Wait until the data are loaded and displayed in the Map Window.

3. From the Data Type drop-down menu, select Signal Strength.

4. From the Channel/SSID pane, click the SSID tab, look for any SSID marked "Unknown," and select it.

Viewing Wi-Fi 4, 5, 6, and 7 Operating Mode

To provide a better view of Wi-Fi 4, 5, 6, and 7 information in the wireless network, Survey’s Display view provides a Wi-Fi 4, 5,
6, and 7 AP Operating Mode heatmap selection. When you view this data type, the heatmap displays different colors for areas
where APs are using Legacy, Mixed HT, Mixed VHT, Mixed HE, Mixed EHT, or Greenfield HT operating modes.

To view the Wi-Fi 4, 5, 6, and 7 operating mode heatmap:

1. From Survey’s Display view, load a data file with Wi-Fi 4, Wi-Fi 5, Wi-Fi 6, and/or Wi-Fi 7 information.

2. Use the Data Type drop-down to select AP Operating Mode.

3. Hover the mouse over any segment of the new heatmap to view the operating mode of the AP detected at that location.
4

Click any spot on the heatmap to see the detailed measurements for that spot at the bottom of the screen.
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The heatmap indicates the signal strength of the strongest AP detected in the mode color. The table below describes the
meaning of each color.

Color [Mode Description

Blue |Legacy Legacy mode represents areas where non-Wi-Fi 4 devices are operating. Blue portions of the map are
regions where a “legacy” device (802.11a/b/g AP) is strongest.

Green |Greenfield |Greenfield mode contains APs operating at High-Throughput (HT) transfer rates. These rates can be

HT sustained by Wi-Fi 4 devices. Green portions of the heatmap represent regions where the strongest AP is

running at HT transfer rate.

Purple |Mixed HT [Mixed mode contains both Wi-Fi 4 and legacy devices. Purple portions of the heatmap indicate that an
Wi-Fi 4 AP is running in the mixed mode.

Orange [Mixed VHT |Mixed VHT (Very High Throughput) mode is for Wi-Fi 5 APs only. The Wi-Fi 5 standard runs only in this
mode. Orange portions of the heatmap represent regions where the strongest .11ac AP is running.

Cyan [Mixed HE |Mixed HE (High Efficiency) mode is for Wi-Fi 6 APs only. The Wi-Fi 6 standard runs only in this mode.
Cyan portions of the heatmap represent regions where the strongest .11ax AP is running.

Dark |Mixed EHT [Mixed EHT (Extremely High Throughput) mode is for Wi-Fi 7 APs only. The Wi-Fi 7 standard runs only in

Green this mode. Dark green portions of the heatmap represent regions where the strongest .11be AP is
running.

View Wi-Fi 4, 5, 6, and 7 MCS Index Data

During an Active, Active iPerf or Passive survey, AirMagnet Survey automatically records the Modulation Coding Scheme (MCS)
detected from Wi-Fi 4, 5, 6, and 7 APs. This number can range from 0 to 31 for Wi-Fi 4 APs, 0 to 9 for Wi-Fi 5 APs, 0 to 11 for Wi-
Fi 6 APs, or 0 to 13 for Wi-Fi 7 APs, with higher numbers corresponding to higher data transfer rates.

You can view MCS information for both Tx (transmission rate) and Rx (receive rate) for detected APs. These data indicate the
MCS for the AP with the strongest signal strength at a given point on the survey floor plan.

To view MCS information:

From the Display view, load a data file that contains Wi-Fi 4, 5, 6 and/or Wi-Fi 7 APs.

Use the Data Type drop-down to select MCS Index.

1
2
3. Select Wi-Fi 4, Wi-Fi 5, Wi-Fi 6, or Wi-Fi 7: Max MCS (AP Tx) or (AP Rx) data type. The heatmap refreshes.
4

Hover the cursor over any point in the survey to view the tooltip of the exact MCS index for the strongest Wi-Fi 4, Wi-Fi 5,
Wi-Fi 6, or Wi-Fi 7 AP detected for that spot.

5. Click any point in the heatmap to see the measurement details at the bottom of the screen. (See the example below.)
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Viewing Wi-Fi 4, 5, 6, and 7 Channel Width

The Channel Width data type allows you to easily view the different channel width used by Wi-Fi 4, Wi-Fi 5, Wi-Fi 6, and Wi-Fi 7
devices in the network environment.

To view the channel width heatmap:
From the Display view, load a data file that contains Wi-Fi 4, Wi-Fi 5, Wi-Fi 6, and/or Wi-Fi 7 APs.
Select the Channel Width data type. The view refreshes.

w N

Hover the mouse over any point in the heatmap to see the tooltip for the channel width at that spot.

4. Click any point on the heatmap to see detailed measurements at the bottom of the screen.
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The heatmap displays the colors corresponding to the strongest AP's channel width color at the given point.

The table below describes the color schemes for various channel widths.

Color Width
Blue 20 MHz (channel width used by 802.11a/b/g operating at legacy speeds)

-172 -



DiffView and Data Analysis

Purple 20 MHz-HT (used by Wi-Fi 4, 5, 6, and 7 APs)
Green 40 MHz (used by Wi-Fi 4, 5, 6, and 7 APs)
Orange 80 MHz (used by Wi-Fi 5, 6, and 7 APs)

Light Blue 160 MHz (used by Wi-Fi 5, 6, and 7 APs)
Dark Green  [320 MHz (used by Wi-Fi 7 APs)

Identifying Wi-Fi 5 Channel Overlap

While wider Wi-Fi 5 channels are capable of transmitting higher throughput rates, they are also more susceptible to RF issues
such as channel interference, utilization, etc. If an Wi-Fi 5 radio detects an issue, it can attempt to retransmit at a smaller
available channel width in accordance to the Wi-Fi 5 specifications.

Example:

A 160 MHz channel can retry as a 80 MHz wide channel.
A 80 MHz channel can retry as a 40 MHz wide channel.
A 40 MHz channel can retry as a 20 MHz wide channel.

A Wi-Fi 5 wide channel uses a specific 20 MHz channel as the primary channel. This primary channel contains the Wi-Fi beacon
information, for example. The remaining 20 MHz channels used by an Wi-Fi 5 wide channel are referred to as secondary
channels.

If an Wi-Fi 5 radio retransmits at a smaller channel than originally allocated, this affects overall throughput and performance.
This reduction in throughput and performance of an Wi-Fi 5 wide channel is what the Wi-Fi 5 Channel Overlap heatmap

conveys.

To identify Wi-Fi 5 channel overlap:

1. From the Display view, load a data file that contains Wi-Fi 5 information.

2. From the data type drop-down menu, select Wi-Fi 5 Channel Overlap.

3. Hover the mouse over any point in the heatmap to see the tooltip for the channel overlap information for that spot.
4. Click any spot in the heatmap to see detailed measurements at the bottom of the screen.
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Please note that for all of the following examples, AP #1 and AP #2 have overlapping coverage.

Red areas indicate overlapped primary channels. These are areas where overall performance is significantly lower because
two AP/Client connections cannot transmit simultaneously on the overlapping channel.

For example:
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D AP #1 is set to transmit an Wi-Fi 5 80 MHz wide channel with the primary channel on channel 36 (36P + 40 + 44 +
48).
. AP #2 is set to transmit an Wi-Fi 5 40 MHz wide channel with the primary channel on channel 36 (36P + 40).
or:
D AP #1 is set to transmit an Wi-Fi 5 80 MHz wide channel with the primary channel on channel 36 (36P + 40 + 44 +
48).
. AP #2 is set to transmit a 20 MHz channel on channel 36.

Orange areas indicate overlapped secondary channels that cause fallback to a 20 MHz channel. These are areas where overall
performance is much lower because two AP/Client connections on overlapping Wi-Fi 5 wide channels must fallback to a
slower 20 MHz channel to transmit simultaneously.

For example:

. AP #1 is set to transmit an Wi-Fi 5 80 MHz wide channel with the primary channel on channel 36 (36P + 40 + 44 +
48).

. AP #2 is set to transmit an Wi-Fi 5 40 MHz wide channel with the primary channel on channel 40 (36 + 40P).

. AP #1 reduces its transmitting channel to a single 20 MHz channel on channel 36. AP #1 is unable to use channels
40, 44, and 48.

. AP #2 reduces its transmitting channel to a single 20 MHz channel on channel 40. AP #2 is unable to use channel
36.

Yellow areas indicate overlapped secondary channels that cause fallback to a 40 MHz channel. These are areas where overall
performance is slightly lower because two AP/Client connections on overlapping Wi-Fi 5 wide channels must fallback to a
slower 40 MHz channel to transmit simultaneously.

For example:

. AP #1 is set to transmit an Wi-Fi 5 80 MHz wide channel with the primary channel on channel 36 (36P + 40 + 44 +
48).

. AP #2 is set to transmit an Wi-Fi 5 80 MHz wide channel with the primary channel on channel 48 (36 + 40 + 44 +
48P).

. AP #1 reduces its transmitting channel to a 40 MHz wide channel on channels 36P and 40. AP #1 is unable to use

channels 44 and 48.

. AP #2 reduces its transmitting channel to a 40 MHz wide channel on channels 44 and 48P. AP #2 is unable to use
channels 36 and 40.

Green areas indicate no significant channel overlap. Channel overlap does not impact overall performance in these areas. An
Wi-Fi 5 wide channel does not have a 20 MHz channel that is overlapped by any 20 MHz channels from other APs.

For example:
. AP #1 is set to transmit an Wi-Fi 5 40 MHz wide channel with the primary channel on channel 36 (36P + 40).
D AP #2 is set to transmit an Wi-Fi 5 40 MHz wide channel with the primary channel on channel 48 (44 + 48P).
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Background

Transmission
Initiator

Transmission
Recipient

In Wi-Fi 5, a transmission initiator sends a Request to Send (RTS) message set with a channel bandwidth to use for a trans-
mission; for example, 80 MHz. A transmission recipient sends a Clear to Send (CTS) message set indicating how much channel
width is available and not currently used. This mechanism allows two APs with overlapping 80 MHz channels to transmit sim-
ultaneously by falling back to an available 40 MHz or 20 MHz channel, if the full 80 MHz channel is not available. An example
of how this works is shown in the following diagram:

Channel #:] 36

o A I 0
AL | I N
40 MHz
o |

Channel #:] 36

| L L
AP | I
40 MHz
I —

Example 1: Red

Channel #:] 36

o EA I S

APHL | I N
40 MHz
-—

Channel #:] 36

T T

S T
40 MHz
—

Example 2: Orange

Channel #] 36

o EA I B0

APHL | I N
40 MHz
-—

Channel #:] 36

e I LI
AP ]
40 MHz
- —

Example 3: Yellow

In each example, AP#1 and AP#2 have overlapping 80 MHz channels. The primary 20 MHz and 40 MHz channels are indicated
by "P". Each example has a different level of potential performance impact due to the difference in primary channel

assignments.

Example 1 shows the situation highlighted in red in the Channel Overlap heatmap. Each AP has the same primary channel.

Therefore, they cannot transmit simultaneously if any of the 20 MHz sub-channels are in use.

Example 2 shows the situation highlighted in orange in the Channel Overlap heatmap. Each AP has a different 20 MHz
primary sub-channel, but the same 40 primary MHz sub-channel. Therefore, to transmit simultaneously, each AP can fallback
to its 20 MHz primary sub-channel to transmit, but not to a 40 MHz sub-channel.

Example 3 shows the situation highlighted in yellow in the Channel Overlap heatmap. Each AP has a different 20 MHz primary
sub-channel and a different 40 MHz primary sub-channel. Therefore, to transmit simultaneously, each AP can fallback to its 40

MHz primary sub-channel to transmit.
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Tooltip Text Explanation

Channel Overlap

Overlapped Primary Channels:
APH#1l — (0:10:18:A9:78:93 153 P, 80MHz, 149-161 -84dBm

AP#2 —  D8:EB:97:A4:C9:03 153 P, 80MHz, 149-161 -62dBm

S

Primary
Channel
Channel
Width

Channel
Range

The heatmap tooltip text for Overlapped Primary Channels is shown above. There are two APs with 80 MHz channels that

overlap completely on channels 149, 153, 157, and 161. The primary channel of each AP is the same: 153. Therefore, these
two APs cannot transmit simultaneously.

Channel Overlap

Overlapped Secondary Channels - Fallback to 20 MHz:
APHL —> 84:1B:5E:03:DF:71 149 P, 80MHz, 149-161 -56dBm
AP#2 —— D8:EB:97:A4:C9:03 153 P, 80MHz, 149-161 -68dBm

T

Primary
Channel
Channel
Width
Channel
Range

The heatmap tooltip text for Overlapped Secondary Channels with Fallback to 20 MHz is shown above. There are two APs
with 80 MHz channels that overlap completely on channels 149, 153, 157, and 161. The primary channel of AP#1 is 149 and
the primary channel of AP#2 is 153. A 40 MHz channel fallback for each AP would be on channels 149-153 which would

overlap and prevent simultaneous transmission. Therefore, these two APs must fallback to their non-overlapping 20 MHz
primary channels - 149 and 153 - to transmit simultaneously.

Channel Overlap

Overlapped Secondary Channels - Fallback to 40 MHz:
APHL —> 84:1B:5E:03:DF:71 149 P, 80MHz, 149-161 -56dBm
AP#2 ——— D8:EB:97:A4:C9:03 157 P, 80MHz, 149-161 -68dBm

T

Primary
Channel
Channel
Width

Channel
Range
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The heatmap tooltip text for Overlapped Secondary Channels with fallback to 40 MHz is shown above. There are two APs
with 80 MHz channels that overlap completely on channels 149, 153, 157, and 161. The primary channel of AP#1 is 149 and
the primary channel of AP#2 is 157. AP#1 can fallback to a 40 MHz channel on 149-151, and AP#2 can fallback to a 40 MHz
channel on 157-161, to transmit simultaneously.

Using the Real-Time AP Locator

Survey’s AP Locator feature uses collected survey data to calculate approximate locations for detected APs. Before starting to
survey the desired location for a particular AP, you must perform the following steps to configure the feature and fine-tune
the scanning process. These steps ensure that the device is located with both precision and speed.

Note: These steps focus on conducting a GPS survey; this information may vary slightly if you are conducting AP Location
surveys on non-GPS projects.

To locate an AP:

1. During project creation, import the map of the site to be surveyed; you must specify the type of environment in which the
AP is located (that is, Restricted Closed Office for a standard office building) for the Survey Environment, as shown in the
figure below.

Survey Environment

(") Resticted Closed Office - Hotel, Walled Office

{(*) Open Space Office - Cubicles, etc.

() Commercial - Warshouse, &iport, Convention Center, b all
(") Outdoor - Free Space (Mo RF Obstruction)

{7 Outdoor - Residential [Light FF Obstruction)

" Outdoor - Downtown [Severe BF Obstruction)

Note: If the site is a small portion of a larger GPS map, the image should be cropped just to cover the specific area to be
surveyed.

2. From the Settings tab of Survey’s Configuration dialog box, check Auto Position APs with signal greater than __ dBm
and specify a minimum signal level to be used (if desired). Click OKto save the changes.

%ﬁgutu Position APz with zignal greater tharé |-100 | dBm
izplay MALC addrezs only
Prompt for refresh after AP location change

Note: If "Auto Position APs..." is enabled, the survey retract button are grayed out (unavailable).

3. Place the external antenna (outside) on the roof of the car. It is recommended that an omnidirectional antenna be used
for best results.

4. Select the band (2.4, 5, or 6 GHz) in which Survey should operate and the channel on which the device is located, if
known. See the figure below.

250 ms |

200 ms W
150 ms

200 ms
780 ms
1 zec
B zec
10 zec

280 mz -

EEEEEERER

PR

Note: As shown in the figure above, the scan interval should be set to 250 ms for best results.
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5.

8.
9.

From the Survey view, select the Passive Survey option and use the drop-down list to select SSIDor AP, as needed. See
the figure below.

Survey Type | Passive - |[24/5.06Hz -

Ny =

If known, select the specific APor SSID to be located from the drop-down list. See the figure below.

Survey Type | Passive v ||24/50GHz |
|SSID Ll aruba-11 ac H

aruba-11ac -
| eH | MALC A¢ aruba-Bghz t

Note: If you select ANY from the SSID list, the Survey view cannot calculate AP placement until a specific AP is selected.
This can be done during the survey process by selecting the desired AP from the scrolling list in the passive survey
window, as shown in the figure below. After the selection has been made, the application tries to calculate the device’s
location. However, after the survey is completed, calculated positions of any additional APs detected are shown on the
Display view.

@ | MAC Address | ©) | @ [ | 551D -
1... BCF37FBA... 35 aruba-ap

11 ECFa7res.. 58 B 29 aubaap
=

Start the survey and drive slowly (between 5-10 mph) around the perimeter of the site.

@

Note: After some data are collected, an icon (#-11(BG)) representing the selected AP appears on the site map in its
calculated position. This icon moves about during the course of the survey as its location is recalculated from new data.
The AP icon is color-coded based on Survey’s confidence in the current location; the colors progress from red (lowest
confidence) through yellow, green, and finally, black (greatest confidence). This confidence level is also displayed in the
Passive Survey frame in place of the Signal/Noise ratio.

When the survey is completed, stop the survey and save the data.

View the data on the Displayview to analyze the results of the survey.
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1in.=32.90ft Dimensions [XH Y): 237 .30 ft 1 204.25ft
ey

Note: The Display view automatically places all APs detected during the survey, even though only one AP is shown on the
Survey view.
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AirWISE View

In this chapter:

ABOUt AIFWISE ViQW ... . 181
AIFWISE Requirements WindoW ... ... 182
Channel/SSID List ... 202
Configuring Pass/Fail Threshold Values .......... ... ... ... ... 202
Testing AirWISE Requirements Compliance on Site Map ... ... ... ... ... .. . . . . 203
Determining the Number of APs Needed inan Area ........... ... ... ... .. ... . . .. i 205
Managing AirWISE Requirement Policies .............. ... ... . 206
Selecting an AirWISE Requirement Policy ........ ... ... .. . ... i 207
Creating Custom Requirement Policies ... .. ... ... ... . . . . 207
Saving Changes to AIrWISE Policies ... ... ... ... ... ... . i 209
Removing AIFWISE PoliCies ........... ... .. i 210
AirWISE Menu and Toolbar Reference ........... ... ... 210
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About AirWISE View

AirWISE is a powerful and easy-to-use tool to review and change the design requirements for your wireless LAN. AirWISE uses
these requirements to automatically analyze your site survey data for problems.

To open the AirWISE view, click Qarwise on the Navigation Bar after you have opened a project.
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The list of requirements varies depending on which policy you select in the AirWISE Requirements Window. For more details
on each AirWISE requirement, see:

 Signal Coverage
e Multiple AP Signal Coverage

« Channel Interference

o Predictive PHY Data Rate Down Coverage

« Signal Noise Ratio Coverage

* Noise Level

o User Capacity

* Operating Mode

e Channel Width

e Wi-Fi 4 Highest MCS Index
o Wi-Fi 5 Highest MCS Index
e Wi-Fi 6 Highest MCS Index
e Wi-Fi 7 Highest MCS Index

o iPerf Throughput Up
e iPerf Throughput Down

« Cisco Location-based Services

e Measured PHY Data Rate Up Coverage

e Measured PHY Data Rate Down Coverage

» RSSI Neighboring Cell Coverage

o RSSI Serving Cell Coverage

e Throughput Downlink Coverage

» VoFi Packet Retry
« VoFi PHY Data Rate

« VoFi Signal Coverage
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* VoFi WiMOS

For more information, see the "AirWISE Requirements Window" below.

AirWISE Content Pane

When you select an AirWISE Requirements listing in the AirWISE Summary pane, the AirWISE Content window displays a
heatmap of the associated requirement.

@ AirMagnet Survey Professional Edition - Indoor.svp - a X
File Edit View Help
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3 Multiple AP Signal Coverage 0n -10
- Channel Interference 905

-3 Measured PHY Data Rate Up LEE] 20
-2 Measured PHY Data Rate Do.. 100.0

<3 Predictive PHY Data Rete Do NA -30
<J Signal Moise Ratio Coverage 644

<3 Noise Level 100.0 -40
<J User Capacity A

<3 Operating Mode 613 50
<2 Channel Width 1000

<3 WIiFi 4 Highest MCS Indlex 100.0 &0
<J Wi-Fi 5 Highest MCS Index 0o

Bselect Al @24GHz @5GHz B 6GHz

@ Channel
=@ CH (36,1)
W@ CH (36 P, 40MHz, 36-40)

@ Channel @ SSID Requirement  AitpSE

Using original data: All checked channels Selected APs 2

You can display additional information by clicking on the tabs in the bottom-left corner:

Flequirement  Ait15E
* Requirement: Opens the AirWISE Requirements window, which summarizes all the AirWISE requirements and the com-
pliance status of the WLAN site according to the data contained in the survey project file.

e AirWISE: Opens the AirWISE Content window, which shows the site map contained in the survey data collected. It allows
you to customize certain parameters to see how the changes would affect compliance with AirWISE Requirements.

AirWISE Requirements Window

The AirWISE Summary pane on the AirWISE view lists the default AirWISE requirement policy included with AirMagnet Survey.

As described in this section, new policies may be created and the default requirements can be customized to conform to your
particular needs.
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Regquirement Palicy SRR RIS

™ |

AIMWISE Requirements %% of Good Area | Fass/Fail |
Requirements Overview

< Signal Coverage
- Multiple AP Signal Coverage
<J Channel Interference 0.7 Fail
<J PHY Connection Rate Covera... [ [
- Predictive PHY Data Fate Do..
-J Signal Noise Ratio Coverage [P [P
-J Moise Level A, A,
<J User Capacity M M
<J Operating Mode 79.9 Fail
<J Channel Width 226 Fail
<3 'wWiFi 4 Highest MCS Index
<3 'WiFi & Highest MCS Index

<3 'Wi-Fi B Highest MCS Index

The AirWISE Summary pane displays the following AirWISE information:

* AirWISE Requirements: Click the down-arrow to select from a list of AirWISE Requirement policies. The list contains the
default AirWISE requirements included with AirMagnet plus any policies that you add.

* % of Good Area: Shows the status of the survey data in terms of compliance with requirement's configurable threshold
value. For example, if the requirement threshold value is set to -67 and all the data is -67 or greater for this requirement,
the percentage of good area is 100%. N/A indicates that this particular requirement is not applicable to the type of survey
data selected in the Display view.

« Pass/Fail: A configurable value that indicates whether the "% of good area" is in an acceptable threshold. For example, if
the Pass/Fail value is set to 100% and the "% of good area" is 80%, the Pass/Fail column reads "Fail." However, if the
Pass/Fail value is set to 80% and the "% of good area" is 80%, the Pass/Fail column reads "Pass."

In addition, by selecting an AirWISE Requirements listing, you can view the associated heatmap in the Content Pane.

Wi-Fi 4 MCS Index

e Threshold: Minimum Tx MCS Index required
o Default value: 15
o Pass/Fail default value: 100%

e For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation
This requirement allows you to view precisely which areas of the current survey data file meet the requirements specified by

the Minimum Tx MCS Index required threshold. Areas that meet the requirement are displayed in light green (), whereas
regions that do not reach the required MCS are displayed in a color assigned by the color-codes on the legend. Hover the
mouse over any given point to view a bubble help pop-up that displays detailed information about the APs detected at that
location.

Background

Wi-Fi 4 defines MCS (Modulation and Coding Scheme) which is an integer value (0 through 76) which determines the
modulation, coding rate, and number of spatial streams for a transmission. The following PHY data rate table illustrates the
possible combinations of MCS, Channel Width, and Short Guard Interval (SGI) which determines the PHY data rate, for MCS 0-
31.
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MCS Index [Spatial Modulation Type |Coding Rate |Data Rate (Mbit/s)
Streams 20 MHz Channel 40 MHz Channel
Non-SGI SGI Non-SGlI SGI
0 1 BPSK 1/2 6.50 7.20 13.50 15.00
1 1 QPSK 1/2 13.00 14.40 27.00 30.00
2 1 QPSK 3/4 19.50 21.70 40.50 45.00
3 1 16-QAM 1/2 26.00 28.90 54.00 60.00
4 1 16-QAM 3/4 39.00 43.30 81.00 90.00
5 1 64-QAM 2/3 52.00 57.80 108.00 120.00
6 1 64-QAM 3/4 58.50 65.00 121.50 135.00
7 1 64-QAM 5/6 65.00 72.20 135.00 150.00
8 2 BPSK 1/2 13.00 14.40 27.00 30.00
9 2 QPSK 1/2 26.00 28.90 54.00 60.00
10 2 QPSK 3/4 39.00 43.30 81.00 90.00
11 2 16-QAM 1/2 52.00 57.80 108.00 120.00
12 2 16-QAM 3/4 78.00 86.70 162.00 180.00
13 2 64-QAM 2/3 104.00 115.60 216.00 240.00
14 2 64-QAM 3/4 117.00 130.00 243.00 270.00
15 2 64-QAM 5/6 130.00 144.40 270.00 300.00
16 3 BPSK 1/2 19.50 21.70 40.50 45.00
17 3 QPSK 1/2 39.00 43.30 81.00 90.00
18 3 QPSK 3/4 58.50 65.00 121.50 135.00
19 3 16-QAM 1/2 78.00 86.70 162.00 180.00
20 3 16-QAM 3/4 117.00 130.00 243.00 270.00
21 3 64-QAM 2/3 156.00 173.30 324.00 360.00
22 3 64-QAM 3/4 175.50 195.00 364.50 405.00
23 3 64-QAM 5/6 195.00 216.70 405.00 450.00
24 4 BPSK 1/2 26.00 28.80 54.00 60.00
25 4 QPSK 1/2 52.00 57.60 108.00 120.00
26 4 QPSK 3/4 78.00 86.80 162.00 180.00
27 4 16-QAM 1/2 104.00 115.60 216.00 240.00
28 4 16-QAM 3/4 156.00 173.20 324.00 360.00
29 4 64-QAM 2/3 208.00 231.20 432.00 480.00
30 4 64-QAM 3/4 234.00 260.00 486.00 540.00
31 4 64-QAM 5/6 260.00 288.80 540.00 600.00

A Wi-Fi 4 STA is required to support MCS 0-7 in 20-MHz (non-SGI) mode; a Wi-Fi 4 AP is required to support MCS 0-15 in 20-
MHz (non-SGl) mode; all other MCS values and modes are optional.

MCS 32 is defined as 40-MHz HT duplicate format (BPSK "2 on both halves of the 40-MHz channel). MCS 33 through 76 define
Unequal Modulation MCS values, where the modulation type differs across spatial streams. For instance, MCS 33 defines a 2
spatial stream transmission with stream 1 modulated with 16-QAM and stream 2 modulated with QPSK.

For other AirWISE requirements, see AirWISE Summary.

Wi-Fi 5 MCS Index

e Threshold: Minimum Tx MCS Index required
o Default value: 9
o Pass/Fail default value: 100%

e For other AirWISE requirements, see AirWISE Summary.
Requirement Explanation

This requirement allows you to view precisely which areas of the current survey data file meet the requirements specified by

the Minimum Tx MCS Index required threshold. Areas that meet the requirement are displayed in light green (), whereas
regions that do not reach the required MCS are displayed in a color assigned by the color-codes on the legend. Hover the
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mouse over any given point to view a bubble help pop-up that displays detailed information about the APs detected at that
location.

Background

Selecting a modulation and coding set (MCS) is much simpler in Wi-Fi 5 than it was in Wi-Fi 4. Rather than the 70-plus options
offered by Wi-Fi 4, the Wi-Fi 5 specification has only 10. The reason for the dramatic simplification is that Wi-Fi 5 separates the
spatial stream number from the MCS number, and each spatial stream has the same MCS for Wi-Fi 5 radios. An MCS number
for Wi-Fi 5 is really about the modulation scheme of a spatial stream. The first 8 (0-7) are mandatory, and most venders
support all 10 MCS options in all products they bring to market. The following table illustrates the possible combinations of
MCS, Spatial Stream number, Short Guard Interval, and Channel Widths.

Spatial Wi-Fi 5 MCS |Guard 20 MHz Channel |40 MHz Channel |80 MHz Channel |160 MHz Channel
Streams Index Interval PHY Data Rate PHY Data Rate PHY Data Rate PHY Data Rate
1 0 LGl 6.5 13.5 29.3 58.5
1 0 SGI 7.2 15.0 32.5 65.0
1 1 LGI 13.0 27.0 58.5 117.0
1 1 SGI 14.4 30.0 65.0 130.0
1 2 LGl 19.5 40.5 87.8 175.5
1 2 SGI 21.7 45.0 97.5 195.0
1 3 LGI 26.0 54.0 117.0 234.0
1 3 SGI 28.9 60.0 130.0 260.0
1 4 LGl 39.0 81.0 175.5 351.0
1 4 SGI 43.3 90.0 195.0 390.0
1 5 LGl 52.0 108.0 234.0 468.0
1 5 SGI 57.8 120.0 260.0 520.0
1 6 LGl 58.5 121.5 263.3 526.5
1 6 SGI 65.0 135.0 292.5 585.0
1 7 LGI 65.0 135.0 292.5 585.0
1 7 SGI 72.2 150.0 325.0 650.0
1 8 LGl 78.0 162.0 351.0 702.0
1 8 SGI 86.7 180.0 390.0 780.0
1 9 LGl not used 180.0 390.0 780.0
1 9 SGI not used 200.0 433.3 866.7

To calculate potential data rates for more spatial streams, find the PHY rate for 1 spatial stream for the given MCS index,
guard interval (LGl or SGI), and channel width. Then, since Wi-Fi 5 scales linearly with streams, multiply the single-stream PHY
rate by the number of spatial streams.

Wi-Fi 6 MCS Index

o Threshold: Minimum Tx MCS Index required
o Default value: 11
o Pass/Fail default value: 100%

e For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation
This requirement allows you to view precisely which areas of the current survey data file meet the requirements specified by

the Minimum Tx MCS Index required threshold. Areas that meet the requirement are displayed in light green (), whereas
regions that do not reach the required MCS are displayed in a color assigned by the color-codes on the legend. Hover the
mouse over any given point to view a bubble help pop-up that displays detailed information about the APs detected at that
location.

Background

Wi-Fi 6 has a similar modulation and coding set (MCS) as Wi-Fi 5 with two additional modulations, 1024-QAM 3/4 and 1024-
QAM 5/6. However, Wi-Fi 6 uses a fixed 0.8 us Guard Interval for indoor environments. The following table illustrates the
possible combinations of MCS, Spatial Stream number, and Channel Widths.
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Wi-Fi 6 MCS Spatial 20 MHz Channel PHY[40 MHz Channel PHY|80 MHz Channel PHY[160 MHz Channel

Index Stream Data Rate Data Rate Data Rate PHY Data Rate
0 1 8.6 17.2 36 72.1
1 1 17.2 34.4 72.1 144.1
2 1 25.8 51.6 108.1 216.2
3 1 34.4 68.8 144.1 288.2
4 1 51.6 103.2 216.2 432.4
5 1 68.8 137.6 288.2 576.5
6 1 77.4 154.9 3243 648.5
7 1 86 172.1 360.3 720.6
8 1 103.2 206.5 432.4 864.7
9 1 114.7 229.4 480.4 960.8
10 1 129 258.1 540.4 1080.9
11 1 143.4 286.8 600.5 1201

To calculate potential data rates for more spatial streams, multiply the single-stream values by the number of spatial streams
(e.g., for 8 streams, multiple the single stream value by 8.)

Wi-Fi 7 MCS Index

e Threshold: Minimum Tx MCS Index required

e Default value: 13

o Pass/Fail default value: 100%

e For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation
This requirement allows you to view precisely which areas of the current survey data file meet the requirements specified by

the Minimum Tx MCS Index required threshold. Areas that meet the requirement are displayed in light green (), whereas
regions that do not reach the required MCS are displayed in a color assigned by the color-codes on the legend. Hover the
mouse over any given point to view a bubble help pop-up that displays detailed information about the APs detected at that
location.

Background

Wi-Fi 7 has a similar modulation and coding set (MCS) as Wi-Fi 6 with an additional modulation of 4096-QAM (4K-QAM) and
supports up to with 16 spatial streams. Theoretically, Wi-Fi 7 will eventually support maximum data rates up to 46 Gbps.

Survey Pro detects Wi-Fi 7 APs and displays data rates and heatmap information for APs using up to four streams.
Like Wi-Fi 6, Wi-Fi 7 calculates predictive PHY data rate based on a 0.8 us Guard Interval.

The following table illustrates the possible combinations of MCS, Spatial Stream number (up to four), and Channel Widths.

Wi-Fi 7 [Spatial |20 MHz Channel |40 MHz Channel |80 MHz Channel 160 MHz Channel (320 MHz Channel
MCSs Stream ([PHY Data Rate PHY Data Rate PHY Data Rate PHY Data Rate PHY Data Rate
Index (Mbps) (Mbps) (Mbps) (Mbps) (Mbps)

0 1 9.75 19.5 39 78 156

1 19.5 39 78 156 312

2 1 29.25 58.5 117 234 468

3 1 39 78 156 312 624

4 1 58.5 117 234 468 936

5 1 78 156 312 624 1248

6 1 87.75 175.5 351 702 1404

7 1 97.5 195 390 780 1560

8 1 117 234 468 936 1872

9 1 130 260 520 1040 2080

10 1 156 312 624 1248 2496

11 1 175.5 351 702 1404 2808
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12 1 195 390 780 1560 3120
13 1 214.5 429 858 1716 3432

To calculate potential data rates for more spatial streams, multiply the single-stream values by the number of spatial streams
(e.g., for 16 streams, multiple the single stream value by 16.)

Channel Interference

e Threshold: Min Signal to Interference, Min Signal of interferer
o Default value: -75, -85

o Pass/Fail default value: 100%

« For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for Channel Interference are displayed in light green (). Areas that do
not meet the requirement are displayed according to the color code on the slider bar on the right-hand side of the view. Let
the mouse hover over any point of the map to show additional details.

Important:AirMagnet Survey measures interference from the point of view of a particular AP. This means that AirMagnet
shows a cumulative view of all the various Wi-Fi sources that are interfering with that one AP. Therefore, make sure that you
deselect all APs that are not the focus of your investigation. (Use the device tree on the left side of the screen). Note that
signals from deselected devices are still considered when determining interference to other APs.

Background

Interference represents a serious threat to the performance of a wireless network. The most common sources of interference
are co-channel interference and adjacent channel interference, which are caused by wireless access points that are operating
on the same channel or on an overlapping channel respectively.

Design networks to avoid co-channel and adjacent channel interference whenever possible.

Channal 11

Ay

— 4

Channgl 11

Site surveyors note that interference is cumulative in nature. Several weak sources of interference can combine to create a
large overall interference for a specific AP. For this reason, AirMagnet Survey always shows the total interference from the
perspective of a single AP. When you select an AP of interest, you can see the total distribution of interference for that single
device.

Channel Width

Threshold: Allowed or Not Allowed

Default values: 40, 80 and 160 MHz Allowed; 20 MHz, 20 MHz HT, and 320 MHz Not Allowed
Pass/Fail default value: 100%

Requirement Explanation

This requirement lets you view the various channel widths detected in the survey data file in use. For example, if the wireless
network being installed must support only 40 MHz channels, set the Thresholds to "Allowed" for the 40 MHz and "Not
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allowed" for 20 MHz, 20 MHz HT, 80 MHz, 160 MHz, and 320 MHz. After loading the desired survey data, the AirWISE view

would show you whether the data meets the requirements. The heatmap shows a light green () color for passing and red (
.) for failing. This requirement is pass or fail based.

Background

Legacy 802.11 systems operate on channels that are 20 MHz wide (actually the channels are 22 MHz wide even though they
are generally referred to as 20 MHz). Wi-Fi 4 defines both 20-MHz and 40-MHz-wide channel operation. When operating in 40-
MHz mode, the capacity of the channel is effectively double that of legacy systems. One may liken this to “doubling the
number of lanes on a freeway so that twice as many cars may pass through”.

The fourteen Wi-Fi 4 channels in the 2.4 GHz band (eleven usable channels in the US) are spaced 5 MHz apart, with center
frequencies from 2412 MHz to 2477 MHz.

SR ‘ channel 7 channel 11
P B ‘ channel & | S
d'nnl:ld1 ' | . d'lar:nels : , channel 9 :
2400 2412 2417 2422 2427 2432 2437 2442 2447 2452 2457 2462 ) 2483

— 22MHz —b|

RF channels do not have exact edges. The modulated portion of a (20-MHz) Wi-Fi 4 RF signal “falls” into +/- 11 MHz of the
center frequency (thus, it is 22 MHz wide); there is however some “bleed over”, or unmodulated RF energy that is present to
about +/- 30 MHz of the center frequency (at relatively much lower power levels). The spectrum mask defines how much RF
energy may be present outside the channel boundary of +/- 11 MHz.

i 0dBr
Transmit spectrum mask \ Unfiltered Sinx/x
-30 dBr
-50 dBr
fc -22MHz fc -11MHz fc fc +11MHz fc +22MHz

A Wi-Fi 4 transmission thus “takes up” 5 channels (the center, two left adjacent and two right adjacent channels). Depending
on transmit power and receiver sensitivity, a transmission may even cause interference on several additional channels (up to
5 away from the center).

For instance, a device transmitting on channel 6 would certainly cause significant interference on channels 5 and 7; some
interference on channels 4 and 8; and might cause (usually negligible) interference on channels 2, 3, 9, and 10. This is why, in
FCC regulated domains, there are effectively just 3 simultaneously usable Wi-Fi 4 20-MHz channels in the 2.4 GHz band. A
typical North American deployment places APs on channels 1, 6 and 11 to cope with “bleed over”. This channel deployment
scheme allows APs in close proximity to each other to minimize interference with each other.

Operating in 40-MHz mode in the 2.4 GHz band makes this problem worse. The 40-MHz spectrum mask (necessarily) allows
higher signal energy to be present on adjacent channels, as shown in the graph below.
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Thus, a 40-MHz Wi-Fi 4 transmission in the 2.4 GHz band takes up 9 channels (the center, four left adjacent and four right
adjacent channels). Thus, the 40-MHz transmission in the 2.4 GHz band (where there are only 11 usable channels) could cause
problems because a single transmission could use more than 80% of the available spectrum in the band. Additionally, the 2.4
GHz band is much more crowded than the 5 and 6 GHz bands because stations must also contend with Bluetooth devices,
microwave ovens, and other common sources of 2.4 GHz interference. Coexistence mechanisms can help reduce but not
eliminate the problem in this band.

Fortunately, newer versions of Wi-Fi allow operation in the 2.4 GHz, 5 GHz, and 6 GHz bands. In most regulatory domains,
there are many more usable channels in the 5 and 6 GHz bands, and the channels are spaced 20 MHz apart. This provides for
much more “room” for 40, 80, 160, and 320 MHz wide channel operation.

Wi-Fi 4, 5, 6, and 7 APs and STAs exchange information about what channel widths are supported using HT, VHT, HE, or EHT
Capabilities Element frame fields. APs operating a 40-MHz BSS must continuously monitor the environment for legacy or non-
40 MHz capable HT STAs in both the primary and secondary channels.

Note:The scenario below describes some possible causes behind a network that is designed to implement 40 MHz operation but
has other channel widths in use detected during the survey.

Thresholds: 40 MHz Allowed, 20 MHz HT and 20 MHz Not Allowed
Symptom: 40 MHz channel width is allowed but you are detecting 20 MHz HT or 20 MHz in use.

Possible diagnoses:

« Interference detected in the secondary channel by AP/STA: The APs (and/or STA) have determined that there is too
much interference in the secondary channel to effectively use both the primary and secondary channels. You must then
determine which 802.11 devices may be causing this interference. Using a Spectrum Analyzer may also help to identify
non-802.11 interference in the secondary channel.

« Associated STAs do not support 40 MHz transmission: One or more Stations which are associated to the AP do not
support 40 MHz operation, which causes 40 MHz AP/STAs to use protection protocols for 40 MHz transmissions. Review
the survey data to determine exactly which APs are operating in 20 MHz mode. You can then examine the Stations around
those APs to determine which station is causing the network to fall back into 20 MHz channel usage.

e 40 MHz Intolerant announced: An AP or STA in this or a neighboring BSS has broadcast "40 MHz Intolerant". An AP broad-
casts this when it does not allow 40 MHz transmissions in neighboring BSSs. A STA broadcasts this to indicate to its asso-
ciated AP that the AP is required to restrict the use of 40 MHz transmissions in its BSS.

Cisco Location-based Services

e Threshold: Number of placed APs required to provide coverage, AP signal strength required to provide coverage
o Default Value: 3, -75

e Minimum APs: 3, Maximum APs: 16

e Minimum signal strength: -85 dBm, Maximum signal strength: 0
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o Pass/Fail default value: 100%

o For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

If three APs or more, that are placed on the floor plan, create a "convex hull" configuration (see diagram below) and meet the
requirements for location-based services coverage (readiness), the convex hull area displays as green. The non-compliant
area (outside the hull) displays as pink.

The creation of a convex hull requires at least three placed APs on the floor plan to form the hull. In addition, any location
point in the hull must not have a signal strength weaker than the defined minimum signal strength value (based on the
placed APs). Both of these requirements must be met in order for the hull to be considered "ready" for location-based
services.

However, if signal strength drops below the minimum requirement and/or AP count drops below the requirement inside the
hull, these locations are color-coded as indicated by the legend.

To view areas in terms of AP count, click the "Number of placed APs required to provide coverage" row in the thresholds area,
just below this view. To see how close the actual AP signal is to your requirement, click the "AP signal strength required to
provide coverage" row in the thresholds area. Let the mouse hover over any point of the map to show additional details. For
the purpose of this requirement, any placed APs closer together than one meter are considered as one physical AP.

The “% of Good Area” indicates the area of the floor plan that meets the requirements. To determine the percentage of good
area in the convex hull you may use the “Arbitrary Region Tool” to outline the convex hull and create a region.

Note: After conducting a survey, you must place all the APs intended for Cisco Location-based services on the floor plan. See
Channel/SSID List.

Legend explanation

Item Description

Green Both the number of APs and signal strength threshold criteria are met.

Pink Area outside the convex hull.

Silver (gray) All the APs meet the signal strength threshold; however, the number of APs requirement is
not met.

With Signal Strength require- |Colors besides green or gray inside the hull indicate the strongest signal strength in areas

ment selected. where the AP requirement and/or signal strength threshold are not met.

With AP requirement selected. |Colors (besides green) indicate areas where either the total number of APs making up the
hull falls below the requirement or the number of APs providing the required signal
strength coverage falls below the requirement.

Background

Location-based services generally involve determining the geographical location of assets or persons. Some applications of
location-based services include RFID tracking solutions; location monitoring of Voice-over-Wi-Fi phones; and locating rogue
access points.

Proper placement of access points is an important consideration for planning location-based services (such as a location-
aware Cisco Unified Wireless Network).

This policy applies the "convex hull" technique for determining compliance. The convex hull technique involves establishing a
perimeter of at least three placed APs in which one could imagine a rubber band wrapped around the "outside" APs. As you
move an AP, the perimeter border (rubber band) adjusts accordingly.

The interior area encompassed by this band can be considered as possessing high potential for good location accuracy. As
tracked devices stray into the area outside the convex hull, accuracy can begin to deteriorate.

Access
Point
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Cisco recommendations

This section contains an excerpt from "Best Practices—Location-Aware WLAN Design Considerations" Used by permission ©

Cisco, Inc. All rights reserved.

For Cisco "Location-aware" deployments, Cisco recommends that designs that make use of only clustered or straight-line
access point placement should be augmented or redesigned in favor of those that combine center access-point placement

with perimeter and corner placement.

Recommended Not Recommended

*AP e AP AP
+ AP + AP
* AP * AP
® AP ¢ AP * AP
= Device = Device

+ AP * AP AP+
v AP * AP v AP AP AP®

" Unvice “AP SAP +AP eAP +AP <P |
+ AP AP e e AP AP* = Device %

If possible, mount antennas such that they have an unencumbered 360° view of all areas around them, without being blocked
at close range by large objects. For example, if possible, avoid placing access point antennas directly against large objects
such as steel columns. One option is to mount the access point along with its antennas to a ceiling location (provided that
this allows an acceptable mounting height). Another option is to use short, low loss cable extension to allow separation
between antennas and such obstructions.

In general, for access points deployed indoors at antenna heights of 20 feet or less, the range of any point on the floor to at
least three detecting access points on that floor (one in each of at least three of the four quadrants surrounding it) is
maintained in approximately 70 feet in an indoor environment. This is a general recommendation that is intended to assist
designers in avoiding situations where excessive inter-access point distance may be a contributing factor to location
inaccuracy.

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:
¢ Increase the transmit power of existing APs

« Reposition APs to meet requirements

e Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should have a clear “line of site” to the areas they serve. Installing APs on the ceiling or high
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the
environment and configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

iPerf Throughput Up
Threshold: Min iPerf throughput up
Default value: 24.0

Pass/Fail default value: 100%
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Requirement Explanation

Areas of the map that meet the current requirement for Min iPerf throughput are displayed in light green (). Areas that do
not meet the requirement are displayed according to the color code on the slider bar on the right-hand side of the view. This
scale is shown in terms of Mbps. Let the mouse hover over any point of the heatmap to show additional details.

Background

Throughput provides a direct insight into how well the network supports a real-world end-user client. An Active iPerf Survey is
required to obtain throughput data. A low throughput rate directly translates to lower performance for an end-user. Con-
sistently low throughput speeds are indicative of either insufficient signal coverage, interference, noise, or misconfigured
wireless devices.

End-user throughput speeds change automatically from a higher throughput rate to a lower one in response to a deteri-
orating connection quality. The best method for determining the real-world throughput at a given location is to perform an
iPerf Survey. During an iPerf Survey, the surveyor “follows” the AP’s connection and actively collects real throughput data.

iPerf Throughput Down
Threshold: Min iPerf throughput down
Default value: 24.0

Pass/Fail default value: 100%

Requirement Explanation

Areas of the map that meet the current requirement for Min iPerf throughput are displayed in light green (). Areas that do
not meet the requirement are displayed according to the color code on the slider bar on the right-hand side of the view. This
scale is shown in terms of Mbps. Let the mouse hover over any point of the map to show additional details.

Background

Throughput provides a direct insight into how well the network supports a real-world end-user client. An Active iPerf Survey is
required to obtain throughput speed data. A low throughput rate directly translates to lower performance for an end-user.
Consistently low throughput speeds are indicative of either insufficient signal coverage, interference, noise, or mis-configured
wireless devices.

End-user connection speeds change automatically from a higher throughput rate to a lower one in response to a deteri-
orating connection quality. The best method for determining the real-world throughput rate at a given location is to perform
an iPerf Survey. During an iPerf Survey, the surveyor “follows” the AP’s connection and actively collects real throughput data.

Measured PHY Data Rate Downlink Coverage
o Threshold: Min Downlink Data Rate Supported

o Default value: 54.0

o Pass/Fail default value: 100%

o For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for Min Downlink Data Rate Supported are displayed in light green ().
Areas that do not meet the requirement are displayed according to the color code on the slider bar on the right-hand side of
the view. This scale is shown in terms of Mbps. Let the mouse hover over any point of the map to show additional details.

Background

Connection data rate provides a direct insight into how well the network supports a real-world end-user client. An Active
Survey is required to obtain connection speed data. A low connection PHY data rate directly translates to lower throughput
and performance for an end-user. Consistently low connection speeds are indicative of either insufficient signal coverage,
interference, noise, or mis-configured wireless devices.

The connection speeds supported by each of the 802.11 protocols are listed below:
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802.11 Standard |Supported Speeds (in Mbps)

802.11b 1,2,5.5,11
802.11g 1,2,5.5,6,9, 11,12, 18, 24, 36, 48, 54
802.11a 6,9, 12, 18, 24, 36, 48, 54

Wi-Fi 4 (802.11n) [1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50, 14.40, 15.00, 18.00, 19.50, 21.70, 24.00, 26.00,
27.00, 28.90, 30.00, 36.00, 39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00, 57.80, 58.50, 60.00, 65.00, 72.20,
78.00, 81.00, 86.70, 90.00, 104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 135.00, 144.40, 150.00,
156.00, 162.00, 173.30, 175.50, 180.00, 195.00, 208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00,
260.00, 270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00, 450.00, 480.00, 486.00, 540.00,
600.00

Wi-Fi 5 (802.11ac)|6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9, 29.3, 30.0, 32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0,
57.8, 58.5, 60.0, 65.0, 72.2, 78.0, 81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0, 115.6, 117.0, 120.0, 121.5, 130.0,
135.0, 144.4, 150.0, 156.0, 162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 216.7, 234.0, 240.0, 243.0, 260.0,
263.3,270.0, 292.5, 300.0, 324.0, 325.0, 351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0, 468.0,
486.0, 520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 702.0, 780.0, 866.7, 877.5, 975.0, 1053.0, 1170.0, 1300.0
Wi-Fi 6 (802.11ax)(8.6, 17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2, 108.1, 114.7, 120.4, 129, 137.6, 143.4,
144.1,154.9,172.1, 180.1, 180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3, 286.8, 288.2, 309.7,
324.3,344.1, 360.3, 361.3, 387.1, 412.9, 430.1, 432.4, 458.8, 464.6, 480.4, 481.8, 504.4, 516.2, 540.4, 542,
550.6, 573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 688.2, 716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9,
860.3, 864.7, 903.3, 917.6, 929.1, 960.8, 963.5, 972.8, 1003.7, 1008.8, 1032.4, 1080.9, 1084, 1101.2, 1147.1,
1152.9, 1201, 1204.4, 1238.8, 1290.4, 1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9, 1621.3,
1651.8, 1720.6, 1729.4, 1801.5, 1806.6, 1835.3, 1921.6, 1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9,
2294.1, 2305.9, 2402, 2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6, 3362.7, 3458.8, 3602.9, 3783.1,
3843.1, 3891.2, 4035.3, 4203.4, 4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 5764.7, 6004.9,
6052.9, 6485.3, 6725.5, 6917.6, 7205.9, 7566.2, 7686.3, 8406.9, 8647.1, 9607.8

Wi-Fi 7 One Spacial Stream only: 8.6, 17.2, 25.8, 34.4, 36.0, 51.6, 68.8, 72.1, 77.4, 86.0, 103.2, 108.1, 114.7, 129.0,
(802.11be) 137.6, 143.4, 144.1, 154.9, 163.3, 172.0, 206.4, 216.2, 229.4, 258.0, 259.4, 286.8, 288.2, 310.0, 324.3, 326.7,
360.3, 432.4, 480.4, 540.5, 576.5, 600.5, 648.5, 720.6, 734.4, 864.7, 960.8, 1081.0, 1152.9, 1201.0, 1297.0,
1441.2, 1468.8, 1729.4, 1921.6, 2162.0, 2402.0, 2594.1, 2949.1

End-user connection speeds change automatically from a higher connection data rate to a lower one in response to a deteri-
orating connection quality. The best method for determining the real-world connection data rate at a given location is to
perform a Active Survey. During a Active Survey, the surveyor “follows” the AP’s connection and actively collects real
connection data such as connection data rate.

Measured PHY Data Rate Uplink Coverage
o Threshold: Min Uplink Data Rate Supported

o Default value: 5.5

o Pass/Fail default value: 100%

o For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for Min Uplink Data Rate Supported are displayed in light green ().
Areas that do not meet the requirement are displayed according to the color code on the slider bar on the right-hand side of
the view. This scale is shown in terms of Mbps. Let the mouse hover over any point of the map to show additional details.

Background

Connection data rate provides a direct insight into how well the network supports a real-world end-user client. An Active
Survey is required to obtain connection speed data. A low connection PHY data rate directly translates to lower throughput
and performance for an end-user. Consistently low connection speeds are indicative of either insufficient signal coverage,
interference, noise, or mis-configured wireless devices.

End-user connection speeds change automatically from a higher connection data rate to a lower one in response to a deteri-
orating connection quality. The best method for determining the real-world connection data rate at a given location is to
perform an Active Survey. During an Active Survey, the surveyor “follows” the AP’s connection and actively collects real
connection data such as connection data rate.
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Multiple AP Signal Coverage
e Threshold: Min No. of AP, Min Signal

o Default value: 2, -67

o Pass/Fail default value: 100%

« For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirements for AP coverage are displayed in light green (). This requirement
contains two requirements. One requirement is based on the number of APs present in the area, and the second is based on
the minimum signal required of the present APs. Both of these requirements must be met to be considered compliant. Either
of these requirements can be shown for non-compliant areas of the map. To view problem areas in terms of AP count, click
the Minimum Number of APs row in the thresholds area, just below the main view. To see how close the actual AP signal is to
meeting your requirement, click the Minimum Signal row in the thresholds area. Let the mouse hover over any point of the
map to show additional details.

Background

Wireless networks with stringent performance requirements should insure that all areas are served by at least two access
points on non-overlapping channels. Each of these APs should meet the minimum signal requirement for the network
(typically between -67 dBm and -75 dBm).

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:
o Increase the transmit power of existing APs

¢ Reposition APs to meet requirements

e Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should have a clear “line of site” to the areas they serve. Installing APs on the ceiling or high
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the
environment and configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

Noise Level

o Threshold: Max Noise Level
o Default value: -90
o Pass/Fail default value: 100%

e For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for noise are displayed in light green (). Areas that do not meet the
requirement are displayed using the color code on the slider bar on the right-hand side of the view. Noise levels are displayed
in dBm with areas of highest noise shown in red. Let the mouse hover over any point of the map to show additional details.

Background

Any energy in the Wi-Fi spectrum that is not recognized as 802.11 traffic is considered noise. High levels of environmental
noise interfere with 802.11 signals and lead to serious performance problems for the wireless network.
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Noise is a very common problem especially in the 2.4 GHz band. The 2.4 GHz band is “unlicensed” and is commonly used by a
variety of technologies including Bluetooth, cordless phones, frequency hopping devices, wireless cameras, and more. Other
devices such as microwave ovens can emit noise simply as a byproduct of their normal operation.

Like signal, noise is measured in units of “dBm”, with a signal of 0 dBm being the strongest, and signals of -100 dBm and
below being the lowest. The maximum acceptable noise depends on the requirements of the network. As a general rule, a
wireless network should aim to keep noise levels below -85 dBm for normal data traffic, and under -90 dBm for networks that
support voice.

Corrective Actions

High environmental noise can be addressed either by removing the source of the noise, or avoiding it by moving Wi-Fi traffic
to a less noisy portion of the spectrum. However, avoidance of noise may not always be an option. To remove the source of
noise, technical staff must identify the noise source. This is most reliably done with a Spectrum Analyzer, which can analyze
the waveform of the noise to pin down a unique source of the noise.

Operating Mode

e Threshold: Allowed or Not Allowed

o Default values: Mixed VHT, Mixed HE, Mixed EHT Allowed; Legacy, Greenfield, and Mixed HT Not Allowed
o Pass/Fail default value: 100%

o For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

The requirement is triggered by any Wi-Fi 5, 6, or 7 networks that fall outside of the selected threshold settings. For example
if the Wireless network being surveyed is designed to provide "Very High Throughput” (VHT), then the Threshold setting
would be set to "Allowed" for the VHT Operating Mode and Not Allowed for the remaining thresholds. After completing the
Survey by using the AirWISE section one can determine if the desired network environment is actually in place. The heatmap

shows a light green () color for passing and red (.) for failing. This requirement is a pass or fail based threshold

Background

The PHY- and MAC-layer improvements introduced in the Wi-Fi 4 amendment and extended in the Wi-Fi 5, 6, and 7
amendments brings Wi-Fi network performance to an unprecedented level in terms of range, throughput, and stability.
However, new Wi-Fi protocols may have the potential of interfering with or even hampering the normal operation of legacy
(802.11a/b/g) networks.

Like 802.11g networks that are backward-compatible to the 802.11b networks, modern Wi-Fi networks are backward-
compatible with stations built on the legacy 802.11a/b/g standards. Thus, Wi-Fi access points must inter-operate smoothly in
a mixed WLAN environment so that they can support both legacy 802.11a/b/g transmissions over 20-MHz channels and high-
throughput transmissions over bigger channel widths.

To effectively address the backward compatibility and coexistence issue, Wi-Fi access points must automatically choose the
appropriate operating mode as is dictated by the changing dynamics of the wireless environment in which they are operating.
Wi-Fi access points must function in any of the following operating modes, depending on the real-time circumstances of the
wireless network.

Predictive PHY Data Rate Downlink Coverage
o Threshold: Min Downlink Data Rate Supported

o Default value: 54.0

o Pass/Fail default value: 100%

e For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for Min Downlink Data Rate Supported are displayed in light green ().
Areas that do not meet the requirement are displayed according to the color code on the slider bar on the right-hand side of
the view. This scale is shown in terms of Mbps. Let the mouse hover over any point of the map to show additional details.
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Background

Connection Rates provide a direct insight into how well the network supports a real-world end-user client. When doing a
Passive survey the ability to see the actual Data rate is not available. To provide Data Rates while doing a Passive survey we
use Signal Strength to Data Rate mapping table. Take the detected signal strength and map it to a known Data Rate. A

low Data Rate connection directly translates to lower throughput and performance for an end-user. Consistently low
connection Rates are indicative of insufficient signal coverage, interference, noise, or mis-configured wireless devices.

End-user connection speeds change automatically from a higher connection data rate to a lower one in response to a deteri-
orating connection quality. The best method for determining the real-world connection data rate at a given location is to
perform an Active Survey. During an Active Survey, the surveyor “follows” the AP’s connection and actively collects real
connection data such as connection data rate.

RSSI Neighboring Cell Coverage
e Threshold: Min Signal

o Default value: -67

o Pass/Fail default value: 100%

« For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current RSSI neighboring cell coverage requirement are shown in light green (). Areas that do not
meet the requirement are displayed using the color code on the slider bar on the right-hand side of the view. The weakest
signals are shown in red. Let the mouse hover over any point of the map to show additional details.

RF Coverage Background

RF signals are the basis for Wi-Fi communication in the same way that copper wire is the basis for traditional networks. Each
wireless client (such as an end-user) must receive adequate levels of RF signal from its Access Point to insure a reliable and
well-performing connection.

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and signals of -100 dBm and below
being the weakest. The minimum acceptable signal depends on the requirements of the network and how it is used. As a
general rule, voice clients should maintain a signal of at least -67 dBm.

Environmental factors significantly affect RF signals. Solid objects attenuate and reflect RF signals, which can cause RF “dead
spots” in otherwise well-served areas. This means that you must carefully survey areas where wireless clients need network
service. Pay special attention to the areas around and in the line of site of physical obstructions such as solid metal object
(beams, pillars, structural elements), solid walls, elevator shafts, and any shielded rooms, such as an x-ray room.

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:
o Increase the transmit power of existing APs

¢ Reposition APs to meet requirements

» Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should have a clear “line of site” to the areas they serve. Installing APs on the ceiling or high
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the
environment and configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.
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RSSI Serving Cell Coverage
e Threshold: Min Signal

o Default value: -67

o Pass/Fail default value: 100%

* For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current RSSI serving cell coverage requirement are shown in light green (). Areas that do not meet the
requirement are displayed using the color code on the slider bar on the right-hand side of the view. The weakest signals are
shown in red. Let the mouse hover over any point of the map to show additional details.

RF Coverage Background

RF signals are the basis for Wi-Fi communication in the same way that copper wire is the basis for traditional networks. Each
wireless client (such as an end-user) must receive adequate levels of RF signal from its Access Point to insure a reliable and
well-performing connection.

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and signals of -100 dBm and below
being the weakest. The minimum acceptable signal depends on the requirements of the network and how it is used. As a
general rule, voice clients should maintain a signal of at least -67 dBm.

Environmental factors significantly affect RF signals. Solid objects attenuate and reflect RF signals, which can cause RF “dead
spots” in otherwise well-served areas. This means that you must carefully survey areas where wireless clients need network
service. Pay special attention to the areas around and in the line of site of physical obstructions such as solid metal object
(beams, pillars, structural elements), solid walls, elevator shafts, and any shielded rooms, such as an x-ray room.

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:
o Increase the transmit power of existing APs

¢ Reposition APs to meet requirements

e Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should have a clear “line of site” to the areas they serve. Installing APs on the ceiling or high
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the
environment and configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

Signal Coverage

e Threshold: Min Signal

o Default value: -67

o Pass/Fail default value: 100%

* To set the default value: AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current RF coverage requirement are shown in light green (). Areas that do not meet the requirement
are displayed using the color code on the slider bar on the right-hand side of the view. The weakest signals are shown in red.
Let the mouse hover over any area of the map to show additional details.
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RF Coverage Background

RF signals are the basis for Wi-Fi communication in the same way that copper wire is the basis for traditional networks. Each
wireless client (such as an end-user) must receive adequate levels of RF signal from its Access Point to insure a reliable and
well-performing connection.

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and signals of -100 dBm and below
being the weakest. The minimum acceptable signal depend on the requirements of the network and how it is used. As a
general rule, data clients should maintain a signal of at least -67 dBm.

Environmental factors significantly affect RF signals. Solid objects attenuate and reflect RF signals, which can cause RF “dead
spots” in otherwise well-served areas. This means that you must carefully survey areas where wireless clients need network
service. Pay special attention to the areas around and in the line of site of physical obstructions such as solid metal object
(beams, pillars, structural elements), solid walls, elevator shafts, and any shielded rooms, such as an x-ray room.

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:
o Increase the transmit power of existing APs

¢ Reposition APs to meet requirements

e Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should have a clear “line of site” to the areas they serve. Installing APs on the ceiling or high
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the
environment and configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

Signal-to-Noise Ratio Coverage

e Threshold: Min Signal-to-Noise Ratio
o Default value: 25
o Pass/Fail default value: 100%

e For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current Signal-to-Noise (SNR) coverage requirement are shown in light green ( ). Areas that do not
meet the requirement are displayed using the color code on the slider bar on the right-hand side of the view. The weakest
SNR values are shown in red. Let the mouse hover over any area of the map to show additional details.

SNR Background

SNR is a key measurement of the quality of the wireless signal transmission. A good SNR value means that a higher
modulation and coding scheme (MCS) can be used to increase the data rates over the wireless connection.

SNR is measured in units of “dB”, representing the difference in a signal level measurement in dBm and a noise level
measurement in dBm. For example, a signal level of -40 dBm and a noise level of -65 dBm results in an SNR of 25 dB. The
minimum acceptable SNR depends on the requirements of the network and how it is used. As a general rule, an SNR of 25 dB
or more is desired for good data rates. To achieve the higher data rates available in Wi-Fi 5, and SNR of 32 is desired. To
achieve the even higher rates available in Wi-Fi 7, an SNR of 41 is desired. Keep in mind that data rates also depend on other
factors such as channel width and the number of spatial streams.

SNR is affected by two factors: the signal level from the transmitting AP or client, and the background noise level including
noise from interferers. Providing higher signal levels and/or lower noise levels improves the SNR. See the sections on Signal
Coverage and Noise Level for more details on these.
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Corrective Action

Insufficient SNR can be addressed in several ways.

o Increase the transmit power of the AP

« Add additional APs to provided additional coverage

» Reposition APs to avoid obstructions

o Select a different WLAN channel that has less noise and interference

« Mitigate interference sources (remove or relocate them)

Throughput Downlink Coverage
e Threshold: Min Downlink Throughput Supported

o Default value: 5.5

o Pass/Fail default value: 100%

e For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation
Areas of the map that meet the current requirement for Min Downlink Throughput Rate Supported are displayed in light

green (). Areas that do not meet the requirement are displayed according to the color code on the slider bar on the right-
hand side of the view. This scale is shown in terms of Mbps. Let the mouse hover over any point of the map to show
additional details.

Throughput calculations can provide a direct insight into how well the network supports a real-world end-user client. When
creating virtual Survey’s with Planner/Advisor the Physical Data Rates are calculated from an Signal Strength to Data Rate
mapping table. Then, take this number with the Selected (Frame Size) and calculate the Throughput rate the client can
expect to see.

Tips

Design your Planner/Advisor project with knowledge of the type of wireless traffic the network must support. For example, a
Wi-Fi usage to supports a lot of video traffic might require a larger frame size. This changes your throughput calculation.
Larger frames have less overhead while transferring data. If you intend to support VoFi traffic then you would want to use a
smaller frame size to emulate typical VoFi packets. Smaller frames provide less throughput, mostly due to the increased
overhead required to transfer data packets.

User Capacity

e Thresholds: Maximum Users Supported per AP, With Load Balancing
o Default values: 15, True

o Pass/Fail default 100%

e For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Intelligent capacity planning ensures that all network users have access to an adequate amount of bandwidth and that
wireless access points are arranged in a way to logically share the client load.

To perform a capacity plan, you should first establish the network bandwidth that each end user needs. Then, you can
calculate the maximum number of end-user clients that should associate with an access point, based on the total throughput
available from the AP. With these two pieces of information, you can use AirMagnet Survey to map out a scientific capacity
plan using the following steps.

Identify key end-user client areas. Select the O (Rectangular Region Tool) from the Toolbar, and then draw a box
covering the area where end users need support. Enter the number of users that need to be supported in this area, and enter
the length and width of the area. Repeat this process until you have accounted for all network end users and all locations.
The program automatically tells you whether the users are covered or not.
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Using the "With Load Balancing" Threshold
Note: Load Balancing is a setting on certain APs. Do not enable this setting unless you know that the network operates with
APs that support (and use) load balancing.

If the AirWISE requirement for "With Load Balancing" is set to "True", the AirWISE display attempts to distribute the users in
the defined areas evenly among the APs that cover that area. For example, if there are three APs that all provide coverage to
a given block of cubes with six users in them, each AP gets two users assigned to it. If the "With Load Balancing" field is set to
"False", the user stations are assigned to whichever AP provides the strongest signal in their respective areas.

Each end-user area is automatically broken into equal-sized cells that represent the area for each user. Areas in green ()
meet the capacity requirements set in the application, while a red area (.) indicates a client that connects to an overloaded

AP. An area in gray () means that NO Service is available in that area. Let your mouse hover over any area of the map to
see the strongest AP at that location and any other APs that are operating nearby. Use the simulation tool to simulate the
result of relocating the APs, adjusting AP power, and adding additional APs to meet the capacity requirements.

VoFi Packet Retry

o Threshold: Maximum percentage of packet retry allowed
o Default value: 10%

o Pass/Fail default value: 100%

o For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

The WLAN RF spectrum is open, dynamic, shared, and subject to noise, interference, packet collisions, multipath, hidden
node syndrome, etc. When there are errors caused by any of the above issues, the transmitter of the error frame would not
receive an 802.11 control frame called an acknowledgment frame. When there is no acknowledgment observed, the
transmitter, assuming that the receiver did not receive the frame successfully, would re-transmit the unacknowledged frame
with the Retrybit in the frame set to one. This indicates a re-transmission. The figure below illustrates the Retryfield in the
802.11 frame header.
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Background

The VoFi packet retry policy takes rates recorded from transactions from the phone to the AP (uplink) as well as those from
the AP to the phone (downlink) into account when displaying these data. As shown in the legend bar on the right-hand
portion of the view, the data rate is color-coded to display the combined status of the two transmission directions:

Areas of the map in which both uplink and downlink retry rates are good are displayed in light green ().
o Areas in which the uplink retry rate is good but the downlink retry rate is not are displayed in yellow.
¢ Areas in which the downlink retry rate is good but the uplink retry rate is not are displayed in orange.
« Areas in which both uplink and downlink retry rates are bad are displayed in red.

Let the mouse hover over any point of the map to show additional details.

VoFi PHY Data Rate

o Threshold: Minimum data rate required

o Default value: 24.0
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o Pass/Fail default value: 100%

o For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

The VoFi PHY data rate policy takes rates recorded from transactions from the phone to the AP (uplink) as well as those from
the AP to the phone (downlink) into account when displaying these data. As shown in the legend bar on the right-hand
portion of the view, the data rate is color-coded to display the combined status of the two transmission directions:

Areas of the map in which both uplink and downlink rates are good are displayed in light green ().
e Areas in which the uplink rate is good but the downlink rate is not are displayed in yellow.

e Areas in which the downlink rate is good but the uplink rate is not are displayed in orange.

» Areas in which both uplink and downlink rates are bad are displayed in red.

Let the mouse hover over any point of the map to show additional details.

Background

Connection data rate provides a direct insight into how well the network supports a real-world end-user phone. A VoFi Survey
is required to obtain connection speed data. A low connection PHY data rate directly translates to lower throughput and
performance for an end-user phone. Consistently low connection data rates are indicative of either, insufficient signal
coverage, interference, noise, or mis-configured wireless devices.

End-user connection speeds change automatically from a higher connection data rate to a lower one in response to a deteri-
orating connection quality. The best method for determining the real-world connection data rate at a given location is to
perform a VoFi Survey. During a VoFi Survey, the surveyor “follows” the AP’s connection to the phone and actively collects
real connection data such as connection data rate.

VoFi Signal Coverage

o Threshold: Minimum AP signal strength required
o Default value: -67 dBm
o Pass/Fail default value: 100%

« For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current RF coverage requirement are shown in light green (). Areas that do not meet the requirement
are displayed using the color code on the slider bar on the right-hand side of the view. The weakest signals are shown in red.
Let the mouse hover over any point of the map to show additional details.

RF Coverage Background

RF signals are the basis for Wi-Fi communication in the same way that copper wire is the basis for traditional networks. Each
wireless client (such as an end-user) must receive adequate levels of RF signal from its Access Point to insure a reliable and
well-performing connection.

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and signals of -100 dBm and below
being the weakest. The minimum acceptable signal depends on the requirements of the network and how it is used. Voice
clients require a strong signal and should maintain a signal of at least -67 dBm.

Environmental factors can significantly affect RF signals. Solid objects attenuate and reflect RF signals, which can cause RF
“dead spots” in otherwise well-served areas. Therefore, you should pay special attention to the areas around, and in the line
of site of physical obstructions. Typical obstructions can include any solid metal object, solid walls, elevator shafts, and any
shielded room such as an x-ray room.

VoFi-Specific Coverage Data

In contrast to the general Signal Coverage requirement, the VoFi Signal Coverage represents the information gathered from
the AP to which the VoFi phone is associated during the survey process. This information does not represent all coverage
detected on the VoFi deployment. Other VoFi APs may be placed in the vicinity of the survey path but not be displayed
because the phone did not associate with them during the survey.
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MOS Coverage
e Threshold: Min MOS Score

o Default value: 3.2

Requirement Explanation

Areas of the map that meet the current requirement for desired MOS Score are labeled in light green (). Areas that do not
meet the requirement are displayed according to the color code on the slider bar on the right-hand side of the view. This
scale is shown in terms of 1 through 5. Let the mouse hover over any area of the map to show additional details.

Background

The MOS score is a numerical indication that is use used in the multimedia transmission world to provide the ability to rate
the actual quality of the transmitted data. The MOS number is shown in a range of 1 to 5 with 1 being the worst and 5 being
the best.

Channel/SSID List

The figure below shows the Channel/SSID List on the AirWISE view, which allows you to group the APs contained in the survey
data either by channel or by SSID using the corresponding tab.

[~] Select All  []2.4GHz []5GHz [«] 6GHz

&) Channel

W& CH 1

WM& CHE

W& CH 11

W] @R CH (26 P, 40MHz, 36-40)

W& CH (48 P, 80MHz, 26-48)

W @R CH (48 P, 160MHz, 36-64)

W &R CH 149

W @R CH (149 P, 80MHz, 149-161)

W @R CH (157 P, 80MHz, 149-161)

= € CH (97E P, 160MHz, 97E-125E)
L R 04:42:1 A CR:F7:38 (WiFife-6,-20)

& Channel & ssip

Also, if your survey includes simulated data (see About Simulation view), you may choose whether to use original data or
simulated data by selecting Use Simulated Data from the View menu (checked is enabled).

Configuring Pass/Fail Threshold Values

Each requirement includes a Pass/Fail option, a configurable percentage value that indicates whether the "% of good area'
lies in an acceptable threshold. For example, if the Pass/Fail value is set to 100% and the "% of good area" is 80%, the
Pass/Fail column reads "Fail." However, if the Pass/Fail value is set to 80% and the "% of good area" is 80%, the Pass/Fail
column reads "Pass."

@ .

Use the On column to select (check) the alarm types you want.

Click the Edit Pass/Fail Thresholdicon

Edit the value in the Minimum % of coverage to pass column.

H W

Click Save.
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SelectUnselact All Alarms

Default

Edit Pass/Fail Thresholds
Qn | Alarm Type Minimum % of cowverage to pass
l‘7 <J Signal Coverage oo
|7 <3 Multiple AP Signal Coverage 100.0
v -3 Channal Interfersnce 100.0
|7 - Measured PHY Data Rate Up Coverage 1000
|7 -3 Measured PHY Data Rate Down Coverage oo
lv_ <3 Predictive PHY Data Rate Down Coverage oo
|7 - Signal Noise Patio Coverags 1000
[ - Noise Level 100.0
v -J User Capacity 1000
[~ 2 Operating Mods 1000
[~ -2 Channel ‘Width 100.0
|7 -3 802 11n Highest MCS Index 1000
|7 - 802 11ac Highest MCS Index 1000
l‘7 <3 802 11ax Highest MCS Index oo

Save Cancel

Testing AirWISE Requirements Compliance on Site Map

A change of threshold in signal coverage can significantly affect the size of the area with good signal coverage as can be seen
graphically in the Content Window when you select the AirWISE tab. The AirWISE view offers a variety of troubleshooting
features. This section shows how to visually test several what-if hypotheses you may have in relation to any of the AirWISE

Requirements on a site map in the AirWISE view.

Note: To analyze survey data on the AirWISE view, you must first load the selected survey data on the Display view and then
switch to the AirWISE view. The following discussion assumes that you have already loaded the data on the Display view.

To test AirWISE requirements on the site map:

1. While you are on the AirWISE view, click Multiple AP Signal Coverage. The AirWISE view refreshes.

-203 -



AirWISE View
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Multiple 4F Signal Coverage
Threshold

Dezcription

Coverage

\ Heuuirement| Aitw|SE |Desc§rm_twaﬁj .

Note:The figure above shows a network’s compliance status to the Multiple AP Signal Coverage requirement based
on the survey data collected. A large part of the site is in RED, which implies that the signal coverage there is bad.
You can try to rectify this situation either by increasing signal strength of the existing APs or by removing one of

the APs from the network. Steps 2 through 3 below are just for illustration purposes.

2. From the bottom of the Content Window, reduce the minimum signal strength.

3. Click ™ (Refresh). The AirWISE view refreshes.
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O B A S

)
3
=
4 b
< ]
= |
5
3
Multiple 4F Signal Coverage
Threshald Description

2 Number of APs required ta provide coverage

-7 Plinirmum £

\ Heuuirementl Bitwd|SE |Descmpt\on|

Note: As shown above, the WLAN site is now 91.3% covered when the signal strength was decreased to -77 dBm. Based on
this result, you can probably use two APs to cover the entire site with a minimum signal strength of -77 dBm.

Determining the Number of APs Needed in an Area

The AirWISE view not only enables you to easily determine the number of APs needed to provide adequate signal coverage for
an entire WLAN site, but also allows you to quickly figure out on the view the optimal number of APs that are needed to cover
a certain area of the site using a certain channel. As a result, you can save the resources that would otherwise have to be

used in numerous trial-and-error attempts to find the best solution.

Note: To analyze survey data on the AirWISE view, you must first load the selected survey data on the Display view and then
switch to the AirWISE view. The following section assumes that you have already loaded the data on the Display view.

To determine the number of APs needed for an area of the network:

1. Select a requirement in the Summary Pane to display the heatmap for that requirement in the Content area.

2. In the Display view, click U (Rectangular Region Tool) on the Toolbar.

3. Onthe site map, click a starting point and mark an area of interest by dragging a rectangular frame around it.

4. Click L] (Refresh). The AirWISE view refreshes.
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[® Aiviagnet Suvey Professional Edition - Indoorsvp

File Edit View Help

B Panner F Mult Floor Planner & Survey Display [F] Simulation FF Multiview &y Diffview ’a AWISE | [%] Reports.

& W 9 0 O ¥ x

W QA Q ®M /W 5 & @ @ Vewownl- 2 [F

Reguirement Policy J a3 O T A s vx
<115 Signel
= @Bm)
%ofGood Area | Pass/Fail A | 7] i
. . S|
l = J a0
3 Chomnel Inerference 19 Fail .
3 Measured PHY Data Riate Up N/A NA - 20
-2 Measured PHY Data Piate Do. N/A NA —
3 Predicive PHY Data Fate Do ) Pass o 0
-2 Signal Noise Ratio Coverage N/A NA | ©
<3 Noise Level N/A NA .
3 UserCapacty A WA = -
3 Operating Made 0 Pass 1
3 Chomnel Widh o H £
3 802.11n HighestMCS Index 10 3
2 802.11acHighestMCS Index 0 .| 0
-3 802.11ax Highest MCS Index T P m | 5| T
Aselect Al Dl24cH: 156 D6GH = 0
E@CH1 il | = 00
2@ CH (1) |
@@ CH (1P, 40MHz, 1-5) |
H® CHA H
“® CHS5 i
M@ CHE —
2@ CH (61 |
2@ cHs |
2@ CcHY |
2@ cH 11
2@ CH 36
@@ CH (36 P, 80MHZ, 36-48)
6@ CH 40
(@ CH (40 P, 80MHz, 36-48)
V@ CHas Signel Coverage.
1@ CH (44 P, 40MHz, 44-48) Threshold | Description
FI@ CH (44 P, 80MHz, 36-48)
48) v
Requirement  AitvISE  Description
Create or modify plans Using original data: All checked Channels
5. From the Channel/SSID pane, select the Channeltab.
6. Click the Select All check box to deselect all entries in the Channel/SSID pane.
7. Manually select the entries by checking the corresponding check boxes.
@ AirMagnet Survey Professional Edition - Indoor.svp X
Fle Edt View Help
s Mot Floor Planner oo Survey [T Display [JE Simulation [ Multiview S, DifView | ) Arwise | [%] Reporss
B H D 0O0¥ X W Q Q&K% 4@ @ veowa- ) @
Recuirement Policy @@ @ @ @) e e e I o TS St
2 |5 Signel
- (dBm)
Reguirements % of Good Area PassiFail A |17 5
Ssi ge m 5
3 Muliple AP Signel Coverage 00 Fail | T o
3 Channel Inerference 04 Fail ] !
3 Measured PHY Data Rote Up NA A - e
2 Measured PHY Dsta Rate Do. NA N/A — 3 Y
-3 Predicive PHY Data Rete Do, 0. Pas: | ulal ol
3 Signal Noise Ratio Coverage A NA | —_—
3 Noiss Level NA NA 4 - L
3 User Capsciy NA A = -
2 Operating Mode 0.0 Pas: ]
<3 Channel Width 0 Pas: 3 50
2 802.11n Highest MCS Index WA NA 3
280211 ac HighestMCS Index NA NA | n
3 802.11x Highest MCS Index 00 v M |5 .
Dseect Al G246 EsGHz DlecH: o .
D@ cH52 | = -100
D@ CH (56,1 |
D@ CH 56 al
1@ CH (60.1) =
O@ CH (100,1) o
@ CH (100 P, 80MHz, 100-112) -
B2 CC32E5:55D1:7E (AMM-11ax-56,-27) |
M E2CBACST:AZC2 (ngenius&sniffer,-61) | )
1% EG.CB:ACST:AZC2 (NSVisitor,-60) |
L@ CH 104
CI@ CH (112 P, 80MHz, 100-112)
D@ CH (116 P, 80MHz, 116-128)
O@ CH (132 P, 80MHz, 132-144)
D@ CH 149
@ CH (149 P, 80MHz, 149-161) Signal Coverage
D@ cH 153
CI@ CH (153 P, 40MHz, 149-153)
@ CH (157 P, 40MHz, 157-161) v

© Channel @ SSID

Requirement AvWISE Description

Using original data: AP : CC32E555:D1:7E Selected APs 1

Note: The figure above shows that the marked area of the WLAN site is mostly not covered by the other APs.

Managing AirWISE Requirement Policies

AirWISE Requirement Policies allow you to maintain different requirement profiles, which you can then apply to existing
Survey projects. This helps you ensure compliance with various corporate requirements over different projects (or even in
different areas of a single project). You can also enforce two levels of wireless compliance, such as locations where both
wireless voice (VolP) and data infrastructures are in place. Due to the potentially wide variations in requirements for voice
traffic as opposed to standard data transmissions, these two implementations require different minimum signal levels, AP

placement, and PHY data rate information.
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The policy management portion of the view contains five main functions, as shown in the image below. These functions are
described in more detail in the following sections.

Requirement Policy @ @ ﬁ fﬁ‘ ﬁ\

D efault -

Selecting an AirWISE Requirement Policy

The AirWISE policy selection drop-down list allows you to specify the current profile in use. This list includes preconfigured
policies as well as any user-defined profiles that have been created. To select a new profile, click the drop-down and make
the desired selection from the list.

Requirement Policy f@ ﬁ?‘ {’E‘ fﬁ" ﬁ?'

[ efault t]
|. Cizoo Location Service

Cizco_7920-80211b

Cizco_7921G-802.11a
I Cizco_7921G-302.11bg

Cizco_7925-80211a

Cizco_7925-802.11bg

Yocera

Note: Policies are included with AirMagnet Survey by default.

Creating Custom Requirement Policies

Although Survey includes preconfigured policies designed for standard deployment types, you may also customize your own
policies tailored to your wireless environment. This section describes the basic steps for creating and modifying a custom

policy.

To create a new AirWISE policy:

Gt
1. From the Requirement Policy window, click (New policy). The New Requirement Policy window appears.

New REQ Policy

Palicy Mame:

@) Create new palicy

() Copy from:

L Ok, ;I [ Cancel

2. Enter the desired name for the new policy.

3. Choose one of the options:

-207 -



AirWISE View

« Create new policy (default): Creates the policy using the default values for all requirements.

« Copy from: Creates the policy by copying the values of another policy. Selecting Copy From displays a drop-down menu
to select the policy to be copied.

Click OK to continue after making the desired selection. The new policy is selected on the AirWISE view.

After the new policy has been created, you can modify any of the thresholds as needed. Use the same steps described in
Adjusting AirWISE Requirement Thresholds.

#
Note: To delete a user-created policy, click with the policy selected.

Working in Requirement Window
This section explains how to change a requirement threshold value to affect compliance to the related AirWISE Requirement.

Note: To analyze survey data on the AirWISE view, you must first load the selected survey data on the Display view and then
switch to the AirWISE view. The following explanation assumes that you have already loaded the data on the Display view.

1. When AirWISE is opened, the default view shows a list of requirements and associated configurable threshold values in
the right-side table. However, if a particular AirWISE policy is selected from the list of AirWISE requirements in the left-
side table, you can click the Requirement tab to display the table.

Thveshoid

2. Inthe Threshold column, select a value to change and overwrite it with the new value.

Bl 2 Signal Coverage

signal strength required

B 2) Multiple &P Signal Coverage

Bl 2 Signal Coverage

| strength required

.

E 2y Multiple &P Signal Coverage

3. Click (Refresh). The change and its impact on the network’s compliance with the selected AirWISE Requirement
are reflected instantly in the AirWISE Summary section of the view.
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Feguirement Policy e ® o

2

AiWISE Reguirements % of Good Area | Pass/Fail |
Requirements Overview

~J Signal Coverage
-3 Multiple AP Signal Coverage
- Channel Interference

- PHY Connection Biate Covera... [l [REEN
-J Predictive PHY Data Rate Do... 100.0 Pass
~d Signal Moise Ratio Coverage [l [l
- Moise Level T, SN
-~ User Capacity M, M,
~J Operating Mode 794 Fail

<3 Channel Width Fail
~J Wi-Fi 4 Highest MCS Index
~J Wi-Fi § Highest MCS Index

3 Wi-Fi B Highest MCS Index

4, With the requirement selected, click the AirWISE tab in the lower-left corner of the Content Window to view how the
change is reflected in the heatmap.

) 2 3 o 5 o 3
T N S N S S RS S N R

[ =

&1

4\ |
|

Sighal Coverage

| Fectenent| anusE |Descrpton]

Saving Changes to AirWISE Policies

After changes have been made to a custom policy, you must save the changes to ensure that they aren’t discarded after the

project is closed or navigates away from the AirWISE view. This can be performed by simply clicking g (Save policy).

However, if you have made changes to one of the preconfigured policies, the changes must be saved under a different profile

) ) " .
name. This operation can be performed using (Save policy as...).

Note: If unsaved changes exist when you attempts to navigate away from the AirWISE view, a message asks if the changes
should be saved.
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Removing AirWISE Policies

%
Clicking (Remove policy) opens the Remove Policy dialog box, which allows you to manage the attributes of the
current project’s policies.

Remove Policy @

Cizco Location Service
Cizco_7320-802.110
Cizzco_7921G-802.1174a
Cizzo_7921G-802.11bg
Cizco_7925-802.11a
Cizco_7925-802.11bg
Default

Yocera

Fiead only file

| Remaove | [SetHeadUnly] [ Daone

As seen above, the Remove Policy window provides three major options for the policies:
+ Remove: Deletes the selected policy application.
« Set Read Only: Sets the selected policy to Read Only, which ensures that the policy cannot be modified or removed.

« Done: Closes the Remove Policy window.

AirWISE Menu and Toolbar Reference

Toolbar

The following table provides description for additional Toolbar tools available in the AirWISE view.

Icon [Tool Name Description

Reset AirWISE Changes all AirWISE settings back to their defaults.
Requirements
Load AirWISE Same as File > Load AirWISE Requirements,
Requirements
Save AirWISE Same as File > Save AirWISE Requirements,
Requirements

Rect Region Tool |Allows you to mark and select a rectangular area on the site map in
the AirWISE window.

Arbitrary Region [Allows you to mark and select an area of any shape.

Tool

Clear Last Region |Allows you to remove the area selection mark you last made on the
site map.

XX O0no|g|o

Clear All Regions |Allows you to remove all area selection marks you have made on
the site map in the AirWISE window.
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AirWISE View

e The Legend on the AirWISE view shows the level of compliance to AirWISE requirements

Signal
LE) according to the threshold (signal value) you specify.
o
e Areas that meet the requirements are shown in green.
-10
« Areas that fail to meet the requirements are shown progressively in shades of yellow and red,
o reflecting the different levels of non-compliance. The more red the color, the worse the non-
-30 compliance.
-  Use the .™ Refresh button on the toolbar to update the view after you have adjusted the
;L threshold value.

File Menu

The File menu on the AirWISE view includes some additional options:

Menu Option

Description

New AirWISE Policy...

Opens the New Requirement Policy dialog box. See Creating Custom Requirement Policies
for more information.

Save AirWISE Policy

Saves any changes made to the current AirWISE policy.

Note: If the current policy is one of the preconfigured policies packaged with Survey, an
error message is displayed prompting you to save under a different name.

Save AirWISE Policy As...

Opens the Save As dialog box which allows you to save a current AirWISE Policy using a
different file name.

Import AirWISE Policy...

Opens the Open dialog box, which allows you to open a previously created AirWISE policy
file into the current project.

Export AirWISE Policy...

Opens the Save As dialog box, which allows you to save a current AirWISE Policy using a
different file name to a separate location (for example, to a USB external drive). Two files
are created: The .SAR file and .PCT file. Both files must be imported into another installation
of AirMagnet Survey PRO to share the policy.

Remove AirWISE Policy...

Opens the Remove Policy dialog box. See Removing AirWISE Policies for more information.

Load AirWISE Areas...

Opens the Open dialog box, which allows you to open an AirWISE Area (.saa) File. The file
contains data regarding areas drawn on the AirWISE view to define requirement regions.

Save AirWISE Areas

Saves the current AirWISE areas.

Save AirWISE Areas As...

Saves the current AirWISE areas under a new file name.

Edit Menu

The only option for the Edit menu is Copy Heatmap Image. Select this option to copy the current heatmap image to the

clipboard.
View Menu
Option Description
g% Zoom In Enlarges the view of the current floor plan (same as Ctrl+Page up). (You can also use your mouse's
scroll wheel.)
Q% Zoom Out Reduces the view of current floor plan (same as Ctrl+Page Down), (You can also use your mouse's
scroll wheel.)
E Zoom to Fit Fits the current floor map to the map window.
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@ Zoom to Actual

Size

Fits the current floor map to its actual print scale.

Set Zoom...

Opens the Set Zoom dialog box where you can specify the specific ratio at which the view of the map
can be increased.

Toolbars and
Docking Windows

Choose to show or hide the Legend and Status Bar (show is checked). Reset Toolbar: Dragging the
Toolbar handles undocks the Toolbar. Clicking this option reset the Toolbar to its default setting.

Show Rulers

Shows or hides rulers along the edge of the map window.

Show Grids

Shows or hides grids in the map window.

Use Simulated Data

The View menu of the AirWISE view includes the Use Simulated Data option. When your survey
includes simulated data (see About Simulation view), you can choose whether to use original data or
simulated data (checked indicates Use Simulated Data).

T n Refresh

Generate and refresh the heatmap. (You can also press F5>.)

Help Menu

Item

Description

Contents

Open Help documentation

Sample Project

Open a sample MFP building project for Wi-Fi 5 or Wi-Fi 6.

About Multi Floor Planner

View basic information about MFP such as version and build number.
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Reports View

AirMagnet Survey can automatically convert any survey data shown on the Display view into a variety of data reports, which

can be viewed, printed, or distributed from the Reports view. You can access the Reports view by clicking m Reports o the
navigation bar.

Note: You must have an open data file in the Display view and also select an option from the Report List before you can view
data reports.

In this chapter:

Reports Introduction ... ... 214
File MONU 215
VW MU 215
Report Template List ... .. .
Customizing a Report Template

General information Tab ... ... .
RepoOrt Translation ... .
CaNNEl S SID TrE@ ..o . e 218
REP oIt WiNdOW 219
To0lbar 220
Viewing Survey Data RepOrts ... ... . . 221
PrINtiNg RePOIES ... . . 221
EXPOFtiNG ROP OIS 221
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Reports Introduction

The Reports feature enables you to generate a report based on the data file selected in the Display view.

A variety of preconfigured reports are available. The following options enable you to customize any report:
o Edit an existing report by adding and/or removing sections.

+ Duplicate a report and modify the duplicate.

o Start with a blank report and add desired sections.

« Revise the text of any heading and/or section content.

o Localize a report automatically to any of the following languages: English, German, French, Arabic, Russian, and Japanese.
You can also manually revise the translated text.

e Customize the Title Page graphics

« Customize to show/hide cover page, table of contents, header, footer, page number, and each section’s title and contexts.

You can access the Reports view by clicking Reportson the navigation bar.

Double-click a report to generate it. The report displays in the main view.

(&) AirMagnet Survey Professional Edition - Indoor.svp - o X

B

File View Help

¢ (& Panner F Multi Floor Panner 0 Suney (55 Display Simulation Muttiview S Ditfview € Awise | [%] Reports
‘9 it & [blw Q& & K B R veoea- 2 [T
() @ @M @‘n<>u/30

&) Repoits
-BY Active IPERF Survey Report

-[E5j AP Interfersnce Report
-5 Channel Inteiferance Report
Overall Coverage Repart by &P Prepared for:
Overall Coverage Repart by Channel Prepared by:

Localion:
Time of Survey: Tuesday, September 29, 2015 7:17:30 PM

Overall Coverage Repart by 551D
- Passive Survey Report

Per 4P Repart

Per Channel Report

Per 551D Report

-5 Planner Report

RF Spectum Repart

Survey Moble Report

oFi Report

< >

Select All [ 24GHz 5GHz []66Hz

@ Channel
M@, cHs Y
- @ CH (36 P, 40MHz, 36-40)

@ Channel & S0

Using original data: All checked channels
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File Menu

The Reports File menu includes options that can help you manage and distribute survey data reports.

Option Description

Report con- Opens the General Information tab in the Report Template manager where you can modify aspects of the
figuration... report, including logo, footer, and location.

ACL... Opens the ACL (Access Control List) window where you can add APs to or delete them from the ACL table.

This feature enables you to categorize access points discovered during a survey into two groups: those
that you manage (ACL) and those that you do not manage. Non-ACL access points include those from
your neighboring businesses and rogue access points.

Click Add to display a list of Access Points contained in the survey. Check the APs you want to include in
ACL, and then click OK. If the ACL feature is used, the report sorts the APs into these two groups.

Print... Print the current report.
Print Setup... Change print settings for the current report.

View Menu

The View menu on the Reports view provides an additional option:

Landscape Orientation: Switch the report orientation from portrait to landscape. Once in Landscape orientation, the report
may be changed back to Portrait orientation by deselecting Landscape Orientation.

Report Template List

The Report List displays the Report Templates. Each template is preconfigured to generate a report containing topics relevant
to the title of the report (for example, Passive Survey Report). However, you may fully customize any report to meet your
needs.

Note: A report is based on the selected data file in Display view. Therefore, the report may only contain data included in that
data file. For example, your report cannot contain VoFi information if the associated data file does not contain a VoFi survey.

) & K@

£ Reparts
Active IPERF Survey Report

Achive Survey Report

Airw15SE Report

AF Interference Report

Channel Interference Report

K. CustomB epart

Overall Coverage Report by AP

Overall Coverage Report by Channel

Overall Coverage Report by 551D

Per &P Fieport Edit
Per Channel Repo Delete
Per S5ID Report
RF Spectrum Rep:
Survey Mobile Rep Export
'oFi Report

Rename

B I I I

< >

In the Report List, the following actions are available:

Item Description

E‘:Eg‘ right-click the folder Add a new, blank template or copy an existing template. Type a name for the
or Reports template. Choose none for a blank template or choose a listing from the drop-

and then select New Custom Report |6,y to create a duplicate template. Then click OK.

Template
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("?\ right-click and select
or Edit

Edit the selected template.

ﬁ:"‘ right-click and select
or Delete

Delete the selected template. Once deleted, the template cannot be restored
unless the product is re-installed.

Right-click and select Rename

Rename the selected template.

Right-click and select Export

Opens a file window that lets you select a folder to export the selected template in
ZIP format.

Import

Right-click the Reports folder, select Import Custom Report Template, and then
browse to the desired ZIP file. Click Open,

Customizing a Report Template

If you choose to Edit or Create a report template (see Report List), the Create Custom Report Templatemanager opens with

the Report Templatetab displayed.

« If you chose to Createa new template, the left-side of the manager is empty. This enables you to build the template by
adding the desired section from the Available Categories section.

« If you chose to Edit a template, the left-side of the manager contains the preconfigured sections associated with the
template title. You may choose to remove undesired sections from the Custom Report Template area on the left and/or
you may add sections from the Available Categorieslist.

Editing Report Template:"Passive Survey Report”

Report Template | General Information |

==

Report Template Name:  Passive Survey Report

Custom Report Template

Default ReportLanguage  English v Restore Default

Available Categories

[ 1 Executive Summary

I3 4 WLAN Deployment Requirements

[ 6 Current Deployment Site Survey

=| 8 Conclusions

[ 5 Current AP Placement and Configuration

[3) 7 Deployment Validation Against Requirements = #-{E5) 7 Deployment validation Against Requirements

+ © W -
#-E3) 2 Introduction

=l 3 Methodology

{ﬁ) 4 WLAN Deployment Requirements

{£3) 5 Current AP Placement and Configuration
@ & Current Deployment Site Survey

m

#-3) 8 Additional Survey Measurements
-,) {£3) 2 overall Coverage Report by Channel
{23 10 overall Coverage Report by SSID
{Z5) 11 Overall Coverage Report by AP

{2 12 Per Channel Report

{3 13 Per SSID Report

-3 14 Per AP Report
{1 15 Planner Report

Executive Summary Description

.AbB.'QE

This wireless site survey and RF analysis were performed in order to gain an in-depth understanding of present RF interference
sources and to meet overall wireless coverage requirements. The primary goal and subsequent objectives were designed with
coverage, desired throughput and usability as primary driving requirements from the business group. This survey was created using
an industry standard set of AirMagnet Survey PRO wireless tools and software, which are used for building and securing wireless
networks. This survey encompasses site surveying, RF spectrum analysis surveying and real time active site surveying
technigues. This document includes site survey specific information, Access Point configuration and installation data sheets, and RF
coverage pattern maps. A wireless survey was performed at the customer site. The purpose of the survey is to determine the
number and placement of wireless access points necessary to provide ubiquitous coverage for the entire building.

o

1. To subtract a section from the report, locate the desired section by expanding the Custom Report Templatetree. Select
the section. Click the right facing arrow to move the section to Available Categories.

2. To add a section to the report, locate the desired section by expanding the Available Categories tree. Select the section.
Click the left facing arrow to move the section to Custom Report Template.

3. You may also modify any of the default description text associated with section. Select the section in the Custom Report
Template tree. This displays the text (if any) in the description area at the bottom. Modify the text.

4. Click OK to save changes
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General information Tab

Click the General Informationtab to customize information such as the survey title, surveyor name, survey location, custom
report header and footer, and so on.

This tab also includes the Translation button that enables some additional translation features. See Report Translation.

Editing Report Template:"Active IPERF Survey Report™ | =

General Information

Survey Title:
Surveyor Name:
Location
Company:

Date

Zoom: 25.50%

Report Template | General Information

Cover Sheet Picture:  Default Cover Sheet Picture

If no results are found in the project for a report template category, that category will
have the message "Results for this section were not part of the survey”. To remove a
categorv from apoearina in the report. uncheck: it in Reoort Temolate tab

Cover Sheet
Includs Cover Shest [71Include Data Filename
Preview Cover Sheet

Individual Distribution
[ Include individual heat map

Corporate Logo: Default Coporate Logo

Ed

Mumber of AP per page

BB
0

oooooOm

| »

6 APs -

Mapimum number of individual
APs . (Enter number between 1

and 300) Include Table of Corterts

Include Section Headers and Text
— 300 Include Page Headers/Footers

.

Include Page Numbers
Report Page Header:

Report Page Footer:

After modifying the properties desired, you can preview a sample of the report’s cover sheet in the right-hand portion of the
window by clicking Preview Cover Sheet. The table below describes the fields available for customization.

Field

Description

Survey Title

The title of the survey. Note that this differs from the name of the template in that the Survey
Title is printed on the cover page of the report itself.

Surveyor Name

The name of the person who conducted the survey.

Location The location at which the survey was taken.
Company The company for which the survey was conducted.
Date The date of the survey.

Cover Sheet Picture

The picture that is displayed on the cover sheet of the finished report. Recommended size is
650w x 400h pixels. This image appears in the cover sheet of all reports. BMP, JPG, PNG and
GIF are supported. When browsing for an image, be sure to select the correct image type
desired from drop-down.

Corporate Logo

If desired, you can specify a logo to be displayed in the lower-right corner of the cover page.
Recommended size is 164w x 164h pixels. This image appears in the cover sheet of all reports.
BMP, JPG, PNG and GIF are supported. When browsing for an image, be sure to select the
correct image type desired from drop-down.

Individual Distribution

This option allows you to force the report to display a limited number of APs in each heatmap
display. In this manner, you can view fewer devices per page and get a better idea of each AP's
coverage area. This mechanism can be enabled for any or all of the heatmaps displayed in the
report.

Translation

Enables report text to be localized to the language of choice. See Report Translation.

Report Page Header &
Footer

If desired, you can enter text to appear in the header and footer portions of the report. This is

displayed in addition to the default page number shown on all reports.
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Include Cover Page, Data Check the corresponding boxes to include/hide different parts of report.
Filename, Table of Contents,
Section Headers and Text,
Page Headers/Footers, and
Page Number

Report Translation

in the Report Template manager, there are some options available for enabling you to localize a report to a desired
language.

By default, the Windows setting for "Display Language" is presented, so translation in this regard refers to editing text.

Note: Before modifying a template, you may find it desirable to first duplicate a report template and include the desired
language in the file name, for example, Passive Survey (German).

« Default Report Language: This drop-down, located on the Report Template tab, enables you to view report text in the
following languages: English, German, French, Arabic, Russian, and Japanese. After selecting a language option from the
drop-down, click Restore Defaultto apply the language to any sections in the Custom Report Template area of the
template manager.

« Manually edit any text: You may manually edit the text in any section by selecting the section and then editing the text
that appears in the text editor area (the lower section of the template manager).

* Manually edit any header text (category headers): right-click a heading in the Custom Report Template area of the
template manager. Select Rename and type the desired text.

« Incidental items on the report pages: Additionally, there is some incidental text in the report not included in the
methods above. From the General Information tab, click Translation. Translate the items in the left column into the
desired language using the fields in the right column.

Report Translation @

Original wersion | Translated version | -

Degired Sighal Coverage

m

Multiple &F Signal Coverage

Channel Interference

Meazured PHY Data B ate Uplink Coverage
Measzured PHY Data R ate Downlink Coverage
Predictive PHY Data Rate Downlink Coverage
Throughput

Signal Moize R atio Coverage

Moise Level

Uszer Capacity

Operating Mods

Channel *fidth

Highest MCS Index

|Perf Thraughput U plink Be

[ Copy From Report Template ] Use Default

| Save | ’ Cancel

Once translation is completed, click OKto save any changes and close the Report Template manager.

Channel/SSID Tree

This part of the Reports view allows you to tailor the content of the report. In general, the reports can be displayed by
channel or by SSID. You can toggle between the two by clicking
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I & Charnel E 5510
. The image below shows all the APs on each available channel as well as the SSID and

maximum RF signal level of each AP.

[]Select All []2.4GHz []5GHz [»]6GHz

@ Channel
)

@ Charinel E 351D

As seen above, there are check boxes above the Channel/SSID Tree:

o Select All: This function enables you to select or deselect all entries on the Channel/SSID Tree with a click of the button.
By default, all the entries in the Channels/SSID Tree are selected when the Reports view opens. It is a good idea to use this
button to deselect all the entries and then manually select only the entries in which you are interested. In this way you

can customize your survey data reports using data about the selected devices.
e 2.4 GHz: This checkbox selects only the channels in the 2.4 GHz band.
e 5 GHz: This checkbox selects only the channels in the 5 GHz band.
e 6 GHz: This checkbox selects only the channels in the 6 GHz band.

Report Window

The Report Window displays the report based on the options selected from the Report List and Channel/SSID Tree. There are
a number of tools across the top of the Report Window. They are specifically designed for viewing and sharing survey data

reports, as described below.
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Page3ofig

Icon Name Description
Iﬁ} Export Brings up the Export dialog box which allows you to export the current report to a
specific destination in a selected format.
|4 To First  |Allows you to move to the beginning of the current report.
Page
Back Allows you to return to the previous page of the report.

Page
I 2 of 38 |count

Shows the total number of pages contained in the current report and the page you are
viewing.

Note: You can directly navigate to a specific page in the report by highlighting the
current page number and then entering the page number of interest and pressing the
Enter key on your keyboard.

3 Forward [Allows you to move to the following page of the report.
b To Last  [Allows you to move to the end of the current report.
Page

Toolbar

The toolbar contains the commonly used tools for viewing and printing reports. Most of these tools are identical to the
options found in the Fileor Viewmenus of the view.
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Icon [Name Description
o% Zoom In Enlarges the size of the current report on the view. (You can also use your mouse's scroll wheel.)
a% Zoom Out [Reduces the size of the current report on the view. (You can also use your mouse's scroll wheel.)
E Zoom to Fit [Fits the current report to the size of the Report Window.
a Actual Size [Resets the current report to actual printing size.
Refresh Refreshes the data in the current report.
Report
G Report Opens the Report Configuration view, where you can specify or modify information that appears on the
Information |reports to be generated.
i]?'-_ ACL Opens the ACL window, where you can add or delete APs from the ACL table.
Landscape |Allows you to switch the orientation of the report on the view between portrait (default) and landscape.
& Print Allows you to print the current report.

Viewing Survey Data Reports

The following are the general procedures for viewing a data report:

1.

2
3.
4
5

While in the Display view, open a survey data file.

From the Navigation bar, click (5] Reports . The Reports view appears.

From the Report List, select a report.

From the Channel/SSID Tree, click the Channel or SSID tab.

Use the controls

on the view to adjust your viewing options.

The heatmap colors displayed in reports are somewhat dependent on monitor display settings.

Printing Reports

To print a survey data report:

1.

2.
3.

From the Report List Window, double-click to open a report.

Click ﬁ (Print Report). The Print view appears.

Make the selections and/or entries as shown on the view, and click OK.

Exporting Reports

You can export reports in multiple electronic file formats and to a number of destinations. This makes it possible to share and
back up your survey data with ease.

To export a survey data report:

1.
2.

3. Click

Customize the report, if necessary, using the Channel/SSID Tree.

Double-click the desired report from the Report List Window.

(Export Report). The Export view appears.
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4. Click the Format down arrow and select a file format from the drop-down list.
5. Click the Destination down arrow and select a destination for the file to be exported.

6. Click OK. The Export Options dialog box appears.

Note: Depending on the option you select in Step 5, the report can be exported to a disk drive or sent out as an email
attachment. You can then open and view the report in the format you have selected, provided that you have the application

that supports it (file format).
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RF Signal Adjustments

In this chapter:

About Signal Adjustment .. ... . 224
Using Signal Adjustment Options ... ... . ... ... . 224
NO A JUSEM Nt 224
Pre-Defined Adjustment ... .. . . 224
CUSTOM AdJUSEMENt . 225
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About Signal Adjustment

You can choose a wide variety of 802.11 wireless network adapters. However, there is a possibility that manufacturing
differences between the vendors can result in different signal readings.

To reduce this problem, NetAlly has a list of “preferred” Wi-Fi adapters, which you can view here: https://www.net-
ally.com/wp-content/uploads/AirMagnet-Recommended-Adapters.pdf

NOTE: Signal adjustment on channels in the 6 GHz band are not supported.

Using Signal Adjustment Options

AirMagnet Survey comes with a Signal Adjustment dialog box to make wireless network adapter adjustment fast and easy.
You can bring up the dialog box by clicking File > Configure... > 802.11 > Adjust Signal....

Once you have brought up the Signal Adjustment dialog box, click the down arrow in the upper-left corner and select one of
the following options:

+ No Adjustment
e Pre-Defined Adjustment (This is the entry below No Adjustment, for example, AirMagnet 802.11 a/b/g/n Wireless PC card.)

e Custom Adjustment

No Adjustment

No Adjustment means no adjustment offsets are applied by AirMagnet to the wireless network adapter. This option should be
used when you prefer to use the adapter manufacturer’s raw RF signal strength readings.

To use a wireless network adapter’s default settings without adjustment, perform the following steps:

1. From the upper-left corner of the Signal Adjustment dialog box, click the down arrow and select No Adjustment from the
list menu. (See the figure below.)

Signal Adjustment “

<Mo Adjustments v ALL Channels

-30 dBm
0 dBm

+30 dBm
5 -0 5 20 2% 30 35 40 45 50 B5 B0 65 70 75 80 B 40 85 0

Noise floor adjustment: 0 Cancel

Note: When you have selected No Adjustment option, all other controls in the Signal Adjustment dialog box are grayed
out (unavailable).

2. Click the OK button to implement the selection.

Pre-Defined Adjustment

If the wireless network adapter you are using is on the pre-adjusted list, then the AirMagnet application automatically
recognizes the adapter and displays the predefined adjustment option. You can then select and use the AirMagnet-adjusted
values or make changes to the predefined settings. (This is customizing a pre-adjusted wireless network adapter, discussed
below.)

NOTE: All tests for defining the adjusted values for the wireless adapter were performed using adjusted spectrum analyzers in
a professionally shielded isolation chamber to ensure the best possible accuracy. The adjustment first uses the spectrum
analyzer to measure the down-link (from AP to station) radio signal strength from the Access Point at various attenuation
points, with an attenuator placed in between the two. The attenuation is achieved by tuning down the radio signal power the
attenuator receives from the AP. For example, if the attenuator receives the signal strength of -20 dBm from the AP, it is tuned
down to -30 dBm. As a result, the AP signal strength is -30 dBm when received by the spectrum analyzers. The measurements
are carried out at on all channels applicable to the wireless protocol used on the wireless network adapter being adjusted.
Once the benchmark values are established using the spectrum analyzer, the same measurement procedures are performed
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with the wireless network adapter (for example, AirMagnet 802.11 a/b/g/n Wireless PC Card) and adjust the values in
reference to the benchmark values.

For example, at Attenuation Point A, the spectrum analyzer displays a radio signal power value of -20 dBm, and the adapter
being adjusted displays -30 dBm. AirMagnet adds 10 dBm to bring it to line up with the benchmark values. The predefined
offsets are relative to the spectrum analyzer. In other words, the predefined adjustment patterns make the target Wi-Fi
adapter report signal strength readings similar to those reported by professional-grade spectrum analyzers. For the same
wireless network adapter, this same procedure is repeated on every applicable channel/frequency to derive the predefined
adjustment values. All adjustment data involving those pre-adjusted wireless network adapters are included in the
application.

To use predefined adjustment, do the following:

1. Click the down arrow and locate your wireless network adapter in the predefined adjustment entries.

Signal Adjustment “
Prozim ‘Wireless 8434 802.11a/b/g/n USE &dapter w Channel 1 2.4GHz w

-30 dBrm
0 dBr

+30 dBm
45 0 45 .20 25 30 3/ 40 45 50 B85 6D 65 70 75 B0 B85 40 95 100

Moise floor adjustment; 0 Cancel

2. Select the adapter (for example, AirMagnet 802.11 a/b/g/n/ USB Adapter Card as shown in the figure above) if the name
of your wireless network adapter appears.

3. Click OK.

Note: You can make any change to a pre-adjusted wireless network adapter by making custom adjustments on the basis of a
predefined adjustment. Custom adjustments do no change any of the signal values that depend on the pre-adjustment
settings. See the next section.

To change predefined adjustments, do the following:

Repeat Steps 1 through 2 in the previous paragraph.

From the upper-right corner, click the down arrow and select a channel of interest.

Use the sliders to turn up or down the RF signal strength as desired.

When the “Create a custom signal adjustment based on current settings?” message appears, click Yes.
Continue to adjust the signal strengths with the sliders.

Enter a value in the noise floor adjustment box.

N o~ N e

Click OK to implement the change.

Note: Custom signal adjustment on a pre-adjusted wireless network adapter must be done channel by channel because the
changes apply to a single channel only.

Custom Adjustment

Custom adjustment lets you create your own adjustment table for your wireless network adapters. This process uses Signal
Adjustment dialog box.

Custom adjustment patterns can equalize the signal strength readings between any combination of Wi-Fi adapters. Begin by
measuring (similar to the process defined in pre-adjustment section) two different radios with zero offsets at varying
distances, comparing the received signal strengths at each distance, then calculating the differences between Wi-Fi adapters
and using the differences to set the offset of one radio in an effort to match the signal strength reading of the other Wi-Fi
adapter.

This feature allows you to adjust the RF signal strength and noise floor of the wireless network card in 5 dBm increments.
This way you can normalize different Wi-Fi adapters to exhibit similar signal level readings. Without using this feature, the
signal level readings may vary significantly between Wi-Fi adapters from different vendors, or even between different models
from the same vendor.
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The horizontal numbers (-5 to -100) represent the signal strength levels received by a Wi-Fi adapter. At each signal strength
level, an offset can be set (from -30 dB to +30 dB) by adjusting the sliders up or down.

To custom-adjust a wireless network adapter’s RF signal power, do the following:

1. From the drop-down list menu, select Custom Adjustment (The name of your wireless network adapter should be
appended here, if it has not been pre-adjusted). See the figure below.

Signal Adjustment “
Proxim Wireless 8494 802.11a/b/g/m USB Adapter v ALL Channels v

-30 dBm
0dBm

+30 dBm
el o0 15 20 25 30 35 40 45 AO 55 6D 65 70 75 80 B 40 95 00

Noise floor adjustment: 0 Cancel

2. From the upper-right corner, click the down arrow and select a channel of interest.

Note: Normally, signal adjustment is performed on a per-channel basis unless you want to apply the same adjustment to
all channels. In this case, you should select All Channels from the channel list menu.

3. Use the sliders to adjust the RF signal strengths.
4. If you wish, highlight the number for the Noise floor adjustment box and type a new value over it.

5. Click OK when completed.
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Analyzing VoFi Survey Data

Since it is far easier to troubleshoot and repair issues with a VoFi wireless deployment before supporting active users with it,
NetAlly strongly recommends that you conduct and analyze a VoFi survey before attempting to activate it in a real-world
scenario. This process can be drastically different from deploying a standard data network simply because what would
amount to a small issue for a wireless data installation (slight drop in signal strength, small wireless dead zone, and so on)
can be a much greater problem when the deployment is intended to support voice traffic. A disconnect that lasts for two
seconds would go largely unnoticed in a standard wireless deployment, but the same disconnect during a VoFi call can result
in dropped calls and overall diminished call quality.

The process of analyzing data collected from a VoFi survey is generally similar to that of a standard survey, but VoFi surveys
contain additional data (such as roaming information) to help identify problem zones in the VoFi deployment coverage.

NOTE: VoFi surveys are not supported for the 6 GHz band.
« VoFi Data Types

e Roaming Analysis
» Troubleshooting Poor Call Quality

VoFi Data Types

The Data Type List Menu for VoFi-specific surveys contains selections that are unique to voice deployments, as shown below.
VoFi Signal Strenagth (AP-=Phone) |'|

VoFi Signal Strength (AP-=Phone)

Roaming £one

Capacity »
Channel Utilization

AP -= Phone [
Phone -» AP »

Each selection provides information for troubleshooting and maintaining VoFi deployments.

« VoFi Signal Strength: shows the signal strength detected at each point along the survey path. Note that this selection
provides data on transmissions from the AP to the phone.

* Roaming Zone: displays the regions in which phones are most likely to roam. When this map is loaded, potential roaming
zones are displayed in red.

« Capacity: Number of Station(s) shows the number of stations detected on the AP during the survey. Note that “stations”
can see other VoFi phones in addition to other wireless clients (such as notebooks or wireless-enabled desktops). Number
of Active Call(s) shows the number of active calls detected during the survey. This value includes the call monitored
during the VoFi survey process.

« Channel Utilization—displays the overall utilization on the current channel. Note that this value accounts for standard
wireless traffic in addition to VoFi traffic on the channel.

The AP -> Phone and Phone -> AP options each provide three additional display types. These selections provide data
detected from transmissions between the AP and the VoFi phone.

e WiMOS Score—much like the MOS score widely used to monitor the quality of wired communications, the WiMOS score
provides a value to display the call quality at each point during the survey process. This value can range from 1 (poor) to
4.5 (excellent).

« PHY Data Rate—displays the data transfer rate detected during the survey. This value is measured in Mbps.

* Packet Retry Rate—shows the percentage of packet retries over the course of the survey path. Excessive packet retries
can indicate wireless hazards (such as interferers) in the surveyed environment. Note that this percentage is calculated as
a percentage of retry packets transmitted over the past second.
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Roaming Analysis

VoFi phones roam in even the best of VoFi deployments, so a roaming analysis is critical to ensuring that users can enjoy unin-
terrupted service during these roaming periods. AirMagnet Survey PRO allows you to review roaming information captured
during the VoFi survey process, including each instance in which the phone roamed, its location, and the time it took to re-
associate to the new AP. These data can subsequently be used to determine potential hazards or holes in the VoFi wireless
deployment.

Note: Roaming events are displayed in real-time during the VoFi survey process. See Conducting VoFi Surveys for more
details.

Survey’s VoFi Roaming Events tab provides a summary of all captured instances of roaming as well as the pertinent data
associated with each event.

Select All Events

L3

{¥oFi Hoaming E vents
ERC] - I
EI # Roaming Start

- § From &P Qa_VaFi_2

----- f Channel: 149

P # Last Enown Signal -73 dBm
= # Roaming Result

----- § Success Beconnect

..... i ToAP: QA VoFi_3

----- I Channel 157

----- I Signal -78 dBm

----- f FRoaming Time: < 1 zec

m

- § Roaming Start

- # Roaming Result
- § Roaming Start o
- # Roaming Result

El'"

o L Lrh UM |

3 Channel | E 5510 “oFi Roaming Everts

Each instance in which the VoFi phone roamed during the survey process is included in this tab and has a checkbox allowing
you to view the roam location on the map. By default, all roaming events are automatically checked when a VoFi data file is
loaded. The roaming instances are displayed on the site map with icons that demonstrate where the roaming started and
stopped, as shown below.
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(s)

Event #

Roaming 4
Roaming 4

¥

The (Roaming Start) icon allows you to identify the location at which the phone enters and exits the roaming state. You

can hover the mouse over these instances to view additional data regarding the roam.

(&) AirMagnet Survey Professional Edition - Sample VoFi Survey.svp p— m s
File Edit View Help
(B Flanner  Fo Mutti Floor Planner K Survey [ simulstion Multivien 2y Ditrview ) AinwisE [%] Reports
Clip e = . — — —
p\;]N_ii‘ﬁﬂ@a@‘keliQQSSk@@;V@Wm”' & _E
ttion 'Sit aVIQ@SﬁmNEVDFiSUWEyWP O O A A Y
ase Pro] | | =i Site Map |
I AMLc 222N dd | b L0 Arques HQ Floorplan Ldwg -
[7 AmSp 3 Survey Data = .
d ] 1in.=4188% Dimensions(X x ): 203.19 ftx 269.02
[T AMSp HERTRN - @ g VoFiSurveyl.svd =y
Pexpert 4 yorig| | - P PassiveSurveylsvax 3
I iperfli A8l = 4 Survey Path E
[ Optivi VoFiSurveyl.path E
7 Parser va [ PassiveSurveyLpath q
2 b

[ Surve Rofil— =
B Viewe T'd' [#] Select All Events E|

E’_] By Insfil| & VoFi Roaming Events b

u‘ fe Lol &1 Roaming 1 B

“5? " © i Roaming Start 3

AP Signal Channel WiMos Channel Utilization # of Station(s) # of Call(s) Event #

From AP QA VoFi 3  -82dBM 157 247 7.60 1 1 Roaming 4

To AP QA_VoFi_2  -76 dBM 149 157 848 2 1 Roaming 4

Result: Success Reconnect Roaming Time: less than 1 sec

to— PoYeT—r T 3,

The bubble help pop-up allows you to attempt to determine the reason that the phone roamed at this point on the map. The
information is displayed for each AP involved in the roam (for example, the original AP and the one to which the phone
roamed), as summarized in the table below.

Column Description

AP Displays the name for both APs in the roaming transaction. The original AP is listed first, followed by the new
AP (for example, the one to which the phone roamed).

Signal The signal strength detected from each AP at the roaming point. In most cases, the phone attempts to roam
from an AP with lower signal strength to one with a stronger signal.

Channel The channel on which each AP is operating.

WiMOS The WiMOS value for the call before and after the roam. A higher score indicates improved call quality.

Utilization |The percentage of available bandwidth on the channel used at the time of the roam.

Station(s) [Total number of stations associated to each AP. This value includes other phones, which are recognized as
stations.

Call(s) The number of active VoFi calls being supported by each AP.

Results Displays whether the roaming attempt was successful or failed. Failed attempts result in the call being lost.

-230 -



VoFi Data and Surveys

Roaming The amount of time that passed while the phone was attempting to roam.
Time

Troubleshooting Poor Call Quality

VoFi call quality can suffer due to various different factors in the wireless environment. This section is designed to help you

o . . y MultiView

identify the root cause of a problem detected during the VoFi survey process. The MultiView feature
allows you to view up to four different data types for a VoFi survey data file at any given time. This can be extremely useful
when attempting to identify and troubleshoot a region in which the WiMOS value unexpectedly drops on the map. The steps
below illustrate the recommended method for diagnosing the root cause behind a low WiMOS.

See the MultiView View topic, starting with Map Window for instructions on using MultiView.

To troubleshoot a region with low WiMOS:

1. After identifying the problem area on the map, import the same project containing the VoFi data file into the MultiView
window four times (See MultiView File Menu).

2. Select the same VoFi data file for each view pane.
3. Make sure the Automatic Multi-Select option is off (See MultiView Toolbar).
4. Use the Data Type drop-down list to load the following heatmaps into the four panes:
» Signal Strength (from AP -> Phone)
e PHY Data Rate (from AP -> Phone)
e Packet Retry Rate (from AP -> Phone)
e Channel Utilization

3. Assess the signal coverage at the region with a low WiMOS using the Signal Strength map. If the signal strength is low (for
example, -67 dBm or lower), the signal coverage provided by the deployment is insufficient to support a VoFi imple-

mentation. See Insufficient Signal.

4. If the signal level is sufficient, look at the PHY Data Rate at that area. If it is lower than 24 Mbps, the conversation is not
being transmitted at a high enough data rate for high quality conversation levels. See Low PHY Data Rate.

5. In the case where the speed is adequate for the conversation, the problem may lie in the Packet Retry Rate
map. Excessive retries can mean that transmissions from the AP to the phone are not always going through, which can
result in a call being lost. See High Retry Rate.

6. Finally, if the other three maps have been verified to be problem-free, the overall utilization of the channel may simply be
too high. Any Wi-Fi deployment is inherently limited in the number of transactions that can be supported simultaneously,
and as utilization climbs, traffic may be transmitted at slower speeds to give the infrastructure more time to process
exchanges. If you find that too much of the network is being used at a given time, you may need to upgrade the infra-
structure with additional APs to support the volume of traffic detected.

Insufficient Signal

Ensuring adequate signal coverage is a significant challenge for standard data network implementations; however, Voice-
enabled deployments present unique challenges, not the least of which is the fact that a VoFi implementation requires a
much higher signal level to ensure adequate call quality. If you are finding that your signal coverage is insufficient for either
type of implementation, this can generally be caused by several different factors:

» Insufficient infrastructure:This factor is easiest to diagnose but may not be easiest to remedy. If a deployment does not
have enough APs to ensure adequate signal coverage throughout the entire region, transmissions suffer. This is par-
ticularly noticeable for VoFi deployments, because voice traffic requires a strong signal to ensure that voice-quality trans-
mission speeds are maintained.

Although it may seem that adding more APs to the deployment should be the obvious answer to this problem, this is not
always the case. In some situations, this may be the best solution; however, due to the nature of the wireless spectrum,
APs that are placed too closely to each other (both in physical proximity as well as in adjacent channels on the same
band) can create interference for each other, causing additional problems. In some cases, you may find it more helpful to
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rearrange the placement of the existing APs by sacrificing coverage in areas that do not require VoFi signal strengths (e.g.,
break rooms, lobbies, and so on) to maintain adequate signal in the most heavily-used areas.

o Interferers: Network interference can come from two major sources: 802.11 and non-802.11 devices.

© 802.11 devices include all existing wireless devices currently active on the network, including APs, stations, VoFi
phones, and so on. Most often this interference comes from APs on the same network operating on the same (or
adjacent) channels. Standard wireless practice recommends that APs placed in close proximity be configured to use
channels that are at least five apart. Common practice for the 2.4 GHz band is to use channels 1-6-11, although
standards may vary depending on country/region.

© Non-802.11 sources can include a wide variety of common items, including cordless phones, Bluetooth devices,
microwave ovens, or even fluorescent lighting. Reduce this interference by placing APs far from potential interferers,
particularly microwaves or wireless cameras.

© For advanced analysis, you can identify all sources of interference in the environment using a Spectrum Analyzer.

o Obstacles: Large or dense physical objects in the middle of a wireless deployment can reduce signal coverage in their
immediate vicinity, creating "holes" in the network's coverage. Obstacles are most commonly pillars or thick walls, but
can also include bodies of water, rooms full of equipment, etc. Moving obstacles in the wireless environment is often
unfeasible, so you may need to either add or rearrange APs in the deployment.

Low PHY Data Rate

The rates at which packets are transmitted through the wireless network can drastically affect the quality of service for users,
most particularly during VoFi conversations. This can be caused by a number of different factors:

» Mixed-mode devices: Wireless deployments that are designed to operate at high speeds (such as those provided by Wi-Fi
6 or 7 devices) can have those speeds dramatically reduced when slower devices (such as those that operate on 802.11b-
only) are introduced into the environment. Such "legacy" devices can cause traffic from all sources to be transmitted at
lower rates due to the simple fact that they cannot operate at the higher rates.

In these cases, eliminating the legacy devices is the easiest solution. This can often be done simply by upgrading or
replacing the older components, ensuring that the replacements can meet the higher speeds required for the deployment.

o Interferers: Network interference can come from two major sources: 802.11 and non-802.11 devices.

© 802.11 devices include all existing wireless devices currently active on the network, including APs, stations, VoFi
phones, and so on. Most often this interference comes from APs on the same network operating on the same (or
adjacent) channels. Standard wireless practice recommends that APs placed in close proximity be configured to use
channels that are at least five apart. Common practice for the 2.4 GHz band is to use channels 1-6-11, although
standards may vary depending on country/region.

© Non-802.11 sources can include a wide variety of common items, including cordless phones, Bluetooth devices,
microwave ovens, or even fluorescent lighting. Reduce this interference by placing APs far from potential interferers,
particularly microwaves or wireless cameras.

© For advanced analysis, you can identify all sources of interference in the environment using a Spectrum Analyzer.

« Insufficient signal coverage

High Retry Rate

High levels of packet retry attempts indicate that packets are being lost during transmission. This can create problems for
standard data networks (due to slower transmission rates) and can drastically impair the quality of voice transactions
conducted on the same deployment. Dropped packets can cause jitter or gaps in a conversation, quickly rendering a VoFi
connection unintelligible.

High percentages of retries can be caused by:
o Interferers: Network interference can come from two major sources: 802.11 and non-802.11 devices.

o 802.11 devices include all existing wireless devices currently active on the network, including APs, stations, VoFi
phones, and so on. Most often this interference comes from APs on the same network operating on the same (or
adjacent) channels. Standard wireless practice recommends that APs placed in close proximity be configured to use
channels that are at least five apart. Common practice for the 2.4 GHz band is to use channels 1-6-11, although
standards may vary depending on country/region.
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© Non-802.11 sources can include a wide variety of common items, including cordless phones, Bluetooth devices,
microwave ovens, or even fluorescent lighting. Reduce this interference by placing APs far from potential interferers,
particularly microwaves or wireless cameras.

© For advanced analysis, you can identify all sources of interference in the environment using a Spectrum Analyzer.

Excessive Devices: Some deployments have more devices than the network infrastructure can support. This can result in

transmission collisions and traffic being ignored in favor of devices with a better signal. You can address the problem by

expanding the infrastructure (that is, add APs) or by reducing the total number of stations requiring service.
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Using WLAN Tools

In this chapter:
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Using the Ping Tool . ... ... . . 237
Verifying GPS Information ... . . 237
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Introduction to WLAN Tools

This section describes the four diagnostic tools AirMagnet Survey provides for evaluating and troubleshooting a WLAN. Access
these tools from the Tools window.

» Signal Distribution
- DHcp

- Ping

e GPS Information

Signal Distribution

The Signal Distribution tool is designed to enable WLAN professionals to detect RF signal problems (for example, signal
multipath) by visually analyzing RF signal distribution patterns. The sample image below shows healthy signal distribution as
indicated by the yellow dashed lines clustering in a single range. In case of multipath, the yellow dashed lines would be
scattered all over the chart.

To access the Signal Distribution tool:

1. From the Toolbar, click: (Tools). The Tools window appears. By default, the Signal Dist.tab (Signal Distribution) is
automatically selected when the Toolswindow opens.

Tools @

(AP |[.0cfb.ca3 fairtek-01] ) @ @

| Chanrel # Flis Sid

| in | (LEY | Current

Signal

SHR

| DHCP |

2. Click the down arrow in the upper-left corner of the window to select AP or STA.
3. Click the down arrow in the upper-right corner, and select the AP or STA to be analyzed.

4. Click Logging Option. The Signal Distribution Option window appears.
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From the lower-right corner of the Tools window, select either or both of the following:

' Signal Distribution Option =
Log file
[ Wiew Log... ] [ Set Log Fields... ]
Beep when log entries [ v]
[T] Reset log file with new log session
Graphing speed [Ever_l,l 1 second v]
Lo by tirne [Ever_l,l 3 zeconds v]
i ]84 ] [ Cancel ]
5. Make the desired selections and click OK.
6.
e Signal
¢ Noise
7.

Click Go. The signal distribution pattern of the selected AP or STA is plotted on the chart.

Using the DHCP Tool

WLAN connectivity problems can arise from data link layer malfunctions or IP network layer misconfiguration. To
troubleshoot and pinpoint the cause of the problems, you must investigate the interaction between the two network layers.
AirMagnet Survey’s embedded DHCP tool emulates a WLAN client acquiring IP-level connectivity beginning from the initial
802.11 client association procedure.

To access the DHCP tool:

1.

2.
3.

From the Tools window, click the DHCP tab. The Tools window refreshes.

Tools

=

Cards:  Proxim Wireless 8434 802.11a/b/g/n USE Adapter #16

[ap | [L0cib ca3 fairtek-01] -

Subnet Mask
Default Gateway
DHCP Server
DNS Servar
WINS Server
Lease Obtained
Lease Expires
Lease Period

FIPING [www google.com

#Pings:|5

Delay: 1

Timeout: 1000 ~ | ms
sec

Lengin: (2 ~|byte

| signal Dist | DHCP |

From the top left corner of the Toolswindow, click the down arrow to select APor SSID.

From the top right corner of the Toolswindow, click the down arrow and select the APor SSID from the drop-down list.

4. Click Start. AirMagnet Survey starts associating with the selected AP or SSID and perform the tests.

Note: During the association, AirMagnet Survey uses the 802.11 configuration parameters for the AP or SSID, which can be
accessed using File > Configure... > 802.11. The associated AP or SSID is shown on the view. An error message pops up on
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the view if an unintended AP is associated or the intended association fails. This serves as a confirmation that a data link
layer problem exists.

5. Verify the DHCP acquisition of the IP address for the client service, default gateway, and DNS server.

6. Click Renew to initiate the DHCP request once the association with the intended AP has been confirmed. The following
IP-level configuration parameters are filled in on the view if DHCP request/reply is successful:

e Device IP address
e Subnet mask

o Default gateway
e DNS server

If it turns out that these parameters are NOT the ones you expected or if you received a DHCP failure message, the chances
are that there is an error in the encryption key configuration. If the problem persists after you have verified the correct
encryption key, there might be a problem with the DHCP server.

Using the Ping Tool

You can add a Ping test to DHCP test to verify end-to-end connectivity. It is used after all the IP configuration parameters are
collected and confirmed using DHCP.

To add a Ping test:

1. From the Tools window, click the DHCP tab.
2. Check the Ping option.
2. Configure the following options:
e AP/SSID
e #Pings
e Timeout
e Delay
e Length
3. Enter the end node’s domain name, for example, www.yahoo.com.
4. Click Go. Real-time Ping responses appears on the view.

Note: If the Ping test shows time-out, it means that the Ping connectivity with the local LAN has failed. In this case, you
should check the health of the default gateway and the physical connection between the associated AP and the wired LAN.
Enter a host name on your corporate network such as your internal Web server, for example, www.in-
ternal.My/computer.com, and click Go.

Verifying GPS Information

This tool is used to verify if your AirMagnet Survey is receiving GPS signals. To use AirMagnet Survey to conduct large-scale,
outdoor, GPS-aided site surveys, your Survey must be able to communicate with the GPS device it is connected with. When
using GPS software in conjunction with AirMagnet Survey, the GPS software must receive GPS position data before the survey
is started.

Note: This feature is available only in Survey PRO and only when the GPS port is enabled.
To verify GPS Information:

From the Tools dialog box, click GPS Information. The Tools dialog box refreshes. Survey PRO connects to the GPS device
and displays a dialog box. For more information, see Creating a GPS-Aided Survey Project Using an Existing Site Map.
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Tools

Speed

Longitude:

Latitude:

Altitude:

Heading:

uTC:

$GPGSAA3,07,13.10,09.23,.08.....4.02532°34

121.574058°W

37.383887°N

257M

4829

0.07

232407.000

Please note the GPS device must be NMEA compliant.

Signal Dist | DHCP [{ GPS Irfomation |
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Converting Between milliWatt and dBm

The milliwatts and dBm Conversion tab of the calculator provides two conversion operations: from dBm to milliwatt and
from milliwatt to dBm. dBm is used to express an absolute value of power relative to a milliwatt.

Wireless Calculator @

| Free Space Loss | Fresnel Zone | Dowrtilt Angle I Dowrtilt Coverage
Wiliwatts and dBm Conversion | System Operating Margin

(t03)

Power (mWatt) Sign?tllg::ngm
dBm = (10Log(mWatts}) — 4 feBmTy
ImWait =0 dBm LS
millVWatts to dBm
0 mW = dBm
dBm to milliWatts
0 dBm = mW

To convert milliwatts to dBm:

1. From the Calculator window, select the Milliwatts and dBm Conversiontab.
2. Under milliwatts to dBm, enter a value in milliwatts (from 0 to 1000).

3. Click Calculate. The system converts the value to dBm.

To convert dBm to milliwatts:

1. Under dBm to milliwatts, enter a value in dBm (from -100 to 100).

2. Click Calculate. The system converts the value to milliwatts.

System Operating Margin

System Operating Margin (SOM) is the difference between the signal a radio actually receives versus that the signal needed
for good data recovery (Receiver Sensitivity). SOM measures in dB the signal loss a system can sustain before it degrades to
the error rate specified at the Receiver Sensitivity threshold. SOM accounts for all gains and losses in the components (such
as transmitter power, type of antenna, distance, etc.) that make up a wireless network system. The goal is to make sure that
the system has sufficient power to send radio signals to their destination.

Normally, a minimum 20-dB SOM is recommended. However, factors (inadequate Fresnel clearance, desensitization,
etc.) require many network designs to use a 30 dB (or greater) SOM. SOM calculation assumes an interference-free open
space.
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Wireless Calculator

(]

Free Space Loss I Fresnel Zone I Dowrtitt Angle I Downtitt Coverage

Miliwatis and dBm Conversion | System Operafing Margin

Tx Antenna Gain

Cpen Space

Tx CableLoss

Ta Pawer

Transmitter or
Amplifier

Fx Antenna Gain

((9)) ———— ((9))

Fx CableLogs

Rz Signal Stiemgth

Receiver or Amplifier

Frea Space Lass = J0LogIMHz) + 0L og (Distanee in Matars) - 27.4

R Signal Lave) = T Powar— Te Cabla Loss + Te Antanna
Gat — F5L * Bx Antenia Gain — RE Cable Loss
SOM = Rx Shfial Level — Rk Sansitivity

Frequency: 2400 MHz Tx Cable Loss: 0 dB
Power: 0 mWatts Tx Antenna Gain: 0 dBi
Distance: 0 Feet Fx Cable Loss: dB
R Antenna Gain: 0 dBi
Fx Sensitivity: -83 dBm
Free Space Loss: dB
Rx Signal Level: dBm
System Operating Margin: dB
Caloulate | | Resat

To calculate System Operating Margin:

1. Click the System Operating Margintab. The Calculator window refreshes.

2. Make the following entries:

¢ Frequency

e Power

o Distance

e Tx Cable Loss

e Tx Antenna Gain

e Rx Cable Loss

¢ RxAntenna Gain

e Rx Sensitivity

3. Click Calculate. The following values are calculated:

e Free Space Loss

» Rx Signal Level

e System Operating Margin

Free Space Loss

Free space loss refers to signal attenuation that occurs assuming that all absorbing, diffracting, obstructing, refracting,
scattering, and reflecting influences are removed and have no effect on RF signal propagation. Free space loss is mainly
caused by beam divergence (signal energy spreading) over larger areas at increased distances from the source.
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Wireless Calculator @

| Milliwatts and dBm Conversion I System Operating Margin
| Fresnel Zone I Dowrtilt Angle I Downtilt Coverage

(( )) Rx Signal Strength
— Il

Distance

Froe Space Loss = 20Log.w(MHz) + 20LogaDistance in Moters) - 27.4

Frequency: 2400 MHz

Distance: 0 Feet
Free Space Loss = dB
Caloulate | | Resat

To calculate the free space loss:

1. From the Calculator window, select the Free Space Losstab. The Calculator window refreshes.

2. Make the following entries:
¢ Frequency
o Distance

3. Click Calculate.
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Fresnel Zone Clearance

The line-of-sight condition between the transmitter and the receiver is crucial in high-frequency radio communication. The
Fresnel zone is an elliptical-shaped area between two antennas where no obstacles may exist so that radio signals can be

transmitted. The zone defines the optimum clearance and lets you determine the best antenna height between the AP and
the client stations without any obstacles.

Wireless Calculator @

Milliwatts and dBm Conversion I System Operating Margin
Free Space Loss | Dowrtilt Angle I Downtilt Coverage

L e
! !

RiFget) = 72.05 x «d[Miles]/4F
Rimeters] = 17.3Z ¥ Jd{kilameters |jaf

Distance: 0 Mies
Frequenicy: 24 GHz
Fresnel Zone Radius: Feet
60 % Fresnel Zone Radius: Feet

=

To calculate Fresnel Zone:
1. From the Calculator window, select the Fresnel Zone tab. The Calculator window refreshes.
2. Make the following entries:
» Distance
e Frequency
3. Click Calculate. The following values are automatically calculated:
e Fresnel Zone Radius

e 60% Fresnel Zone Radius
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Downtilt Angle

Antenna downtilt affects radio signals traveling between the transmitter and the receiver. As a rule of thumb, the higher the
transmitter antenna and the shorter the distance, the more tilt is required. For instance, for a 30-meter high transmitting
antenna, a 0.35-degree antenna tilt is required to reach a 12-meter high receiving antenna at a distance of 3,000 meters.

Wireless Calculator @

Milliwatts and dBm Conversion | System Operating Margin
Free Space Loss I Fresnel Zone  |; | Downtilt Coverage

]

| Distanecs |
| |
Distance = (Hb - Hr} § Tan & Angla = Tan" [ (Hb — Hr)/Distance}}
Base Antenna Height (AMSL): 0 Feat
Remote Antenna Height: 0 Fest
Distance 0 Feet Titt Angle = Degrees
Angle 0 Degees Distance => Feet

=

To calculate the Downtilt Angle:
1. From the Calculator window, select the Downtilt Angle tab. The Calculator window refreshes.
2. Make the following entries:
e Base Antenna Height
e Remote Antenna Height
e Distance
e Angle
3. Click Calculate.
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Downtilt Coverage

Downtilt Coverage defines the area into which the antenna of an AP can beam.

Wireless Calculator

Free Space Loss I Fresnel Zone I Dowrtitt

Angle

Inner Cell Radies |

Cuter Coll Radius.

Millwatts and dBm Conversion I System Operating Margin

Antenna Height:
Dowrtitt Angle:
Vertical Beam Width:
Inner Radius =

Outer Radius =

Calculate

0 Fest

0 Degress

0 Degrees
Feet

Feet

Tnsr Radis Distance = H{ Tan[Aatenna Downtil Angla + Bagmi®idih « 3}
Cuter Radius Distance = H ! TaniAntenna Downtill Angla - BaamWidih 7}

To calculate the Downtilt Coverage:

1.
2.

Make the following entries:
e Antenna Height

« Downtilt Angle

e Vertical Beam width

Click Calculate.

From the Calculator window, select the Downtilt Coverage tab. The Calculator window refreshes.
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Working with Spectrum Analyzers

This section describes AirMagnet Survey’s ability to integrate with supported spectrum analyzers. This integration allows you
to view RF traffic across the entire wireless spectrum. Spectrum Analyzers display potential sources of wireless interference
detected during a survey. This can help you identify and eliminate RF hazards in the wireless environment as soon as they are
detected.

Notes:

« This feature is available only on AirMagnet Survey PRO.

« AirMagnet Survey supports integration with the following supported analyzers:
© AirMagnet Spectrum XT

* To use this feature, you must have install the supported spectrum analyzer and configure it on your laptop. See
Configuring a Spectrum Analyzer for more information.

* Not supported for the 6 GHz band.

Collecting Spectrum Data

The integrated Spectrum Analyzer Window appears below the Map Window on the Survey view, provided that a supported
spectrum analyzer adapter is installed (inserted) and that this option is enabled in AirMagnet Survey. A close-up look at the
Spectrum Analyzer Window is provided below.

The Spectrum Analyzer Window displays the FFT (Fast Fourier Transform) plot which contains three types of data represented
by the line charts in distinctive colors. The table below briefly describes each of these data.

Color [Data Description
Type
Yellow |Max The maximum power value detected at any time since the plot was initiated. Max Hold means that the plot
Hold holds onto the maximum power value up to the present.

Red |Max The maximum power value detected during the most recent measurement interval.

Green [Average |[The average power value detected during the most recent measurement interval.

Viewing Spectrum Data

With spectrum analyzer integration, you can see the integrated spectrum analyzer Window on the Display view if they have
this featured enabled. You can also display and analyze spectrum data by mousing over any data point along the survey path.
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Note: When you mouse over a point on a survey path, you not only see a tip view showing the Wi-Fi data collected at that
spot but also a pushpin that is related to what you see in the Spectrum Analyzer Window below. With spectrum data on the
view, a tip view pops up if you mouse over any spot on the FFT plot in the Spectrum Analyzer Window. This tip view shows
more spectrum data about that spot.

Spectrum integration allows you to identify non-802.11 devices that cause interference with the wireless deployment
(henceforth known as “interferers”). Click here for more details.
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You can also use Spectrum XT to display a spectrum heatmapto help locate major sites of spectrum traffic.

Spectrum Heatmap Display

To provide a more comprehensive and user-accessible means of viewing spectrum data, Survey implements a spectrum
heatmap option when spectrum analyzer integration is enabled. This allows you to view all RF traffic in the entire spectrum,
including both Wi-Fi (APs, stations, and so on) and non-Wi-Fi (Bluetooth devices, microwaves, and so on) sources. The
spectrum heatmap displays the average spectrum level for each channel at any given point on the map. The color-coded
display makes it easy to determine areas of unusual spectrum traffic, allowing you to quickly troubleshoot problem spots.

To view the spectrum heatmap:

1. From the Display page, load the spectrum data file.

2. Click the data type drop-down list in the map window and select Spectrum. The heatmap refreshes, displaying spectrum
data.
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You can narrow the displayed spectrum to a specific channel, allowing you to identify unusual traffic at the particular
frequency of interest.

Note: The heatmap displays an overview of spectrum information. You can still mouse over a point on the survey path to
view specific spectrum data for that exact location.

The spectrum heatmap can be particularly useful when you want to determine the optimal channel for a new AP. By viewing
the heatmap on the desired channel, you can see whether there is excessive spectrum traffic at that location. If the spectrum
traffic level is high, you must change the environment to eliminate interferers or select a new location.

Spectrum Interferers

Interferers can be viewed in a list and as detected in the deployment by using the interferer heatmap provided on the Display
view. The interferer power heatmap shows the power levels for any such devices detected during the survey process and also
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provides a list of the devices found. This can be useful for identifying potential interference sources that may not be picked
up by a standard Wi-Fi survey.
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Digital Video Controller Digital Videa Montr(DSSS) 2469.97 MHz

Digital Cordless Phones FHS5 Cordless Phone 2474.03 MHz

Selected APs 2

After gathering interferer data, you can view the interferers detected listed in the Categories tree towards the left of the view.

Ly

lgl| Categories

802.11 FHSS

----- @ Baby Monitor

----- ¥/ €3 Bluetooth

----- &, Cordless Phones

----- £, Digital Cordless Phones
----- 1 Digital Video Controller
----- W B Jammers

----- w8 Microwave Cvens

----- & Motion Detector

v (g Mon-Bluetooth Wireless Mouse
----- Wi # Possible Interferer

----- '.' Radar Signal

----- () Unknown

----- | @) Wireless Camera

----- P Wireless Game Controller
----- =) Zigbee

Bold categories indicate that devices that match that particular category were detected during the survey. (For example, in
the first figure above the system detected interference from Bluetooth devices, cordless phones, and Digital Video Controllers
over the course of the survey.) You can identify the location of the devices by selecting the desired type; the heatmap
refreshes to highlight only the location(s) in which that device was detected.
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Working with Spectrum XT

All interferers detected across the entire survey path are displayed in the bottom pane of the window, below the spectrum
graphs. This table provides various data regarding the detected interferers, including the Type, Name, a brief description, and
its center frequency (if known).

-20 dBm

-70 dBm

-120 dBm

240 GHz

Type | Name | Description | Center Frequency
Digital Cordless Phones FHS5 Cordless Phone 2475.72 MHz
Digital Cordless Phones FHS5S Cordless Phone 2466.84 MHz
Eluetoath Bluetoath 247309 MHz
Digital Video Controller Digital Yideo MonitorD555) 2483.97 MHz
Digital Videa Contraller Digital Widea Monitar[D555] 2469.97 MHz
Digital Cordless Phones FH5S Cordless Phone 2474 03 MHz

Generating Spectrum Analyzer Reports

AirMagnet Survey not only enables you to collect and analyze the enormous amount of spectrum data in the airwave over
your WLAN site, but also allows you to convert these valuable data into reports, making it convenient to share, archive, and
further analyze the data.

However, to generate and view spectrum analyzer reports, you must make sure that first of all spectrum data are being
collected during the site survey. To do so, you have to make sure that the following requirements are met at the time of the
survey:

1. You have AirMagnet Survey PRO installed on your laptop.
2. You have the associated spectrum analyzer adapter inserted in your system.

3. You have the Spectrum Integration feature enabled on AirMagnet Survey, which can be done by selecting File >
Configure... > Spectrum Integration > Enable Spectrum Integration.

If these three requirements are met, you should be able to see the Spectrum Analyzer Window with spectrum data in it at the
bottom of the Survey view when you are doing the survey.

Once spectrum data are collected, the next step is to open the data file on the Display view and mark the spectrum data
collection points on the survey path. This is important because even though spectrum data are collected, no Spectrum
Analyzer report shows up on the Reports view until the spectrum data collection points are marked on the survey path.
Otherwise, you get an error message when you try to open the Spectrum Analyzer Report on the Reports view. To see how to
mark spectrum data collection points along the survey path on the Display view, click here.

Once you have marked all the spectrum data collection points on the Display view, AirMagnet Survey automatically generates
the Spectrum Analyzer Report, which can be viewed from the Reports view just as with any of the other reports. For instruc-
tions, click here.

Marking Spectrum Data Collection Points

To mark spectrum data collection points:

1. From the Display view, open the data file that contains the spectrum data.

2. Right-click inside the Map Window. A pop-up menu appears.
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From the right-click menu, select Mark Spectrum Data Mode.

2475.72 MHz
246E.84 MH2
2472.09 MHz
2469.97 MHz
2469.97 MH2

Note: A check mark appears in front of Mark Spectrum Data Mode when this feature is activated.

4.

In the Map Window, click to select the spectrum data collection points along the survey path.
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Working with Spectrum XT

Note: Pin icons appear where you click. Pins are automatically numbered in the order they appear. As you click, spectrum
data also appears in the Spectrum Analyzer Window. Be sure to click along the survey path. Otherwise, no icon appears and
no spectrum data point is marked.

Viewing AirMagnet RF Spectrum Reports

To view the RF Spectrum Report:

Reports

1. Click |j P on the Navigation bar to switch to the Reports view
2. From the Report List Window, select RF Spectrum Report.

3. Navigate through the report using the tools on the view.

Note: Normally, the number of pages contained in a report depends on the amount of data in the data file selected. However,
in the case of the RF Spectrum Report, the length of the report is determined by the number of data collection points (you
have marked), which in turn determine the amount of data contained in the report.
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Software License Agreement

Software License Agreement

Use of this product requires acceptance of the Terms and Conditions available at
https://NetAlly.com/terms-and-conditions or which accompanies the product at the time of shipment or, if applicable, the
legal agreement executed by and between NetAlly and the purchaser of this product.
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